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Preface

This guide contains essential information about configuring Kofax Capture and Kofax Capture Network
Server (KCN Server).

This guide assumes that you have a thorough understanding of Windows standards, applications, and
interfaces. It also assumes that, if you are installing KCN Server, you have a thorough understanding of
the Internet, Web servers and your Web server software, your network configuration, and Kofax Capture.

This guide is for system administrators and developers who are configuring Kofax Capture or KCN Server,
or who need a description of the configuration features and procedures.

Related Documentation
In addition to this guide, the Kofax Capture documentation set includes the following:

Kofax Capture Installation Guide
The Kofax Capture Installation Guide contains essential information about requirements and installation
procedures related to Kofax Capture and Kofax Capture Network Server (KCN Server).

Kofax Capture Developer’s Guide
The Kofax Capture Developer’s Guide provides guidance and instructions for customizing Kofax Capture.
Several examples and code segments are provided to demonstrate how to create custom panels, Ribbon
tabs, workflow agents, modules, and scripts to enhance Kofax Capture processing.

Help for Kofax Capture
Kofax Capture online Help provides online assistance for system administrators and operators.

Kofax Capture API References
The Kofax Capture API Reference (APIRef.chm) is an online guide that provides the details of each
API library needed to customize Kofax Capture. The Kofax Capture Export Type Library API Reference
(APIRefExport.chm) gives details needed to customize an export connector. Both API References
are intended to be used alongside the Kofax Capture Developer’s Guide as a primary resource for
customizing Kofax Capture.

You can access both API References in the following folder, which is available on your Kofax Capture
installation media:

Documentation\Help\APIRef
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Kofax Capture Release Notes
Late-breaking product information is available from release notes. You should read the release notes
carefully, as they contain information that may not be included in other Kofax Capture documentation.

Kofax Capture Technical Specifications
Contains information on supported operating systems and other system requirements.

Training
Kofax offers both classroom and computer-based training that will help you make the most of your Kofax
Capture solution. Visit the Kofax website at www.kofax.com for complete details about the available
training options and schedules.

Getting Help with Kofax Products
The Kofax Knowledge Base repository contains articles that are updated on a regular basis to keep you
informed about Kofax products. We encourage you to use the Knowledge Base to obtain answers to your
product questions.

To access the Kofax Knowledge Base, go to the Kofax website and select Support on the home page.

Note The Kofax Knowledge Base is optimized for use with Google Chrome, Mozilla Firefox or Microsoft
Edge.

The Kofax Knowledge Base provides:
• Powerful search capabilities to help you quickly locate the information you need.

Type your search terms or phrase into the Search box, and then click the search icon.
• Product information, configuration details and documentation, including release news.

Scroll through the Kofax Knowledge Base home page to locate a product family. Then click a product
family name to view a list of related articles. Please note that some product families require a valid
Kofax Portal login to view related articles.

• Access to the Kofax Customer Portal (for eligible customers).
Click the Customer Support link at the top of the page, and then click Log in to the Customer Portal.

• Access to the Kofax Partner Portal (for eligible partners).
Click the Partner Support link at the top of the page, and then click Log in to the Partner Portal.

• Access to Kofax support commitments, lifecycle policies, electronic fulfillment details, and self-service
tools.
Scroll to the General Support section, click Support Details, and then select the appropriate tab.
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Chapter 1

Overview

Kofax Capture is designed to support both document capture and data capture in a single application.
Both structured and non-structured documents can be scanned in a single batch. The system
automatically recognizes and processes each document in the batch based on characteristics that you
define. The definition process is simple, quick, and provides an extraordinary amount of control over how
your documents are processed.

Kofax Capture Network Server (KCN Server) extends the capabilities of Kofax Capture by allowing
inexpensive Kofax Capture remote workstations to assist in the capture and processing of documents and
data. With Internet (or intranet) capabilities, Kofax Capture workstations can be connected to a central site
to assist in the document and data capture process.

This guide provides information about configuring and managing your Kofax Capture and KCN Server
installations.

Processing Queues - An Overview
In Kofax Capture, a queue is a processing step for a batch of documents. For example, a Scan module
is available for scanning or importing documents and a Validation queue is available for validating
documents.

As batches flow through your Kofax Capture system, they are routed from queue to queue in a "workflow."
The queues that are used to process a batch, and the order that processing occurs, are specified as part
of the batch class definition.

Kofax Capture supports the following queues, which are listed in the order they are typically used: 
• Scan
• Quality Control
• Recognition Server
• Validation
• Verification
• OCR Full Text
• PDF Generator
• Export

Although not technically considered a processing queue, Kofax Capture also supports the Administration
module, from which you can create batch classes; and Batch Manager, from which you can monitor and
process the batches in your system.
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Note Two other processing queues, XML Import Connector and Email Import Connector, are available
but now are deprecated. As a result, they will be removed in a future product release.

Use the batch class definition to specify which queues are used to process batches.

Batch Editing
You can modify batches after scanning or importing images and perform tasks such as moving pages
or folders, inserting pages or folders, and creating documents or folders. Kofax Capture supports batch
editing in the Scan, Quality Control, Validation, and Verification modules.

Note Batch editing for Validation or Verification is possible only if the appropriate batch class properties
are configured for those queues in the Administration module.

Edit your batches in the Batch Contents panel. This panel is selected by default and displays the contents
of a batch using a tree structure similar to that used by many file management applications, such as
Windows Explorer.

You can easily edit batches by moving (dragging) thumbnails or icons, or by assigning properties, such as
"Rejected."

When moving a page, its thumbnail appears directly under the cursor. If you drag multiple pages, the
first thumbnail is shown under the cursor along with multiple edges, as if multiple thumbnails are being
dragged behind it.

Batch Editing Operations
All batch editing operations, as listed here, work in either the icon or thumbnail views:
• Moving a page to a document or within a document (you cannot move loose pages into a folder)
• Moving a page outside a document (making a loose page)
• Deleting a page
• Inserting a page (Scan and Quality Control modules only)
• Replacing a page (Scan and Quality Control modules only)
• Moving a document into or out of a folder
• Moving documents within a folder
• Deleting a document
• Creating a document
• Splitting a document
• Merging documents
• Rotating and saving a page or document
• Rejecting a page or document
• Un-rejecting a page or document
• Marking a page as reviewed (Quality Control module only)
• Marking a document as verified (Quality Control module only)
• Moving a folder into or out of another folder
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• Moving folders within a folder
• Adding a new folder
• Deleting a folder
• Changing a folder class
• Creating folders automatically

Using the thumbnail and icon views, you can also do the following:
• View page properties
• View document properties
• View batch properties

Retain Zoom Feature
Retain Zoom is available only in the Validation and Verification modules. Use this feature to retain pan and
zoom settings for the image viewer during the following operations:
• Switching pages
• Switching documents
• Opening batches
• Closing batches

Once you select Retain Zoom, your selection is retained. It is not possible to retain independent settings
for the zoom options.

Select Retain Zoom on the View tab, in the Zone group, under Pan Mode. The display behavior conforms
to the following rules:
• Magnify Zone, Anchor Zones, and Pan to Zone are automatic settings; Manual Zoom turns off all

automatic settings.
• Any automatic zoom function takes precedence over Retain Zoom or Manual Zoom. If Retain Zoom

and one of the automatic functions are selected at the same time, Retain Zoom has no apparent effect
unless you change pages. When changing pages, Retain Zoom prevents the viewer from resetting to a
full page view.

• If none of the automatic zooming features is selected, Retain Zoom takes precedence over Manual
Zoom.

• If only Manual Zoom is selected, zoom settings return to the full page view when you switch fields or
pages.

Using Kofax Capture and Kofax Capture Network Server Across
Regions

With Kofax Capture or Kofax Capture Network Server, you can share batch classes and batch processing
among sites that use different language versions of Kofax Capture or have different regional settings.
Regional settings such as date format or decimal separator (which are set up in Windows Control Panel
for every computer) are automatically converted when a batch class is imported. Other items within the
batch class, such as profile names, are translated to the language of Kofax Capture on the imported
computer.
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All client workstations in a Kofax Capture client/server installation must use the same language version
and the same regional settings.

This section provides information on regional settings and format options, what is (and is not) translated,
and how you can use the Display Label feature to create batch field and index field names.

Regional Settings Conversion
All occurrences of numeric, date, and time values in the following items are converted to the regional
format settings of the computer that imports the batch class or the remote site that downloads the batch
class.
• Kofax Capture profiles (Recognition, Image Cleanup, etc.)
• Kofax Capture known values (also called "suggested values") for batch fields and index fields
• Default values for batch fields and index fields
• Results returned by image cleanup profiles

For the Kofax Capture Database and Text export connectors, all numeric, date, and time data derived
from Kofax Values is converted.

The following regional examples from Windows Control Panel compare common numeric, date, and time
formats for the United States and Germany.

Setting United States/Sample Germany/Sample

Decimal separator "." (period)
1000.23

"," (comma)
1000,23

Date format M/d/yyyy
8/16/2018

dd.MM.yyyy
16.08.2018

Time format H:mm:ss tt
2:10:35 PM

HH:mm:ss
14:10:35

Language Translation
When a batch class is imported, Kofax Values and default profile names are translated to the language
of Kofax Capture on the destination computer. This translation occurs regardless of the Kofax Capture
language originally used to create or export the batch class.

Kofax Values
The actual text of Kofax Values contained within the brackets (either default or manually entered) is
translated as used for endorsing strings or annotations, batch field defaults, index field defaults, or as an
index value for export connector setup.

When a batch is exported, results returned by the Kofax Values are not translated.

Kofax Default Profiles (Kofax Capture Only)
The names of the following types of default Kofax profiles (prefixed by the name "Kofax") are translated.
• Recognition profiles
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• Image cleanup profiles
• Color image cleanup profiles
• Separation and form identification profiles

Items Not Converted/Translated
This section lists items that are not converted or translated and installation configurations or situations in
which no translation or conversion can occur. Unless noted, the items below apply to both Kofax Capture
at the central site and Kofax Capture Network Server remote sites.
• Import/export of batch classes among computers that use different code pages
• Batch classes created in versions of Kofax Capture prior to 6.1 (when the product was known as Ascent

Capture)
• Dictionary values that are numeric or related to date or time
• Recognition profile language and character set selections
• Export text constants, customizations, and string fields that contain numeric, date, or time entries
• Batch names derived from time/date, because they are classified as strings, which are not converted or

translated
• Kofax Capture module names
• Results returned by Kofax Values
• String data entered in the Kofax Capture programming interfaces, which applies to:

• Export connectors
• Import scripts
• Kofax Capture Module Type Library
• Custom modules
• Validation and recognition scripts

Display Labels (Kofax Capture Only)
For each batch field or index field, you can enter a corresponding Display Label value. The value in the
Display Label (instead of the actual batch field or index field name) appears where field names are seen,
such as in the Scan, Validation, and Verification modules, and in batch properties in Batch Manager.

For example, you may have an index field named cust_name, but you could create a display label
"Customer Name" that is more easily understood by users processing the batch. Or, if you are creating a
batch class for use in another region, you could enter the labels in the language of the region where the
batch class will be imported.

The Display Label column is available in the following windows:
• Create Batch Class
• Batch Class Properties
• Create Document Class
• Document Class Properties

If a display label is left blank, the batch field or index field name appears.
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Tip You may want to limit the length of display labels. Although the Index/Batch Field Name cannot
exceed 32 characters, the display label may contain up to 254 characters. A label with more than one
line of text wraps to several lines, which may be difficult for users to read.

Upload Batches
Complete batches at the remote site are "ready" for the Kofax Capture Network Server module in Batch
Manager at the remote site. When uploading begins, the batch moves to the "In Progress" state. When
the batch has been successfully inserted into the Kofax Capture workflow at the central site, the batch is
deleted from the remote site.

Ready batches can be uploaded by any of the following methods:
• Automatically at the next scheduled automatic polling time
• Manually with the Synchronize Now button in the RSA
• Manually with the Process Batch button in Batch Manager (if the status of the batch indicates that the

batch is "Ready" for the KCN Server module)

Batches have an "In Progress" status in the Kofax Capture Network Server module during the upload
process. As each batch is uploaded and inserted into the Kofax Capture workflow at the central site, the
status is updated in Batch Manager at the remote site.

If the remote site uploads a batch with a name that already exists at the central site, the uploaded batch is
renamed. When the batch is renamed, the base name is appended with a tilde symbol (~) and a number,
such as ~0001. An entry about the renamed file and the new name is added to the Kofax Capture Network
Server log file (ACIS_YYMM.txt), but not in the remote site log file.

Note You should not stop or restart the Web server while remote sites are uploading batches.

Upload Batches With Automatic Synchronization
You can configure which site controls the polling settings and schedule. Based on the polling settings, new
or modified batch classes are downloaded, and completed batches are uploaded based on the currently
assigned remote site profile.
• To automatically upload batches, set polling times.
• Centrally controlled polling times are set in remote site profiles defined with the Kofax Capture Network

Server Remote Site Profiles window available from the Site Profiles window in the Administration
module. Once the remote site profiles are defined and downloaded to the remote site, the settings take
effect.

• Remotely controlled polling times are set in the RSA Polling Settings window available from Batch
Manager at the remote sites. Once the settings are defined and saved at a remote site, they take effect
for the remote site.

Creating Remote Site Profiles
Create remote site profiles to define how you want certain batch processing activities between the central
site and remote sites to proceed. In particular, you can configure the following:
• Where to run each Kofax Capture module
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• Which batch classes are accessible to specific remote sites
• Which licenses to allocate to each remote site
• Which site (central or remote) controls the polling settings, and what polling settings to use

Each remote site can be assigned a different remote site profile, or two or more remote sites can be
assigned the same remote site profile. If you change a profile, all remote sites that share the same profile
receive the updated profile the next time that they synchronize.

Setting up remote site profiles involves performing the following major steps at the central site.

Step 1: Select an Existing Remote Site Profile
Before setting the attributes of the remote site profile, select a profile to use as a model for the new
remote site profile.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Remote, and then click

Site Profiles.
The KCN Server Remote Site Profiles window appears.

3. Select a remote site profile.

Step 2: Configure a Remote Site Profile
To configure a remote site profile, select an existing profile, and then modify the information on the
appropriate tabs of the Kofax Capture Network Server Remote Site Profiles window, as needed. After you
finish selecting or entering the information, save the remote site profile with a new name.

Setting Up Batch Routing

When you set up batch routing for a remote site profile, specify which modules to run at the central site
and which to run at the remote site.

Because using the Quality Control module as a standard processing module or only when an exception
occurs, consider the following:
• Exception batches are automatically routed to the Quality Control module at the site where the

exception occurs, regardless of where the Quality Control module was set up to run.
• Batches without exceptions are routed to the site where the Quality Control module has been set up to

run, if the Quality Control module is defined as part of the batch class definition.

Tip To include the Quality Control module in your workflow, specify that batches be processed through
the Quality Control module at your remote sites. This forces the batches through the Quality Control
module before they are uploaded to the central site. Problems are fixed more easily if batches are
accessible to the remote site user.

Before assigning batch classes with custom modules to remote site profiles, you must:
• Register the custom module at your central site and at remote sites. Then, copy the custom module’s

executable to <Kofax Capture installation folder>\Bin at the appropriate remote sites.
• Add the custom module to a batch class at the central site and publish the batch class.
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• In the remote site profile for the specific remote sites, add the custom module to the list of modules set
to run at remote sites.

• Assign the batch class with the custom module to the appropriate remote site profiles.

To set up batch routing:
1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Remote, and then click

Site Profiles.
3. In the remote site profile for the specific remote sites, add the custom module to the list of modules to

run at remote sites.
4. Assign the batch class with the custom module to the appropriate remote site profiles.

The KCN Server Remote Site Profiles window appears.
5. Select a profile from the list of remote site profiles.
6. Click the Batch Routing tab.

The Batch Routing tab appears.
7. Select a module from the list.
8. In the Assigned Site column, select the location for that module. Repeat steps 5-7 as needed.
9. Edit the Rescan Location to specify where documents are rescanned if a problem occurs.

Batches for which Partial Batch Export is selected in the associated batch class are processed at the
remote and central sites as follows:
• At the remote site: Batches are routed from Scan through all modules set to run at the remote site.

Then, for any batch that contains errors, the rejected documents and pages are routed to the Quality
Control module for repair at the remote site. Once repaired, the documents and pages are processed
through the batch class workflow at the remote site, starting with the first module after Scan. When
all documents and pages are successfully processed for all modules set to run at the remote site, the
batch is marked "Ready" (for the Kofax Capture Network Server module) and only then is the batch
able to be uploaded to the central site.

• At the central site: Batches are routed from the first module set to run at the central site through the
final module, Export.

In the Export module, all error-free documents and pages are exported to their predefined destinations,
and any rejected documents and pages are routed to Quality Control for repair at the central site.

Once repaired, the documents and pages are processed through the batch class workflow, starting with
the first module after Scan at the central site. The batches are never routed back to the remote site.

Database Validation

If database validation is selected for a batch class assigned to a specific remote site, the appropriate
database software and files must be available to the Validation module at the remote site. An error
message appears if the required files and database software cannot be found.

1. Click the Assigned Batch Classes tab.
The Assigned Batch Classes tab appears.
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2. Select one of the following:
• All batch classes: Causes all batch classes to be assigned to the selected remote site profile.

When selected, you cannot select from the displayed list of batch classes.

• Selected batch classes: Makes the list of batch classes available to you. You can then select the
batch classes to assign to the remote site profile.

Note Unpublished batch classes cannot be used by remote sites.

3. If you selected "Selected batch classes," do one of the following:
• Select one or more batch classes from the Available list, and then click Add.
• Double-click a batch class on the Available list.
• Click Add All.

4. To override the batch routing module sequence specified on the Batch Routing tab for the selected
batch class, do the following:

a. Click Override Batch Routing.
The Override Batch Routing for Batch Class window appears.

b. Select Starting with this module.

c. Select a module from the list.
Only modules assigned to the workflow for the batch class are available in the module list. When the
batch is ready to be processed by the selected module, the batch is uploaded to the central site and
processing is performed by the selected module at the central site.
The text "Overridden" and the selected module name appear under Batch Routing in the Assigned
list.

Note You cannot select the Scan module as the starting module for processing the batch class at
the central site.

5. Repeat steps 3 and 4 for as many remote site profiles as necessary.

Removing Batch Classes from the Assigned List
1. Click the Assigned Batch Classes tab.

The Assigned Batch Classes tab appears.
2. Do one of the following:

• Select a batch class from the Assigned list, and then click Remove. The selected batch class is
moved back to the Available list.

• Double-click a batch class in the Assigned list.
• Click Remove All.

Setting Up Licensing

The Licensing tab on the Remote Site Profiles window is used to configure workstation licensing for
remote sites. Remote sites only have access to the licensed modules within their profiles.
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Note Additional licenses may be needed if you are adding remote sites to your Kofax Capture Network
Server installation.

1. Click the Station Licensing tab.
The Station Licensing tab appears.

2. Select the type of license from the Available list.
3. Click Add.

The Assigned list is incremented by one license multiplied by the number of remote sites assigned
to that remote site profile. The Available list is decremented by that same value. Alternatively, you
can double-click a license to move it from one list to another.

4. If necessary, click Refresh to update the display.

Removing Licensing
1. Click the Station Licensing tab.

The Station Licensing tab appears.
2. Select the license from the Assigned list.
3. Click Remove.

The Assigned list is decremented by one license multiplied by the number of remote sites assigned
that remote site profile. The Available list is incremented by that same value. Alternatively, you can
double-click a license to move it from one list to another.

4. If necessary, click Refresh to update the display.

Setting Up Polling

Polling refers to the process of checking for batches and user statistics (if User Tracking is selected) to be
uploaded to the central site, and batch classes and configuration settings to be downloaded to the remote
sites.

Note During polling, the Kofax Capture Network Server may also download the settings for the patch
code reserved for batch separator sheets.

The Polling tab on the Remote Site Profiles window is used to set up control of polling and the polling
schedule for a specific remote site profile.

When you set up polling, select which site (central or remote) will set up and control the polling schedule.
You also set up the polling schedule, if you selected central control of polling.

You can elect to have the polling schedule controlled by the central site (the default) or individually by the
remote sites.

If you select the central site, the polling settings affect all the remote sites that share the profile containing
the polling settings. The remote sites are prohibited from setting their own polling times. The next time a
remote site polls the central site, the settings are downloaded to the remote site.

If you select remote site control of polling, you can specify the polling settings individually for each remote
site that shares the remote site profile.

1. Click the Polling tab.
The Polling tab appears.
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2. Select the site (central or remote) to control polling.
If you select "Central control of polling," continue with this procedure.
If you select "Remote site control of polling," the other settings on the Polling tab are unavailable.

3. Select one of the following settings in the Polling Settings area to specify how often polling should
occur:
• Never poll: Turns off automatic polling. However, if the start date and time are in the future, polling

occurs once at that time, and then never again. If the start date and time are in the past, polling
does not occur even once.

• Poll every: Turns on automatic polling at defined intervals for remote sites. When selected, you
must also select a numeric value from 1-99 and a unit of polling frequency.

4. Select a start date.
5. Select a start time.
6. Select one of the following settings to use if the connection fails between the remote site and the

central site.
• Never retry: Prevents remote sites from attempting to reconnect to the central site. However, the

remote sites do attempt to reconnect at the next scheduled polling time.

• Retry every: Remote site automatically attempts to reconnect to the central site. When selected,
you must specify how often and for how long the connection should be retried. Select a numeric
value in the range of 1-99, and a unit of time for each.

7. Specify how often the status of uploaded batches should be checked. Select a numeric value in the
range 1-99, and a unit of time.

Save the Remote Site Profile
Click Save or Save As.

When editing an existing profile, you are prompted to confirm overwriting the existing profile. If you are
creating a new profile, the Save As window appears.

Note You can overwrite or edit any profile except the "(None)" profile. Any changes to a profile affect all
remote sites sharing that profile.

Editing Remote Site Profiles
You can edit remote site profiles as needed. Modifications affect any remote site with that profile and take
effect the next time the remote site synchronization occurs.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Remote, and then click

Site Profiles.
The Kofax Capture Network Server Remote Site Profiles window appears.

3. Select an existing profile.
4. Make your changes to the profile after selecting the appropriate tabs.
5. Click Save.
6. Click Close.
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Assigning a Remote Site Profile to a Remote Site
By assigning a remote site profile to a remote site, you determine which modules and batch classes the
site is allowed to use. Each remote site can be assigned only one profile.

1. Start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Remote, and then click

Site Manager.
The KCN Server Site Manager window appears.

3. On the site list, select the name of a remote site.
4. On the profile list, select a remote site profile.
5. To edit a remote site profile before assigning it, click Edit.

The KCN Server Remote Site Profiles window appears.
6. Edit the profile, and save it.

Note Changing the attributes of a profile affects all sites it is assigned to. To specify a default
remote site profile for a new site, select the option on the "New remote site behavior" list.

You are returned to the Remote Site Manager window.
7. To save the changes, click Close.

Deleting Remote Site Profiles
You can delete a profile from the list of remote site profiles available for assignment.

Note You cannot delete any remote site profiles assigned to (or in use by) remote sites. You must first
remove the assignment through the Kofax Capture Network Server Remote Site Manager window. You
cannot delete the "(None)" or the "(Default)" remote site profiles.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Remote, and then click

Site Profiles.
The Kofax Capture Network Server Remote Site Profiles window appears.

3. Select an existing profile.
4. Click Delete.
5. Click Close.

Creating a List of Central Sites
You can create a list of central sites used to configure batch upload behavior for multiple central site
configurations.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Central, and then click

Site Manager.
3. On the Central Site Manager window, click New.
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4. On the Central Site window, enter the URL of the central site you want to add.
The list is sorted automatically by site name.

5. Click OK.
The URL is verified.

6. Continue to add the central sites to your configuration.
7. Click OK.

Editing a Central Site
You can edit the URL of a central site in the Central Site Manager window.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Central, and then click

Site Manager.
3. On the Central Site Manager window, select a central site.
4. Make any necessary changes.
5. Click OK.

Deleting a Central Site
You can delete a central site from the Central Site Manager window.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Central, and then click

Site Manager.
3. On the Central Site Manager window, select a central site.
4. Click Delete.

Batch Export Error Recovery
Use the Error Recovery check box on the Export Properties window to configure preferences for batch
error recovery.

Note By default, the error recovery check box is not selected.

If Selected
If the Error Recovery check box is selected, all batch processing is terminated whenever there is an error.
In addition:
• All documents in the batch are marked as un-exported and they are re-exported after Quality Control

processing.
• The entire batch is rejected and sent to Quality Control.

Note When documents are re-exported after leaving Quality Control, some back-end systems may
require special handling to successfully process the same document again.
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The preceding behavior occurs with any error, fatal or not.

If Not Selected
If the Error Recovery check box is not selected, the following occurs if a fatal error occurs:
• All processing for the batch is terminated.
• The entire batch is rejected and sent to Quality Control.

For non-fatal errors:
• The document causing the error is rejected and ignored for the rest of the batch processing. No attempt

is made to forward the batch to other assigned export connectors.
• Processing continues for the remaining documents in the batch.
• When all documents are complete (or have experienced an error), the batch is sent to Quality Control.

Problem Recovery
If you have network or other communications problems, Kofax Capture behaves as explained in this
section.

If a Kofax Capture module ends abnormally, the system automatically releases its licenses within 30
minutes. You cannot adjust this time period.

If the network connection with the Kofax Capture Service is lost, the system automatically releases
licenses within 30 minutes. Until the network connection is restored, it is not possible to run modules that
require a license.

Note If a client workstation is restarted abnormally, the system behaves the same as described here.

If a server fails and then Kofax Capture is reinstalled, the system acts as if it were a new installation.
When your volume-based licensing is restored after reactivation, it reflects the most current usage within
24 hours of the initial failure.

If an error occurs within the Kofax Capture Service, it may cause it to become temporarily unavailable. If
this happens, you are not able to start any new Kofax Capture modules until the Kofax Capture Service is
successfully restarted. After the service is restarted, the system proceeds as if no modules were currently
connected and no licenses were allocated. There is no need to reactivate your license.

As Kofax Capture applications run, they acquire station and use volume licenses. A Kofax Capture
application may fail unexpectedly, be terminated by the administrator, or the client workstation may be
turned off.

In such cases, the station licenses used by that workstation are still allocated for up to 30 minutes. The
Kofax Capture Service releases these licenses by the 30 minute deadline.

A similar situation occurs if a Kofax Capture application is disconnected from the network for more than
30 minutes. If the connection is restored and the application is still running, its license is automatically
reacquired. If the license is no longer available, an error occurs.
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If the KCN Server service is also configured on this computer (it may be a manually embedded process
within the Kofax Capture service), it also impacts remote site functionality. We recommend that the Kofax
license service be a dedicated process that is not shared with the KCN Server service. See the Installation
Guide for more information about the KCN Server service.

Standalone Systems

Once restarted, the Kofax Capture Service considers no modules to be running.

If a standalone workstation is fatally lost and Kofax Capture is reinstalled later, the system acts as a new
installation. In such cases, you must reactivate with the most recently obtained activation code. If your
activation code is more than 30 days old, you need to obtain a new code by performing an automatic or
manual activation.

Any volume-based licensing is restored to a usage state at least as current as 24 hours before the loss of
the Kofax Capture Service.

Error Log File
Errors that occurs in any Kofax Capture module are logged in an error file, Err_yymm.txt, which resides in
<Kofax Capture installation folder>\Logs. In the file name, yy is the last two digits of the year
and mm is a two-digit number representing the month in which the information is logged.

In Kofax Capture, the format of the error log is such that key information is easy to locate. In addition
to "standard" log entries, the log also includes technical information to assist support personnel in
troubleshooting.

Each error logged to the error log file includes the following information:
• Date and time
• Error code
• Internal package ID
• Specific status1
• Specific status2
• Specific status3
• Module path
• Module name
• Station ID
• Module version
• Source module
• Line
• Error message
• Return value
• Call stack output

To redirect the log file, create or change the LogFilePath value in the registry in the following key:

HKEY_LOCAL_MACHINE\SOFTWARE\Kofax Image Products\Ascent Capture\3.0
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If you specify an invalid or non-existent path, the default path is used.

Note Do not edit the registry unless you are qualified to do so. You can easily render the computer
inoperable if you inadvertently corrupt the registry.

Deleted Batches Log File
The deleted batches log file, Log_yymm.txt, resides in <Kofax Capture installation folder>
\Logs and gives information about batches deleted from the following modules: Scan, Validation or
Verification (in batch editing mode), Quality Control, or Batch Manager.

In the file name, yy is the last two digits of the year and mm is a two-digit number representing the month
in which the information is logged. For any given month and year, the log file is created as soon as a batch
is deleted. Then, information about all batches deleted in the same year and month is appended to the log
file.

The following sample shows the information that is logged to Log_yymm.txt.
“01”,“batch name”,
“batch description”
“02”,“batch creation station ID”,
“batch creation date”,
“batch creation time”
“03”,“expected number of documents in batch”,
“expected number of pages in batch”,
“pages per document”,
“document separation”, (Described below)
“save document separators”, (Described below)
“actual documents in batch”,
“actual pages in batch”
“04”,“batch class name”,
“batch class description”
“05”,“queue start date”,
“queue start time”,
“queue end date”,
“queue end time”,
“queue process name”,
“queue termination state”, (Described below)
“station ID”,
“queue termination error code”, (Described below)
“error text”,
“keystroke count - manual index fields”,
“keystroke count - corrections to OCR index fields”,
“keystroke count - corrections to ICR index fields”,
“keystroke count - corrections to bar code fields”,
“keystroke count - corrections to OMR index fields”,
”error state”

Document separation states:
• 0: Separator sheets used
• 1: Separator sheets used

Save document separator states:
• 2: Standalone separator sheet checked
• 3: Standalone separator sheet not checked
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Queue termination states:
• 2: Batch ready
• 4: Batch in progress
• 8: Batch suspended
• 32: Queue put batch in error state
• 64: Queue completed processing batch
• 128: Batch status assigned as "reserved"

Error states:
• 0: No errors
• 1: Contains errors

Keystroke counts include most keystrokes, with the following exceptions: Control, Shift, Alt, and any key
combination that is a shortcut for a menu or other standard Windows operation.

The "contains errors" value is used to indicate a batch that is forwarded, even though it contains rejected
documents or pages. This occurs when the Partial Batch Export feature is selected.

Due to page size constraints, the sample log entries are shown on multiple lines. In the actual log file,
each deleted batch entry is logged as a single line.
“01”,”Batch Test”,”Deleted batches log information.”
“02”,”John Devan”,”2013-02-16”,”17:20:51”
“03”,”0”,”0”,”0”,”1”,”1”,”3”,”6”
“04”,”Tax Formalistic 2003 tax forms.”
“05”,”2013-02-16”,”17:20:51”,”2013-02-16”,”17:23:04”,”Scan”,
“64”,”John Devan”,”0”,”Devan”,”0”,””,”0”,”0”,”0”,”0”,”0”,”0”
“05”,”2013-02-16”,”17:24:13”,”2013-02-16”, “17:32:12”,”Validation”,
“64”,”Bob Jones”,”0”,”Jones”,”0”,””,”0”,”0”,”0”,”0”,”0”,”1”
“05”,”2013-02-16”,”17:32:14”,”2013-02-16”,”17:33:07”,”Export”,
“64”,”Sue Brown”,”0”,”Brown”,”0”,””,”0”,”0”,”0”,”0”,”0”,”0”

Kofax Capture Enterprise
Kofax Capture Enterprise contains additional features designed to extend Kofax Capture capabilities for
enterprise-level installations.

Any Kofax Capture installation can be upgraded to Kofax Capture Enterprise.

Note Some Kofax Capture Enterprise features were available in prior versions of Kofax Capture.

High Availability Support

A high availability system is capable of performing tasks with virtually no downtime. Any complex system
has many components, any of which can fail or degrade at any moment. A highly available system
continues to function even if one or more of its components fail.

The High Availability support feature consists of a number of independent components that, when
deployed in a highly available computer system, result in robust, fault-tolerant operations. Although fault-
tolerant systems are primarily intended for enterprise-scale organizations, even the smallest company
may benefit from some of these components.
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High Availability includes support for SQL Server Enterprise, Oracle, and IBM DB2.

Multiple Instance Support

Use the Multiple Instance Support feature to install multiple instances of any Kofax Capture Service.
This improves the capabilities of multi-CPU computers, so they can take full advantage of their potential
processing throughput. For example, a Recognition Server station running on a dual-CPU computer can
have up to eight instances of the service installed, increasing the number of batches that the workstation
can process.

Terminal Services and Citrix Support

You can use Terminal Services and Citrix server technology to run instances of Kofax Capture modules
remotely. By using a server to host the modules to be controlled at remote stations, enterprise-level users
can consolidate IT management and prevent the need to install software on client workstations.

WebSphere Support

Kofax Capture Enterprise users have the option of installing and deploying KCN Server Server
components on IBM WebSphere version 6.0 or 7.0. WebSphere can be implemented either on Solaris or
Windows operating systems.

Backup Licensing Option

Backup license keys (used with High Availability Support) are available. Contact your sales representative
for more information about this alternate licensing option.

Disaster Recovery Support

With Disaster Recovery, you can add alternate central sites to an enterprise configuration, specify batch
upload behavior, back up and restore batches and batch classes, export and import administrative data,
and more. This feature ensures business continuity when equipment fails or disaster strikes.
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Administration

System administrators use the Administration module to set up batches and maintain the Kofax Capture
installation. From this module, an administrator can do the following:
• Define the types of documents to be processed and how they are indexed.
• Decide the batch processing workflow, including the order in which documents are routed to each

module.
• Set up each module for processing.
• Define processing profiles, such as document separation, form identification, image cleanup, and

recognition.
• Scan sample pages for automatic recognition and indexing.

Note Optical / Intelligent Character Recognition accuracy is affected particularly by, but not limited to,
image quality and image cleanup configuration. Character recognition accuracy of 100 percent is not
guaranteed.

Batch Contents Panel Thumbnails
The Batch Contents panel is set to the thumbnail view by default. You can change to the icon view at any
time by selecting the View tab on the Options window.

The thumbnail view has the following characteristics:
• Adjustable display size ranges from 40 x 40 to 200 x 200 pixels.
• Plus and minus signs suppressed at the root level.
• Nodes automatically expand when you drag items.
• Supports batch editing.
• Context menu access via right-click
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Unless otherwise noted, the thumbnail and icon views behave identically.

Batch Contents Panel with Thumbnails

Batch Contents Panel with Icons

Thumbnails for pages are miniature representations of the actual scanned images. Thumbnails for
documents and other non-page elements appear as small graphic binders or eDocument symbols.

The blue document binder symbol is opened or closed depending on the state of its branch.
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The thumbnails in the tree view are fully interactive. You can jump from page to page or document to
document by clicking a thumbnail. You can also drag items to new locations and delete them from the
batch. If your system responds too slowly to these activities, try switching to the icon view.

Note You can also view the non-interactive Batch Thumbnails panel.

Thumbnail Size
Thumbnail display settings are controlled from the View tab in the Options window. The default size for
thumbnails is 60 x 60 pixels.

You can set thumbnail sizes from 40 x 40 pixels to 200 x 200 pixels. Thumbnail sizes must be square,
although the image represented by the thumbnail may not be. For example, the image in the thumbnail
may be 60 pixels high and 40 pixels wide for a scanned form. The thumbnail still occupies 60 x 60 pixels,
but the left and right portions are empty.

The larger the thumbnail, the easier it is to recognize the contents of a page. However, more resources
are required to process and store larger thumbnails.

The following figure] shows a standard 8.5” by 11” page displayed with a 100 x 100 pixel thumbnail size
(represented by a normally invisible dashed line).

Standard 8.5 by 11 Inch Page with a 100 by 100 Pixel Thumbnail

The display size setting is persistent during the current session and saved for each user between
sessions.

Thumbnail Caching
You can set the number of thumbnails to store in memory to any value from 100 to 9999. The default
value is 100. Caching a higher number of thumbnails speeds up batch editing, but may tax the resources
on some systems.

Thumbnail Symbols
This table shows the common symbols used in the thumbnail view. Note that individual document pages
are not just symbols, but instead are representations of the actual scanned image files.

Thumbnail View Symbols

Stack of document trays indicates the root of a batch.
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Closed binder shows that a document branch is collapsed.

Open binder shows that a document branch is opened.

Closed folder shows that a folder branch is collapsed.

Open folder shows that a folder branch is opened.

Blue check mark indicates verified documents or reviewed pages. The check mark is overlaid on the
thumbnail.

Red X indicates items that have been rejected. The red X is overlaid on the thumbnail.

Symbol used as the background graphic for eDocuments. Normally you see this with an icon on
top. For example, if your eDocument is a Microsoft Word file, you see the current icon for Word on
top of this image. If the thumbnail size is set to fewer than 50 pixels, this background graphic for
eDocuments is suppressed, leaving only the icon.

Symbol used to represent empty backside pages when scanning duplex with a simplex scanner.
These temporary pages are subsequently removed when the backside images become available.

Icon View
Icon views behave identically to thumbnail views, but use a different type of graphical representation for
items in the tree. For example, the page icons do not reflect the actual content of the page.

If you turn off the option to display thumbnails, the Batch Contents panel switches to the icon view.

Batch Contents Panel with Icons

The icon view has the following characteristics:
• All icons are fixed at 24 x 24 pixels.

35



Kofax Capture Administrator's Guide

• The plus and minus signs are suppressed at the root level.
• Nodes automatically expand when you drag items.
• Icons fully support batch editing.

Special Status Marks
Three special marks are available to indicate the status of a page or document: reviewed, verified, or
rejected.

Reviewed Mark

The ability to mark a page as reviewed is a feature of the Quality Control module. Reviewed items are
indicated by a blue check mark over the thumbnail. The icon view is similar.

Verified Mark

The ability to mark a document as verified is a feature of the Quality Control module. Reviewed items are
indicated by a blue check mark over the document binder symbol. Verified documents use the same blue
check mark as reviewed pages.

Rejected Mark

The ability to mark a page as rejected is a feature of the Quality Control, Scan, Validation, and Verification
modules. You can mark the page you have rejected, or see pages that are automatically rejected by Kofax
Capture. Rejected items are indicated by a red X over the thumbnail.

Zone Types
A zone is an area on an image to be processed in a particular way. For example, you might want to
capture data from the same location on all your forms. You can define a zone around that area on a
sample page, and then specify the type of processing you want Kofax Capture to perform on that area.

Kofax Capture supports the zones types listed in the table, and you can have a total of 254 zones on a
page. Note that each type of zone is displayed with different border characteristics.

Type of Zone Display Characteristic Example

Index zone (manual) Solid blue line

Index zone (automatic recognition) Dashed green line

SmartGroup Dashed magenta line

Registration zone Solid black line

Separator zone Dash-dot red line

Form identification zone Dashed red line
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Tip "Confident" and "non-confident" zones display with different border colors in the Validation and
Verification modules.

Index Zones
Index zones contain data for index fields. Kofax Capture can automatically capture the data using an
automatic recognition technique such as Kofax Advanced OCR, bar code recognition, or others. You can
also have validation operators read information from the image and manually enter the data for the field.
You can define up to 1024 index zones per page.
• Manual index zones: If the data that the validation operator uses to fill the index field is at a fixed

location on the form, you can draw an index zone around this location. At validation time, the validation
or verification operator is shown this area of the form, making the data easier to find and read.

• Automatic index zones: If an automatic recognition method (for example, OCR, ICR, bar code
recognition, or others) can be used to capture the data for an index field, you can draw an index zone
around the location of the data and then specify a recognition method for the area. At data capture time,
the zone is submitted to the appropriate recognition engine for processing. The data is captured and
returned to the index field. When specifying recognition or cleanup properties, you can use QuickZones
to adjust settings to achieve the best results.

You can draw more than one zone for an index field to use two recognition methods to capture the data.
The data captured from the zone with the most confident results is used. That value is displayed for your
validation operators. The zones can appear at different locations on the form, or one on top of another.

Use the Create Index Zone window to create an index zone or edit its properties.

Note You can group index zones without using scripts. See SmartGroups for details.

Limits for Zones
The following lists limits for zone size and position.

Sizes
• OMR zones 

• 26x26 inches
• ICR Zones

• 26x26 inches
• OCR zones

• 26x26 inches for images up to 200 dpi
• 17x17 inches at 300 dpi
• 13x13 inches at 400 dpi
• 8x8 inches at 600 dpi
• 3x3 inches at 1200 dpi

• Character length
• All zones must have 254 characters, or fewer.
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Index Fields
An index field is a keyword associated with a document and used:
• As a way of retrieving a document after it has been exported to permanent storage. For example, if a

customer asks to review an order form, it would be convenient to retrieve the form by entering a known
keyword for the form (such as the vendor name, the vendor ID, the PO number, etc.).

• As a way of retrieving data from an image. For example, you might want to read certain pieces of
information from an image and store the values in a database.

• To define index fields and associate them with a document class using the Create Document Class
window.

Use the Document Class Properties window to edit index fields.

Index Field Considerations

When selecting your index fields, consider the following:
• How many index fields are necessary? If you have only one index field and it is entered incorrectly,

you’ll never be able to retrieve the document. However, if you have many index fields, you’ll spend too
much time validating each document.

• Can you automate the validation process with some kind of recognition method (OCR, ICR, bar code
recognition, or other)? For example, if critical data is encoded in bar codes on your forms, bar code
recognition is a good way to capture that data.

Index Field and Batch Field Attributes

The following table lists attributes you can associate with batch fields and index fields.

Field Attributes

Field Name Comments

Name You must assign a name to your batch and/or index fields. When you create a batch or
index field, Kofax Capture assigns a default name to the field, although you can assign
a different name. Use meaningful names.

Field Type You must associate a field type with your batch and/or index fields.

Default You can specify a default value for your batch and/ or index fields. You can enter a
value, or select a Kofax Value.
The default value must conform to the data type specified for the field type. For
example, if the field type is a VARCHAR with a maximum length of 25 characters, the
default value must contain no more than 25 alphanumeric characters. In addition, the
maximum length for CHAR and VARCHAR data types is 25,000 characters. However,
the maximum number of characters for a default value is 254. This is true even if the
number of characters for the CHAR or VARCHAR field type is greater than 254. See
Data Types.

Required Use this attribute to specify whether the batch or index field is required.

Verify (index fields only) Use this attribute to specify that the index field must be verified in the Verification
module.
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Field Name Comments

Hidden Use this attribute to hide the value of the batch or index field. This might be useful for
fields that have a default value associated with them or when values are generated by
a field macro.
You cannot set both "Required" and "Hidden" to True. If you set one to True, and then
attempt to set the other to True, the first one is reset to False.

Sticky (index fields only) Use this attribute to carry a value from one document to the next.

Total (index fields only) Use this attribute to use the index field in a batch totaling process.

Table Fields

Kofax Capture supports tabular data structures (two-dimensional data) in the form of table fields. Table
fields may be useful if you want a single field to store multiple names, part numbers, or other similar items.

Table fields are "enhanced" index fields capable of supporting multiple values. Table fields can be used as
the associated field for an index zone, index group zones, or for page-level bar codes.

Without using a customization, all rows of the table field have the same zone coordinates. Operations that
are valid for single value index fields are also valid for table fields. A table field represents a column in a
Kofax Capture table.

If your table has only a single column, that table field may also be referred to as a "multi-value field." This
is an abbreviated way of identifying tabular data in a single column.

Do not confuse Kofax Capture table fields with the automatic recognition of tabular data in forms. The
Recognition Server module does not provide true tabular recognition. If you create an index field around
a table in your form, the recognition results for the entire zone are collapsed into the first row of the table
field, regardless of how many rows are in the table on the form.

Validating/Verifying Table Fields

The Validation and Verification modules display table fields in the index fields panel using a special format.

Table fields are contained within frames. The display label of the table is used as the title for the frame,
and it is visible in the upper-left portion of the frame. For each row, all the index fields for that row are
displayed in the order defined for the document class. Each row in the table is delimited by a separator
line.
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Tables in the Index Field Panel

In the preceding figure, Line Item is a three-column table (Name, ItemNo, and Price) with two rows.  All
tables have one row by default. Use the Field menu to add additional rows.

The Field menu for this panel contains the items Insert Row Above, Insert Row Below, and Delete Row for
adding rows above or below the current row, and for deleting the current row.

Page Level Bar Codes

Table fields can be associated with the bar codes found on a page. As with index zones, results are
written to the first row of the table field only.

Field Types

As with single value index fields, field types used by one or more table fields may not be deleted.

Batch Class Import

Importing batch classes is largely unaffected by table fields. However, when importing batch classes
generated with versions of Kofax Capture prior to 7.0, special rules are applied if that batch class has a
field type called (TABLE).

Because (TABLE) is reserved for table fields, if an imported batch class contains (TABLE) as a field
type, the field type is imported and renamed (regardless of the Transfer Mode setting). In this case, the
following line displays in the Import Progress control of the Import/Export entertainment window:

Warning: Field type (TABLE) renamed: <new name>.

Note The algorithm for determining the new name is similar to that of renamed items during batch class
import. The base of the new name is (TABLE), with a suffix that guarantees uniqueness.

Database Validation

Use the Table Settings tab on the Database Validation Properties window to specify a table field as the
index field to validate. This feature is used to look up information in a database to provide values for index
fields. The following rules summarize the behavior of a database validation using tables.

The specific table row value validated depends on the trigger setting for the database validation on the
Options tab on the Database Validation Properties window in the Administration module. If the trigger
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is "Document preprocess" or "Document post-process," the first row of the table field is validated. If the
trigger is "Field preprocess" or "Field post-process," the current row of the table field is validated.

When a table field is auto-filled from the database validation results, the behavior is modified slightly.
• If the trigger is "Document preprocess" or "Document post-process," the first row of the table field is

automatically filled.
• If the trigger is "Field preprocess" or "Field post-process" and the table field is from the same table as

the index field being validated, the current row is automatically filled.
• If the trigger is "Field preprocess" or "Field post-process" and the table field is not from the same table

as the index field being validated, the first row of the table field is auto-filled.

Example

Suppose your form has the following table.

Table in a Form

You might start by adding a table definition in the Document Class Properties window. The following
example also includes display labels.
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Table Definition in the Document Class Properties Window

Once your table structure is in place, you can draw 5 manual index zones around the table contents, as
shown below:

Index Zones in a Table

When you process a batch, the table data appears in the index field panel in the Validation module.
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Tables in the Index Field Panel

The validation operator can enter the data from the table by manually adding or deleting rows as
necessary.

Width Alignment
Width alignment forces the width of an image to be aligned on a specific boundary. This is useful when
your images are rotated 90 degrees (the length becomes the new width), and the application requires
image widths to be even multiples of 8 or 16.

Pad Width to Byte Boundary
Pads image width up to the next multiple of 8.

Pad Width to Word Boundary
Pads image width up to the next multiple of 16.

The default is no width alignment.

Batch Totaling
Batch totaling is a quality assurance technique in which the sum of certain index fields is compared to the
expected value.

You specify that an index field is to be used in a batch totaling process when you define index fields for
a document class. During production, the scan operator is prompted for an expected batch total by the
Scan module. Typically, the operator manually computes the value from data on the documents in the
batch, enters the expected batch total, and then processes the batch. Then, at the Validation module and
Verification module (if specified), Kofax Capture computes the sum of the selected index fields.

The computed sum is compared to the expected value entered by the scan operator. If the values match,
the batch is accepted. If the values do not match, a batch total error is reported.

An index field set up for batch totaling applies only to its specific document class. If you have an identical
index field in several document classes, and you want to total all of them, you must set each index field
individually in all the document classes that use it.
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OMR Settings
When drawing a zone around an area for OMR processing, you should include only the OMR shape
(usually a square, rectangle, or circle) with little white space outside the shape.

When setting up the zone, keep the following in mind.
• If you draw a large zone box around an OMR item, the percentage of black pixels is relatively small.

Consequently, if a user makes a small check mark, it may not significantly change the percentage of
black pixels. If this small change does not put the percentage over the threshold, then the OMR engine
detects it as "unmarked." Therefore, the smaller the zone box around the OMR item, the easier it is to
detect a mark.

• There are always slight differences in registration (paper position) as documents are fed through a
scanner. If your zone box is very close in size to the OMR item, then the paper may shift so that part (or
all) of the item is no longer in the zone, leading to detection errors. Therefore, the smaller the zone box
around the OMR item, the greater the chance of registration problems.

• For best results, make the zone boxes as small as you can. If registration errors turn out to be a
problem, gradually increase the size of the box until the errors are minimized.

Make sure that zone boxes around similar OMR items are all the same size. This ensures consistent
results.

The following confidence settings are available for the OMR engine.

Pixel Percentage Threshold

This is the default setting. The confidence is calculated as the percentage of black pixels in the OMR
zone. For example, a confidence of 32% means that 32% of the pixels in the OMR zone were black. The
higher the number, the more likely the box has been checked.

The following graph shows the relationship between pixel percentage and confidence for the "pixel
percentage filled" method of determining confidence. In this case, the threshold is set to 50%, but it could
be set anywhere between 0% and 100%.
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Pixel Percentage Threshold

Probability that zone is marked

The confidence is calculated based on the probability that the zone has been marked. Typical confidences
for marked zones fall in the 80%-90% range and unmarked zones in the 0-20% range. This method is
well-suited for zones used in groups when "Pick best" is checked in the Index Group Zone Properties
window.

The following graph shows the relationship between pixel percentage and confidence for the "probability
that zone is marked" method of determining confidence. In this case, the threshold is set to 50%, but it
could be set anywhere between 0% and 100%. Moving the threshold displaces the center of the curve left
or right, but the basic shape remains unchanged.
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Probability Marked Threshold

100% if Marked, 0% if Not

This is similar to the preceding option. The confidence is set to either 100% or 0% (no intermediate
values) depending on whether the zone is marked or not.

The following graph shows the relationship between pixel percentage and confidence for the "100% if
marked, 0% if not" method of determining confidence. In this case, the threshold is set to 50%, but it could
be set anywhere between 0% and 100%.
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Confidence Set to 100% or 0% Threshold

Difference from Threshold

The confidence is calculated on how far the pixel percentage is from the threshold point. Consequently, a
completely blank zone and a completely filled zone would both have a confidence of 100%. On the other
hand, if the threshold is set to 30% and the number of black pixels is 29% or 31%, the confidence level
would be very low, since a small error in scanning could flip the results. This method indicates how certain
the OMR engine is of its results, not the pixel percentage.

This setting is a good choice for "yes/no" check boxes that are not part of a group. In general, using this
setting in a group does not produce useful results and is not recommended. In groups, you may need the
recognition engine to pick the best result. Since this method can yield 100% confidence for both a blank
and a checked item, your "pick best" results cannot be predicted.

The following graph shows the relationship between pixel percentage and confidence for the "difference
from threshold" method of determining confidence. In this case, the threshold is set to 50%, but it could be
set anywhere between 0% and 100%. Moving the threshold displaces the center of the curve left or right,
but the basic shape remains unchanged.
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Difference from Threshold

For best results, verify your settings with image files representative of the images you plan to process.

User Dictionaries
The recognition engines included with Kofax Capture can make use of dictionary files to improve the
accuracy of your index field data.

Only a single dictionary can be used with a document class. The dictionary can support a single language.
If you have selected multiple languages, only the first language in the list of the selected languages uses
the dictionary. User-defined dictionaries are not supported if you select Chinese, Japanese, or Korean as
the primary language. All the following rules for dictionaries apply, regardless of the language.

Full Text Dictionary

This dictionary is used by the PDF Generator module and by OCR Full Text recognition. You can create
an ASCII text file to be used as a dictionary with any ASCII text editor, and note that each word must be
on a separate line in the ASCII text file.

The Full Text dictionary should contain terminology specific to the document class, although output from
the recognition engine may contain words not found in the dictionary.

The dictionary file must be in a folder accessible to the recognition engines or modules that use it. This
may be either on the local workstation, via a mapped drive, or a UNC path.
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Zonal Dictionary

Zonal dictionaries are the same as Full Text dictionaries. However, with a zonal dictionary, each field type
can have only one dictionary, but a dictionary can be used by one or more field types. For example, you
could have seven field types and five dictionaries, with one dictionary shared by three field types.

OCR Dictionaries

You can specify a dictionary to be used for OCR processing. If specified, the dictionary is used by
the Kofax Capture OCR recognition engines at data capture time and could be useful for checking
unrecognized words.

There are several types of dictionaries you can use.

You can specify an OCR dictionary at the field type level and/or the document class level:
• If specified at the field type level, the dictionary is used for zonal OCR processing. The dictionary

should contain terminology specific to the field type. The field type level dictionary must be accessible
to the Recognition Server module.

• If specified at the document class level, the dictionary is used by the PDF Generator or the OCR Full
Text modules. It should contain terminology specific to the document class. The document class level
dictionary must be accessible to the modules that use it.

Using a dictionary does not guarantee that the output from the recognition engine will match an entry in
the dictionary. The dictionary is used as an aid to help the engine make the best possible decision it can,
but does not control the engine's final output.

Note For multiple languages, only words not found in the dictionary are flagged. If the selected language
does not have a dictionary, the word is not flagged.

You specify a field type level dictionary from the Create Field Type window or Field Type Properties
window.

You specify a document class level dictionary from the Create Document Class window or Document
Class Properties window.

Zone Display at Validation Time
Zones for which data is automatically captured (for example, with OCR, ICR, or other recognition
technologies) are displayed for your validation operators as either "confident" or "non-confident" zones. A
"confident" zone is one that is marked as having a high probability of accuracy. A "non-confident" zone is
one that is marked as having a low probability of accuracy.

By default, confident zones are displayed at validation time with green borders, while non-confident zones
are displayed with red borders. (You can specify a different color scheme from the Validation module.)
While all zones should be carefully validated, your validation operators should pay special attention to
"non-confident" zones.

Once you visit a zone (place the cursor in the index field) and then leave it, the zone displays as
"confident" (green), even if you do not change the contents.

49



Kofax Capture Administrator's Guide

Zone display behaves a little differently when the zone is part of a group. In that case, by default, the
display zooms to the group rather than the specific zone. This setting can be changed in the Index Group
Zone Properties window so that the display zooms to the most confident member of the group.

Note If you select the Retain Zoom feature, the zooming behavior may change.

SmartGroups
Many documents include related items. For example, you might find fields for first and last name, three
areas for a social security number, or a phone number with a separate field for the area code.

In the following example, the form has space for the user to select from several payment methods. All the
OMR index zones within the magenta box make up a single group.

SmartGroups

Use the "SmartGroups" feature to take advantage of the relationship among items by creating a group that
includes one or more index zones. This capability eliminates the need to set up a special-purpose script.

"Groups" and the groupings are called "index group zones."

Note Manual index zones cannot be used in groups.

With SmartGroups, you can:
• Automatically combine data from separate fields into a single field, such as Full Name = First Name +

Last Name
• Automatically use a bar code, or revert to text data if necessary
• Control how many fields can be filled in for the group (a specific number or a range)
• Combine separate month, day, and year fields into a single date

As you work with SmartGroups, keep the following points in mind:
• On paper, your items may be physically grouped together. This is natural and convenient for users

of the form. Kofax Capture, however, creates logical (instead of physical) groups. The elements that
comprise a group can be anywhere on the form.

• To create an index group zone, you must draw a rectangle on your sample page and then assign an
Associated field to the rectangle. The rectangle then becomes the index group zone.

• Index zones are grouped based on the Associated field, not on the location, size, or contents of the
rectangle. All index zones with the same Associated field are in the same group. For example, to
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include five items in a payment method group with "payment method" as the name of the Associated
field, you must use "payment method" for all five index zones.

Note You can create index zones with the same Associated field without grouping them. In this case,
the index zone with the highest confidence is used as the result.

• The rectangle does not have to surround the group's index zones, but it should. By default, the image
viewer (in the Validation and Verification modules) zooms to show the entire group based on the size
and location of the rectangle. If index zones exist in the group but outside the rectangle, they may
not show up in the zoomed view. (You can elect to have the view zoom to the zone with the highest
confidence instead of the entire group, and you can also retain your zoom settings.)

• The Create Index Group Zone window - General tab has a list for selecting the Associated field for
the group. The list is automatically populated with a list of fields taken from index zones on the form.
SmartGroups searches for an available zone that is graphically within the rectangle you drew for
the group, and selects it as the most likely Associated field. If multiple zones are available within the
rectangle, SmartGroups selects the index field that comes first alphabetically. If no index zones exist in
the rectangle, the list contains all the fields on that page in alphabetical order.

• When creating a group, it is better to draw the individual index zones first, and then draw the rectangle
for the index group zone around them. (The Administration module does not allow you to draw one
rectangle inside an already existing rectangle.) However, if you are modifying an existing index zone
and the group rectangle is in the way, you can temporarily move it aside while working on the index
zones. When you are done with the index zones, move the group box back into position and adjust its
size if required.

• The confidence level for a group is calculated from the confidence levels for all the members of
the group. The precise method for this varies with your settings. In some cases, particularly when
concatenating all the results from a group, the display may not show the most confident zone (even if
the Display Most Confident Zone option is set).

• You can specify how the number of expected values returned by a group. A group can return from 0 to
254 values. Normally, when more than one selection is allowed, you would select to have the results
concatenated in the Associated field.

SmartGroup Tree Structure

Note If you are grouping OMR index zones, the "Return value for unmarked zone" field must be blank
(null) for all the OMR index zones in the group. If this field is not blank, the number of results may not
be correctly reported.
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• You can view the group structure in the Batch Class tree or the Document Class tree. You see the index
group zone icon followed by the name of the group (taken from the Associated field). Indented under
this are all the index zones in the group. Note that, contrary to ungrouped index zones, each index zone
in a group is identified by the name of the recognition profile it uses (not the name of the Associated
field).

Note You can use the same recognition profile for more than one member of the group. In that case, the
index zones appear in the tree with the same name. This may make it difficult to associate a zone in the
tree view with its location on the sample page. You can easily resolve this by selecting the zone in the
tree, and looking on the sample page for the corresponding zone.

Creating SmartGroups
Use the SmartGroups feature to group related index zones on a form. See SmartGroups for more
information.

Create a group zone by drawing a rectangle on the screen, setting its parameters, and adding index
zones to the group.

The following procedure assumes that you have already set up the fields and field types for your
document class. See Field Types and Creating a Field Type for more information.

Create index zones on the sample pages you import for form types.
1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click the arrow under Index, and then click New Index Group

Zone.
Your cursor changes from a pointer to a cross hair.

3. Draw a rectangle on your sample page.
The rectangle should contain all the index zones that belong to the group. You can adjust the size
and position of this rectangle later (See Adding Members to a SmartGroup for details.)

Note The group box acts as a visual aid by drawing your eye to the contents of the group. It also
controls the image viewer's zoom level in the Validation and Verification modules. Finally, it affects
the automatic selection of the Associated field in the list in the Create Index Group Zone window
- Group tab.

After the rectangle has been drawn, the Create Index Group Zone window appears.
4. From the Associated Field list, select the index field to associate with the group.

If the rectangle you just drew contains only group members (index zones with the same Associated
field), the default value in the list is the correct Associated field for your group.

5. Select either Display group zone or Display most confident zone.
This controls the way the group is displayed in the Validation and Verification modules.

6. Fill in the minimum and maximum number of non-empty return values you will accept.
This can be a number from 0 to 254. It cannot exceed the value in the Maximum field or the
Minimum field. To specify an exact number of return values (for example 3) set the minimum and
maximum values to the same number.

7. Select Pick best or Concatenate. If you select Concatenate, then specify a delimiter.
If you select Pick best, only the value with the highest confidence is returned.
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8. Click OK to save your SmartGroup and add it to the tree view.
The group shows up next to a group icon and has the name of the Associated field.

At this point, you have created a new SmartGroup but not explicitly added any members. However, any
existing index zones with the same Associated field as the group automatically join the SmartGroup. See
Adding Members to a SmartGroup for details.

Adding Members to a SmartGroup
If you create the SmartGroup first, and then create a number of index zones with the same Associated
field as the SmartGroup, those index zones automatically join the group. On the other hand, if you create
the individual zones first, and then create a SmartGroup with the same Associated field as the index
zones, the index zones also automatically join the SmartGroup. In other words, an index zone belongs to
a group when it has the same Associated field as the group.

To remove an index zone from a SmartGroup, just associate that index zone with a different field.

Each index zone within the group can have its own recognition profile. You can also use the same
recognition profile for more than one zone in a group, but if you do, those zones have the same name
when visible in the batch or document class tree views. Normally an index zone is represented in the tree
views by the name of its Associated field. When an index zone belongs to a SmartGroup; however, it is
represented in the tree views by the name of its recognition profile. In such cases, the SmartGroup takes
the name of the Associated field.

To clarify this, consider a group for payment method where the choices are the following:
• American Express
• Check - Money Order
• MasterCard
• PO Number
• Visa

The name of the group (its Associated field) could be Payment Method, and the names of the recognition
profiles could be the same as each choice (American Express, Visa, etc.).

The following graphic shows two versions of the same SmartGroup. In the group on the top each index
zone has a different recognition profile; in that group it is easy to determine the purpose of each index
zone. In the group on the bottom, all index zones have the same recognition profile. In this group, it is
difficult to know the purpose of each index zone. In either case, the SmartGroup functions in exactly the
same way.

While the group on the top is easier to read, the group on the bottom has fewer recognition profiles to
manage. If you later need to make adjustments to the recognition profiles, you only have to do it once for
the group on the bottom. You need to make adjustments to five profiles for the group on the top.

You can select the approach that best meets your needs.
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Two Ways to Categorize a SmartGroup

For all OMR index zones in a group, you must be sure the "Return value for unmarked zone" field is blank.
This field appears on the Recognition Profiles window, where it is the default setting, or the Index Zone
Properties window, where it overrides the default. The initial value for this field is 0, so you must explicitly
delete the contents to make it blank. If this field is not blank, the group may not behave as expected when
counting return values. Even an apparently empty entry counts as a return value if it contains invisible
characters such as spaces. Only "null" entries are recognized as not having a return value.

Adding Index Zones to a SmartGroup

The following procedure assumes that you have already created a SmartGroup, but not created the index
zones.

1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click the arrow under Index, and then click New Index Zone.

Your pointer changes to a cross hair.
3. On the sample page, draw a rectangle around the area to use as an index zone.

The Create Index Zone window appears. You can temporarily move the SmartGroup rectangle out
of the way while drawing index zones.

4. On the Associated field list, select the field already associated with the SmartGroup.
5. Make sure that "Use automatic recognition" is selected (this is the default setting).

You cannot have a manual index zone in a group.
6. Select a recognition profile from the list.
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7. You can create a unique recognition profile for each index zone in the group, as shown on the top in
the preceding illustration.

a. Click Edit.
The Recognition Profiles window appears.

b. Make appropriate adjustments to the settings.

c. Use the Test button to check your settings.

d. In the case of an OMR index zone, make sure that the "Return value for unmarked zone" is
blank (delete all characters in the field).

e. Click Save As and give your profile a descriptive name that works for your group.

f. Click Close to exit the Recognition Profiles window.
8. Click OK to save the index zone and place it in the tree. Note that it is indented under the group and

identified by the name of the recognition profile it uses.
9. Click OK.

10. Repeat the preceding steps for each index zone you want to include in the group.

Creating a SmartGroup and Adding Index Zones

The following procedure assumes that you have already created the index zones (all with the same
Associated field), but not created the SmartGroup.

1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click the arrow under Index, and then click New Index Group

Zone.
Your pointer changes to a cross hair.

3. Draw a rectangle around index zones on the sample page.
The Create Index Group Zone window appears.

4. In the Associated field list, confirm that the correct Associated field is selected as the default. If
not, select the correct Associated field from the list.

5. Select a Validation Display.
6. Select the minimum and maximum Number of Values in Result Set.
7. Select the type of Result Set.
8. Click the Test button to check your settings.
9. Click OK to save the SmartGroup and place it in the tree.

Setting the Number of Expected Values in a SmartGroup
A SmartGroup may have 0 to 254 values in the result set. When grouping related items together using
SmartGroups, you can specify how many values you expect in the result set by specifying a range or an
exact number.

If the actual number of results is outside the expected range, the SmartGroup returns a blank value
with zero confidence. Consequently, the SmartGroup is outlined (in red by default) in the Validation (or
Verification) module, and requires manual indexing.

Example 1
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Assume that a social security number is broken into three separate areas on a paper form. You require
all three values to get a valid social security number. Follow these steps to set the number of expected
values in a SmartGroup to an exact number.

1. Create the SmartGroup and set the Associated field and Validation Display options.
2. Set the minimum Number of Values in Result Set to 3.
3. Set the maximum Number of Values in Result Set to 3.

Note Setting the minimum and maximum values to the same number specifies that exactly that
number of results are expected (in this case, 3).

4. Select other options as appropriate.
5. Click Test to check your settings.
6. Click OK to save the SmartGroup and place it in the tree.

Example 2

Assume that a survey is asking passengers to pick their favorite three hotel chains from a list of ten.
Participants can select from zero to three hotel chains. Follow these steps to set the number of expected
values in a SmartGroup to a range.

1. Create the SmartGroup and set the Associated field and Validation Display options.
2. Set the minimum Number of Values in Result Set to 0.
3. Set the maximum Number of Values in Result Set to 3.

Note Setting the minimum to zero allows for no results at all.

4. Select other options as appropriate.
5. Click Test to check your settings.
6. Select OK to save the SmartGroup and place it in the tree.

Tip If your form has an area that should be left blank by the person filling it in (for example a "For
Office Use Only" section), you can set both the minimum and maximum values to 0. The Validation
or Verification module will highlight the group if any fields in that area are marked.

Using SmartGroups to Automatically Combine Zones
Use SmartGroups to automatically combine zones. For example, you can take a First Name zone and a
Last Name zone and combine them to create a value for a Full Name field. Or you might combine three
zones (month, day and year) into a single date (mm/dd/yyyy).

The following example demonstrates this technique by combining a First and Last name.

Consider the case where a form has an area called First Name and a second area called Last Name. You
have drawn index zones around the two areas and set the appropriate recognition and image cleanup
profiles. Both index zones are associated with an index field called Full Name.

You intend to create a SmartGroup around these two areas, where the group is also associated with the
Full Name index field. When done, the SmartGroup looks something like this on the sample page.
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The following procedure assumes that you have already created the First Name and Last Name zones,
and that they are associated with the Full Name index field.

1. On the Insert tab, in the Zones group, click the arrow under Index, and then click New Index Group
Zone.
Your cursor changes from a pointer to a cross hair.

2. Draw a rectangle around the First Name and Last Name index zones as shown in the preceding
example.
The Create Index Group Zone window appears.

3. In the Associated field list, confirm that Full Name is selected as the default. If not, select it from the
list.

4. If necessary, select Display group zone in the Validation Display area (this is the default).
5. Set the minimum Number of Values in Result Set to 2.
6. Set the maximum Number of Values in Result Set to 2.

Note Setting the minimum and maximum values to the same number specifies the exact number
of results expected. In this case, two results are expected: the first name and the last name. If a
different number of values is returned, the group may require manual indexing in the Validation or
Verification module.

7. Select Concatenate in the Result Set area.
The two values are combined into a single result.

8. In the Delimiter field, type a space to insert a single blank space between the two values. Without
the delimiter, the result would be FrankSeymour instead of Frank Seymour.

9. Use the Test button to check your settings.
10. Select OK to save the SmartGroup.

Copying an Index Group Zone
Use Copy to duplicate an existing index group zone. The copy method is useful for adding an index group
zone similar to an existing one to a sample page. All member index zones are also copied. You can
modify the copy of the index group zone as necessary to make it unique.

Note Copy and paste is not available for member index zones.

When you copy an index group zone, certain items associated with the index group zone are copied, and
others are linked.

1. Select the index group zone to copy. You select an index group zone on the Batch class tree view
tab, the Document class tree view tab, or the sample page.
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2. On the Home tab, in the Clipboard group, click Copy.
3. On the Batch class or Document class tree view tab, select a sample page node. On the Home

tab, in the Clipboard group, click Paste.
When you paste from the sample page image, the copied index group zone is placed on the sample
page at the location of the mouse click, where the mouse click is the top left of the index group zone
rectangle. It is also be added to the list of index zones in the index zone tree.
A copy of the index group zone is created with a unique name, such as Name1, Name2, and Name3.
If you perform a copy and paste on a previously copied index group zone such as Name2, then the
new index group zone is created with a unique name such as Name21, Name22, and Name23.

4. Edit the copied index group zone on the Index Group Zone Properties window.

Deleting a SmartGroup
You delete SmartGroups from the sample page on which you created the group.

1. With a sample page displayed, select the zone to delete.
The selected zone appears with sizing handles.

2. Right-click the zone to delete.
A context menu appears.

3. Click Delete.

After deleting a SmartGroup, the following occurs:
• The magenta box disappears from the sample page.
• The individual OMR zones that comprised the group move up one level since their parent has been

eliminated.
• The names of the individual OMR zones that comprised the group change from the recognition profile

name to the associated field name (as with all the other OMR zones that were not in the group).
• Because of this name change, all the ex-group members now have the same name (since they were

given the same associated field in order to group them).
• Kofax Capture still returns the check box with the highest confidence rating; however, all the other

group features are lost. For example, multiple results cannot be concatenated.

Selecting Bar Code or Text Automatically
Use SmartGroups to automatically use a machine-printed (or handwritten) value if the bar code is
unreadable.

Some documents may have a typed value instead of a bar code sticker. The following example shows a
case where the bar code sticker was unavailable and the operator typed the part number.
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Using Text to Specify a Part Number

Normally, bar code data is captured with greater accuracy than textual information. However, you can set
up a SmartGroup to use the bar code when it is available, but revert to the text value when the bar code
is missing. To do so, you would configure the SmartGroup to return the value with the highest confidence.
In the preceding example, the text would, by definition, have a higher confidence level than the bar code
(since it is missing).

The next document in the batch might have a bar code sticker that can be read with 100% confidence. In
that case, the value from the bar code is returned by the SmartGroup.

The following procedure is based on the preceding example and assumes that you have already created
the index zones for the bar code and the text, and that they have the same associated field.

1. On the Insert tab, in the Zones group, click the arrow under Index, and then click New Index Group
Zone.
The cursor changes from a pointer to a cross hair.

2. Draw a rectangle around the two index zones.
The Create Index Group Zone window appears.

3. In the Associated field list, confirm that the correct associated field is selected as the default. If not,
select the correct associated field.

4. Select either "Display group zone" or "Display most confident zone" in the Validation Display area.
5. Set the minimum Number of Values in Result Set to 1.
6. Set the maximum Number of Values in Result Set to 1.

Note Setting the minimum and maximum values specifies the range of expected results, which in
this case is exactly one.

7. Select Pick Best in the Result Set area. This causes the SmartGroup to return the index field that
has the highest confidence level.

8. Click Test to check your settings.
9. Select OK to save the SmartGroup.

59



Kofax Capture Administrator's Guide

Separator Zones
Batches are made up of stacks of paper documents. The documents can be single page documents,
multipage documents, or a combination of both. If your batch contains multipage documents, the images
must be separated into documents after the batch is scanned or imported.

You can use a separator zone to separate your images into documents. This might be useful if the first
page of all the forms in a batch contains fixed data at a fixed location. If the fixed data is a type that can be
read automatically (for example, using OCR, bar code recognition, patch code recognition, or other types
of recognition), you can use a separator zone as a document separator. The page with the separator zone
is considered the first page of the document.

By using the a shape recognition profile with a separator zone, you can separate your batch into
documents using geometric shapes instead of other elements, such as OCR text or patch codes.

When defining a separator zone, you must specify:
• A recognition profile that specifies the recognition method (such as zonal OCR, shape recognition, bar

code recognition, or others) and image cleanup settings for the zone.
• A confidence threshold (not allowed by all profiles) which indicates the minimum acceptable confidence

returned from the recognition method. For successful recognition, the returned confidence from the
zone must be greater than or equal to the specified threshold.

• Optional search text (not allowed by all profiles). If you enter search text, it must exactly match the
data to be captured from the separator zone. For example, if you draw a separator zone around the
data "invoice," the search text must be specified as "invoice" (you cannot abbreviate the search text
as "inv"). The search text must be recognized within the confidence threshold. If an exact match is
required, the confidence threshold should be set to 100.

During processing, Kofax Capture captures the data (using the specified automatic recognition method).
If the results are returned, the page containing the separator zone is considered the first page of a new
document in the batch.

Separator zones are only used if "Use separator zone" is selected as the method for separating
documents on the Custom Separation and Form Identification window.

Creating a Separator Zone
When creating separator zones, you must work with the Batch class tree view tab selected. You cannot
create a separator zone with the Document class tree view tab selected.

In addition, the method of document separation for the batch must be "Use Separator Zone." Select this
option from the Custom Separation and Form Identification windows.

When single document processing is selected and only one document type exists in the batch class,
separator zone separation converts each separated document into an individual batch, and then
automatically closes the batch before separating the next document.

Creating an OCR Recognition Separator Zone

Once a zone is drawn on the sample page, you can resize the zone.
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Separator zones are batch-specific, so you cannot draw a separator zone on a sample page displayed
from the Document class tree view. You must display the sample page from the Batch class tree view.

1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click Separator.

(If the sample document contains multiple pages, you must create your separator zone on the first
page.)

3. Draw a rectangle around the area of your sample page to use as a separator zone.
The Create Separator Zone window appears.

4. Select a recognition profile from the list. If none of the options in the list is appropriate, click Edit and
define a custom OCR recognition profile.

5. Enter the text that must be captured from the zone to cause Kofax Capture to consider the page
the first page of a document. The search text must exactly match the data to be captured from the
zone. For example, if you draw a separator zone around the data "invoice", the search text must be
specified as "invoice" (you cannot abbreviate the search text as "inv").

6. Use the slider to specify a confidence threshold for the recognition profile. Kofax Capture does not
consider the page to be the first page of a document unless the confidence returned is greater than
or equal to the specified confidence threshold.

7. Click Test to use the QuickZones feature to apply your settings to this zone, and check the results.
8. Click OK.

Creating a Shape Recognition Separator Zone

Once your zone is drawn on the sample page, you can resize the zone.

Separator zones are batch-specific, so you cannot draw a separator zone on a sample page displayed
from the Document class tree view. You must display the sample page from the Batch Class tree view.

The Test button is not available if you display the sample page from the Document class tree view tab. To
use QuickZones to verify recognition and cleanup settings, you must display the sample page from the
Batch class tree view tab.

1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click Separator.

(If your sample document contains multiple pages, you must create your separator zone on the first
page.)

3. Draw a rectangle around the geometric shape to use as a separator zone on the sample page.
The Create Separator Zone window appears.

4. Select the Kofax Shape Zonal recognition profile from the list.
5. Select a shape from the Search shape list. Kofax Capture does not consider the page to be the first

page of a document unless the specified shape is discovered.

Note You cannot specify a confidence threshold for bar code, patch code, or a shape zone. If the
selected recognition profile uses any of these methods, the confidence slider is grayed and the
expected confidence is 100 percent. If the bar code, patch code, or shape is found, the zone will
"pass."

6. Click Test to use the QuickZones feature to apply your settings to this zone and check the results.
7. Click OK.
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Drawing Zones
You create zones by first selecting a zone type and then drawing an area to represent the zone on the
sample page. The following table lists the types of zones supported by Kofax Capture.

Kofax Capture Zones

Zone Type Description Toolbar Icon

Index zone (manual) At validation time, the validation or verification operator is shown
this area of the form, which makes the data easier to find and read.

Index zone
(automatic)

If an automatic recognition method (for example, OCR, ICR, bar
code recognition, or others) can be used to capture the data for an
index field, you can draw an index zone around the location of the
data and then specify a recognition method for the area. At data
capture time, the data is captured and returned to the index field.

OCR Registration
zone

A text registration zone can be used to augment or replace page-
level registration. Page-level registration works extremely well in
most cases. However, if your images are different from the sample
pages, you may get better results by using a registration zone.

Shape registration
zone

A shape registration zone can be used to augment or replace page-
level registration. Page-level registration works extremely well in
most cases. However, if your images are different from the sample
pages and standard registration zones are not appropriate, you
may get better results by using a shape registration zone instead.
Whenever possible, use a shape registration zone instead of an
OCR registration zone.

Separator zone A separator zone is an area on an image containing data to be used
to separate documents in a batch. The data must be constant on
the first page of every document.
Separator zones are only used if "Use separator zone" is selected
as the method for separating documents on the Custom Separation
and Form Identification window.

Form identification
zone

A form identification zone can be used to assist the Kofax Capture
page-level form identification feature. It is typically used to help the
form identification engine distinguish among forms that are very
similar. For example, a form identification zone could be useful for
identifying different revisions of the same form.
You can specify more than one form identification zone for a form
type. For multipage form types, the zone must be on the first page.

Group zone Many documents consist of related items. For example, you might
find fields for first and last name. With group zones, you can take
advantage of the logical relationship among items by creating a
group with one or more index zones in it. This capability eliminates
the need to use a special script. With groups, you can combine
data from separate fields, control how many fields can be filled
in for the group, or find conflicts when more than one choice has
(inappropriately) been made.
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You create index zones on your sample pages. To display a sample page, do one of the following:
• From the Document class tree view tab, double-click the document class associated with the form type.

Select a form type, and select the sample page. The sample page appears.
• From the Batch class tree view tab, double-click the document class associated with the form type.

Select a form type, and select the sample page. The sample page appears.

When creating zones on your sample page, use the following guidelines.

In General
• If all index data is separated from other information on your sample page by at least .25", draw your

index zones to include a moderate amount of white space (about .25") around the index data. The white
space around the data allows for horizontal or vertical offsets that might be introduced by a scanner.

• If at least some of the index data is close together (that is, not separated from other information on
your sample page by at least .25"), draw your index zones with only a small amount of white space.
This prevents unwanted data from appearing in a zone, which could reduce the accuracy of character
recognition. Because a small amount of white space does not allow for horizontal or vertical offsets that
might be introduced by a scanner, a registration zone may be required.

For OCR Zones
• In general, characters and numbers must reside completely within the zone boundaries to be read.
• Characters or numbers that do not reside completely within the boundaries are not reflected in the

captured data.

For shape zones, Kofax Capture examines the content of the zone and attempts to find a corresponding
shape. If a shape is found, its ID number is placed in the associated field. The results are available in
the Validation and Verification modules. They can also be used in your custom recognition scripts or
custom modules. If you assign a shape recognition profile to an index zone, you cannot specify a specific
search shape. All shapes are examined and the closest match is used. Your ability to use this capability is
potentially unlimited.

For Bar Code Recognition
• Include at least a 0.5” boundary around the bar code when drawing your zone. If this is not possible,

ensure that a minimum 0.5” margin exists on the left side of the bar code.
• Make sure you include the entire bar code within the zone.

For OCR Registration Zones
• If possible, include at least .25" of white space around the registration data to allow for horizontal or

vertical offsets that might be introduced by a scanner. The registration process measures and corrects
any scan offset by shifting the index zones into place.

• Make sure the border of the zone does not touch other text or elements on the image.
• When manually resetting a registration point, select it carefully. Position the cursor at the lower-left

corner of an imaginary box around the first character of the text in the OCR registration zone. If the first
character has a descender (for example, a lowercase "y"), use the baseline of the character, not the
bottom of the character, when selecting the registration point.

• Test whether a registration point is properly defined: Create a test batch by importing the sample image
file used to define your OCR index zones. If the registration point is properly defined, your OCR index
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zones contain the expected data. If the registration point is not properly defined, your OCR index zones
are shifted and contain unexpected data.

• For best results, keep the search text as short as possible.

For Shape Registration Zones
Include only the portion of the shape you are trying to match. If your zone includes excess components,
the recognition engine will probably return ID number 100 (general shape), thereby leading to incorrect
registration.

The following illustration displays the portions of a shape to include in the zone. When searching for a
particular shape, enclose only that portion of the graphic within the zone boundary.

Line Intersections that Kofax Capture Recognizes

For OMR Zones
Each OMR object (for example, a check box) must be zoned separately. You cannot draw one OMR zone
around multiple OMR items. (You can draw another type of zone around multiple OMR zones. Then, you
can use scripts or SmartGroups to process the results from the zones.)

All OMR zones should be consistent in size. If the OMR shapes are different sizes, create different groups
of OMR zones. Make the zones for each group consistent within that group. Use a different recognition
profile for each group of OMR zones.

To allow for potential registration offsets, the zones should include the OMR shape and as much white
space around the shape as prudent to ensure that all of the zone is included.

Do not create zones whose boundaries touch or get near any other text or unrelated OMR shapes on the
page.

For square or rectangular shapes, you can use an aggressive line removal scheme to remove the shapes
without destroying the inner marks. Once the shapes are removed, you can use the despeckle feature
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to clean up extraneous noise. Then, set your pixel threshold to a low value (for example, 0 or 1). During
processing, "empty" zones return 0s (the shape is not filled in) or 1s (the shape is filled in).

The confidence level is a number returned by a Kofax Capture recognition engine to indicate the level of
certainty in the reported results. The exact method used to calculate the confidence varies with the type of
index zone and the options you set for it. In general, the higher the number, the greater the confidence.

The confidence returned from an OMR zone is really the percentage of black pixels found in the zone.
Therefore, you can use the confidence returned from a zone to determine the most appropriate threshold.

Double Zoning
You can draw multiple zones for the same field. The zones can be in different locations, or even one
on top of the other. Then, you can capture the data from each zone with a different set of recognition
settings. For example, you can use Kofax Advanced OCR with aggressive image cleanup for one zone
and Kofax Advanced OCR with no image cleanup for another zone. The zone data captured with the
highest confidence level is returned for the field. Your validation and verification operators can see the
zone that returned the highest confidence.

Note Using multiple zones could adversely affect performance.

Tips for Drawing Zones
When defining zones on your sample page, follow these guidelines:
• If all index data is separated from other information on your sample page by at least .25", draw your

index zones to include a moderate amount of white space (about .25") all around the index data. The
white space around the data allows for horizontal or vertical offsets that might be introduced by a
scanner.

• If at least some index data is close together (that is, not separated from other information on your
sample page by at least .25"), draw your index zones with only a small amount of white space. This
prevents unwanted data from displaying in a zone, which could reduce the accuracy of character
recognition. But, because a small amount of white space does not allow for horizontal or vertical offsets
that might be introduced by a scanner, an OCR registration zone may be required.

For OCR Zones
• In general, characters and numbers must reside completely within the zone boundaries to be read.
• Characters or numbers that do not reside completely within the boundaries are not reflected in the

captured data.

For Bar Code Recognition
• Include at least a .5" boundary around the bar code when drawing your zone.
• Make sure you include the entire bar code within the zone.

Make sure you include the entire bar code within the zone
• If possible, include at least .25" of white space around the registration data to allow for horizontal or

vertical offsets that might be introduced by a scanner. The registration process measures and corrects
any scan offset by shifting the index zones into place.

• Make sure the border of the zone does not touch other text or elements on the image.
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• When manually resetting a registration point, select it carefully. Position the cursor at the lower-left
corner of an imaginary box around the first character of the text in the OCR registration zone. If the first
character has a descender (for example, a lowercase "y"), use the baseline of the character, not the
bottom of the character, when selecting the registration point.

• Test whether a registration point is properly defined: Create a test batch by importing the sample image
file used to define your OCR index zones. If the registration point is properly defined, your OCR index
zones contain the expected data. If the registration point is not properly defined, your OCR index zones
are shifted and contain unexpected data.

• For best results, keep the search text as short as possible.

For Shape Registration Zones
• Include only that portion of the shape that you are trying to match. If your zone includes excess

components, the recognition engine will probably return code 100 (general shape). For example, if you
are searching for a cross shape, center the zone only on the cross portion of the graphic.

• For best results, keep the shape limitations in mind.

For OMR Zones
• Each OMR shape must be zoned separately. You cannot draw one OMR zone around multiple OMR

shapes. (Note that you can draw another type of zone around multiple OMR zones. Then you can use
scripts or SmartGroups to process the results from the zones.)

• All your OMR zones should be consistent in size. If the OMR shapes are different sizes, create different
groups of OMR zones. Make the zones for each group consistent within that group. Use a different
recognition profile for each group of OMR zones.

• To allow for potential registration offsets, the zones should include the OMR shape and as much white
space around the shape as prudent.

• Do not create zones whose boundaries touch or get near any other text or unrelated OMR shapes on
the page.

• For square or rectangular shapes, you can use an aggressive line removal scheme to remove the
shapes without destroying the inner marks. Once the shapes are removed, use the despeckle feature
to clean up extraneous noise. Then, set your pixel threshold to a low value (for example, 0 or 1). During
processing, "empty" zones return 0s (the shape was not filled in) or 1s (the shape was filled in).
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• The confidence returned from an OMR zone is really the percentage of black pixels found in the
zone. Therefore, you can use the confidence returned from a zone to determine the most appropriate
threshold.

Double Zoning

You can draw multiple zones for the same field. The zones can be in different locations, or even one
on top of the other. Then, you can capture the data from each zone with a different set of recognition
settings. For example, you can use Kofax Advanced OCR with aggressive image cleanup for one zone
and Kofax Advanced OCR without image cleanup for another zone. The zone data captured with the
highest confidence level is returned for the field. Your validation and verification operators can see the
zone that returned the highest confidence.

Note Using multiple zones could adversely affect performance.

Creating an Index Zone
In addition to the standard index zones described here, Kofax Capture also supports the following special
types of index zones:
• Group Zones (SmartGroups)
• OCR Registration Zones
• Shape Registration Zones
• Separator Zones
• Form ID Zones

Create index zones on the sample pages you scan for form types. To display a sample page, do one of
the following:
• From the Document class tree view tab, double-click the document class associated with the form.

Select a form type, and select the sample page. The sample page appears.
• From the Batch class tree view tab, double-click on the document class with which the form type is

associated. Select a form type, and select the sample page. The sample page appears.

1. Select a sample page.
2. On the Insert tab, in the Zone group, click the appropriate button for the type of zone you want.

Your cursor changes to a cross hair.
3. Draw a rectangle around the area on your sample page that you want to use as the zone.

A window appears.
4. Set options as appropriate for your zone.
5. Click Test to apply your settings to this zone and check the results.

The Test button is not available if you display the sample page from the Document class tree view
tab. To use QuickZones to verify your recognition and cleanup settings, you must display the sample
page from the Batch class tree view tab.

6. Select OK.

Tip Once your zone is drawn on the sample page, you can resize the zone.
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Copying an Index Zone

Use Copy to duplicate an existing index zone. When copying and pasting an index zone, a new index field
is also created. The copy method is useful for adding an index zone that is similar to an existing one. You
can modify the copy of the index zone as necessary to make it unique.

When copying an index zone, certain items associated with the index zone are copied, and others are
linked. The following table shows the items that are copied and linked.

Copied Items Linked Items

Index zone None

Index field None

OMR settings None

Table index field None

Custom storage string None

If you paste a table index field on the same sample page, a copy of the index field is created in the same
table. Otherwise, the index field is pasted as a new index field that is not in a table.

1. Select the index zone you to copy. You select an index zone from the Batch class tree view tab, the
Document class tree view tab, or the sample page.

2. On the Home tab, in the Clipboard group, click Copy.
3. To paste the copied index zone, do one of the following:

• From the Batch class tree view tab or the Document class tree view tab, select a sample page
node. On the Home tab, in the Clipboard group, click the arrow under Paste, and then click
Paste.
When you paste from the sample page node, the copied index zone is placed on the sample page
offset from the original index zone's top left location. It is also added to the list of index zones in
the index zone tree. If you paste a zone multiple times, the copied zone placement uses the same
offset as the last zone pasted.

• From the Batch class tree view tab or the Document class tree view tab, right-click the sample
page image. On the context menu, click Paste.

If you perform a copy and paste on a previously copied index zone such as Name2, the new index
zone is created with a unique name such as Name21, Name22, and Name23.
The Export Setup window does not appear when an index zone is created using copy and paste.
Instead, the Export Setup window appears upon publishing the associated batch class.
A copy of the index zone and corresponding index field is created with a unique name.

4. Edit the copied index zone from the Index Zone Properties window.

Editing an Index Zone

You edit index zones with the Index Zone Properties window.
1. Click an index zone on a sample page.
2. On the Home tab, in the Editing group, click Properties.
3. From the Index Zone Properties window, edit the properties.
4. Click Apply to save the changes without closing the window.
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5. Click Test to apply your settings to this zone and check the results.
The Test button is unavailable if you display the sample page from the Document class tree view
tab. You must display the sample page from the Batch class tree view tab to use QuickZones to
verify recognition and cleanup settings.

6. Click OK to save the changes and close the window.
• Once you select the zone, you can resize it.
• You can select a zone to edit on the sample page or from the Definitions tree view. Just expand

the tree under the sample page and select a zone.

Creating a Shape Registration Zone
Use this procedure if you want the page registration zone to use shape recognition.

1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click the arrow under Registration, and then click Create

Shape Registration Zone.
Your cursor changes from a pointer to a cross hair.

3. Draw a rectangle around the area of your sample page to use as a shape registration zone.
The Create Registration Zone window appears.

4. Select a shape recognition profile from the list. If none of the options in the list is appropriate, click
Edit and define a custom shape recognition profile.

5. The appropriate shape is automatically selected in the Search shape list.
6. Click Test to apply your settings to this zone and check the results.

The Test button is unavailable if you display the sample page from the Document class tree view
tab.

7. Click OK.
The new shape registration zone appears on the sample page. The registration point for the zone
appears as a bold cross hair, with the intersection of the cross hair denoting the registration point
location, which varies according to the pixel density of the shape.

Once your zone is drawn on the sample page, you can resize the zone. You can create more than one
shape registration zone.

Creating an OCR Registration Zone
You create OCR registration zones on the sample pages scanned for your form types. To display a sample
page:
• From the Document class tree view tab, double-click the document class associated with the form type.

Select a form type, and select the sample page.
• From the Batch class tree view tab, double-click the document class associated with the form type.

Select a form type, and select the sample page.
• To create one or more OCR registration zones.

1. Select a sample page to display it.
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2. On the Insert tab, in the Zones group, click the arrow under Registration, and then click New
Registration Zone. (If the sample document contains multiple pages, you must create the zone on
the first page.)
Your cursor changes from a pointer to a cross hair.

3. Draw a rectangle around the area of your sample page to use as a page registration zone.
The Create Registration Zone window appears.

4. Select an OCR recognition profile from the list. If none of the options in the list is appropriate, click
Edit and define a custom OCR recognition profile.

5. Kofax Capture suggests the search text; you can also edit the text. The search text must exactly
match the data to be captured from the zone and cannot be longer than 4 characters.
For registration to work, at least half the characters on your form must match the specified search
text. If no search text is specified, the pixel contents must be similar.
Kofax Capture selects the location of the registration point. If a suitable registration point cannot be
found, a default location is assigned to the center of the zone. In this case, the search text is left
blank.

6. Click Test to apply your settings to this zone and check the results.
The Test button is not available if you display the sample page from the Document class tree view
tab. You must display the sample page from the Batch class tree view tab to use QuickZones to
test your zone and recognition and cleanup settings.

7. Click OK. The new OCR registration zone appears on the sample page.
The registration point for the zone is displayed as a bold cross hair, with the intersection of the cross
hair denoting the registration point location.

8. If you changed the search text, you may need to reset the registration point. See Resetting the
Registration Point.

Editing an OCR Registration Zone
Edit OCR registration zone properties on the Registration Zone Properties window. You can resize an
OCR registration zone by selecting it from the sample page and moving the sizing handles.

1. With the sample page displayed, right-click an OCR registration zone and click Properties on the
context menu.

2. On the Registration Zone Properties window, edit the properties.
3. Click Apply to save the changes without closing the window.
4. Use the Test button to check your changes.

You must display the sample page from the Batch class tree view tab to use QuickZones to verify
recognition and cleanup settings.

5. Click OK to save the changes and close the window.

Resetting the Registration Point

If you modify the search text or manually select a shape for a registration zone, you may need to reset the
registration point for the zone. You can select the automatic reset option to move the registration point,
or you can reset it manually. When you select the automatic reset option, Kofax Capture automatically
determines the position for the registration point.
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Resetting the Registration Point Automatically
1. Do one of the following:

• In the tree view, select the registration zone to update.
• With the sample page displayed in the image viewer, select a registration zone.

2. Right-click and select Reset Registration Point.
For OCR registration zones, if the search text listed in the Registration Zone Properties window
does not display within the zone boundaries, the registration point cannot be adjusted with the
automatic reset option.
Kofax Capture moves the registration point for the zone to the lower-left corner of the first character
in the search text, or to the appropriate place in your shape.

Resetting the Registration Point Manually

Do not manually reset the registration point for shape zones.
1. With the sample page displayed in the image viewer, select a registration zone.
2. On the Insert tab, in the Zone group, click the arrow under Registration, and then click Reset

Registration Point.
3. Click the new location for the registration point. The registration point is repositioned to the new

location. Normally, you place the registration point at a location where black and white pixels
intersect.

You cannot reset the registration point by "dragging" it from one location to another. Do not manually reset
the registration point for shape registration zones.

Deleting a Zone
You delete zones on the sample page where you created the zone.

1. With a sample page displayed, select the zone to delete.
The selected zone appears with sizing handles.

2. Right-click the zone to delete.
A context menu appears.

3. Select Delete.

Testing Zones
Use the QuickZones feature to quickly adjust your zone level recognition and cleanup profile settings.

QuickZones greatly reduces the time and effort required to set up or edit automatic index zones (as
well as page level bar codes) by eliminating the need to publish and process batches to see the results.
Instead, you can make changes to any recognition or image cleanup settings, click a single button, and
see the results within moments.

When creating or editing index zones and page-level bar codes, many settings have an effect on how
accurately Kofax Capture recognizes machine-printed characters, hand-printed characters, bar codes,
and other marks. The right settings are critical to getting the most out of your scanned documents, yet it
can be time-consuming to figure them out. Often it is a matter of trial and error.
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Using QuickZones, you can apply recognition profile and image cleanup settings to the current zone
or SmartGroup and check the results in the Zone Test window. You can then make adjustments to
the recognition and cleanup settings until you are satisfied. Consequently, your scanned data is more
accurate, and data validation proceeds more quickly.

You can use QuickZones when your sample page is displayed from the Batch class tree view tab.
Although you can create and edit zones when the Document class tree view tab is selected, you cannot
use QuickZones there.

You can also access the Zone Test window from the Batch class tree view by selecting an index zone or
SmartGroup and right-clicking to display a context menu. Click Zone Test on the context menu to display
the window.

As you are working with zones or SmartGroups, notice that the windows have a Test button. Click Test to
check your settings with the Zone Test window, where you can visually compare the original contents of
the zone or group with the processed results. You can also use the window to try settings for the current
zone on other document samples you may already have scanned.

If you are not satisfied with your processed results, close the window, adjust the settings, and test again.

QuickZones applies your recognition profile and image cleanup settings to the currently selected zone or
SmartGroup. If you test a different zone or group, you may get different results even though the settings
are the same. For greatest overall accuracy, you should test your settings on all the zones that use them,
and with a variety of sample pages.

Testing is an interactive process. You can adjust the various settings and test them as often as necessary
to get the best possible results. While most testing is done while setting up your zones for the first time,
you can return to the Administration module and run further tests any time.

Using QuickZones
Use QuickZones to verify your recognition and cleanup settings while creating or editing zones or
SmartGroups. You do not need to publish or process batches to use QuickZones.

To use QuickZones, you must have at least one image (the sample page) scanned and stored. You can
also run the test on any number of additional examples that have already been scanned and saved.

QuickZones is not available unless your sample page is displayed on the Batch class tree view tab.

There are several ways to access QuickZones.

QuickZones applies your recognition profile and image cleanup settings to the currently selected zone.
If you test a different zone, you may get different results, even though the settings are the same. For
greatest overall accuracy, you should test your settings on all the zones that use them, and with a variety
of sample pages.

Tip Testing is an interactive process. You can adjust the various settings and test them as often as
necessary to get the best possible results. While most testing is done while setting up your zones the
first time, you can return to the Administration module and run further tests any time.
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Using QuickZones on the Ribbon
1. Click the Batch tab on the Definitions panel.

The Batch class tree view appears. Expand the tree if necessary.
2. Create a zone or SmartGroup.
3. Highlight the zone or group to test.
4. On the Home tab, in the Form Type group, click Zone Test.

The Zone Test window appears. Results for the currently selected image file are shown by default.
5. Add one or more sample image files to the Images list:

a. Click Add to open the Import window.

b. Navigate to the appropriate folder and select all the image files to add.

c. Click Add to move the selected files to the "Files to import" list.

d. When the list is complete, click Open to import the files.
6. Select a different image file to use for another test.
7. Click Test to apply your settings to this zone or group and check the results.

Using QuickZones from the Context Menu
1. Click the Batch tab on the Definitions panel.
2. Create a zone or SmartGroup.

The Batch class tree view appears. Expand the tree if necessary.
3. Highlight the zone or group to test.
4. Right-click to display the context menu. You can right-click the name in the Batch class tree, or

anywhere on the sample page.
5. Select Zone Test to display the Zone Test window. Results for the currently selected image file are

shown by default.
6. Add one or more sample image files to the Images list:

a. Click Add to open the Import window.

b. Navigate to the appropriate folder and select all the image files to add.

c. Click Add to move the selected files to the "Files to import" list.

d. When the list is complete, click Open to import the files.
7. Select a different image file to use for another test.
8. Click Test to apply your settings to this zone or group and check the results.

Using QuickZones from the Zone or Group Properties Window
1. Click the Batch tab on the Definitions panel.

The Batch class tree view appears. Expand the tree if necessary.
2. If necessary, create a zone or SmartGroup.
3. Highlight the zone or group to test.
4. Right-click to display the context menu. You can right-click the name in the Batch class tree, or

anywhere on the sample page.
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5. Select Properties to open either the Index Zone Properties window or the Index Group Zone
Properties window, depending on what you have selected in the tree view.

6. Make adjustments to the properties.
7. Click Test to display the Zone Test window. Results for the currently selected image file are shown

by default.
8. Add one or more sample image files to the Images list:

a. Click Add to open the Import window.

b. Navigate to the appropriate folder and select all the image files to add.

c. Click Add to move the selected files to the "Files to import" list.

d. When the list is complete, click Open to import the files.
9. Select a different image file to use for another test.

10. Click Test to apply your settings to this zone or group and check the results.

Using QuickZones from the Recognition Profiles window

This procedure does not apply to SmartGroups.
1. Click the Batch tab on the Definitions panel.

The Batch class tree view appears. Expand the tree if necessary.
2. Create a zone.
3. Highlight the zone to test.
4. Right-click to display the context menu. You can right-click the zone name in the Batch class tree, or

anywhere on the sample page.
5. Select Properties to open the Index Zone Properties window.
6. Click Edit to display the Recognition Profiles window.
7. Make adjustments to the recognition profile.
8. Click Test to display the Zone Test window. Results for the currently selected image file are shown

by default.
9. Add one or more sample image files to the Images list by doing the following:

a. Click Add to open the Import window.

b. Navigate to the appropriate folder and select all the image files to add.

c. Click Add to move the selected files to the "Files to import" list.

d. When the list is complete, click Open to import the files.
10. Select a different image file to use for another test.
11. Click Test to apply your settings to this zone and check the results.

Using QuickZones from the Image Cleanup Profiles Window

This procedure does not apply to SmartGroups.
1. Click the Batch tab on the Definitions panel.

The Batch class tree view appears. Expand the tree if necessary.
2. Create a zone.
3. Highlight the zone to test.
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4. Right-click to display the context menu. You can right-click the zone name in the Batch class tree, or
anywhere on the sample page.

5. Select Properties to open the Index Zone Properties window.
6. Click Edit to display the Recognition Profiles window.
7. Click Edit to open the Image Cleanup Profiles window.
8. Make adjustments to the image cleanup profile.
9. Click Test to display the Zone Test window. Results for the currently selected image file are shown

by default.
10. Add one or more sample image files to the Images list by doing the following:

a. Click Add to open the Import window.

b. Navigate to the appropriate folder and select all the image files to add.

c. Click Add to move the selected files to the "Files to import" list.

d. When the list is complete, click Open to import the files.
11. Select a different image file to use for another test.
12. Click Test to apply your settings to this zone and check the results.

Image Cleanup
Cleaning up images makes them easier to read, and improves the following:
• OCR/ICR accuracy
• OMR accuracy
• Bar code recognition
• Patch code recognition

Kofax Capture allows you to clean up your images in two ways:
• Permanent image cleanup occurs at the page level. It can be used to improve the overall quality of your

images. The images are saved in their cleaned up state, resulting in permanent modifications to the
images.

• Temporary image cleanup occurs at the zone level. It can be used to improve the accuracy of the
automatic recognition engines being used to process the zone. (For example, you might remove
horizontal lines from a zone before using the OCR engine to capture data from the zone.) When the
automatic recognition is complete, the temporary image cleanup is discarded. When editing or creating
zones, you can use QuickZones to verify that the cleanup settings yield the best results. QuickZones
cannot be used with permanent image cleanup.

You perform image cleanup by associating an image cleanup profile with process settings. The profile
specifies an image cleanup filter, along with all the related settings. For example, you can specify an
image cleanup profile on the Create Form Type window - Image tab or Form Type Properties window
- Image tab. Then, whenever forms of that form type are processed, the image cleanup settings are
applied.

You can also associate an image cleanup profile with a recognition profile. Then, whenever that
recognition profile is used, the image cleanup settings are in effect. For example, you can associate an
image cleanup profile with a zonal OCR recognition profile. Whenever that recognition profile is used to
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process a zone, the specified image cleanup settings are used to enhance the data capture from that
zone.

Note Color images use a separate image cleanup profile that is optimized for color files. See Color
Documents for more information.

Image Cleanup for Zones
During processing, zones are clipped from the source image. Any image cleanup specified for the zone
is applied after clipping. This is especially significant for image cleanup features such as line removal.
Consider vertical line removal: By default, the minimum height of a vertical line to remove is 200 pixels.
The line might be longer than that on the image. When the zone is clipped, the total zone height might
only be 150 pixels. If the minimum height is left at the default value, the line would not be removed from
the zone.

Check your image cleanup settings on test images before you process your batches. You can adjust your
settings to achieve the necessary results.

Note that all forms are different, and settings that work well for one set of forms may not work as well on
another. Guidelines for using the image cleanup features are listed here.
• Vertical line removal could be useful for all zones that contain vertical lines. For OCR zones, vertical

lines are sometimes ignored by the recognition engine, but not in all cases. Make sure the line settings
define the size of the line within the zone.

• Horizontal line removal is especially useful for ICR zones that contain horizontal lines. It could also be
useful (when used in conjunction with vertical line removal) for removing check boxes for OMR zones.
Make sure the line settings define the size of the line within the zone.

• Despeckle could be useful for eliminating extraneous noise within a zone. Make sure the speckle
settings remove only the noise and not data.

• Deskew should not be used for zonal image cleanup.
• Deshade could be useful for removing shaded areas within a zone. Make sure the settings only remove

the shading and not data.
• Destreak should not be used for zonal image cleanup. This powerful feature can be very destructive.
• Edge enhancement filters (such as Character Smoothing, Thinning, and others) may be helpful but

should be used with caution. As a rule of thumb, do not select the edge enhancement filters unless you
see good results while testing them.

• Black border removal/cropping should not be used for zonal image cleanup.

Tips for Using Edge Enhancement Filters
For best results, follow these guidelines when selecting edge enhancement filters:
• Character Smoothing always has a positive effect on an image. You can use this filter in combination

with any other image filter.
• The combination of deshading, despeckling, removing lines, and using the Smooth and Clean image

filter produces better results than using only the Smooth and Clean image filter. However, the Smooth
and Clean filter should not be used as an alternative to deshading, despeckling, and removing lines
from an image.
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• Thin should only be applied to images that contain elements that are ballooned or blended together.
Applying this filter to an image that does not contain such elements may cause the loss of important
data.

• Light Thicken should only be applied to images that have been deshaded and despeckled. (Using this
filter may exaggerate background noise.) Light Thicken is less aggressive than the Thicken filter.

• Thicken should only be applied to images that have been deshaded and despeckled. (Using this filter
may exaggerate background noise.) Thicken should only be applied to images that contain thin or light
elements (such as images containing dot matrix characters or fax images). Applying this filter to an
image that does not contain such elements may cause characters and lines to blend together.

• Fill Line Breaks is recommended for use with images that contain lines. However, it may cause parallel
lines close together to be merged (that is, lines that are separated by only one pixel). For images that
contain parallel lines that are close together, use the Fill Line Breaks and Preserve filter.

• Fill Line Breaks and Preserve is recommended for use with images that contain lines that are close
together (that is, lines that are separated by only one pixel).

• Use QuickZones to evaluate your settings while creating your zones. This improves results during
processing.

Smooth and Clean Filter

This filter, which smooths characters, removes background noise, and may eliminate lines, has the
following characteristics:
• Usually has a positive impact on the image, although it is a destructive filter
• Usage should be determined based on image quality
• Increases legibility
• Increases OCR accuracy
• Consistently reduces compressed file sizes by at least 10-15 percent

This filter is faster than using the Thinning filter followed by a Light Thicken filter, but has exactly the same
effect. It sets any black pixel to white if it cannot be considered part of at least a 2x2 block of black pixels
in the source image.

Smooth, Clean, and Preserve Filter

This filter, which smooths characters and lines and removes background noise, has the following
characteristics:
• Usually has a positive impact on the image, although it is a destructive filter
• Usage should be determined based on image quality
• Increases legibility
• Increases OCR accuracy
• Consistently reduces compressed file sizes by at least 10-15 percent

This filter is identical to the Smooth and Clean filter, except that it preserves horizontal and vertical black
line segments that are one pixel wide.

Character Smoothing Filter

This filter, which smooths characters and lines, has the following characteristics:
• No negative impact on the image. It is a non-destructive filter.
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• Usage should not be determined based on image quality
• Increases legibility
• Increases OCR accuracy
• Consistently reduces compressed file sizes by 10-15 percent

This filter considers the color of the four perpendicular pixels (strong neighbors) of every pixel in the
source image. If the majority of the strong neighbors have the color opposite the pixel’s color, the color of
the pixel is toggled to match that of its neighbors.

Thin Filter

This filter thins characters and lines and may remove background noise. The Thin filter has the following
characteristics:
• Potentially negative impact on the image. It is a destructive filter.
• Usage should be determined based on image quality
• Good for character separation (for elements that are ballooned or blended together)
• May reduce compressed file sizes

This erosion filter thins down image elements by setting any black pixel to white if it is perpendicular or
diagonally adjacent to at least one white pixel in the source image.

Light Thicken Filter

This filter thickens characters and lines and may exaggerate background noise, but it is not as aggressive
as the Thicken filter. It performs approximately half the thickening of the Thicken filter. The Light Thicken
filter has the following characteristics:
• Potentially negative impact on the image. It is a destructive filter.
• Usage should be determined based on image quality.
• Good for dot matrix characters or for enhancing fax images (for thin or light elements).
• May increase compressed file sizes.

Thicken Filter

This filter thickens characters and lines and may exaggerate background noise. The Thicken filter has the
following characteristics:
• Potentially negative impact on the image; it is a destructive filter.
• Usage should be determined based on image quality.
• Good for dot matrix characters or for enhancing fax images (for thin or light elements).
• May increase compressed file sizes.

This dilation filter thickens image elements by setting any white pixel to black if it is perpendicular or
diagonally adjacent to at least one black pixel in the source image.

Fill Line Breaks Filter

This filter, which fills in and smooths lines, has the following characteristics:
• Potentially negative impact on the image because parallel lines close together may be merged. It is a

destructive filter.
• Usage should be determined based on image content (images containing lines).
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• May increase legibility.
• May increase compressed file sizes.

This closing filter sets any pixel to black if it cannot be considered part of at least a 2x2 block of white
pixels in the source image.

Fill Line Breaks and Preserve Filter

This filter, which fills in and smooths lines while maintaining the interline gap, has the following
characteristics:
• Potentially positive impact on the image because parallel lines close together are not merged. It is a

non-destructive filter.
• Usage should be determined based on image content (images containing lines).
• Increases legibility.
• May increase compressed file sizes.

This filter is identical to the Fill Line Breaks filter, except that it preserves horizontal and vertical white line
segments that are at least one pixel wide.

Dot Matrix Fonts

Dot matrix fonts are made up of dots printed in patterns to form characters or numbers. Some dot
matrix fonts use a very dense pattern of dots, while others use a more sparse pattern. Because of these
differences, you should try several types of settings to achieve the best results for processing dot matrix
text on your forms. In addition to adjusting the settings for despeckle, you might also try selecting one
or more edge enhancement filters such as "Character smoothing," "Light thicken," or "Smooth, clean,
and preserve." For best results, you should always test your settings with sample batches that are
representative of the ones you’ll process in production.

Tips for Removing Vertical Lines
For best results, follow these guidelines:
• Set the minimum height to a large enough value so that text objects (such as the vertical bar of a

capital "T") are not mistaken for vertical lines. Setting a larger value also allows the vertical line removal
algorithm to work faster because many objects (such as text) can be ignored when searching for lines.

• Set the maximum gap to a maximum value of 2 or 3 pixels (at 200 dpi). Doing so helps prevent text
characters from being considered vertical lines to remove.

• Use QuickZones to evaluate your settings while creating your zones. This improves results during
processing.

Tips for Removing Shaded Areas
For best results, follow these guidelines:
• Set the minimum width and minimum height as large as possible without making the values larger than

the smallest shaded area to detect. For example, if all shaded areas to be removed are 5 inches wide
and 2 inches tall, you can set the minimum height to 1.5 inches (any value less than 2 inches) and the
minimum width to 4.5 inches (any value less than 5 inches). Setting the values too small (for example,
less than 1 inch) could cause the deshade algorithm to detect text objects as shaded areas.
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• Leave the Max speckle width and Max speckle height at their default values. The defaults should be
sufficient to detect most shaded areas.

• Leave the Horizontal adjust and Vertical adjust at their default values. The defaults should be sufficient
for most speckles in detected shaded areas.

• Use QuickZones to evaluate your settings while creating your zones. This improves results during
processing.

Streak Removal
Sometimes, streaks are captured on an image when it is scanned as a result of the following:
• Marks on the original page
• Dust in the scanner assembly
• Faulty scanner CCD (camera)

You can use the streak removal feature to eliminate these streaks.

To remove streaks, you must define the maximum width of the streaks to remove.

Streak Removal

Note that the streak removal feature processes each horizontal scan line on the image to detect runs of
black pixels. Any series of black pixels less than or equal to the streak width are removed. Even though
streak removal processes the image from left to right, its main purpose is to eliminate vertical streaks.

You specify streak removal settings on the Image Cleanup Profiles window. The settings become part of
an image cleanup profile, which you can then include in a recognition profile.

Tips for Removing Streaks

For typical images, set the width of the streaks to remove to a value of 1 or 2 pixels. Since streak removal
looks for any series of pixels that are alike and also less than or equal to the streak width, setting the width
too high could have an adverse effect by eliminating data from the image.
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Use QuickZones to evaluate your settings while creating your zones. This improves results during
processing.

Horizontal Line Removal
If your images contain unwanted horizontal lines, you can remove them with the horizontal line removal
feature. You can optionally select character reconstruction to repair text that intersects the lines that are
removed. Removing lines and repairing characters improves the readability of your images.

To remove horizontal lines, define the characteristics of the lines to remove. You must define the minimum
length and maximum height of the lines to remove, along with other characteristics such as an edge clean
factor and the characteristics of the characters to repair.

Example of Horizontal Line Removal

Specify your line removal settings on the Image Cleanup Profiles window. Your settings become part of an
image cleanup profile, which you can include in a recognition profile.

Tips for Removing Horizontal Lines

For best results, follow these guidelines:
• Set the minimum length to a large enough value so that text objects (such as the horizontal bar of a

capital "T") are not mistaken for horizontal lines. Setting a larger value also allows the algorithm to work
faster because many objects (such as text) can be ignored when searching for lines.

• Set the maximum gap to a maximum value of 2 or 3 pixels (at 200 dpi). Doing so helps prevent text
characters from being considered horizontal lines to remove.

• Use QuickZones to evaluate your settings during zone setup. This improves results during processing.

Despeckle
Speckles on an image are groups of black pixels surrounded by white pixels (or white pixels surrounded
by black pixels). Removing unwanted speckles provides a cleaner image for OCR processing and also
helps reduce compressed file sizes.

To remove speckles from an image, you define the characteristics of the speckles to remove. You must
specify the maximum height and width of the unwanted speckles, and all speckles that satisfy the defined
characteristics are removed.
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Example of Speckles on an Image

You specify despeckle settings on the Image Cleanup Profiles window. Your settings become part of an
image cleanup profile, which you can include in a recognition profile.

Tips for Removing Speckles

For best results, follow these guidelines:
• Set the maximum width and maximum height to appropriate values for your image. Using large values

for these properties could remove portions of the image that you want to keep.
• Check your image to ensure that punctuation marks (such as commas, periods, and quotation marks)

are not being removed. If they are, adjust the values of the maximum width and maximum height.
• Use QuickZones to evaluate your settings during zone creation. This improves results during

processing.

Black Border Removal / Cropping
Black borders can appear on images as a result of capturing the images on scanners that have black belts
or drums. If black borders exist on your images, you can remove them with the black border removal or
black border cropping feature.
• With black border removal, the black border pixels are changed to white pixels on the image. This

cleans up the image without changing the height and width of the image.
• With black border cropping, the black border pixels are removed from the image. This cleans up the

image and reduces the height and width of the image by the size of the black border.

To remove a black border, the software starts at the outer left and right edges of the image and works
inward, turning black pixels into white until it detects a white pixel. When it detects a white pixel, the
software determines whether the white pixel is part of white noise in the border or the edge of the image.
When the software detects the edge of the image, the black border removal process stops.

To crop a black border, the software starts at the outer left and right edges of the image and works inward,
removing black pixels. As soon as it detects a white pixel, the software determines whether the white pixel
is part of white noise in the border or the edge of the image. When the software detects the edge of the
image, the cropping process stops.
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You specify black border removal/cropping settings on the Image Cleanup Profiles window. Your settings
become part of an image cleanup profile that you can include in a recognition profile.

White Noise in a Black Border
White noise can be any white pixel or series of white pixels in a black border, and all black borders contain
a certain amount of it. White noise is not necessarily visible to the naked eye, but it could impact the
process for black border removal or black border cropping.

You can specify a value called "white noise gap," which determines how much white noise the software
ignores during a black border removal or black border cropping process.
• If a series of white pixels in the black border is less than or equal to the value of the white noise gap, it

is considered white noise. The white noise is ignored, and the black border removal/cropping process
continues.

• If the number of consecutive white pixels is greater than the value of the white noise gap, it is
considered the end of the border and the black border removal/cropping process stops.

White Noise Gap

For best results, set the white noise gap to a large enough value to remove/crop the entire black border;
setting it too low prematurely stops the black border removal/cropping process.

Deshade
Shaded areas on an image are rectangular areas made up of a pattern of black speckles. You can remove
shaded areas from your image with the deshade feature. The deshade process removes the speckles that
make up the shaded areas while preserving the text inside the shaded areas.

To remove shaded areas from an image, you must define the characteristics of the shaded areas to
remove. You specify the height and width of the areas and the size of the speckles in them. All shaded
areas that satisfy the defined characteristics are removed. Any text within the shaded areas is preserved.
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Definition of a Shaded Area

You specify deshade settings on the Image Cleanup Profiles window. Your settings become part of an
image cleanup profile, which you can include in a recognition profile.

Hardware-Based Image Enhancement
Kofax Capture provides access to image enhancement algorithms available with Adrenaline hardware
accelerator products. The algorithms are similar to the deshade and edge enhancement filters available
for cleaning up images, but running them on the hardware is faster.

The following algorithms are available.

Descreening

A shade removal algorithm, which is especially useful for removing halftones from photographs.

Image Smoothing

An image smoothing algorithm, which is especially useful for smoothing characters and lines that seem
jagged on your image.

The default is no image enhancement algorithm enabled.

Note The image enhancement algorithms are not available when using scanners (such as Kodak
scanners) that return compressed images.
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Deskew
Because of the mechanical feeding action of scanners, documents may shift out of alignment during the
scan process. The varying amounts of misalignment are referred to as "skew."

The deskew feature can calculate and correct skew angles up to 12 degrees. Correcting an image for
skew can be useful for making the image more readable and for improving operations such as bar code
recognition and OCR.

Note The deskew process scales images slightly, and the amount of scaling is greater at higher degrees
of skew. If the image is skewed more than 10 degrees, the scaling of the image is noticeable.

You specify your deskew settings on the Image Cleanup Profiles window. Your settings become part of an
image cleanup profile, which you can include in a recognition profile.

Field Types
A field type is a global definition for an index field. An index field is a keyword used to retrieve a document
after it has been exported to permanent storage.

Field types provide an efficient way to set up index fields and their validation criteria. You can define a
pool of field types, and then select from this pool when you define document classes.

For example, a field type named "Address" can be defined once, and then be used by all varieties of
document classes requiring an address for an index field. When the index field for the address information
is defined, it is simply a matter of selecting "Address" from the list of defined field types.

You create new field types on the Create Field Types window.

You edit field types on the Field Type Properties window.

Data Types
Kofax Capture supports 11 ODBC-compliant data types for your field types, as shown in the Data Types
table.

You specify the data type for a new field type on the Create Field Types window.

You edit the data type for an existing field type on the Field Type Properties window.

Data Types

Data Type Description

CHAR Variable-length character string. You can specify up to 25,000 characters.

DATE Date string. Note that validation of date fields is sometimes dependent on the regional
date format settings specified from Windows Control Panel.
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Data Type Description

DECIMAL Signed, numeric value with the number of numeric digits greater than or equal to 1, and
less than or equal to 15, and the number of decimal places greater than 0, but less than
or equal to the number of numeric digits.

DOUBLE Signed, floating-point value with the number of digits equal to 15.

FLOAT Signed, floating-point value with the number of digits equal to 15.

INTEGER Numeric value with the number of numeric digits equal to 10, and the number of decimal
places equal to 0. The range is -2,147,483,648 to 2,147,483,647.

NUMERIC Signed, numeric value with the number of numeric digits greater than or equal to 1 and
less than or equal to 15, and the number of decimal places greater than 0 but less than
or equal to the number of numeric digits.

REAL Signed, single-precision value with the number of numeric digits equal to 7.

SMALLINT Numeric value with the number of numeric digits equal to 5, and the number of decimal
places equal to 0. The range is -32,768 to 32,767.

TIME Time string.

VARCHAR Variable length character string. When defining a field type as a CHAR or VARCHAR
data type, you must specify the maximum number of characters for the field type. For
example, if you specify 25 as the number of characters, data for that field can be up
to 25 characters in length. You can specify up to 25,000 characters. However, the
maximum length of known values for field types based on CHAR or VARCHAR is 254
characters.

The DATE Data Type
When defining a field type as a DATE data type, you must consider the date settings specified from
Windows Control Panel. These settings affect the format of the date field and impact validation of the date
field as shown in the table.

The standard validation for DATE checks for the short date format. In addition, the standard validation
does not allow dates earlier than 1930. To use a long date format (such as Tuesday, December 22, 1998)
or a date earlier than 1930, you must update your validation scripts.

With this Windows regional
setting:

You can use this format for
Validation:

Notes:

mm/dd/yy Any date format

m/dd/yy Any date format

m/d/yyyy Any date format

mm/dd/yyyy Any date format

yy/mm/dd yy/mm/dd
dd-mmm-yy
yyyy-mm-dd

Other formats could cause validation
errors.

yyyy-mm-dd yy/mm/dd
dd-mmm-yy
yyyy-mm-dd

Other formats could cause validation
errors.
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With this Windows regional
setting:

You can use this format for
Validation:

Notes:

dd-mmm-yy yy/mm/dd
dd-mmm-yy
yyyy-mm-dd

Other formats could cause validation
errors.

Default Validation and Formatting
Kofax Capture provides basic data type validation of index field data. For each index field, the default
validation code checks that the string generated by a recognition engine or typed in by a validation
operator is an acceptable value for the data type of the field type.

Data Type Description and Default Processing

Char
Varchar

Variable Length String. Validation code tests whether the length of index field string
(excluding leading and trailing spaces) does not exceed the specified maximum number of
characters.

Smallint 16-bit integer. Validation code tests whether the index string can be converted into an Integer.

Integer 32-bit integer. Validation code tests whether the index string can be converted into a Long.

Decimal
Numeric

Floating-point number. Validation code tests whether the index field string can be converted
into a decimal number with the specified total number of numeric digits and precision.

Double
Float

Double-precision floating-point number. Validation code tests whether the index string can be
converted into a Double.

Real Single-precision floating-point number. Validation code tests whether the index string can be
converted into a Single.

Date Validation code tests whether the index field string can be converted into a short date and if
possible then returns the date in the short format according to the current regional setting of
the system. To process dates in other formats, you need to implement your own validation
code in the script.

Time Validation code tests whether the index string can be converted into a Time, and if possible,
returns the time in the long format according to the current regional setting of the system.

Valid Maximum Values Table
This table lists the values supported as field length maximums.

The values listed in these columns specify the minimum and maximum values you can set for the
maximum length of a field. For example, you can set the maximum length for an index field to be any
value from 7 to 32. If you set the maximum length to a value of 10, you can use index field names of 1 to
10 characters in length.

Field Minimum
Max Value

Maximum
Max Value

Notes

Batch class name 1 32

Document class name 1 32

Form type name 1 32
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Field Minimum
Max Value

Maximum
Max Value

Notes

Batch field name 7 32

Index field name 7 32

Field type name 1 32

Field type description 1 80

Field type length for known values 1 254 VARCHAR and CHAR types only

Force Match and Case-Sensitive Attributes
In addition to specifying known values for a field type, you can assign the "force match" and/or "case-
sensitive" attributes to the values. The attributes you select apply to all the known values for a field type.
• With force match selected, the list of known values is sent to the recognition engine (OCR, ICR, bar

code recognition, etc.) processing the index field. In addition, the validation and verification operators
are required to select from the list of values.

• With case-sensitive selected, the known value must be matched exactly by the recognition engine. This
forces a distinction between upper and lowercase characters.

You select these attributes from the Create Field Type window or the Field Type Properties window.

Known Values for Field Types
You can specify known values for a field type. Then, for all index fields based on that field type, the known
values are available to enhance validation operations. 
• At data capture time: If automatic recognition is specified, the recognition engine is provided with a list

of values to resolve unrecognized words. This improves the accuracy of the engine. Note that the "force
match" attribute for the field type controls which recognition engines can use the known values:
• If force match is selected, the values are provided to any automatic recognition engine specified

(OCR, ICR, bar code recognition, etc.).
• If force match is not selected, the values are provided to Kofax Capture’s OCR and ICR engines only.

• At validation time: The validation and verification operators are provided with a list of the known values
to select. This makes validation and verification easier, and potentially increases validation accuracy.
• If force match is selected, the validation and verification operators are required to select or accept a

value from the list of known values.
• If force match is not selected, the validation and verification operators are able to select a value from

the list or enter a different value.

You specify known values for a new field type on the Create Field Type window.

You edit known values for an existing field type on the Field Type Properties window.

Note If you specify both known values and a Zonal dictionary, the dictionary is not used.
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Creating a Field Type
You create field types with the Create Field Type window in the Administration module.

1. On the Insert tab, in the Create New group, click Field Type.
2. On the Create Field Type window - General tab, enter the name for the field type. You can enter up

to 32 characters, including spaces.
The name, which must be unique, is not case-sensitive. Leading and trailing spaces are removed.

3. Enter a description for the field type. The description appears whenever field type properties are
displayed.
You can enter up to 80 characters.

4. Enter the path and file name of a zonal dictionary for the field type.
5. Enter the data type for the field type. Note that some data types require additional information:

a. For CHAR and VARCHAR data types, enter the maximum number of characters for the field
type.

b. For DECIMAL and NUMERIC data types, enter the total number of numeric digits and the
number of decimal places for the field type. For more information on numeric digits and decimal
places, see the data types table.

c. In addition, the date settings in the Windows Control Panel affect the format for field types
assigned the DATE data type.

6. Enter known values for the field type.

a. Click the Values tab.

b. Enter a known value in the edit box.

c. Click Add or press Enter.
The value is added to the list of known values.

d. Select Force match or Case sensitive for the list of values.
Your selection is applied to all the known values for this field type.

e. Repeat the preceding substeps for each known value to add.

f. If required, sort values by using Alphabetically or Custom buttons in the Sort Options group.
7. Click Save to save your field type settings and clear the window. (Alternatively, you can press the

Enter key.)
The new field type appears in the Field Types tree view tab.

8. Click Close to close the window.

Form Types
A form type defines a unique form, such as an order form from a particular vendor or a medical form from
a particular hospital. You can associate one or more form types with a document class.

Use form types to define zone locations on different types of forms within a document class. You can also
customize processing options for a particular form type.
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For example, you might have two form types defined for a document class: Order Form 1 and Order
Form 2. Both forms contain the same types of information, although the information appears in different
locations. Order Form 1 contains some shaded areas that might make OCR processing difficult. Order
Form 2 contains validation information encoded in bar codes.

Two Different Order Form Types

You can define separate form types for each of these forms, and then tailor the processing settings for
each. For example, you can remove the shaded areas from Order Form 1 before you perform OCR
processing to capture index data. You can use bar code recognition to capture data from the bar code on
Order Form 2.

When to Define a Form Type
You must define at least one form type for a document class. In addition, a form type should be defined
whenever:
• The processing for the form includes automatic recognition (such as form identification, automatic

validation, etc.)
• Page Registration is selected
• You have different form types within a document class
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All form types within the document class use the same index fields. For some types of processing, you
must scan or import a sample page for the form type.

You define a form type from the Create Form Type window or Form Type Properties window.

Form Identification Zones
Form identification zones compare specific zones on each scanned image with the same zones on the
sample pages of the batch class. Every time a match is found, document separation occurs and the new
document is identified with the matching form type.

Form Identification Zone Form Identification

Refer to form identification zone separation to learn the most common way form identification zones
are implemented. With the exception of manual separation, form identification zones can be used in
conjunction with every other method of document separation.

Form Identification Zones
A form identification zone is an optional zone that can be used to assist Kofax Capture's page-level form
identification feature. It is typically used to help the form identification engine distinguish between forms
that are very similar. For example, a form identification zone could be very useful for identifying different
revisions of the same form.

You can specify more than one form identification zone for a form type. For multipage form types, the zone
must be on the first page.

Form identification zones are only used in conjunction with page recognition as the method of identifying
forms. The page recognition process uses the page-level form identification engine and the form
identification zones (if any). You select page recognition on the Custom Separation and Form Identification
tab on the Batch Class Properties window.

By using a shape recognition profile with a form identification zone, you can separate your batch into
forms using geometric shapes instead of other elements, such as bar codes.

Note the following:
• A form identification zone is optional. You can perform page recognition without specifying a form

identification zone.
• Form identification zones cannot belong to a SmartGroup.
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• Page-level form identification is typically processed first. If a form identification zone is specified:
• It is only processed if page-level form identification is successful.
• It determines whether the form is successfully identified. If the results of processing the form

identification zone are successful, the form is considered recognized. If not, the form is not
considered recognized.

• If you use multiple Form ID zones on the same page, zone processing stops after the first Form ID
zone is processed with sufficient confidence (based on your profile settings). At that point, the form
is considered “identified” and there is no reason to process additional zones. See Advanced Form
Identification Issues for more information.

When you define a form identification zone, you must specify:
• A recognition profile that specifies the recognition method (such as OCR, bar code recognition, shape

recognition, or others) and image cleanup settings for the zone.
• Depending on the recognition method, a confidence threshold, which indicates the minimum acceptable

confidence returned from the recognition method. If you enter search text, it must exactly match the
data to be captured from the zone. For example, if you draw a zone around the data "invoice", the
search text must be specified as "invoice" (you cannot abbreviate the search text as "inv"). The search
text must be recognized within the confidence threshold. If an exact match is required, the confidence
threshold should be set to 100.

• For a shape recognition profile, a search shape.

Creating a Form Identification Zone
You create form identification zones on the sample pages you scan for your form types.

1. Select a sample page to display it.
2. On the Insert tab, in the Zones group, click Form.

(If your sample document contains multiple pages, you must create your form identification zone on
the first page.)

3. Draw a rectangle around the area of your sample page to use as a form identification zone.
The Create Form Identification Zone window appears.

4. Select a recognition profile from the list. If none of the options in the list is appropriate, select Edit
and define a custom recognition profile.

5. Enter the search text that must be captured to identify the form.
The search text must be recognized within the confidence threshold. If an exact match is required,
the confidence threshold should be set to 100.
Search text is optional and must be matched within the confidence threshold or the form is not
recognized. If no search text is specified, the results must be non-null.

6. Use the slider to specify a confidence threshold for the recognition.
Kofax Capture does not consider the form identified unless the confidence returned from processing
the zone is greater than or equal to the specified confidence threshold.

Note You cannot specify a confidence threshold for bar code or patch code recognition. If the
selected recognition profile uses either of these methods, the confidence slider is grayed and the
expected confidence is 100 percent. If the bar code or patch code is found, the zone will "pass." If
search text is specified, an exact match is required.
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7. Click Test to apply your settings to this zone and check the results.
"Test" is not available if the sample page is displayed from the Document class tree view tab.

8. Select OK.

Editing a Form Identification Zone
You edit form identification zones with the Form Identification Zone Properties window (the title on the
window is Create Form Identification Zone).

1. With the sample page displayed, right-click the form identification zone to edit, and then click
Properties.

2. On the Form Identification Zone Properties window, edit the properties.
3. Click Apply to save the changes without closing the window.
4. Click Test to apply your settings to this zone and check the results. The sample page must be

displayed from the Batch class tree view tab to use QuickZones to verify your recognition and
cleanup settings.

5. Click OK to save the changes and close the window.

Advanced Form Identification Issues
Kofax Capture's internal form identification engine can identify images by comparing them to sample
pages that were previously "learned." To learn a sample page, Kofax Capture creates a histogram of
the sample. Then, to identify a scanned or imported image, the physical characteristics of the image are
compared to the histogram. Images that match the histogram within specified thresholds are considered
identified.

You can optionally define one or more form identification zones, which can assist the form identification
engine. If page recognition is selected and a form identification zone is defined, processing occurs in two
phases:
• Phase 1 - Page-level form identification: A scanned or imported image is compared against the sample

pages already "learned" by the form identification engine. Each comparison returns a confidence and a
difference. To "pass" this phase, the confidence and difference returned must be greater than or equal
to the specified thresholds.

• Phase 2 - Zone-level form identification: All images that pass the first phase are searched for form
identification zones. To "pass" this phase, a form identification zone must be found and successfully
processed. If you have more than one form identification zone on the page, processing stops with the
first successful zone.

Typically, there is only be one "winner." If multiple sample pages are identified, the one with the highest
confidence is used.

Note Images on which form identification zones cannot be found or successfully processed are not
identified. This is the case regardless of the confidence and difference returned from Phase 1 (described
earlier) for the image.

The internal form identification engine is very robust and can identify a wide variety of forms. In some
cases, though, you may get better results by "turning off" page-level form identification and only using the
results from a form identification zone.
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Turn off page-level form identification on the Custom Separation and Form Identification window. In this
window, set the confidence for the selected page recognition profile to 0, which essentially forces all
images to "pass" Phase 1 described earlier.

Similar Sample Pages
If all your sample pages are very similar, turning off page-level form identification could result in a slight
performance improvement. For example, you might be processing different revisions of the same form.
Each revision contains a marker (such as a form revision number or a box) clearly printed in a known
location on every revision.

If page-level form identification is selected, it will probably "pass" all revisions of the form and rely on
zone-level identification to distinguish between the samples. Since revision markers are often printed
in letters suitable for OCR processing or encoded in bar codes, the results of a carefully drawn form
identification zone are very reliable. In this case, bypassing page-level form identification removes the
overhead of the page-level processing without diminishing successful results.

You may also be able to identify your forms based on certain geometric shapes found on the form. In such
cases, you can use a recognition profile for your form identification zone.

Images with Varying DPIs
If you are processing images with varying dpis or images with a different dpi than the associated sample
pages, page-level form identification fails. In this case, you should turn off page-level identification and rely
on a form identification zone to identify your forms.

One solution is to create multiple form types with identical settings, but use sample pages scanned at all
expected dpis. For example, consider this scenario: You know that some of your forms are scanned at 200
dpi and others are scanned at 300 dpi. To account for the differences in dpi, you can create one form type
with sample pages scanned at 200 dpi and another form type with identical settings and sample pages
scanned at 300 dpi. Page-level form identification is able to match the images against the sample pages
with the same dpi.

If the preceding solution does not work (for example, you have no way of knowing the dpis of the images
you’ll be processing), you can use a form identification zone instead.

Distorted Images
Scanning forms printed on very thin paper (such as onion skin or pressure-sensitive multipage form
paper) may produce "stretched" or otherwise distorted images. Distorted images are typically the result of
how a scanner’s feeding mechanism pulls the pages through the scanner. Since the scanner won’t distort
all images in exactly the same way, the results of page-level identification are very low.

Even with the distortion, it may be possible to identify an area on the image that can be used as a reliable
form identification zone. If so, you should disable page-level identification and rely on a form identification
zone to identify your forms.
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Image Variations on Sample Pages
Some forms contain sections that are standard, and other sections that can vary from form to form. For
example, the top half of a form might have a standard header format that is always filled in the same way.
The bottom half of the form might be non-standard and contain free-form data.
• If you are processing this type of form, page-level identification fails. One solution is to scan a sample

page with the free-form section "blanked out." (For example, you can tape a white sheet of paper over
the free-form area.) This may allow the pages you are scanning to match the sample page. Since the
confidence won’t be as high, you may need to reduce the confidence threshold.

• Another solution is to turn off page-level form identification and rely on a form identification zone to
identify your forms.

Images with More Data Than Sample Pages
Sometimes, the images you are processing contain more filled-in data than the sample pages do. For
example, the images used as samples might have few fields filled in while the images in your batches
have many fields filled in. If the differences are significant, the results of page-level form identification
could be low.

One solution is to rescan your sample pages with forms that are more representative of the batches you’ll
be processing. This could improve page-level form identification. If this is not feasible, you should turn off
page-level form identification and rely on a form identification zone to identify your forms.

Performance Issues
As a rule of thumb, page-level form identification takes about 1-2 seconds per page, whereas processing
a single OCR or shape recognition zone takes about a third or a sixth of a second, respectively. If this
increased time is a problem, you can turn off page-level form identification and rely on one or more form
identification zones to identify your forms.

Make sure you carefully draw and specify settings for the form identification zone.

Manual Form Identification
You can manually identify forms within your batch. Typically, this would be done by a scan or quality
control operator.
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Manual Form Identification

Manual form identification is easy, but takes more time than the other separation methods. It requires that
the scan or quality control operator manipulate each document. Refer to Manual Separation to learn how
to process manual separation and form identification.

Kofax Separator Sheets Form Identification
Kofax separator sheets can be printed with a bar code that identifies the following document’s form type.

Kofax Separator Sheets Form Identification

Refer to separator sheet separation to learn more about Kofax separator sheets and the most common
way to implement them. Separator sheets cannot work in conjunction with other separation methods.

Page Recognition Form Identification
Page recognition compares each entire image with the first page of each form type looking for an overall
match. Every time a match is found, document separation occurs and the new document is identified with
the matching form type.
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Page Recognition Form Identification

Refer to  page recognition separation to learn more about page recognition and the most common way to
implement page recognition identification. However, much like form identification zones, page recognition
identification can be used in conjunction with every other type of document separation method (except for
manual separation).

Single Form Type Form Identification
Single form type identification only works when the batch class has one form type. Since there is only one
form type, each document is identified with that form type by default.

Four separation methods identify the form type of the document if only one form type exists in the batch
class:
• Kofax fixed pages
• Kofax patch code separators
• Kofax bar code separators
• Separator zone

Kofax Capture Values / Kofax Values
Kofax Capture supports a set of macros that produce results based on the current Kofax Capture
environment. These macros, called Kofax Capture Values or Kofax Values, can be used to fill batch fields,
index fields, endorser strings, and/or export values.

Note Throughout the product, the term Kofax Capture Values is used, except in the context of export
connectors, where the term Kofax Values is used.
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For example, the value {Batch Class Name} produces the name of the batch class associated with the
current batch. If your processing requirements dictate that the names of your batches be exported with
your batches, you might use {Batch Name} as the default value for a batch field that you export with each
batch.

Furthermore, you can enter special Kofax Capture Values for Index fields, export links, endorsing text, or
batch fields. When the system processes such fields, the Kofax Capture Values are translated into their
actual values.

Using Kofax Capture Values on Localized Systems
When using Kofax Capture Values on localized systems (or across regions), keep the following in mind.

KCN Server
Kofax Capture Values, used for endorsing strings, batch field defaults, batch field values, index field
defaults, index field values, and export connector setup links, are correctly translated into the language of
the localized version of Kofax Capture when a batch class is downloaded from the central site or a batch
is transferred between sites.

If a Kofax Capture Value (such as {Validation Operator's Station ID}) exists in a batch field or index field
when a batch is uploaded, that Kofax Capture Value is correctly translated into the language of the
localized version.

English Kofax Capture Values
You can submit English Kofax Capture Values irrespective of the localized version of Kofax Capture when
using the following:
• Export Setup Link
• Retrieve Export Value
• Batch Field Default Value
• Index Field Default Value
• Batch Field Value
• Index Field Value
• ACCI (OCX/Input Script)

Using Export Setup Link is limited to export connectors because all current export connectors do not
allow the user to type in Kofax Capture Values that are not in the localized set of suggested values. For
example, an English export connector can save an English Kofax Capture Value in the export link table.
During export, the Kofax Capture Value is correctly translated on a localized version of Kofax Capture.

For Retrieve Export Value, suppose during export setup the English {Batch ID} Kofax Capture Value
is linked by hard coding the value in English. In this case, on a localized version of Kofax Capture, the
English {Batch ID} is correctly expanded during export.

English Kofax Capture Values have the following limitations:
• English Kofax Capture Values (on non-English versions of Kofax Capture) cannot be used for endorsing

strings.
• You can only use Kofax Capture Values that are available on the localized version of Kofax Capture.
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• You cannot use English Kofax Capture Values (on non-English versions of Kofax Capture) in the Export
Setup user interface. This is because all export connectors limit the user to setting only those Kofax
Capture Values that are in the list of localized possible values.

List of Kofax Capture Values
The following Kofax Capture Values are supported for batch fields, endorser strings, and index fields.

Values for Batch Fields, Endorser Strings, Index Fields

Value Description

{Current Time} The current system time.

{Current Date} The current system date.

{User Name} Windows user name.

{Station ID} Kofax Capture Station ID, which is the name associated with the
workstation, with the Windows session number appended to it.

{StationIDCommonName} Kofax Capture Station ID, which is the name associated with the
workstation, without the Windows session number appended to it.

{Site ID} Kofax Capture Site ID, which is the name associated with the Kofax
Capture installation.

{Batch ID} A unique, sequential number associated with the batch; assigned when
a batch is created.

{Batch Name} The name of the current batch.

{Batch Reference ID} Reference passed from a batch to its child batches; used for internal
purposes only.

{Batch Description} The description of the current batch.

{Batch Creation Date} The date the current batch was created.

{Batch Creation Time} The time the current batch was created.

{Batch Creator's Station ID} Kofax Capture Station ID of the computer where the batch was created.

{Batch GUID} A type of batch ID that is unique across the central site and all remote
sites that comprise a Kofax Capture installation.

{Scan Operator's Station ID} Kofax Capture Station ID of the computer used to scan the batch.

{Scan Operator's User ID} The user ID for the scan operator.

{Validation Operator's Station ID} Kofax Capture Station ID of the computer used to validate the batch.

{Batch Class Name} The name of the associated batch class.

{Document Count} Reserved.

{Document Creation Date} The date the current document was created.

{Document Creation Time} The time the current document was created.
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Value Description

{Operator User ID} The user ID of the logged in Kofax Capture user. Since different Kofax
Capture users may process the same batch, the user ID captured
depends on the module where the Kofax Capture Value is processed:
Batch Manager, Scan, Validation, or Export.
If the Kofax Capture User Profiles feature is not enabled, the logged in
Windows user ID, if applicable, is used. If there is no logged in Windows
user ID, the returned value is “unknown.”

{Operator Name} The user name associated with the user profile, if any, of the logged in
Kofax Capture user. The user name captured depends on the module
where the Kofax Capture Value is processed: Batch Manager, Scan,
Validation, or Export.
If the Kofax Capture User Profiles feature is not selected, the logged in
Windows user ID, if applicable, is used. If there is no logged in Windows
user ID, the returned value is "unknown."

{Operator Description} The description, if any, of the logged in Kofax Capture user. The
description captured depends on the module where the Kofax Capture
Value is processed: Batch Manager, Scan, Validation, or Export.
If the User Profiles feature is not enabled, the returned value is null.

{Queue} Name of the process that is currently running in the batch class
workflow.

{Sequence Number} A sequence number that increments by one for each batch class. The
default value for {Sequence Number} is 0. This value can increment up
to 2,000,000,000. If the value becomes greater than 2,000,000,000, the
value is set to 0 again.

{UTC Offset} UTC Offset is used to provide Coordinated Universal Time (Greenwich
Mean Time) as part of the generated batch name. For example, when
used with Pacific Time, the UTC Offset value generates (-7:00).

The following values can be used for index fields and export values.

Values for Index Fields and Export Values

Value Description

{Document GUID} A type of document ID that is unique across the central site and all remote sites that
comprise a Kofax Capture installation.

{Document ID} A unique, sequential number associated with the document. It is assigned by Kofax
Capture.

{Document Form Name} The name of the associated form type.

{Document Class Name} The name of the associated document class.

{Repository Document ID} This is a specific value that can be read/written by export connectors to store and
retrieve the document ID used by the first invoked Export Connector. This Kofax
Capture Value directly mirrors the value stored in the RepositoryDocumentID. If
no value has been stored into RepositoryDocumentID, this Kofax Capture Value
resolves to an empty string.

{Remote Validation User ID} Reserved.
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Value Description

You can use the preceding Kofax Capture Values as default values in index fields. If an index field is blank at export
time, and the document has not been indexed, then the default value is used (in this case the "expanded" Kofax
Capture Value).
The following values are derived from the endorsing information for the first page of the current document (when
document separation has been performed at scan time). These values may be used in index fields and in export
values. There is no way to retrieve endorser information for pages other than the first.

{First Page Endorsing String} The endorsing string (prefix plus counter). Not used by Kodak scanners, except for
models 1500, 2500, and 3500.

{First Page Image Address} The image address. Used only by Kodak scanners that support image address.

{First Page Roll Number} The roll number for the film being scanned. Used only by Kodak scanners that
support microfiche scanning.

{First Page Original File
Name}

The original file name and extension of the first page of the document. The
extension of image files is always .tif. Note that because the final extension of image
files can be changed at export time, this name may not match the exact name of
the exported image. If the first page image file was not imported and the original file
name has not been set via some other means, this value returns an empty string.

A special value type can be used to produce the value of a batch field. The sequence to enter this is a "{"
character followed by the "$" character, followed by the batch field name, followed by the "}" character.
For example, the value "{$Text1}" would produce the runtime value of the batch field "Text1". Batch field
values may be utilized in endorser strings, index fields, and export fields.

Batch Classes
A batch class describes how the documents in a batch are processed by Kofax Capture. During
production, each new batch is based on a batch class definition that determines:
• Which modules the images are processed by, and in which order
• How images are separated into documents
• How forms are identified
• How images are cleaned up

A batch class contains one or more document classes, which in turn contain one or more form types. This
gives you the ability to have different kinds of documents and forms within one batch. Kofax Capture can
automatically separate the pages into documents and identify different types of forms.

With Kofax Capture, you can define a pool of batch classes to select from when you create batches. You
define batch classes on the Create Batch Class window.

All batches in Kofax Capture are defined by their batch class. Therefore, you must define a batch class
before you scan or import documents.

You must perform the following tasks to set up a batch class:
• Create one or more field types (optional)
• Create one or more document classes
• Create one or more form types
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• Add the necessary sample pages for your form types (optional)
• Create a batch class
• Associate one or more document classes with your batch class
• Publish your batch class

Kofax Capture provides an object-oriented approach to setting up your batch classes. While some steps
must be done before others, most can be done in any order.

Specifying UNC Paths During Batch Class Setup
During batch class setup, you must use UNC paths in the Kofax Capture Administration module to specify
any folders or files to be accessed from a network. UNC paths are required if you specify network folders
or files for any of the following:
• Image folder on the Batch Class Properties window - General tab
• File names and export folders on the following windows:

• Kofax Export Connector for Text Setup window - Index Storage tab
• Kofax Export Connector for Text Setup window - Advanced tab
• Kofax Export Connector - Database Setup window - Database tab
• Kofax Export Connector - Database Setup window - Document Storage tab

• Full Text or Zonal dictionary on the following windows:
• Create Field Type window - General tab
• Field Type Properties window - General tab
• Create Document Class window - OCR tab
• Document Class Properties window - OCR tab
• Create Document Class window - PDF tab
• Document Class Properties window - PDF tab

• Imported Value List on the Field Type Properties window - Values tab
• Field macro source file or folder on the Field Script/Macro window
• Script source file or folder in the Validation Script window or the Recognition Script window
• Files to import or export

Importing PDF Files
In Kofax Capture, you have the option of importing PDF files as either eDocuments or converting them to
TIFF images. Which option you select depends on whether you process the file as a native PDF file or if
you need to perform some auto-recognition on the contents of the file.

This section provides instructions on how to select these options, and also describes how to import PDF
files for use as sample pages for your form types.

Importing PDF Files as eDocuments
For any batch class, you can have PDF files imported as eDocuments by selecting the "Allow import of
eDocument files" check box on the Advanced tab of the Create Batch Class or the Batch Class Properties
window.
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Make sure the "Treat imported PDF files as TIFF images" box is not selected. Once imported into Kofax
Capture, the PDF files are treated like any other eDocument.

A PDF file is counted as a single page, regardless of the actual number of pages. The number of available
pages of your Kofax Capture license volume is decremented by one for each PDF file imported as an
eDocument.

Treating PDF Documents as TIFF Images
For any batch class, you can select to treat PDF files as TIFF images. Each PDF file is converted to a
multipage TIFF that is processed based on the batch class settings, just like any other supported image
file.

To have every imported PDF file for a particular batch class be converted to a TIFF image file, you must
select the "Treat imported PDF files as TIFF images" check box on the Advanced tab on the Create Batch
Class or Batch Class Properties window.

Each page in the PDF file is converted to a page within the multipage TIFF file. The number of available
pages in your Kofax Capture license volume is decremented by one for each page in the TIFF file.

Importing PDF Files as Sample Page
When defining your form types, you can import PDF files to use as sample pages. When you select a PDF
file to import, it is converted to a TIFF image. The dpi of these images is calculated based on the scale of
the imported PDF image.

All sample page images used in a single form type must be of the same dpi. The dpi is calculated based
on the scale of the imported PDF file, and you receive an error message if the dpi is not the same. If you
need to import PDF files of different dpi values, you can create multiple form types.

Processing Priority
All batches have a processing priority level assigned to them to specify the order in which the batches
are processed at each module. The priority levels can be any value from 1 to 10, with 1 being the highest
priority and 10 being the lowest. The priority level is defined as part of a batch class.

The default priority level for a batch class is assigned in the Administration module on the Create Batch
Class window or Batch Class Properties window. However, the priority level for a batch can be changed
from the Scan module or Batch Manager.

Batch Fields
Use a batch field to associate certain descriptive information with each batch. For example, you might
want to know the user ID of the operator who scanned the batch, the date and time the batch was
scanned, etc.

You can export batch fields to your target database just like index fields.

You specify batch fields for a new batch class on the Create Batch Class window.

You specify or edit batch fields for an existing batch class on the Batch Class Properties window.
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Sample Pages
For some types of processing, you must have sample image files for your form. For example, you need
sample image files for:
• Defining index zones
• Defining OCR registration zones
• Defining separation zones
• Setting up form identification
• Setting up page-level bar code recognition

The sample image should be a form or document of the type defined by the form type. For example, if
order forms from ABC Company are to be processed, you should scan or import an order form from the
ABC Company.

Notes
• Use clean, good quality images for your sample pages.
• Use forms that are representative of the ones you’ll be processing in your batches.
• For best results, use the same make/model of scanner and the same settings for scanning sample

pages as you intend to use for scanning batches. This is particularly true if you intend to use page
recognition as your method of document separation and form identification.

• You must use the same resolution (dpi) for scanning sample pages as you intend to use when scanning
batches. If your documents are scanned at different dpis (for example, some at 200 dpi and others at
300 dpi), you can create a separate form type for each dpi. Then, add the same sample pages scanned
at the appropriate dpi for each form type.

• Kofax Capture automatically attempts to set the scanner to deskew your sample pages. Therefore, you
must use a device capable of deskewing images as you scan sample pages.

• When using unattended scanning, a batch is created for each page scanned if single document
processing is selected in the Batch Class Properties - Advanced tab, and if the batch class contains
multiple document classes with sample pages.

Adding Sample Pages
Use the Administration module to import or scan sample pages for your form types.

Importing Sample Pages

To import a sample page, image files must already exist on disk for your form type. You can use any
image file scanned from a form and saved to disk.

1. On the Scan panel, in the Scan Source list, select an import source.
2. On the Document class tree view tab, select the form type for which you want to add a sample page.
3. On the Home tab, in the Form Type group, click Add Sample Pages.

The "Import files" window appears.
4. On the "Import files" window, select a file and click Open.

The sample page is associated with the form type and displayed in the Administration module view
window.
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The bottom section of the Import window contains a list box for "Files to import." You can select the files to
import and then click the Add button. The files you select are added to the list of "Files to import." You can
use the pointer to reorder the list. Then, click Open to import the files. The files are imported in the order
listed. This is useful if you want to import files from different folders, or import the files in a particular order.

Scanning Sample Pages

To scan a sample page, you must have the following:
• Scanner attached to your workstation.
• Source device defined for the scanner. You define source devices with the Scanner Configuration Utility.
• Clean, good quality forms to scan.

1. On the Scan panel, in the Scan Source list, select a source device.
2. Place the sample pages in your scanner’s ADF or flatbed.
3. Right-click Scan Controls.

A context menu appears.
4. Select your scanner settings and on the Scan Panel, select a profile from the Scanner Profiles list.
5. From the Document class tree view tab, select the form type for which you want to add a sample

page.
6. On the Home tab, in the Form Type group, click Add Sample Pages.
7. On the Home tab, in the Scan group, click Scan.

The sample page is scanned, associated with the form type, and displayed in the Administration
module viewing window.

Note You can also use color .tif images for your sample pages. See "Using QuickZones" and "About
Color Support" in the Administrator's Guide for more information.

Advanced Source Properties
You can associate one or more advanced properties to a source device so that whenever that source
device is selected, the advanced features are applied.

Text Annotations and Endorser Support
Some scanners are equipped with small imprinters that allow pages to be mechanically endorsed with
short text strings as they pass through the scanner. These imprinters are called "endorsers." There are
two types of endorsers:
• Pre-scan endorsers print the text before the page is scanned, allowing the printed string to appear on

the scanned image.
• Post-scan endorsers print the text after the page is scanned so the printed string does not appear on

the scanned image. This is not recommended if you want the electronic images to match the original
hard copy documents.

Use the Kofax Capture endorser/annotation feature to specify an endorser string to be stamped on the
hardcopy documents by the scanner’s endorser, and superimpose that same string on the electronic
images before the images are processed. This way, your electronic images always match the original
documents.
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Text annotations can be used independently of the scanner’s endorser and vice-versa, although they are
most useful when the two are combined.

Note Not all scanners support the endorser/annotation feature provided by Kofax Capture. See your
scanner documentation for more information. Also, see Setting Up Endorser/Annotation Support for
more information about this feature.

Annotation Text String
The endorser/annotation text is a string made up of an alphanumeric prefix plus an optional numeric
counter. The text prefix, the number of digits for the counter, and the increment and reset settings for the
counter are specified when you set up the Scan module for a batch class.

The initial value for the counter is based on the last value from the previous batch of the same batch
class. An operator can change this value when creating a new batch from the Scan module or Batch
Manager.

For example, if you set up the following:
• Text prefix = ABCCompany
• Counter digits = 4
• Starting number for the counter = 1 (specified at scan time)

Your initial endorser/annotation string is the following.

Endorser/Annotation String

You specify prefix text and counter digits on the Scan Properties window - Endorsing tab when you set up
the Scan module for a batch class.

Note Kofax Capture supports a maximum of 80 characters for the text prefix and 6 digits for the counter.
However, the maximum length for the endorser string varies from scanner model to another. See your
scanner documentation for more information. Also, see Setting Up Endorser/Annotation Support for
important notes related to this feature.

Position and Font for Endorser/Annotation Text String

Most scanners that support the endorser/annotation feature provide limited control over where the
endorser prints the endorser string on a page. Some allow you to specify a top and left position for the
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text, while others allow you to specify only the top or left position. Still others allow no user-specified
position for the text.

When setting up your endorser/annotation settings, you can specify position information for your endorser/
annotation text, and font settings for your annotation text as shown below. You specify font and position
settings from the Scan Properties window - Endorsing tab when you set up the Scan module for a batch
class.

Text Offsets

These settings are used for endorser and annotation text.
• Top specifies the top position for your endorser/annotation text.
• Left specifies the left position for your endorser/annotation text.

Font Settings

These settings are used for annotation text only.
• "Type" specifies type size of your annotation text. Typically, you would match the type used for your

endorser string.
• "Orientation" specifies the orientation for your annotation text.

Note Not all scanners support all the font and position options provided by Kofax Capture. See the
documentation that came with your scanner for more information. Also, see Setting Up Endorser/
Annotation Support for important notes about this feature.

Using Custom Endorser Prefixes

You can add almost any prefix to your endorser text string.

Creating a Custom Prefix
1. In the Batch class tree view, select a batch class.
2. Right-click to open the Batch Class Properties window.
3. Click the General tab.
4. Click New to create a new batch field.
5. Create a batch field.
6. Click Apply to save your changes without closing the window.

Adding a Custom Prefix to Endorser Text
1. In the Batch class tree view, select a batch class.
2. Right-click to open the Batch Class Properties window.
3. Click the Queues tab.
4. Select the Scan module.
5. Click Properties to open the Scan Properties window.
6. Click the Endorsing tab.
7. Select endorsing.
8. Click Values.
9. Select your custom prefix (or any other prefix) from the list.
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During scanning, the prefix is added to the endorser text.

Controlling the Behavior of the Endorser/Annotation Counter
You specify increment and reset settings for the counter from the Scan Properties window - Endorsing tab
when you set up the Scan module for a batch class. You can set the following:
• Counter digits

Specify from 1 to 6 digits. The number of digits in the counter controls the maximum value for the
counter. For example, if you specify 3 as the number of digits, the maximum value is 999. If you specify
6 as the number of digits, the maximum value is 999,999.

• Counter increment
Select to have your counter increment by a particular value after every n pages are scanned or after a
patch code is detected. Additional options are available for incrementing on a patch code.

• Counter reset
Select to  reset your counter to a particular value after every n pages are scanned or after a patch code
is detected. Additional options are available for resetting on a patch code.

• Counter Patch Code Control
If you are incrementing and/or resetting your counter after a patch code is detected, specify a left offset
for the patch code. The value should fall within the patch codes on your pages, and provide Kofax
Capture a starting point for searching for the patch code. This could improve performance. If you select
0, Kofax Capture searches anywhere in a horizontal direction.
You can optionally choose to skip the first patch code detected. This applies to incrementing and
resetting after patch code.

The initial value for the endorser/annotation counter is based on the final value generated from the
previous batch using the same batch class. You can change the initial value when a batch is created from
the Scan module or Batch Manager. Some scanners do not support all the counter options provided by
Kofax Capture. See your scanner documentation for more information. Also, see Setting Up Endorser/
Annotation Support for important notes about this feature.

Setting Up Endorser/Annotation Support
Select the endorser/annotation feature when you set up the Scan module for a batch class. Then, you can
specify the settings for endorser/annotation operations.

For example, you can specify:
• Endorser/annotation string, which consists of a text prefix and a numeric counter
• Font and position information for the endorser/annotation string
• Increment and reset options for the numeric counter

All settings are saved as part of your batch class. Then, whenever batches are created based on that
batch class, the settings are applied.

Note the following:
• Your scanner must be equipped with an endorser (even if you are using only the annotation feature).
• Endorsing/annotation does not support grayscale scanning, and it does not work with scanner models

that return compressed data.
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• The endorser/annotation feature is only available with scanners that provide a programmatic API to
their endorsing capabilities. See your scanner documentation for more information.

• Some scanners do not support all the endorser/annotation options listed for the Scan module. Kofax
Capture doesn’t validate your settings until you attempt to scan a batch from the Scan module or
process a batch from Batch Manager.

• If you select settings that are not supported by your scanner, your scan operator is warned that the
settings are invalid. The operator can select to scan the batch anyway, without using the endorser/
annotation feature. Therefore, you should make sure you understand the capabilities of the scanner
used to scan the batch and only select options supported by the scanner. You should also instruct your
scan operators on how they should handle batches with invalid settings. For example, you may not
want them to create batches if problems exist in the batch class.

Selecting the Endorser/Annotation Feature

Use the Endorsing tab on the Scan Properties window to select endorsing and/or annotations. See Setting
Up Endorser/Annotation Support for important notes related to the endorser/annotation feature.

1. On the Create Batch Class window or Batch Class Properties window, click the Queues tab.
2. Click Scan on the list of selected queues, and then click the Properties button.

The Scan Properties window appears.
3. Click the Endorsing tab.
4. On the Endorsing tab, check Endorsing enabled and/or Annotation enabled.

The other settings on the window become available.
5. Specify the endorser/annotation string. The string is made up of a text prefix and a numeric counter

value.

a. Enter/select a prefix string. You can enter a value or select from a list of Kofax Values. You can
enter up to 80 characters, but your scanner might not support a string of that length. See the
note below.

b. Specify the number of digits for the automatic counter. The range is 1 to 6 digits.

Note The length of the endorser/annotation string is the length of the prefix plus the number of
digits in the counter. The maximum length for the string is determined by the capabilities of the
scanner. See your scanner documentation for more information.

c. Specify the offsets for positioning the endorser/annotation text on the page/image. The top
offset specifies the vertical location, and the left offset specifies the horizontal location. Not all
scanners support a user-specified position for the endorsing text. Also, some scanners only
allow user-specified top positions, while others only allow user-specified left positions. If your
scanner does not support the offset positions you specify, they are ignored.

6. If you enabled annotations, specify the font settings:

a. Select a font type. You can choose small, medium, or large.

b. Select an orientation for the text.
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7. Specify how to increment your counter with the Counter Increment options.

a. To turn off the counter, select Off.

b. To increment the counter after n pages, select After n pages. Enter a number for n. Then, enter
the increment value in the By option.

c. To increment the counter after a patch code, select After x patch code. Select a patch code
type for x. Then, enter the increment value in the By option.

8. Specify how to reset your counter with the Counter Reset options.

a. To turn off resetting the counter, select Off.

b. To reset the counter after n pages, select After n pages. Enter a number for n. Then, enter the
reset value in the By option.

c. To reset the counter after a patch code is detected, select After x patch code. Select a patch
code type for x. Then, enter the increment value in the By option.

9. If you are incrementing or resetting the counter whenever a patch code is detected, select options
from the Counter Patch Code Control group.

a. Enter the left offset for the patch code.

b. Check Skip first patch code.
10. Click OK to save your selections and close the window.

Scanner Profile Sharing
Shared profiles, which are saved to a shared location on the network, have the following characteristics:
• Profile loading rules determine which profiles, local or shared, are used by Kofax Capture.
• If User Profiles is selected, only users with rights to access Administrative Utilities can save shared

profiles. This is controlled by the "Allow admin utility usage" user profile setting.
• If User Profiles is selected, users can edit scanner profiles only if the "Allow modification of Scanner

Profiles" user profiles setting is selected. When selected, users can access the following settings in the
Administration, Scan, Quality Control, or custom modules:
• Edit Scan Source Settings
• Save Profile
• Save as Shared Profile
• Revert as Shared Profile
• Delete Profile

• When you uninstall Kofax Capture, local profiles are removed but shared profiles are not.

Profile Loading
When you select a scan source, a Kofax Capture module normally uses shared profiles. Local profiles are
used if any of the following is true:
• Shared profiles do not exist for the selected scan source.
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• The local set of profiles was inherited from the set of shared profiles, but the set has been modified
locally. A set of profiles for a given scan source is considered modified if you have:
• Saved or deleted one or more scanner profiles.
• Saved Kofax VRS settings.

• The local set of profiles was not inherited from the set of shared profiles for the selected scanner. This
could happen if local profiles existed prior to an upgrade or a standalone conversion to a remote site.

To convert local profiles to shared profiles or remove local changes, you can do so manually.

Note If User Profiles is selected, make sure you have selected the "Allow admin utility usage" setting.
Only users with rights to access Administrative Utilities can save local profiles as shared, or revert to
shared profiles.

• To share local profiles: On the Scan panel, click Share the current profile.
• To remove local changes, on the Scan panel click Revert to shared profiles.

Profile Locations
The profile storage location is a hierarchical set of folders organized by scan source. Scanner profiles,
including Kofax VRS profiles, are stored in a folder specific to the scan source, and they can be local or
shared.

Local profiles are stored in the ScannerProfiles folder under the Kofax Capture <LocalPath> folder.
The following is a sample folder hierarchy.
<ServerPath>
  SharedScannerProfiles
   Software Import
     Default.*
       Kodak i-30 with VRS
     Default.*
     MyProfile.*

Note On a standalone installation, shared profiles are not selected and the shared profiles folder does
not exist.

Shared Profiles and KCN Server
With Kofax Capture Network Server, you can share profiles between the primary central site and remote
sites. Synchronization of shared profiles is bi-directional, between the remote site and its primary central
site. Only shared profiles for updated scan sources are transferred. Both sites have the most recent set of
profiles.

Remote site synchronization includes shared (not local) profiles.

Note Synchronization is based on the date/time of the shared profiles folder for a given scan source. All
profiles in the older folder are deleted, and then all profiles in the most recent folder replace those in the
older folder. Synchronization of shared profiles is not configurable. It cannot be turned off.
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Converting to a Remote Site
When you convert a server installation to a remote site, existing shared profiles are deleted. If the
workstation was a standalone installation, the shared profile folder is configured automatically.

Disaster Recovery
Shared profile synchronization occurs between a remote site and its primary central site. Alternate central
sites are not included.

Independent Verification
Use the Verification module to double check the indexing done during the validation process. Independent
verification ensures even greater accuracy by preventing a batch from being verified by the same person
that validated it.

When independent verification is selected, you are not able to open a batch in the Verification module if
you also validated that batch. 

Example

Suppose your company has a pool of operators, and you have some batch classes that require
independent verification.

Normally, all the operators perform validation. Eventually a number of batches are waiting for verification,
so several operators work on verification for awhile. When opening batches in the Verification module,
each operator selects one of the waiting batches. However, the batches presented are somewhat different
for each operator. Specifically, the list does not show batches validated by the same operator. Each
operator can only process the batches he or she did not validate.

Independent verification, which is off by default, is selected in the Verification Properties window.

Note To use independent verification, the User Profiles feature must be on, and must remain on. If you
attempt to publish a batch class that does not meet this requirement, a publish error occurs. If you turn
off user profiles after publishing the batch, independent verification may not work as expected.

In some rare cases, more than one operator may have verified a batch. Only the most recent operator is
recognized by the independent verification feature.

eDocuments
Kofax Capture can import, process, and export almost any type of file. You do not need to limit your
batches to image files. Image files are defined as those with the following extensions:
• .tif
• .jpg
• .bmp
• .pcx
• .cal
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In addition to the graphic file formats in the preceding list, Kofax Capture can also import .pdf files, which
are imported as .tif files and processed like any other .tif file. You can also select to treat .pdf files as
eDocuments rather than as .tif files. 

All other types of non- image files are classified as eDocuments regardless of content.

The support of eDocuments is controlled at the batch-level, and each batch can be set independently of
other batches. See Using eDocuments for more information.

Examples of eDocuments:
• Simple text files
• Microsoft Word documents
• Microsoft Excel documents
• Microsoft PowerPoint documents
• Adobe Acrobat PDF files
• Adobe Photoshop files
• Audio Video Interleaved (.avi) files
• Corel WordPerfect documents
• Corel Ventura documents

In simple terms, eDocuments are treated like blank pages by the Kofax Capture modules. Additionally,
each eDocument is treated as if it were a single page.

Although eDocuments can move from module to module with the batch, it is not possible to use zone-
based automatic recognition or data capture features with them. However, you can manually index them in
the Validation module. You can also write a custom script, OCX, or custom module to pull electronic data.
Or you can use the Kofax Capture XML Import Connector module.

Each module with an image viewer attempts to display eDocuments. The Scan, Quality Control,
Validation, and Verification modules all have image viewers, and you can view eDocuments as a normal
part of your batch processing. The eDocument displays as if it were opened in Internet Explorer.

The main advantage of eDocuments is that you can create a batch based on your archiving or processing
needs. All the documents you need can now be processed together in a single batch regardless of file
type.

Data cannot be automatically captured from eDocuments. Any indexing for these documents must be
done manually in the Validation module. Auto-indexing eDocuments results in blank index values with zero
confidence. This does not generate an error, but depending on your needs may require manual validation.
If your batch has a large number of eDocuments as compared with image files, your manual validation
time could increase significantly.

In many cases, your process may not require the indexing of eDocuments. Each module in Kofax Capture
with an image viewer gives you the option of suppressing the display of eDocuments. If there is no need
for your operators to look at them, they simply display as blank screens in the viewer. Suppressing the
display, when possible, improves your processing time.

The Recognition Server treats eDocuments as blank pages. Any image cleanup performed in this or the
Scan module does not affect eDocuments.

The OCR Full Text module also treats eDocuments as blank pages.
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eDocument Limitations
When viewing eDocuments, please keep the following limitations in mind.
• The Kofax Capture image viewers make use of some features in Internet Explorer 5.0 and higher.

Consequently, the image viewers exhibit the same features and limitations as the browser. Kofax
Capture can display any type of file that the browser recognizes and displays.

• Because IE does not support rotate or zoom, the rotate and zoom toolbars, keyboard shortcuts, and
other items in the image viewer are disabled when an eDocument is being displayed.

• Depending on the type of file, the eDocument appears in the image viewer window or in its native
application.

• If the eDocument can be displayed in the image viewer window, then you do not need the native
application installed on your workstation. However, depending on the type of document, you may need
one or more plug-ins for Internet Explorer. These plug-ins are available from a number of sources, most
frequently the manufacturer of the application that was used to create the eDocument.

• If the eDocument cannot be displayed in the image viewer window, and if you do not have the native
application installed, the standard Windows Open With window appears. Use this window to select an
alternate program to use for viewing the eDocument.

• If a required plug-in is missing, operators may be prompted to install the plug-in.
• If you do not have a suitable alternate application, the image viewer remains blank.
• Depending on the application and the eDocument, it may take a few moments for the contents to

display.
• The contents of an eDocument cannot be predicted or controlled from within Kofax Capture. Microsoft

Word documents, for example, may contain links to other files, OLE objects, or Web sites. Some of
these links may still function in the image viewer.

• When viewing eDocuments, your zoom settings are not retained by the image viewer. Viewing behavior
for eDocuments cannot be predicted because the Kofax Capture image viewers make use of certain
features in Internet Explorer. Consequently, Kofax Capture can display any type of file that Internet
Explorer can display, but with the same capabilities and limitations as the browser.

• Some eDocuments may have macro capabilities that could potentially cause problems when opened.
For example, a macro might be looking for a file that does not exist on the current workstation.

• Certain types of computer viruses may also be transmitted in eDocuments. It is suggested that you
install appropriate anti-virus software.

• Kofax Capture sets the properties for eDocument files to "read-only." In some cases it may be possible
to make changes to the eDocument when it is displayed in an image viewer. These changes cannot be
saved in the source folder, and the integrity of the original file is preserved by Kofax Capture.

• Single document processing is not available when processing eDocuments because they are not
automatically separated in the Scan module.

Form Identification
Form identification cannot be used on eDocuments, although any image files in the same batch are
identified. In this case, eDocuments are passed through as if they were blank pages.
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Export Connectors
Export connectors may be set to support or not support eDocuments. This is handled by setting the value
for a property in the .inf file that came with Kofax Capture. The default .inf file installed with Kofax Capture
is set to enable eDocument support for the default text and database export connectors. Changing the
property to “false” turns off eDocument support for that export connector.

The Export Connector Manager has a Properties button that displays a window that indicates support for
eDocuments. If you attempt to use eDocuments with an export connector that does not support them, you
receive a warning message when you publish the batch.

Custom Modules
Custom modules may be set to support eDocuments. This is handled by setting a property in the .aex file.
The default .aex file that is installed with Kofax Capture (for the sample custom module) is set to enable
eDocument support. Changing the property to “false” turns off eDocument support for that custom module.
See the Kofax Capture Developer's Guide for more on custom modules.

The Custom Module Properties window indicates support for eDocuments on the General tab. If you
attempt to use eDocuments with a custom module that does not support them, you receive a warning
message when you publish the batch.

Document Separation
As with image files, eDocuments can be separated using a variety of methods. Remember that for
separation purposes, the Recognition Server treats each eDocument as a single page.

Each method of separation is discussed below.

Manual Separation

Manual separation of eDocuments is the same as for image files.

Auto-Import Separation

Auto-import of eDocuments is exactly the same as for image files.

Fixed Page Separation

You can use the fixed page method to separate eDocuments, but keep in mind that all eDocuments are
treated as single page documents regardless of the actual page count.

Patch and Bar Code Separation

Patch codes and bar codes cannot be used to separate eDocuments. In this case, eDocuments are
passed through as if they were blank pages. Image files are separated correctly.

Page Recognition Separation

Page recognition cannot be used to separate eDocuments. In this case, eDocuments are passed through
as if they were blank pages. Image files are separated correctly.

Kofax Capture Export Library
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When the Export module detects an eDocument, it sends that document straight to the export destination
without alteration. In the case of a multipage image file, eDocuments are saved in a subfolder. Doing this
helps organize the files in an easily accessible structure.

PDF Support
Kofax Capture can import PDF files as either eDocuments, or as .tif image files.

Batch Classes Import and Export - An Overview
Kofax Capture allows you to import and/or export your batch classes. This makes your batch classes
portable, and allows you to share batch classes with other sites.

When you export a batch class, all the elements configured for one or more batch classes (such as field
types, document classes, batch properties, sample pages, scripts, and more) are compressed into a .cab
file (Microsoft cabinet file). You can send the .cab file to another site, where it can be imported into that
system.

Importing a Batch Class
1. From the Administration module, on the Home tab, in the Batch Class group, click Import.

The Open window appears.
2. Browse to the folder where your .cab files are located.

(Batch classes are exported as .cab files.)
3. Select a .cab file and click Open.

The Import/Export window appears. As soon as the Import/Export window appears, the .cab file is
unpacked and prepared for import. The results of this process appear in the Unpacking results area
on the window. When done, the "Unpacking done. Completed" message appears.

4. When the message "Unpacking done. Completed" appears, click OK.
The Import window appears.

5. On the Import window, select the batch classes to import from the list of Available Batch Classes.
Click the Add button to add them to the list of Selected Batch Classes.
The list contains all the batch classes that were exported into the .cab file you unpacked.

6. Select a Transfer Mode. You can choose one of the following:
• Do not import duplicates: Does not overwrite duplicate batch class settings.

• Save duplicates to new name: Saves duplicate batch class settings to a new name.

• Replace duplicates with items imported: Overwrites duplicate batch class elements (such as index
fields) with the ones you are importing.

7. Click Import.
Once the batch class is imported, it cannot be used until you publish it. In addition, you may need to
recompile any custom scripts associated with the batch class.
The Import/Export window lists the import results.

Importing Batch Classes that Export Index Data to a Database: In some cases, you may need to set up
your export connectors again after you import batch classes. Consider this scenario: You import a batch
class that was set up at another site. The export connector for the batch class uses field IDs to reference
a back-end database, and the field IDs match the ones for the database at the other site. If the field IDs
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in your database do not match the field IDs from the other site, you are not able to export the index data.
For this case, you do not get errors or warnings when you publish the imported batch class. However,
you do get errors at export time. As a workaround, you should run a test batch through to export after you
publish your imported batch classes. If problems occur at export time, set up the export connector again
and republish the batch class.

Partial Batch Export
The Partial Batch Export feature offers an alternate approach to exception processing, whereby a batch
with documents or pages in error is not automatically routed to Quality Control for repair. Instead, a batch
with errors is processed through the modules in the order originally defined for the batch class. Once
the batch reaches the Export module, the error-free documents and pages are exported. The exception
documents and pages are routed back to Quality Control for repair and then processed through the batch
class workflow, starting with the first module after Scan. This approach is helpful if you do not want to
delay batch processing for error-free documents or pages that exist in the same batch with exception
items.

How Partial Batch Export Works
Select Partial Batch Export in the Administration module on the Batch Class Properties - Advanced tab.
On the Advanced tab, you select the processing module at which Partial Batch Export should first go into
effect. Starting with the specified module, rejected documents and pages are forwarded along with error-
free items to the next module. The feature remains in effect for any modules in the workflow that follow the
specified module.

For example, you might have Scan, Recognition Server, Validation, Verification, and Export set up as the
processing modules for a batch class. Beginning with the Validation module, you specify that batches in
error be advanced to the next module.

As a result, Partial Batch Export is not enabled for the batch if errors occur in the Scan or Recognition
Server modules. If a bad document is detected in these modules, the batch is sent to Quality Control for
repair. If a bad document is detected after the batch reaches the Validation module, the batch in error is
forwarded through the workflow in the module order designated on the Batch Class Properties - Queues
tab. After reaching the Export module, the error-free items are exported and the bad document is routed
back to Quality Control for repair. The repaired item is then processed through the batch class workflow,
starting with the first module after Scan.

Page Registration
Sometimes, registration differences exist between a form image and its sample page. For example,
a form image might be shifted horizontally or vertically from the sample pages. This might occur if
different scanners are used to scan the form image and sample page. This might also occur because the
paper slips as the documents enter the scanner’s mechanical feeder or optical differences in scanner
mechanisms.

To account for these differences, Kofax Capture supports a page-level registration feature. Page-level
registration involves comparing a newly scanned image with its sample page. Then, zones on the image
are automatically adjusted based on any horizontal or vertical shifting introduced by the scanner. (The
adjustment process is called registration.)
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Page-level registration is defined at the form type level and is selected by default. You can edit the
settings for page-level registration from the Image tab on the Create Form Type window or the Form Type
Properties window. You can specify:
• A confidence threshold that indicates the minimum acceptable confidence returned by the registration

process. Kofax Capture does not consider the form image registered unless the confidence returned is
greater than or equal to the specified confidence level. The default confidence is set to 1 percent, which
works for a wide variety of forms. You can adjust the confidence to a higher setting.

Note The page-level registration feature is very sensitive to differences between images and their
sample pages. Adjusting the confidence to higher values could cause images that don’t look like
the samples to be rejected. This might be useful for catching a variety of problems such as incorrect
pages, inadequate scans, and so on because the images won’t match the samples. On the other
hand, it could cause more images to be rejected. Therefore, you should try several settings in some
test batches before you use your settings in production.

• Whether all pages should be registered. Typically, you would select this option to verify registration for
all the pages in your documents. You should set the confidence threshold to 75 percent or more to force
a stricter match between images and the sample pages. 

Tip Optionally, you can define an OCR registration zone or a shape registration zone to augment page-
level registration.

Turning Off Page Registration
The page registration feature is very robust and can correctly register a wide variety of forms. In some
cases, though, you may get better results by turning off page registration and using a registration zone
instead.

You can turn off page registration from the Create Form Type window - Image tab or the Form Type
Properties window - Image tab by setting the Page Registration confidence to 0.

Registration Zones
A registration zone can be used to augment or replace page-level registration. Page-level registration
attempts to offset all zones based on how far large features on the page are offset from the same features
on the sample page. This works extremely well in most cases, but produces invalid results in others.

Page-level registration may not give you the desired results if your images are different from the sample
pages, zone locations vary on the pages, or the scanned images are stretched or distorted. If page-level
registration is not working, you may get better results by using one or more registration zones.

Registration zones include the following elements:
• A registration point, represented on the sample page by a cross.
• A recognition profile based on an OCR recognition engine or the Shape engine.
• A specification that tells the engine what to search for (text or type of shape).

Note You can test your zones using the QuickZones feature to make sure that your registration zone is
being processed with high confidence.
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OCR Registration Zones
An OCR registration zone is an area on an image containing text data that is "fixed" in relation to index
data on a form. For example, your form may have a company name in the same spot on each page. OCR
Registration zones are used to correctly position index zones on your images, which could enhance the
automatic capture of index data.

OCR Requirements

To get reliable results, your OCR registration zones must meet the following minimal requirements. Zones
that do not meet these requirements may still yield acceptable results, but performance of the recognition
engine cannot be predicted in such cases.

OCR registration zones include the following Kofax Capture elements:
• A registration point. The point is typically located at the lower-left corner of the first character of the text

in the zone on your sample page.
• A recognition profile that uses OCR as the method of recognition.
• Search text (optional). As a rule of thumb:

• The first character must match the raw OCR results.
• The remaining characters are compared against the processed OCR results (after any recognition

script has been run). A match occurs if about half the characters match, or if the search text is
contained in the results.

• For best results, search text should be as short as possible.
• You can test your zones with the QuickZones to make sure that your search text is being recognized

with high confidence.

Note The use of search text is recommended in most situations. If there is no suitable text for a
registration zone, you may want to create a registration zone without search text. In that case, the
registration process is based on the position of the first text character detected in the zone at runtime.

Page Registration
Sometimes, registration differences exist between a form image and its sample page. For example, a
form image might be shifted horizontally or vertically from the sample pages. This might occur if different
scanners are used to scan the form image and sample page. This might also occur because of paper
slippage as the documents enter the scanner’s mechanical feeder or optical differences in scanner
mechanisms.

To account for these differences, Kofax Capture supports a page-level registration feature. Page-level
registration involves comparing a newly scanned image with its sample page. Then, zones on the image
are automatically adjusted based on any horizontal or vertical shifting introduced by the scanner.

Page-level registration is defined at the form type level and enabled by default. You can edit the settings
for page-level registration from the Image tab on the Create Form Type window or the Form Type
Properties window. You can specify:
• A confidence threshold that indicates the minimum acceptable confidence returned by the registration

process. Kofax Capture does not consider the form image registered unless the confidence returned is
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greater than or equal to the specified confidence level. The default confidence is set to 1 percent, which
works for a wide variety of forms. You can adjust the confidence to a higher setting.

Note The page-level registration feature is very sensitive to differences between images and their
sample pages. Adjusting the confidence to higher values could cause images that don’t look like
the samples to be rejected. This might be useful for catching a variety of problems such as incorrect
pages, inadequate scans, and so on because the images won’t match the samples. On the other
hand, it could cause more images to be rejected. Therefore, you should try several settings in some
test batches before you use your settings in production.

• Whether all pages should be registered. Typically, you would select this option to verify all pages in
some way. Therefore, you should set the confidence threshold to 75 percent or more to force a stricter
match between images and the sample pages.

Tip Optionally, you can define an OCR registration zone to enhance page-level registration.

Augmenting Page Registration

You can augment page registration with registration zones.

Registration zones contain data to be read for registration purposes. This type of zone is typically used
with Kofax Advanced OCR or Kofax Shape Zonal processing to ensure that other zones on the page are
correctly aligned. To use Kofax Advanced OCR or Kofax Shape Zonal registration, you define one or more
registration zones.

If you create only one registration zone on a page, it should be positioned near the index zones. The
search text for a single registration zone should be clear and distinct so that it yields good results.

You can define multiple registration zones per page.

Shape Registration Zones
A shape registration zone is a type of registration zone that (instead of text) uses geometric patterns
that are "fixed" in relation to the data on a form. A shape registration zone is used to accurately position
recognition zones on your images, which could enhance the automatic capture of the data.

Shape Types

Kofax Capture is capable of recognizing a variety of geometric shapes on a form. These shapes may be
used for shape registration zones as well as other zones that use shape recognition profiles. The following
shapes can be recognized.

Shape Table

Name Icon ID* Definition

Line Intersection 1 A shape that resembles a "plus" sign. However, the
intersection point does not need to be in the center of either
of the lines.

Top Intersection 10 A vertical line whose highest point meets a horizontal line
between its endpoints.
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Name Icon ID* Definition

Bottom Intersection 11 A vertical line whose lowest point meets a horizontal line
between its endpoints.

Left Intersection 12 A horizontal line whose leftmost point meets a vertical line
between its endpoints.

Right Intersection 13 A horizontal line whose rightmost point meets a vertical line
between its endpoints.

Lower-left Corner 20 A vertical line whose lowest point meets a horizontal line at its
leftmost point.

Lower-right Corner 21 A vertical line whose lowest point meets a horizontal line at its
rightmost point .

Upper-left Corner 22 A vertical line whose highest point meets a horizontal line at
its leftmost point.

Upper-right Corner 23 A vertical line whose highest point meets a horizontal line at
its rightmost point.

Lower-left Edge 30 The lower left quadrant of a solid rectangle.

Lower-right Edge 31 The lower right quadrant of a solid rectangle.

Upper-left Edge 32 The upper left quadrant of a solid rectangle.

Upper-right Edge 33 The upper right quadrant of a solid rectangle.

General 100 Any shape that cannot be classified as one of the preceding
shapes.

*The ID number is returned if the shape is found. It is seen in index fields or windows (such as the Zone
Test window) where the results of the shape recognition process are reported. The ID number can also be
used in scripts.

Shape Requirements

To get reliable results, your shapes should meet the following minimal requirements. Shapes that do not
meet these requirements may still yield acceptable results, but performance of the recognition engine
cannot be predicted in such cases. If you have a shape that falls outside of these guidelines, you may
need to experiment to see if you can use it.

Note that the skew of any shape cannot be greater than 1 in 5 (approximately 11 degrees). For example,
the Line Intersection shape cannot be rotated so that it resembles an "X".

Note These requirements are specified in pixels because shape recognition happens at the pixel level.
At 200 pixels per inch, 20 pixels is 0.1 inches or 2.5 mm.

• For lines:
• The line thickness must be least 2 pixels.
• All line lengths must be at least 20 pixels.
• The length of the line must be at least 5 times the thickness, but cannot be less than 20 pixels.
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• For edges:
• The edges of a solid rectangle must be at least 20 pixels in both the vertical and horizontal directions.
• The edges of a solid rectangle must be at least 20 pixels in both the vertical and horizontal directions.

• General
• The general shape must contain at least 1400 black pixels and no more than 10% white pixels.

Special Tip

You can also assign a shape recognition profile to separator zones, form identification zones, and index
zones.

For index zones, Kofax Capture examines the content of the zone and attempts to find a corresponding
shape. If a shape is found, its ID number is placed in the associated field. These results are then available
in the Validation and Verification modules. They can also be used in your custom recognition scripts or
custom modules. If you assign a shape recognition profile to an index zone, you cannot specify a specific
search shape. All shapes are examined and the closest match used.

Multiple Registration Zones on a Single Page
Registration zones contain data to be read for registration purposes. This type of zone is typically used
with OCR or shape processing to ensure that other zones on the page are correctly aligned. You can
define one or more OCR or shape registration zones on a single page.

You can define multiple registration zones per page. To achieve optimal results, follow these guidelines.

Zone Placement - Single Registration Zone

If you create only one registration zone on a page, it should be positioned near the index zones. The
shape for a single registration zone should be clear and distinct so that it yields good recognition results.

Zone Placement - Multiple Registration Zones

You can define multiple registration zones per page. To achieve optimal results, refer to the table.

Note While results improve with multiple registration zones on a page, be aware that an increased
number of zones may adversely affect the time it takes to process your batch.
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Number of Zones Placement Suggestions Placement Example

One Zone Place as close to index zones as
possible.

Two Zones Place the two registration zones in
diagonally opposite corners of the
page.
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Number of Zones Placement Suggestions Placement Example

Three Zones Place the registration zones so
that the registration points form a
triangle on the page.

Four or more zones Place the registration zones near
the data that is to be processed
on the page. Also, do not rely
on the success of a single
registration point. For example,
if you have several registration
zones near the top of a page, and
a single registration point near the
bottom, the registration alignment
could be poor if the registration
fails for the bottom zone.
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Multiple Export
Normally, the final step for Kofax Capture is exporting a batch (including captured data) to a long-term
storage system. This is handled by the Export module, which relies on export connectors to govern the
process.

In most cases, the batch is exported to a single destination, such as a text file, database, or document
management system. There may be occasions when you want to export a batch to more than one
destination (back-end). The multiple export feature makes this possible.

The multiple export feature uses the concept of an "assigned export connector" in Kofax Capture. This
refers to an export connector that has been assigned to a document class and which contains the various
settings that pertain to that assignment. Consequently, if you repeatedly use the same export connector,
each becomes a different "assigned export connector." When you assign an export connector to a
document class, it may be given a name (if supported by the export connector type). This is called the
"assigned name."

You can assign up to 99 export connectors to a document class.

Other
When setting up a document class for multiple exports, keep the following in mind:
• The multiple export feature can support up to 99 assigned export connectors within a document class.
• If all the assigned export connectors for a batch have been successfully processed, the batch is

automatically deleted.
• Once an export connector is assigned, it may then cause problems if batch fields or index fields are

added, deleted, or modified. Therefore, assign export connectors only after you are sure that changes
are final.

• On-screen log messages in the Export module include the assigned export connector number and
assigned name (if any).

• Multiple export publish checks occur as they do for single export connectors. If a document class has
multiple assigned export connectors, then any publish checks occur in the order specified on the Export
Connectors window.

• If some documents could not be exported to all their destinations during processing, those documents
are rejected with a partial export error. When you open the batch in the Quality Control module, the
partially exported documents are displayed in the Partial Export Errors window for your review.

Using Multiple Export
With the multiple export feature, you can export the same document within a batch to more than one
destination. This feature also includes some settings that allow you to optimize the export process.

Before you can use an export connector in Kofax Capture, the connector must be registered.
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Procedural Overview

This section describes the basic procedure to follow for using the multiple export feature. The following
assumes that the batch class and document class are already defined. It also assumes that Export is the
final queue in the batch class.

1. If necessary, run the Administration module.
2. If necessary, register the export connector with Kofax Capture using the Export Connector

Manager window.
3. Select a document class in the Batch class tree view.
4. Assign an export connector.
5. Complete the setup windows.
6. Repeat steps 3 and 4 until all required connectors have been assigned.
7. Adjust the order of the connectors by dragging them up or down.
8. Publish and process the batch.

Assigning Multiple Export Connectors
1. Click the Batch class tree view tab.
2. Select a document class for your connectors.
3. Right-click the selected document class.
4. Select Export Connectors to open the Export Connectors window - General tab.
5. Select an export connector from the Available Export Connectors column on the left.
6. Click Add to move the connector to the Assigned Export Connectors column and open the

corresponding setup window.
Depending on which export connector you assign, the setup window may vary.

7. Provide the necessary setup information.
8. Click OK.

The connector you selected is now listed in the Assigned Export Connectors column.
9. If necessary, reposition the connector in the list by dragging it up or down.

10. Repeat steps 4–9 for all the connectors you want to assign.

File Format/Compression Format Combinations
JPG - JPEG Compression

Multipage TIFF - CCITT Group 4

Multipage TIFF - CCITT Group 3

Multipage TIFF - CCITT Group 3/2-D

Multipage TIFF - Uncompressed

Multipage TIFF - JPEG Compression

Multipage TIFF-LZW Compression
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PCX - PackBytes

TIFF - CCITT Group 3

TIFF - CCITT Group 3/2-D

TIFF - CCITT Group 4

TIFF - JPEG Compression

TIFF - Uncompressed

Notes for color and grayscale images:
• JPG is the standard file format for color and grayscale images. You cannot convert bitonal (black and

white) images to the JPG file format.
• If all the images in the batch are color and/or grayscale, you should select "JPG - JPEG Compression."
• If the images in the batch are mixed (color, grayscale, and/or bitonal images), you should select a

combination that includes the TIFF file format with any compression other than JPEG. The exported
images all have the ".tif" extension. However, any color images in the batch contain compressed JPEG
data within the TIFF file format.

Treat Non-TIFF Images as eDocument Files
In certain situations, you may want to force all non-TIFF files to be treated as eDocument files:
• When JPG and BMP files are processed, they are usually repeatedly re-compressed in Kofax Capture.

Even with the JPG compression slider set to 100%, these images are subtly changed. By treating them
as non-image files, the images are not processed.

• At export, JPG and BMP files are typically converted to TIFF files with JPG images inside them. This
option provides a way to force these files to keep their original file type.

• Although Kofax Capture is able to run OCR Full Text on color images, it may produce invalid results if
run on some pictures. You may want to skip imported pictures, but process TIFF files normally in the
same document.

An additional benefit of the "Treat Non-TIFF Images as eDocument Files" setting is that the Kofax Capture
system does not attempt to process these images in any way. Provided the setting isn’t required, it greatly
speeds up Kofax Capture processing. This may be especially critical when working with extremely large
image files.

Creating a Batch Class
Create a batch class with the Create Batch Class window.

A new batch class does not go into effect until you publish it.
1. On the Insert tab, in the Create New group, click Batch Class.

The Create Batch Class window appears.
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2. Enter the information on the following tabs:
• General
• Queues
• Workflow Agents
• Separation and Form Identification
• Foldering
• Batch Naming
• Advanced

For details on individual settings, click Help on any tab.
3. Click OK to save the batch class information and close the window.

Using Database Validation
Use the Database Validation feature to automatically fill in index fields from data stored in a database.

Procedural Overview
This section describes the basic procedure to follow for using the Database Validation feature. The
following assumes that the batch and document classes are already defined. It also assumes that the
Validation module is in the batch class module.

1. Select a document class.
2. Open the Database Validation window.
3. Complete the setup windows.
4. If necessary, adjust the order of the validations.
5. Publish and process the batch.

Adding a Database Validation
Before you can take advantage of the Database Validation feature, you must add a validation and set
parameters.

1. Select the appropriate document class in one of the tree views.
2. Right-click the selected document class to open a context menu.
3. Select Database Validation.

The Database Validation window appears.
4. Click Add to view the Database Validation Properties window - Database tab.
5. In the Name field, provide a name for this database validation.

Try to use a name that is meaningful to you or your operators.
6. On the Database type list, select the type of database to use when looking up the data. Depending

on your selection, the lower portion of the screen may vary slightly.
7. In the next field, for an Access database, provide the name of the Access database file. For an

ODBC level 3 compliant data source, provide the name of the data source. For a SharePoint list,
provide a URL.

8. Provide the workgroup file name (Access only).
9. Provide a user name and the password, if required.
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10. Click the Table Settings tab to display the table options.
11. On the "Index field to validate" list, select the index field to use as the basis for a match.
12. On the "Validate against table" or "Validate against list" list, select the item that contains the

necessary data.
13. On the "Match column" list, select the item that contains the data that serves as the basis for a

match. The contents of this column are compared to the index field you selected earlier.
14. Select Auto-fill index fields from results to link index fields to database fields.
15. Match the index fields you want to have automatically filled to the corresponding database columns.

If you leave a match blank, auto-fill does not occur for that index field.
16. Click the Options tab and set the options.
17. Click the Workstation tab and set up the caching options.
18. Click the KCN Server tab and set up the type of database connection and cache to use. Depending

on the database type, the settings on this tab may be unavailable.
19. Click OK to close the window and add your database validation to the list in the Database Validation

window.

Note You can change the order of database validations in the Database Validation window by selecting
a validation and dragging it up or down. Database validations are processed in the order listed.

Removing a Database Validation
1. Select the appropriate document class in one of the tree views.
2. Right-click the selected document class to open a context menu.
3. Select Database Validation.

The Database Validation window appears.
4. Select the database validation to remove.
5. Click Remove to delete it from the list.

Editing a Database Validation
1. Select the appropriate document class in one of the tree views.
2. Right-click the selected document class to open a context menu.
3. Select Database Validation.

The Database Validation window appears.
4. Select the database validation to edit.
5. Click Properties to open the Database Validation Properties window.
6. Make any necessary changes.
7. Click OK to close the window and save your edits.

Moving a Database Validation in the List
1. Select the appropriate document class in one of the tree views.
2. Right-click the selected document class to open a context menu.
3. Select Database Validation.

The Database Validation window appears.
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4. Select the database validation to move.
5. Drag it up or down in the list.

Downloading Batch Classes Using Automatic Synchronization
You can set a specific synchronization time when new or modified batch classes are downloaded
automatically to the appropriate remote sites. The batch classes that a site receives depend on the remote
site profile for that site. 

1. Create or select a remote site profile at the central site using the Kofax Capture Network Server
Remote Site Profiles window available from the Administration module and assign it to a remote
site.
Once the remote site profiles are defined and downloaded to the remote site, the settings take effect
for the remote site.

2. If desired, you can also set synchronization polling times at the remote site in the RSA Polling
Settings window. This window is available from Batch Manager at the remote sites.

The polling times set by either method are also used by the RSA if it has been installed as a service.

Using eDocuments
Use the eDocuments feature to seamlessly process batches containing both image and non-image
files. The support of eDocuments is controlled at the batch class level, and each batch class can be set
independently of other batches.

Using eDocuments in a batch is simply a matter of selecting the feature.

Selecting the eDocuments Feature
1. Create a batch class or select an existing batch class to edit.
2. Right-click to display the context menu.
3. Select Properties to display the Batch Class Properties window.
4. Click the Advanced tab.
5. Select the Allow import of non-image files check box.
6. Click OK to save your settings and close the window.

Note When you create a new batch class, eDocuments are inactive by default.

Showing eDocuments
You can select to show or hide eDocuments in the image viewer.

1. Open one of the following:
• Scan module
• Quality Control module
• Validation module
• Verification module
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2. Click the Kofax Button, and then click Options.
The Options window appears.

3. Click the View tab to display viewing options.
4. Select the Suppress eDocument file display check box.
5. Click OK to save your settings and close the window.

Enabling Single Document Processing
By default, Kofax Capture processes all the documents in a batch as a group. This means that in a
batch of a hundred documents, the first document is not sent to the next module until the rest of the 99
documents are processed. Single document processing removes this delay by creating a new batch every
time a new document is separated so that the single document batch can be sent to the next module as
soon as it is separated. Depending on the system configuration and the number of documents in each
batch, single document processing can significantly speed up document processing.

Note Single document processing is only available when the Scan module automatically performs
document separation; otherwise, an error occurs when you publish the batch class, and you have to
either change the separation method or turn off single document processing.

When unattended scanning is used, the single document processing feature requires the batch class to
contain multiple document classes with sample pages.

Single document processing is not available for use in the Quality Control module or with Kofax Capture
Import Connector - Email.

1. On the Batch class tree view tab, select the batch class to edit.
2. Right-click the selected batch class, and then click Properties.
3. On the Batch Class Properties window, select the Advanced tab.
4. Select the Process documents as independent batches check box.
5. Click OK to save your settings and close the window.

Publishing a Batch Class
When finished setting up or editing a batch class, you must publish it. Publishing your batch class ensures
it is complete and ready to use to scan or import documents.

You cannot create batches based on a batch class until it is successfully published without errors. Before
publishing a batch class, use the Validate function to identify errors or warnings that need to be resolved.

1. On the Home tab, in the Batch Class group, click Publish.
The Publish window appears.

2. On the Publish window, select one or more batch classes. Click Select All to select all batch classes
on the list.

3. Select the Cancel Publish / Validate operation if error occurs check box to automatically cancel
the Validate or Publish operation if an error occurs. In this situation, a message appears to indicate
how many batch classes are published successfully prior to the error.
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4. Before publishing the batch classes, validate them to identify any issues that need resolution.

a. Click Validate.
The Validate process runs stringent checks on your batch class selections. If you are validating
multiple batch classes, a progress bar appears. The validation results appear in the Results
box.

b. If errors or warnings appear in the Results box, click Close to fix or review the affected settings.
• Errors are generated for settings that prevent successful processing of a batch. You cannot

publish the batch class until these settings are fixed.
• Warnings are generated for settings that could cause a problem, but they do not prevent you

from publishing the batch class. Check the settings to ensure they are valid.

Tip You can copy the contents of the Results box into a text or document file.

c. If no issues are detected, proceed to the next step.
5. Optionally, you can click Versions to view the Version History for a selected batch class to select a

different version to publish. You can also delete a batch class or compare it to another version. For
details, see the Version History Window help topic.

6. Publish your batch classes.

a. Click Publish.
The Publish process runs stringent checks on your batch class selections. If you are publishing
multiple batch classes, a progress bar appears. The publishing process results appear in the
Results box.

b. If errors or warnings appear in the Results box, click Close to fix or review the affected settings.
7. Repeat the preceding steps until the Publish process is error-free.
8. Click Close to exit the window.

Retaining Batch Class Versions
Enable the Versions feature to retain published batch class versions. You can retain all versions of every
batch class, or you can specify the number of recent versions to retain.

1. On the Home tab, in the Batch Class group, click Versions.
The Batch Class Versions window appears.

2. Select one of the following:
• Do not retain batch class versions: Disables the Versions feature. Previously published batch

class versions are not retained.
• Retain all versions: (Default) All versions of previously published batch classes are retained.
• Retain this number of recent batch classes:

Retains the specified number of recent versions per batch class. For example, if you select 15,
the 15 most recent published versions are retained per batch class. Each time you publish a batch
class, the list is refreshed.
If the number of published batch class versions exceeds 15, the oldest version is automatically
deleted if it is not in use. If still in use, the version is deleted as soon as all affected batches are
exported or deleted.
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Viewing the Batch Class Version History
When the Versions feature is enabled, you can access the Version History for any batch class.

1. Select a batch class, right-click, and select Publish.
2. On the Publish window, click Versions.

The Version History appears for the selected batch class.
3. See the "Version History Window" topic in the Kofax Capture help for information about the options to

republish, delete, or compare batch class versions.

Renaming a Batch Class
You can rename a batch class on the Batch class tree view tab or the Batch Class Properties window.
When renaming a batch class, be aware of the following:
• As soon as you rename a published batch class, it is automatically unpublished (unavailable). The new

name goes into effect when you republish the batch class.
• After you rename a batch class, any existing batches created under the original batch class name retain

their references to the original name.
• Duplicate batch class names are not allowed.
• If a renamed batch class contains a document class with an export connector referring to the batch

class name, you must update each batch class name reference in the connector settings.

Renaming a Batch Class on the Batch Class Tree View Tab
1. On the Batch class tree view tab, select the batch class to rename.
2. Press F2 to enable Edit mode, and then type the new name.
3. Press Enter to save the new batch class name.

Renaming a Batch Class on the Batch Class Properties Window
1. On the Home tab, in the Edit group, click Properties.

The Batch Class Properties window appears.
2. On the Batch Class Properties window, place your cursor in the Name field and replace the existing

name with a new name.
3. If appropriate, update the Description field.
4. Click Apply to save the new batch class name without closing the window.
5. Click OK to save the new batch class name and close the window.

Editing a Batch Class
After editing a batch class, you must publish it before your changes can be applied to batches. The
changes cannot be applied to batches created before the new publication date.

1. On the Batch class tree view tab, select the batch class to edit.
2. On the Home tab, in the Editing group, click Properties.

The Batch Class Properties window appears.
3. On the Batch Class Properties window, edit the properties.
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4. Click Apply to save your settings without closing the window
5. Click OK to save your settings and close the window.

Deleting a Batch Class
1. On the Batch class tree view tab, select a batch class.
2. On the Home tab, in the Edit group, click Delete.

Document Classes
A document class is a definition of a particular type of document, such as an order form or medical form.
For each document class, you can specify:
• Index fields to use to retrieve the documents (optional)
• Attributes for the defined index fields (such as hidden, sticky, etc.)
• At least one form type (required)

Document classes provide a convenient mechanism for associating the same group of index fields to
multiple form types. You can define a document class, and then add one or more form types to it. Then,
you can associate a set of index fields to the document class. The same set of index fields is shared
across all the forms types defined for the document class.

For example, consider this scenario: A sales department receives order forms from five different sources.
Each order form is formatted differently, but all contain the same types of information (customer name,
customer address, item number, total, etc.).

For this case, one document class called "Catalog Orders" can be defined. A different form type for each
form can be added to the document class.

Then, a set of index fields can be associated with all form types in the document class.

You create new document classes with the Create Document Class window.

You edit document classes with the Document Class Properties window.

Using Kofax PDF Text Under Image or Kofax PDF Image + Text
The Kofax PDF Text Under Image and Kofax PDF Image + Text output options both produce a PDF file
that contains bitmaps for images and text for data that has been converted to character strings. The
resulting files are smaller than image-only files and can be searched as if they were text documents.
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The following procedure assumes that your document and batch classes already exist. If not, you can
make these selections while creating new classes.

1. Open the Document Class Properties window.

a. Click the PDF tab.

b. Select Enable Kofax PDF generation.

c. Select a dictionary.

d. On the Recognition Profiles list, select Kofax PDF Text Under Image or Kofax PDF Image +
Text.

e. Optionally select Skip first page of each document.

f. Optionally set values in the information fields that are used as metadata when the file is opened
in a PDF document reader after export.

g. Click OK.
2. Open the Batch Class Properties window.

a. Click the Queues tab.

b. Add the Kofax PDF Generator and other required modules.

c. Click OK.
3. Select the document class, right-click to open the Export Connector window, and select the export

connector to be used for PDF output. You can select any connector that supports Kofax PDF output,
including a custom export connector.

4. On the export connector setup window, select the option for PDF output, and specify the output
folder. Save the settings and exit the setup window.

5. Publish the batch class.

Using Kofax PDF Image Only
The Kofax PDF Image Only output option produces a PDF file that contains bitmaps for both images and
text. The resulting files are significantly larger than image under text files, and they cannot be searched.
However, image only files are simpler to create and do not require additional licensing from Kofax.

The following procedure assumes that your document and batch classes already exist. If not, you can
make these selections while creating new classes.

1. Open the Document Class Properties window.

a. Click the PDF tab.

b. Select Enable Kofax PDF generation.

c. Select a dictionary.

d. In the Recognition profiles list, select Kofax PDF Image Only.

e. Select Skip first page of each document.

f. Optionally set values in the information fields that are used as metadata when the file is opened
in a PDF document reader after export.

g. Click OK.
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2. Open the Batch Class Properties window.

a. Click the Queues tab.

b. Add the PDF Generator and other required modules.

c. Click OK.
3. Select the document class, right-click to open the Export Connector window, and select the export

connector to be used for PDF output. You can select any connector that supports Kofax PDF output,
including a custom export connector.

4. On the export connector setup window, select the option for PDF output, and specify the output
folder. Save the settings and exit the setup window.

5. Publish the batch class.

Copying a Document Class
Use Copy to duplicate an existing document class. The copy method is useful for adding a document
class that is similar to an existing one. You can also copy a document class to a selected batch class.
When you paste a copied document class, it is given a different name, such as Name1, Name2, and
Name3. You can then modify the document class as needed.

When copying a document class, certain items associated with the document class are copied, and others
are linked. The following table shows the items that are copied and linked.

Copied and Linked Items

Copied Items Linked Items

Index fields
Table Index fields
Form types (and related items)
Custom storage strings
Document validation scripts
Database validation
The following items are copied only when the copied
document class is pasted to the same batch class from
the batch class tab:
PDF Properties
Setup export connectors
Document separation zone

Field types
Recognition profile
Separation and form identification profiles
Image cleanup profiles
Color image cleanup profiles

Note All related items within Form Types are also copied or linked.

Copying a Document Class to the Document Class Tree View Tab
1. On the Batch class tree view tab or the Document class tree view tab, select an existing document

class to copy.
2. On the Home tab, in the Clipboard group, click Copy.
3. From the Document class tree view tab, select an existing document class.
4. On the Home tab, in the Clipboard group, click Paste.
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A copy of the document class is created with a unique name, such as Name1, Name2, and Name3.
If you perform a copy and paste on a previously copied document class such as Name2, then the
new document class is created with a unique name such as Name21, Name22, and Name23.

You can edit the copied document class from the Document Class Properties window.

Copying a Document Class to a Batch Class
1. On the Batch class tree view tab or the Document class tree view tab, select an existing document

class to copy.
2. On the Home tab, in the Clipboard group, click Copy.
3. On the Batch class tree view tab, select the batch class to which you want to copy the document

class.
4. On the Home tab, in the Clipboard group, click Paste.

A copy of the document class is created with a unique name, such as Name1, Name2, and Name3.
The copied document class is associated with the selected batch class.

5. Edit the copied document class from the Document Class Properties window.

Creating a Document Class
You create document classes with the Create Document Class window.

1. On the Insert tab, in the Create New group, click the arrow next to Document Class, and then click
New Document Class.

2. On the Create Document Class window, on the General tab, enter the name for the document
class.
You can enter up to 32 characters, including spaces (leading and trailing spaces are removed). The
name is not case-sensitive and must be unique.

3. Enter a description for the document class.
The description appears whenever document class properties are displayed. You can enter up to 80
characters.

4. Define the index fields to be associated with the document class:

a. Click New Index Field.
Default information for a new index field is appended to the list of index fields in the Index
Fields table. You can edit any of the default values.

b. Change the name for your index field.
You can enter up to 32 characters, including spaces (leading and trailing spaces are removed).
The name is not case-sensitive and must be unique.
By default, index field names are added in the form Namen (where n is a value from 0 to the
maximum number of index fields). Since the name of the index field appears (unless you specify
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a display label) during validation and verification in the Validation and Verification modules, you
should select names that are meaningful to your validation and verification operators.

c. Select a field type for your index field from the Field Type list. To define new field types, click
New Field Type.

d. Specify a default value.
You can enter a value, or select from the list of Kofax Values. If specified, the default value
appears as data in the index field during validation. The validation or verification operators are
able to enter a different value if necessary.

e. Select True or False in the Required column. If you select True, the index field is required to
contain a value during validation. The validation and verification operators are not allowed to
close the batch until a value is entered for this field.

f. Select True or False in the Verify column.
If you select True, the index field must be verified in the Verification module after being
processed in the Validation module.

g. Select True or False in the Hidden column.
If you select True, the index field is not shown to the validation or verification operators. This
might be useful for certain types of processing. For example, you might want to collect values
during automatic validation, and compare them with a validation script. Then, the results can be
assigned to a non-hidden index field. Or, you might want to set values in a script that you do not
want the validation or verification operators to change.

h. Select True or False in the Sticky column. If you select True, the value of this index field for
one document is carried over to the next document. The validation or verification operator can
override the value in the subsequent document if necessary.

Note If you specify "Sticky" and a default value, the default value is used and the "Sticky"
attribute is ignored.

i. Select True or False for the Total attribute.
For numeric index fields, you can set True to select batch totaling. The scan operator is
prompted for a value for the batch.

5. Repeat the preceding substeps for each index field you want to add.
6. Click the OCR tab and select settings for OCR Full Text processing:

a. Select Enable OCR full text to select OCR Full Text processing.

b. Enter the path and file name of a Full Text dictionary for the document class.

c. Select a recognition profile from the list of profiles. If necessary, click Edit and define a custom
profile.

d. Select Skip first page of each document.
The first page of your documents is skipped.
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7. Click the PDF tab and select the settings for PDF processing.

a. Select Enable Kofax PDF generation to apply PDF processing.

b. Enter the path and file name for a Full Text dictionary file or browse for the file. The Full Text
dictionary is used to check unrecognized words during PDF generation. The dictionary file must
be accessible to the PDF Generator module.

c. Select a recognition profile from the list of profiles. If necessary, click Edit and define a custom
profile.

d. Select Skip first page of each document.
The first page of your documents is skipped.

e. Select Enable XMP (Extensible Metadata Platform) for metadata to save metadata (title,
subject, date, description, and more) of the PDF file as an XMP stream in the output.

Note If this option is not selected, by default the metadata is stored in a document information
dictionary associated with the document. The metadata can be viewed if the compatible PDF
reader application is used.

f. Configure PDF Document Information and Custom Properties settings.
8. Click Apply to save your settings without closing the window.
9. Click OK to save your settings and close the window.

Deleting a Document Class
1. Verify that the document class to be deleted is not currently in use by any batch classes.
2. On the Document class tree view tab, select the document class to delete.
3. Do one of the following:

• On the Home tab, in the Edit group, click Delete.
• Right-click and select Delete.

4. When prompted to confirm deletion, click Yes.

Deleting a Document Class from a Batch Class
Use this procedure to delete a document class from a batch class. The document class is still available
after deletion, but it is no longer associated with the batch class.

1. On the Definitions panel, expand the batch class that contains the document class to remove.
2. Select the document class to remove and do one of the following:

• On the Home tab, in the Edit group, click Remove.
• Right-click and select Remove.

3. When prompted to confirm removal of the document class from the batch class, click Yes.

Editing a Document Class
After editing a document class, you must publish the batch class before the changes are applied to
batches. Your changes cannot be applied to batches created before the new publication date.

1. On the Document class tree view tab, select the document class to edit.
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2. On the Home tab, in the Edit group, click Properties.
The Document Class Properties window appears.

3. On the Document Class Properties window, edit the properties.
4. Click Apply to save your settings without closing the window.
5. Click OK to save your settings and close the window.

Adding a Document Class into a Batch Class
You can add a document class to a batch class by inserting or copying it.

You can also use the Copy function to duplicate an existing document class and copy it to a selected
batch class. The copy method is useful for adding a document class that is similar to an existing one.

Inserting a Document Class into a Batch Class
1. On the Batch class tree view, select the batch class where you want to insert a document class.
2. On the Insert tab, in the Create New group, click Existing Document Class.

The Insert Document Class window appears.
3. On the Insert Document Class window, select one or more document classes to be inserted.
4. Click OK.

Renaming a Document Class
You can rename a document class on the Batch class tree view tab, the Document  class tree view tab, or
the Document Class Properties window. When renaming a document class, be aware of the following:
• New document class names go into effect when you republish the batch class associated with them.
• After you rename a document class, any existing batches created under the original document class

name retain their references to the original name.
• Duplicate document class names are not allowed.
• If a renamed document class uses an export connector referring to the document class name, you must

update each document class name reference in the connector.

Renaming a Document Class on the Batch Class or the Document Class
Tree View Tabs

1. From the Batch class tree view tab or the Document class tree view tab, select the document class
to rename.

2. On the Home tab, in the Edit group, click Rename and then type the new name.
3. Press Enter to save the new document class name.

Renaming a Document Class on the Document Class Properties Window
1. On the Batch class tree view tab or the Document class tree view tab, select the document class to

rename.
2. On the Home tab, in the Edit group, click Properties. The Document Class Properties window

appears.
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3. From the Document Class Properties window, click in the Name field and replace the existing
name with a new name.

4. Update the Description field.
5. Click Apply to save the new document class name without closing the window.
6. Click OK to save the new document class name and close the window.

Copying export connectors from one class to another
After configuring export connector settings for a document class, you can save time by copying them to
another document class that uses the same connector. You can also export field mapping values for fields
that have the same name and type. The following rules apply:
• If the batch class does not include the export queue, the export connector is copied, but a warning

message is displayed when the batch is published or validated.
• If the destination batch class/document class does not have corresponding field/index fields, such

mappings are ignored and not copied.

1. On the Document class tree view tab, select the required document class.
2. Right-click to display the context menu and select Copy Export Connector. If more than one export

connector is associated with the document class, select the required export connector from the
submenu.

3. Navigate to the destination document class and right-click.
4. Select Paste Export Connector.

A new export connector is created with all the copied settings from the source document class. When
the message "Export connector successfully copied. Do you want to open the Export Connector
Setup?" appears, do one of the following:
• Click Yes to open the setup screen for the export connector.
• Click No to close the screen without opening the export connector setup screen.

Folder Classes
Folder classes define the properties of folders for a batch class. Batches are a collection of pages,
documents, and folders organized into a hierarchy that you define.

In addition to organizing your documents within Kofax Capture, the real advantage to using folders comes
after the documents are exported. The document import process is much easier if the folder hierarchy
in Kofax Capture matches (as closely as possible) the hierarchy used by your document management
software.

A folder class is added to a batch class, and as with other elements of a batch class, you can create, edit,
and delete folder classes.

Folders are created and filled with documents as the documents are processed through the Kofax
Capture workflow. You can create folders manually (with batch editing), or you can set them to be created
automatically based on rules you define. Likewise, you can place documents into folders manually or
automatically.
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Pages can be added to documents, and documents can be added to folders. Folders can be added to
other folders (nesting) up to 32,000 levels. However, loose pages cannot be added to a folder (although
you may have loose pages at the root level of your batch, they must be placed into a document before
they are added to a folder). 

Folder Creation
Automatic folder creation (auto-foldering) is a process by which the folders in a batch are created or
populated based on document index field values.

Although you can manually create a folder hierarchy through various batch editing functions, this may
be time-consuming, and the results may not be consistently or correctly applied. To address this, Kofax
Capture can automatically create and populate folders when a batch is closed at certain points in the
workflow. You can also invoke auto-foldering at any time in the workflow by selecting an option in the
Batch menu in the interactive modules (Validation, Verification, Scan, and Quality Control).

In the Administration module, you identify which folder classes to use in a batch. You do not actually
create any folders.

Folder creation rules define the organization for folders that are created and populated automatically.
You can think of them as a "default" folder hierarchy, although the hierarchy does not actually exist until
the batch is processed and the rules executed. The folders are created in accordance with the rules as
a batch is processed through the workflow. You can create any type of folder structure; however, you
are limited to the folder classes associated with the batch class, and you can have no more than 32,000
nested levels of folders.

If an unexpected error should occur during folder creation, in most cases the entire creation operation is
rolled back. No new folders are created and no documents are placed in them. For certain types of errors,
you may end up with the folder hierarchy partially created and partially populated with documents.

Basic Auto-foldering Process
During automatic folder creation, a document's index field values are compared to existing folder index
field values. If the appropriate rules are satisfied, then the document is placed in a matching folder.

Otherwise, a new folder is created, its folder index field values are copied from the document index field
values, and the folder is added to the folder hierarchy. The document is then added to that newly created
folder. This only affects documents that are not already in a folder.

Index Fields
Any document index field value (if it is not in a table) may be used to drive automatic folder creation.
Hidden index fields may also be used. This may be useful if a field is automatically recognized and used
to drive folder creation, but should not be visible to the validation operator.

Note that index fields can be filled in through a variety of techniques including bar codes, patch codes,
OCR/ICR, scripting, and customizations. Appropriate index field values must be provided before they can
be used to create a folder.
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Folder Creation Rules
Automatic folder creation is driven by a series of rules that are defined as part of the batch class. A
particular folder creation rule defines how document index fields can be used to identify an existing folder
or create a new folder, and then place the document into that folder.

Rules are defined on the Foldering tab on either the Create Batch Class window or the Batch Class
Properties window.

The document class index field is identified by selecting a document class, and associated index field.
Only document classes attached to the batch class can be used.

Next, it is necessary to select a corresponding folder class and folder class index field. Only folder classes
attached to the batch class can be used. For auto-foldering to function properly, the field type of the
document class index field and the associated folder class index field must match.

The next step is to define a nesting level for the folder. The level parameter identifies the depth within the
folder hierarchy that the rule is to be applied. If folders are never nested in other folders, then a depth of
1 is used (for example, folders situated directly off the batch). For more than one level of nesting, rules
associated with a greater depth are necessary.

The final step is to identify the actual rule behavior. Two choices are available:

1. Create When Value is Unique
There are several choices for creating folders when the value is unique. The default value is
"unique (null as error)" if this is the first time you are assigning a rule to an index field in a particular
document class. Otherwise, the default value is the already assigned rule. In other words, the
creation rules must be the same among all index fields in the same document class.
When using this method, the selected document index field value is checked against the
corresponding folder index field value in already existing folders of the specified folder class. With
this method, there is no need to manually sort your documents before scanning them. Documents
with the same index field value can be scanned in any order, and auto-foldering places them all in
the same folder.
If a match is found, then the document is placed in the folder and becomes the last document in
that folder. If more than one folder matches, then the last matching folder (the one at the end of the
hierarchy in the batch ordering) is used. All matching uses a case-insensitive string comparison. For
example, "cat" and "CaT" are treated as a match. Note that "01" and "1" do not match since a string
comparison (rather than numeric) is used, irrespective of the field type.
If a matching folder is not found, then a new folder is created. In this case, the folder class is the one
specified in the folder creation rule. After the new folder is created, the document is moved into that
folder.
Once a folder has been created, the folder index field is set to the value of the corresponding
document index field. The confidence of the folder index field is set to the same value as that of
the document index field. At this point, the values of all other folder index fields are blank, and their
confidence values are zero. Blank folder index fields may not appear blank during validation if the
Validation module applies a default value.
Use this method to organize your documents into logical folder groups within Kofax Capture. In order
for your export connector and document management software to make use of this structure, you
need to configure the Kofax Capture foldering rules so that the resulting folder hierarchy can be
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recognized by them. For example, the folder name property in an export connector should typically
be set to equal the value of the corresponding folder index field in Kofax Capture.
There are three variations on this method of auto-foldering.
• unique (null as value): If you select this method, a blank document index field creates an

"unnamed" folder and places the document in that folder. All the documents with blank index fields
end up in the same folder.

• unique (null as wildcard character): If you select this method, a blank document index field
matches any existing folders with the appropriate folder class, irrespective of the value. If there is
more than one matching folder, then the last one is used.

• unique (null as error): If you select this method, a blank document index field results in an error,
and puts the batch into an error state.

2. Create When Value is Not Null
This method (also referred to as "not blank") is best used in cases in which the sequence of
documents is used to determine folder grouping, instead of the unique value of an index field.
With this method, if the document index field value is blank, then the document is moved to the most
recently created folder. If no folder has been created by this algorithm, but a folder already exists,
then the last existing folder is used, regardless of the folder class. If the document index field value
is not blank, then a new folder is created, whether or not the index field value matches that of an
existing folder.
The key concept with this method is that a folder is created when any non-blank value is recognized,
even if it is the same value repeatedly. You may find this useful in cases in which "special"
documents are inserted in the batch to flag the beginning of a new folder. For instance, a particular
document may have a patch code that always indicates the creation of a new folder. It is the
sequence of these documents, not the value, that identifies the folder grouping.
However, if no folders exist, and a document with a blank index field is processed, the document is
rejected with the following note:
Automatic Folder Creation Error - Creation by Sequence rule requires a
non-null value or existing folder.

Automatic folder creation stops at this point, and no further documents are processed. Prior folder
creation results are retained. This method assumes you have already organized your documents into
logical folder groups outside Kofax Capture.

Folder Creation Scenarios
Scenario 1: Single Level Folders by Social Security Number

Imagine you want to collect the performance reviews of multiple employees into folders for each
employee, based on the social security number. Each time the social security number changes, a new
folder is created. Assume that the batch class contains a single folder class called "Employee Records"
with a folder index field called "SSN" (Social Security Number).

Assume that the batch class also contains a single document class called "Annual Review" with a
document index field called "SSN." In this example, you intend to put a bar code on every annual review
with the social security number, and have that value placed into the document index field "SSN."

To implement this example, first configure Kofax Capture to automatically read this data and place it into
an index field.
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You also decide to put a generic patch code on each document to allow document separation.

Next, enable folder creation, and set up a single folder creation rule, similar to the following example.

Single Folder Creation Rule

After publishing the batch class, scan a batch that contains documents from various employees in no
particular order. For each unique SSN, a folder is created. This folder contains all documents with a
matching SSN.

Scenario 2 - Single Level Folders by Patch Code

In this case, you want to identify all documents associated with a particular insurance claim where the
claim number serves as the folder key, yet it is not assigned until later in the workflow. Assume that the
batch class contains a single folder class called "Insurance Claim" with a folder index field called "Claim
Number." Also, the folder class includes an additional, hidden index field called "Folder Start."

Assume further, that the batch class also contains a single document class called "Claim Document" with
a hidden index field called "Folder Start. "

Finally, in this example, "Folder Start" is filled at scan time with a bar code, and document separation is by
patch code.

To implement this example, first configure Kofax Capture to automatically read this data and place it into
an index field.

Next, enable folder creation, and set up a single folder creation rule, as shown in the example.

Single Folder Creation Rule

After publishing the batch class, sort the claim documents corresponding to a claim number and place a
patch code sticker on each for document separation. Additionally, on the first document of each group (of
claim numbers), place a bar code sticker on the front. Note that the bar code is the same for all groups.

Next, scan the batch. When the batch is closed, folders are created around each collection of documents.
Each time a document with a bar code is detected, a new folder is generated. Because the other
documents in the group do not have a bar code, a blank or null value is returned, meaning that a folder is
not created.

Note that the folders do not yet contain the Claim Number index value. The validation operator manually
reviews each claim, and enters a claim number into the Claim Number folder index field.

Scenario 3 - Document Classes without Automatic Folder Creation Rules
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There may be cases in which you want multiple document classes within a single folder. In such cases, it
is likely that only one of those document classes would serve as a trigger for creating the folder.

For instance, a particular form might occur in the batch that indicates that a new folder should be created,
and that has a key folder index field for that folder. Subsequent documents of various other document
classes should be placed in that folder, but do not contribute any values to that folder, nor do they trigger
creation of a new folder.

In this case, set up a folder creation rule for the document class that triggers folder creation; rules are
not needed for the other document classes. During automatic folder creation, documents with document
classes that do not trigger a new folder are placed in the most recently created folder. If no folder is
created by the algorithm, then the last folder is used.

Note that a document with no form type still follows these rules. It has an implied document class of
"none," which never has an automatic folder creation rule associated with it.

Scenario 4 - Multiple Document Classes per Folder Class

There may be cases in which you want multiple document classes to create multiple folders using the
same folder class. In other words, you have several kinds of documents that should all go into the same
folder.

The auto-foldering rules might look something like the following example.

Auto-Foldering Rules

Scenario 5 - Multiple Folder Creation Rules per Document Class

It is possible to have multiple folder creation rules that involve the same document class and folder class,
but use different index fields.

For instance, assume that a document has two bar codes: one that indicates SSN and one that indicates
Name. If you want both the SSN and the Name to be automatically populated in new folders, then two
automatic folder creation rules would need to be created, one for each field.

Auto-Foldering Rules

You cannot have two folder creation rules with the same document class, document index field, folder
class, and folder index field.

If your folder rules use one of the "create by value" methods, then if any of the document index fields
involved in folder creation don't match, a new folder is created. Keep in mind that a blank field may act as
a "wildcard" character in these cases.
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Blank values act as wildcard characters, in that they match any existing folders with the appropriate folder
class, irrespective of the value. If there is more than one matching folder, then the last one is used.

If your folder rules use "Create when Value is Not Null," then if any of the document index fields involved
in folder creation are not blank, a new folder is created.

Multiple Levels
The preceding scenarios have been limited to single-level folder hierarchies. In some cases, you may
wish to classify documents based on a multilevel folder hierarchy. Folder creation rules in these cases can
become quite complex.

When there are rules involving multiple levels, each level is evaluated independently, with level 1 first,
level 2 next, and so forth up to the nesting limit of 32,000 levels. After evaluating the rules for a particular
level, the rules for the next level only apply to the sub-hierarchy selected (or created) by the rules at the
prior level.

All the rules for a particular level must have the same creation rule. In other words, mixing creation rules
within a level is not allowed.

All the rules with the same folder class and document class must be at the same level. This means that
they must also have the same creation rule. If there are no rules for a particular level (but there are rules
for higher levels), then the system chooses the last existing folder at that level (irrespective of folder
class).

If there are no creation rules for the current level, and no folders at that level, the document is rejected
with the following note:

Automatic Folder Creation Error - No rules for level <n>, and no existing
folder.

Automatic folder creation stops at this point, and no further documents are processed. Prior folder creation
results are retained.

Scenario 6 - Multiple Level Folders by Social Security Number, and Document Type

Assume that the Annual Review example is extended, so that multiple kinds of documents are involved. In
this case, you want to classify the document first based on SSN, and second, based on document type.

The folder class "Employee Records" is used from the first scenario. Another folder class called
"Employee Documents" is added to the batch class with a folder index field "Document Type." Also,
assume that the document class "Annual Review" is replaced with a more general purpose document
class called "Employee Document" with two index fields: SSN and Document Type.

Document separation is performed by patch code, as in the first example.

A bar code on every document indicates the social security number, which is used to populate the SSN
document index field. Additionally, a second bar code indicates the document type.

Configure Kofax Capture to automatically read this data and place it into the Document Type index field.
Next, enable folder creation, and set up rules.
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Auto-Foldering Rules

When you scan a batch of documents, the batch contains various document types from various
employees in no particular order. Under these rules, for each unique SSN, a top-level folder is created.
For every unique document type found with that SSN, a subfolder is created. 

Copying a Folder Class
Use Copy to duplicate an existing folder class. You can copy folder classes to do the following:
• Use an existing folder class to create a new folder class with similar features.
• Copy an existing folder class to another batch class.

When you paste a copied folder class, it is given a different name, such as Name1, Name 2, or Name3.
You can then modify the folder class as needed. When copying a folder class, the following items are
copied and linked to the copied folder class:
• Folder validation scripts
• Setup custom storage strings

Copying a Folder Class to the Folder Class Tree View Tab
1. On the Batch class tree view tab or the Folder class tree view tab, select an existing folder class.
2. On the Home tab, in the Clipboard group, click Copy.
3. On the Folder class tree view tab, select an existing folder class.
4. On the Home tab in the Clipboard group, click the arrow under Paste and then click Paste.

A copy of the folder class is created with a unique name, such as Name2 or Name3.
5. Edit the copied folder class from the Folder Class Properties window.

Copying a Folder Class to a Batch Class
1. On the Batch class tree view tab or the Folder class tree view tab, select an existing folder class.
2. On the Home tab, in the Clipboard group, click Copy.
3. On the Batch class tree view tab, select the batch class to which you want to copy the folder class.
4. On the Home tab, in the Clipboard group, click the arrow under Paste and then click Paste.

A copy of the folder class is created with a unique name, such as Name1, Name2, and Name3. The
copied folder class is associated with the selected batch class.

5. Edit the copied folder class from the Folder Class Properties window.

Note If you perform a copy and paste on a previously copied folder class such as Name2, the new folder
class is created with a unique name such as Name21, Name22, and Name23.
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Creating a Folder Class
You create folder classes (which can be used for auto-foldering) with the Create Folder class window in
the Administration module.

1. On the Insert tab, in the Create New group, click the arrow under Folder Class, and then click New
Folder Class.

2. On the Create Folder Class window - General tab, enter the name for the folder class.
You can enter up to 32 characters, including spaces (leading and trailing spaces are removed). The
name, which must be unique, is not case-sensitive.

3. Enter a description for the folder class.
You can enter up to 80 characters.
The description appears whenever folder class properties are displayed.

4. Define the index fields to be associated with the folder class:

a. Click the New Index Field button.
Default information for a new index field is appended to the list of index fields in the Index
Fields table. You can edit any of the default values as necessary.

b. Change the name for your index field.
You can enter up to 32 characters, including spaces (leading and trailing spaces are removed).
The name, which must be unique, is not case-sensitive.
By default, index field names are added in the form Namen (where n is a value from 0 to the
maximum number of index fields). Since the name of the index field appears (unless you specify
a display label) during validation and verification, select names that are meaningful to your
validation and verification operators.

c. Select a field type for your index field from the Field Type drop-down list. To define new field
types, click the New Field Type button.

d. Specify a default value. You can enter a value, or select from the list of Kofax Values. If
specified, the default value is displayed as data in the index field during validation. The
validation or verification operators are able to enter a different value.

e. Select True or False in the Required column.
If you select True, the index field is required to contain a value during validation. The validation
and verification operators are not allowed to close the batch until a value is entered for this field.

f. Select True or False in the Verify column.
If you select True, the index field must be verified in the Verification module after being
processed in the Validation module.

g. Select True or False in the Hidden column.
If you select True, the index field is not shown to the validation or verification operators. This
might be useful for certain types of processing. For example, you might want to collect values
during validation, and compare them by using a validation script. The results can then be
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assigned to a non-hidden index field. Or, you might want to set values in a script that you do not
want the validation or verification operators to change.

h. Select True or False in the Sticky column.
If you select True, the value of this index field for one folder is carried over to the next folder.
The validation or verification operator can override the value in the subsequent folder if
necessary.
If you specify "Sticky" and a default value, the default value is used and the "Sticky" attribute is
ignored.

5. Click Apply to save your settings without closing the window.
6. Click OK to save your settings and close the window.

Deleting a Folder Class
1. On the Folder class tree view tab, select the folder class to delete.
2. On the Home tab, in the Edit group, click the arrow next to Delete and then click Delete.

Deleting a Folder Class from a Batch Class
Use this procedure to delete a folder class from a batch class. The folder class is still available after
deletion, but it is no longer associated with the batch class.

1. On the Definitions panel, click the Folder tab and select the folder class that contains the document
class to remove.

2. Do one of the following:
• On the Home tab, in the Edit group, click Remove.
• Right-click and select Remove.

3. When prompted to confirm removal of the document class from the batch class, click Yes.
4. Republish the batch class.

Editing a Folder Class
1. On the Folder class tree view tab, select the folder class to edit.
2. On the Home tab, in the Editing group, click Properties.

The Folder Class Properties window appears.
3. On the Folder Class Properties window, edit the properties.
4. Click Apply to save your settings without closing the window.
5. Click OK to save your settings and close the window.

You must publish your batch class before your changes are applied to batches. Your changes cannot be
applied to batches created before the new publication date.

Renaming a Folder Class
You can rename a folder class on the Batch class tree view tab, the Folder class tree view tab, or the
Folder Class Properties window. When renaming a folder class, be aware of the following:
• New folder class names go into effect when you republish the batch class associated with them.
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• After you rename a folder class, any existing batches created under the original folder class name
retain their references to the original name.

• Duplicate folder class names are not allowed.
• If a renamed folder class uses an export connector referring to the folder class name, you must update

each folder class name reference in the connector settings.

Renaming a Folder Class on the Batch/Folder Class Tree View Tabs
1. On the Batch class tree view tab or the Folder class tree view tab, select a folder class.
2. On the Home tab, in the Editing group, click Rename.
3. Type the new name.
4. Press Enter to save the new folder class name.

Renaming a Folder Class on the Folder Class Properties Window
1. On the Batch class tree view tab or the Folder class tree view tab, select a folder class.
2. On the Home tab, in the Editing group, click Properties.

The Folder Class Properties window appears.
3. Update the Description field.
4. On the Folder Class Properties window, click in the Name field and replace the existing name with

a new name.
5. Click Apply to save the new folder class name without closing the window.
6. Click OK to save the new folder class name and close the window.

Image and Recognition Profiles
Profiles are a sets of saved settings that can be used to speed up the creation of batch classes and other
definitions. Kofax Capture supports several types of profiles.

Image Cleanup Profiles
An image cleanup profile is a preset combination of settings for cleaning up images. You specify an image
cleanup profile at the form type level and anywhere you specify a recognition profile.

Image cleanup profiles provide an efficient and convenient way to specify image cleanup settings for a
process. Each profile specifies one or more image cleanup features, along with all their related settings.
You can define a pool of image cleanup profiles, and then select from this pool whenever you are setting
up a process that uses the image cleanup features.

Kofax Capture supports a set of Kofax-defined image cleanup profiles, which combine default settings for
the most common processing tasks. You can also define, name, and test (using QuickZones) your own
custom profiles.

Note Color images use a separate image cleanup profile that is optimized for color files. See Color
Documents for more information.
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Image Compression Profiles
An image compression profile is a preset combination of settings for compressing images. You specify an
image compression profile at the document type level and anywhere you specify a recognition profile.

Image compression profiles provide an efficient and convenient way to specify image compression
settings for a process. Each profile specifies one or more image compression features, along with all
their related settings. You can define a pool of image compression profiles, and then select from this pool
whenever you are setting up a process that uses the image compression features.

Kofax Capture supports two Kofax-defined image compression profiles: Kofax PDF and None. Kofax PDF
provides the default settings for PDF compression; None disables PDF compression.

Recognition Profiles
A recognition profile is a preset combination of settings for automatically recognizing and capturing data.
You can specify a recognition profile whenever you define the following types of processing:
• Bar code recognition
• Patch code recognition
• Form identification
• OCR Full Text processing
• Zone processing
• PDF and and Image recognition

Recognition profiles provide an efficient and convenient way to specify recognition settings. Each profile
combines a recognition engine (such as bar code recognition, zonal OCR, and others), all associated
recognition settings, and an optional image cleanup profile. You can define a number of recognition
profiles, and then select from this pool whenever you set up an automatic recognition process.

Kofax Capture ships with a set of Kofax-defined recognition profiles, which combine default settings for
the most common types of automatic recognition. It also allows you to define, name, and test (using
QuickZones) your own custom profiles.

Selecting Recognition Profiles

A recognition profile specifies a recognition engine and its associated settings, along with an optional
image cleanup profile.

You can define recognition profiles that use the following recognition engines:
• Optical Character Recognition (OCR): Recognizes machine printed characters and translates them into

computer-readable data.
• Kofax PDF Generation: Recognizes machine-printed characters and converts them into PDF files.
• Intelligent Character Recognition (ICR): Recognizes handwritten alphabetic and numeric data and

translates it into computer-readable data.
• Optical Mark Recognition (OMR): Recognizes pencil or pen marks in specific document positions and

translates the marks into computer-readable data.
• Shape recognition: Identifies shapes based on their geometric characteristics, and translates the

shapes into numeric data.
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• Bar code recognition: Reads bar codes and translates them into ASCII values. Bar code recognition is
a reliable method for capturing data field information, separating documents in a batch, or identifying
forms.

• Patch code recognition: Recognizes a patch code on a page and uses it to separate documents.
• Page recognition: Identifies forms based on their physical characteristics. You scan or import a sample

page, which Kofax Capture "learns." Then, whenever you scan that same type of form, Kofax Capture
can recognize the form and automatically identify it.

Recognition Engines
Kofax Capture supports the following recognition engines:
• Bar code
• Form identification
• ICR
• OCR Zonal and OCR High Performance
• OCR Full Text
• OMR
• Patch Code

Font Samples
The following samples show the specialized fonts supported by certain Kofax Capture recognition
engines. Note that these are samples only, and do not represent the full set of supported characters for
each font.

Farrington 7B

Farrington 7B is used by the Kofax High Performance recognition engine.

OCR-A

OCR-A is used by the Kofax High Performance recognition engine.
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CMC7

CMC7 is used by the Kofax High Performance and the Kofax Advanced OCR recognition engine.

OCR-B

OCR-B is used by the Kofax High Performance recognition engine.

E13B

E13B is used by the Kofax High Performance and the Kofax Advanced OCR recognition engine.

Using the Kofax Advanced OCR Zonal Engine
On some forms, you may need to process OCR characters in an index zone. The Advanced OCR Zonal
engine may yield better results than the other zonal OCR engines when the zones contain lengthy strings
of text (instead of a single number or name).

You can select the Advanced OCR Zonal engine for the following zone types:
• Index Zone
• Separator Zone
• Form ID Zone

The Advanced OCR Zonal engine cannot be used with registration zones.

The following procedure assumes that your document and batch classes already exist. If not, you can
make these selections while creating new classes.

1. Open the Batch Class Properties window.

a. Click the Queue tab.

b. Add the Recognition module and other required modules.

c. Click OK.
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2. On a sample form, draw an index zone around the text.
The Create Index Zone window appears.

3. Configure the zone to use Kofax Advanced OCR Zonal.

a. Select the Auto Recognition check box.

b. Select the Kofax Advanced OCR Zonal engine from the profiles list.

c. Click Edit and make adjustments to the settings. Note that this requires saving the profile under
a new name.

d. Click Test to verify the accuracy of your results based on the sample page.

e. Click OK.
4. Publish the batch class.

Color Support
Kofax Capture offers full data capture capability for color images. You can scan in a document and save it
as a color image file.

As it processes the documents in a batch, Kofax Capture keeps watch for color images. When one is
discovered, the image is first deskewed. Next a bitonal (black and white) copy is created. The bitonal
image is processed by Kofax Capture as if it were originally scanned in black and white. The following
graphic shows a portion of a document after the color has been removed.
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Converting a Color Document into Black and White

Color images offer less contrast and contain more information than bitonal images. Color file sizes can
be larger than an identical black and white image; up to 24 to 32 times larger. It takes proportionally more
time to process color images. Everything from a simple deskew filter to complex edge detection could
require more time and put an extra burden on your workstations and networks.

Kofax Capture can overcome many of the drawbacks of working with color image files. It intelligently
manages this extra burden by converting the color image to a bitonal image the first time it is needed.
Depending on a number of factors such as image size, workstation capabilities, network load, and others,
it may take several seconds to convert a color image to bitonal. For this reason, the bitonal image is only
created once. To maximize scan performance, this conversion is not automatically done at scan time, but
rather the first time a bitonal image is required by one of the Kofax Capture modules.

Once a bitonal image has been created, it is saved and can be reused as the batch travels from module to
module.

Since Kofax Capture offers flexibility in how you process batches, each module (that needs to) creates
and saves a bitonal image if one doesn’t already exist. The only exception to this is in the Administration
module when using QuickZones. QuickZones creates bitonal images of the sample page for zone testing
purposes, but does not save them (since samples are not a part of the batch).

Use the Color Image Cleanup Profiles window to toggle deskewing as well as adjust the brightness and
contrast thresholds. As with bitonal images, deskewing color files can lead to distortions in the resultant
image.
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Compression
Kofax Capture internally stores color images as JPEG compressed TIFF files. This is a "hybrid" graphics
format that falls within the TIFF file specification.

Note If you attempt to open this kind of TIFF file in a third-party application, you may encounter
difficulties. JPEG compressed TIFF is a rarely used format, and some applications may not recognize
the file structure.

There are two broad classes of compression: lossy and lossless.
• Lossy compression shrinks a file by throwing away information. This information cannot be recovered

when the image is opened for viewing. Most lossy compression schemes attempt to discard
information that is not critical or very visible to the eye, but as the rate of compression is increased,
the missing information becomes more noticeable.

• Lossless compression schemes retain all information. When the file is decompressed, it looks exactly
like the original. A lossless compression scheme cannot compress a file as much as a lossy scheme.

JPEG is a lossy method of compressing files, and so quality becomes an issue.

The JPEG standard permits variable compression rates that allow you to trade file size (amount of
compression) against image quality. The more highly compressed an image, the worse the image quality
becomes.

This tradeoff is made with the quality setting when you save a document using JPEG compression. A
quality setting of 100 percent (the maximum) yields the best image, but with minimal compression.

Automatic data capture is very sensitive to the image quality. Good OCR results require a high-quality
setting, usually 100 percent. Bar codes and patch codes can usually be recognized with quality settings as
low as 75 percent (in ideal cases, it could even be lower).

Important Notes about Color Support
Sample Pages and Color:
• Both bitonal and color sample pages are normally deskewed. However, this step is skipped if “Deskew

Sample Images” is not selected.
• Color sample pages are displayed in color in the Administration module and in the image viewer. When

making use of color sample pages, keep in mind that (depending on the colors) it may be difficult to
view the zones on the page. For example, index zones are shown on the sample page with green
rectangles. If the sample page has a green background, then these rectangles may be difficult to view.

Color Profiles:

Kofax Capture ships with three standard color profiles:
• None: This profile turns off all color processing except thresholding.
• Kofax Color Photo: This is the default profile, and is optimized for image files with color photographs.

Deskewing is turned off.
• Kofax Color Image: This profile is optimized for color forms. Deskewing is enabled.

Publishing:
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Batch classes with color sample pages may take somewhat longer to publish than if all the images are
bitonal.

Scanning and Separation:
• Color images are not deskewed in the Scan module. All deskewing for color images takes place in the

Recognition Server.
• If the Scan module performs automatic separation, it treats color images as if they were blank.
• When separator sheets are used at scan time, a warning message appears if the first page is not

a separator. However, this warning is suppressed if the first page is color because Kofax Capture
assumes separation on color documents is done in the Recognition Server. Once this has occurred, all
separation is ignored for the duration of the scan.

• Fixed page separation can be used at scan time with color images. Other methods of separation that
rely on reading values from the color image (such as bar codes) cannot be performed by the Scan
module. These types of separations are done in the Recognition Server.

• The Scan module also marks color documents for auto-recognition so that they are processed by the
Recognition Server.

Recognition Server:
• If a bitonal image has not already been created, the Recognition Server creates one. When color

image files are deskewed or converted to bitonal by the Recognition Server, the message "Enhanced
document" displays in the event log. (This message is also used if permanent bitonal image cleanup is
set for the form type.)

• Once a bitonal image is created, it is available to the various recognition scripts for processing. All
automatic recognition is done on bitonal images.

• The Recognition Server performs permanent image cleanup on bitonal images. Other modules (custom
modules for example) may need a clean bitonal image after the Recognition Server is through with it.

Image Viewer Support
• The Scan, Validation, Verification, and Quality Control modules all have an image viewer that can

display color documents. Color display is turned on by default but can be turned off by checking “View
Bitonal Image” on the View tab, in the Display group. When checked, it forces the image viewer to
display the bitonal version of the color image for the current page. As soon as the page is switched, the
image viewer reverts to showing color images.

• In the image viewer, you can rotate the view of the page. If you are rotating a color image, its
corresponding bitonal image must also be rotated. Consequently, the rotation process takes somewhat
longer. Not only do you have more pixel information to rotate in the color image, but you have to rotate
an entirely separate (and usually hidden) bitonal image as well.

• The same applies to bitonal images in the image viewer. If you rotate a bitonal image, any
corresponding color image also needs to be rotated.

Color Documents
You don’t have to do anything special to use color document images in Kofax Capture. The feature is
always available, and operates automatically in the background. By default, when Kofax Capture detects
a color image, it converts it to a bitonal image and carries on with the processing. If the image is not color,
the conversion is skipped and processing continues. 

In most cases, the default color settings work just fine. If adjustments are necessary, use the Color Image
Cleanup Profiles window.
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The "Kofax Color Photo" profile is the default setting. If you set it to "none," color image cleanup does
not occur. Color documents can still be scanned and exported with the batch, but a bitonal version is not
created and automatic recognition features are turned off.

If your batch contains color images, keep the following points in mind:
• Color images are larger and take longer to process.
• Color images take longer to send over your network or the Internet. You may find that your current

network cannot meet the added demand.
• You can import color images as sample pages.
• Sample pages are automatically deskewed. If you are not happy with the results of the deskewing

process, you can temporarily disable it on the Scan Settings tab, in the Settings group.
• Good OCR and ICR results require resolutions of at least 200 dpi; 300 dpi is preferred. You should also

use the highest JPEG quality setting. OCR results with lower resolutions or quality may be problematic.
In general, larger characters yield better results than smaller text as resolution or quality drops.

• OCR accuracy may be dramatically improved simply by turning on the fill line breaks and thickening
image processing options. In many cases, this appears to repair the fuzziness caused by JPEG
compression. This suggestion may not help for every document, but it should improve OCR accuracy in
a significant number of cases.

• If you create a custom module that will be exposed to color images, it must be able to:
• Detect a color image.
• Reference the bitonal image for a given color page if it comes after the Recognition Server in the

queue list.
• Modify a color image if it comes before the Recognition Server in the queue list.

• Automatic separation by patch code, bar code, or Kofax Separator Sheets treats color images as if they
were blank pages in the Scan module.

Note Kofax Capture only supports 24-bit .bmp files. If you attempt to import .bmp files with a different
color depth, an error message occurs. To avoid the error, ensure that all .bmp files are 24-bits prior to
importing them into Kofax Capture.

Shape Recognition Limitations
To get reliable results, your shapes must meet the following minimal requirements. Shapes that do not
meet these requirements may still yield acceptable results, but performance of the recognition engine
cannot be predicted beyond these limits. If you have a shape that falls outside these guidelines, you may
need to experiment with it.
• The line thickness must be at least 2 pixels.
• The line length must be at least 20 pixels.
• The line must be at least 5 times the thickness, but cannot be less than the 20 pixels already specified.
• The edges of a quadrant must be least 20 pixels in both directions.
• Each column and row of the quadrant must be at least 90% black.
• For the vertical edge, the sum of vertical pixels of the shape (after the image has been deskewed) must

go from less than a minimum line width to a density of 90% in 4 pixel columns. The horizontal edge
must also meet an analogous specification.

• The general shape must contain at least 1400 black pixels and no more than 10% white pixels.
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• The skew cannot be greater than 1 in 5 (approximately 11 degrees).

Note These requirements are specified in pixels because shape recognition happens at the pixel level.
At 200 pixels per inch, 20 pixels is 0.1 inches or 2.5 mm.

Defining a Custom Image Cleanup Profile
You can define a custom image cleanup profile on the Image Cleanup Profiles window.

1. On the Tools tab, in the Image Profiles group, click the arrow under Cleanup, and then click B & W
or Color.

2. Select the name of an image cleanup profile on the list. The other options on the window change to
indicate the settings defined for that profile.

3. Select and configure one or more filters:

a. Select a filter from the list of Filters.
Custom options for the filter appear in the Custom Settings frame.

b. Select the options for the filter:
• Black Border Removal
• Deshade
• Deskew
• Despeckle
• Horizontal Line Removal
• Streak Removal
• Vertical Line Removal
• Edge Enhancement

c. Repeat substeps a and b for each filter to select.
4. Click Save As to save your settings without closing the window.
5. Click Save to save your settings and close the window.

Defining a Custom Image Compression Profile
You can define a custom image compression profile on the Image Compression Profiles window.

1. On the Tools tab, in the Image Profiles group, click Compression.
2. In the Name box, select an existing name or create your own custom profile using Save As.

For the following Kofax PDF Compression settings, we recommend that you accept the default
settings because they are preset to produce the best results for a variety of documents.

3. Optionally adjust the Sensitivity. High settings preserve faint data; low settings suppress textured
backgrounds.

4. Optionally adjust the Background quality.
The background is rendered as a compressed image, and this parameter controls the quality of this
image. A high setting increases quality, but decreases compression, increasing file size; a low setting
reduces quality, but increases compression, reducing file size.
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5. Optionally select Picture detection and adjust the Quality.
Pictures are rendered as compressed images. This option adjusts picture quality and file size. For
each of these parameters, high settings increase quality but increase file size; low settings reduce
quality and reduce file size.

6. Click Save As to save your settings without closing the window.
7. Click Save to save your settings and close the window.

General Guidelines
• In general, use the default values.
• Set scanning resolution to 300 DPI or higher if very small font sizes are expected.
• Set the lowest possible compression ratio for any other modules that process images before they are

processed by Kofax PDF Compression.
• If a batch does not contain any pictures, save processing time by not selecting Picture detection.
• If documents have highly textured backgrounds, such as transcripts, decrease the sensitivity to

suppress the background; to strengthen any weak data, increase the sensitivity.
• Both quality sliders control the trade-off between image quality and file size.

Limitations

Kofax PDF Compression has no effect on the following types of images and files:
• Black and white images compressed using JBIG2
• Color and gray scale images with a resolution that is lower than 140 DPI

Defining a Custom Recognition Profile
You can define a custom recognition profile on the Recognition Profiles window.

To display this window:
• On the Tools tab, in the Recognition group, click Profiles. When the window is displayed this way, you

can define one or more custom recognition profiles that are available for selection when you set up an
automatic recognition process.

• On any window from which you set up bar code recognition, patch code recognition, form identification,
or zone processing, click the Edit button. (All windows from which you can select a recognition profile
contain a list of predefined profiles and an Edit button.)

To define a custom recognition profile, you must start with a predefined profile. Then, you can modify the
settings and save them to a new name. If you select a Kofax-defined profile, the settings are the defaults
for the associated recognition engine.

1. Select the name of a predefined recognition profile from the list.
2. Select settings for your new profile.
3. Select an Image Cleanup profile from the list. If none of the profiles is appropriate for your needs,

click the Edit button.
The Image Cleanup Profiles window appears so that you can define a custom profile.

4. Click Save As to save your settings without closing the window.
5. Click Save to save your settings and close the window.
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Selecting an Image Cleanup Profile
You can select an image cleanup profile from any window where you set up image cleanup settings. For
example:
• On the Create Form Type window, on the Image tab; or on the Form Type Properties window, on the

Image tab, you can select an image cleanup profile for permanent image cleanup.
• On the Recognition Profiles window, you can select an image cleanup profile to associate with that

recognition profile.

1. Select a predefined image cleanup profile from the list.
You can select one of the Kofax-defined profiles as listed below, or any custom predefined profile
from the list.
• Kofax Dot Matrix OCR
• Kofax Form Identification
• Kofax ICR
• Kofax OCR
• Kofax OCR Full Text
• Kofax Scan

2. Save your selection as appropriate for the window.
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Selecting a Recognition Profile
You can select a recognition profile from any window from which you set up bar code recognition, patch
code recognition, form identification, or zone processing. The windows contain a list of predefined profiles.

1. Select a predefined recognition profile from the list of profiles. You can select one of the Kofax-
defined profiles as listed below, or any custom predefined profile on the list.
• Kofax 128 Bar Code
• Kofax 3 of 9 Bar Code
• Kofax Advanced OCR Zonal
• Kofax Enhanced OCR Zonal
• Kofax Advanced OCR Full Text
• Kofax Enhanced OCR Full Text
• Kofax PDF Image +Text
• Kofax PDF Image Only
• Kofax Enhanced PDF Image Only
• Kofax PDF Text Under Image
• Kofax Enhanced PDF Image On Text
• Kofax High Performance ICR Zonal
• Kofax High Performance OCR Zonal
• Kofax ICR Zonal
• Kofax OMR Zonal
• Kofax Patch Code
• Kofax Shape Zonal

2. Save your selection as appropriate for the window.

Note If none of the predefined profiles is appropriate for your needs, you can define a custom
recognition profile. Any window from which you can select a recognition profile also allows you click the
Edit button to define a custom profile.

Advanced Page Registration
Kofax Capture’s page registration feature can "register" images by comparing them to their associated
sample page. If necessary, zones are adjusted to match the sample page. By default, page registration is
enabled for all pages that contain one or more zones.

The page registration feature is very robust and can correctly register a wide variety of forms. In some
cases, though, you may get better results by turning off page registration and using an OCR registration
zone instead.

You can turn off page-level registration on the Create Form Type window - Image tab or the Form Type
Properties window - Image tab by setting the confidence for page registration to 0.

For information on creating an OCR registration zone, refer to Creating an OCR Registration Zone.
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In some situations, as noted here, you may want to turn off page registration or adjust its confidence to a
low setting.

Note You should always test your settings with sample batches that are representative of the ones to be
processed during production.

In some situations, as noted here, you may want to turn off page registration or adjust its confidence to a
low setting.

Images with Varying DPIs
If you are processing images with varying dpis or images with a different dpi than their associated sample
pages, page registration will fail.

One solution is to create multiple form types with identical settings, but use sample pages scanned at all
expected dpis. For example, consider this scenario: You know that some of your forms are scanned at 200
dpi and others are scanned at 300 dpi. To account for the differences in dpi, you can create one form type
with sample pages scanned at 200 dpi and another form type with identical settings and sample pages
scanned at 300 dpi. This could improve page registration.

If the preceding solution does not work (for example, you have no way of knowing the dpis of the images
to be processed), you can use an OCR registration zone instead.

Distorted Images
Scanning forms printed on very thin paper (such as onion skin or pressure-sensitive multipage form
paper) may produce "stretched" or otherwise distorted images. Distorted images are typically the result of
how a scanner’s feeding mechanism pulls the pages through the scanner. Since the scanner won’t distort
all images in exactly the same way, the results of page registration could be very low.

Even with the distortion, it may be possible to identify an area on the image that can be used as a reliable
OCR registration zone. If so, you should turn off page-level registration and rely on an OCR registration
zone to register your images.

Image Variations on Sample Pages
Some forms contain sections that are standard, and other sections that can vary from form to form. For
example, the top half of a form might have a standard header format and is always filled in the same way.
The bottom half of the form might be non-standard and contain free-form data.

If you are processing this type of form, page-level registration will fail. One solution is to scan a sample
page with the free-form section "blanked out." (For example, you can tape a white sheet of paper over the
free form area.) Since the confidence won’t be as high, you may need to lower the confidence threshold.

Another solution is to turn off page-level registration and rely on an OCR registration zone to register your
images.
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Images with More Data Than Sample Pages
Sometimes, the images you are processing contain more filled-in data than the sample pages. For
example, the images used as samples might have few fields filled in while the images in your batches
have many fields filled in. If the differences are significant, the results of page registration could be low.

One solution is to rescan your sample pages with forms that are more representative of the batches you’ll
be processing. This could improve page registration. If this is impossible to do, you should disable page-
level registration and rely on an OCR registration zone to register your images.

Performance Issues
As a rule of thumb, page registration takes about 1 second per page, whereas processing an OCR
registration zone takes about a third of a second.

For best results, you should use either page registration or an OCR registration zone. If the overhead of
page-level registration is a problem, you can turn it off and rely on an OCR registration zone. You can use
QuickZones to interactively check the recognition profiles you set up for page registration.

Bar Code Recognition
A bar code is a machine-readable pattern of dark and light elements in which data is encoded. The data
can include numbers, alphanumeric characters, special characters, and other information. Reading bar
codes is one of the most accurate methods for capturing data from document images.

Kofax Capture can recognize individual bar codes found in predefined zones on a document. This type
of zone-level processing is well-suited for bar codes that are always found in the same location on each
document.

Alternatively, Kofax Capture can recognize a specified number of bar codes that may be found anywhere
on a document page. This type of page-level processing is well-suited for reading bar codes that are
found on a page, but not always in the same location. For example, the bar codes may be printed on
stickers that could be applied anywhere on a document.

During a bar code recognition operation, the document image or zone being processed is searched
for possible bar codes. If a potential bar code is found, it is examined to determine if it satisfies the
requirements for the operation. For example, the physical characteristics of the candidate bar code (such
as bar code type) are checked against the recognition settings you specified in your recognition profile. If
the candidate bar code meets all the requirements, it is decoded and its ASCII data is returned for use in
further processing.

For example, data returned from a bar code may be used to:
• Fill one or more index fields
• Separate documents and/or batches
• Identify forms
• Key into a database record, allowing index fields to be filled with values from the record
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Where Bar Code Recognition Occurs
In Kofax Capture, bar code recognition occurs in various modules as follows:

Module/Feature Activity Type of Processing

Administration When testing zones Zone-level bar codes
Page-level bar codes

Scan
Quality Control

When scanning from a scanner or
importing documents

Page-level bar codes
Document separation based on bar
codes1

Batch separation based on bar codes

Recognition Server When using automatic recognition
techniques to process documents

Zone-level bar codes
Page-level bar codes (when used
with zone-level bar codes 2)

Auto-import, XML Import Connector,
or custom import scripts

When importing documents with the
XML Import Connector module, a
custom import script, or the standard
Auto-Import feature

Page-level bar codes
Document separation based on bar
codes

1 When processing color images with the Standard Bar Code Engine, document separation based on bar
codes is performed in the Recognition Server module. See Using Bar Code Separation for details.
2 Under certain conditions, page-level bar codes used with zone-level bar codes are processed in Scan,
rather than Recognition Server. Refer to Page Level Bar Code Processing for details.

Note When single document processing is enabled, bar code document separation converts each
separated document into an individual batch, then automatically closes the batch before separating the
next document.

Enhanced Versus Standard Bar Code Engine
Kofax Capture supports an Enhanced Bar Code Engine and a Standard Bar Code Engine. Both engines
process color and bitonal images as described below:

With the Enhanced Bar Code Engine, you can process color bar codes directly from color images with a
dpi as low as 100. You can also process one-dimensional and/or two-dimensional (2-D) bar code types
with this engine. It is typically more accurate than the Standard Bar Code Engine, especially for low-
quality or low dpi images. However, the Enhanced Bar Code Engine may be slower than the Standard Bar
Code Engine. The Enhanced Bar Code Engine requires additional licensing.

With the Standard Bar Code Engine, color images are internally converted to their bitonal (black and
white) equivalents. Then, any Kofax Capture module processing the images uses the bitonal version.
You can process one-dimensional bar code types with this engine. It is typically faster than the Enhanced
Bar Code Engine, but less effective with low-quality or low-dpi images. With this engine, best results are
achieved with 200 dpi images or higher. No additional licensing is required.
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Bar Code Recognition Profiles
Bar code recognition settings are defined in recognition profiles, which are used by all modules that
process bar codes. You define recognition profiles with the Recognition Profiles window when you set up
your batch classes in the Administration module.

Note that if the Enhanced Bar Code Engine is enabled for a recognition profile, but the required licensing
is not in place, the Standard Bar Code Engine are automatically be used. Processing for which a 2-D bar
code type is specified produces empty results. No warnings or messages appear.

An exception to this is when you test zones on sample pages from the Administration module. If the
Enhanced Bar Code Engine is enabled, but the required licensing is not in place, empty results are
returned. However, a warning appears in the Results area of the Zone Test window.

You can enable or disable the Enhanced Bar Code Engine with a recognition profile, which you define
from the Recognition Profiles window. If the Enhanced Bar Code Engine is enabled for a profile, and the
required licensing is in place, it is used whenever that profile is used.

Document Separation with Bar Codes on Color Images
When processing color images with the Enhanced Bar Code Engine, separation based on bar codes is
performed at scan time, either with the Scan module or the Quality Control module. The bar codes are
read directly from the color images.

However, when processing color images with the Standard Bar Code Engine, document separation based
on bar codes is performed with the Recognition Server module. For this case, a bitonal version of the
color image is generated, and the bar codes are read from the bitonal image.

If you attempt to use the Standard Bar Code Engine for document separation based on a 2-D bar code,
the first page is not recognized as a separator.

Page-Level Bar Code Processing
Page-level bar codes that appear on a page without any automatic index zones are recognized in Scan.
When an automatic index zone is used on the same page as a page-level bar code, then the page-level
bar code is recognized in Recognition Server.

However, when the following two conditions are met, then page-level bar codes that appear on the same
page as an automatic index zone are recognized in Scan, rather than Recognition Server:
• Only one form type is used in the batch class.
• Only one bar code recognition profile is used for page-level zones and separator zones.

Bar codes that are not used for indexing or separation are typically discarded. You have the option of
retaining them by selecting the "Retain bar codes and patch codes on all pages" check box on the Batch
Class Properties - Advanced Tab. When you select this option, the bar code data (value, type, location)
is stored at the page level. As a result, validation scripts or other customizations can use the decoded
information without having to re-recognize the bar codes. For details, see the help for the Administration
module.
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Page-Level Bar Codes
Kofax Capture can read all the bar codes on a page, and use their values to fill index fields. You associate
index fields with bar codes on the page with the Page Level Bar Code Properties window. 

In addition, you specify the bar codes to search for other bar code settings at the form type level. You do
so on the Create Form Type window - Page Level Bar Code tab or the Form Type Properties window -
Page Level Bar Code tab.

Enhanced Bar Code Engine
Kofax Capture supports an Enhanced Bar Code Engine that allows:
• Color bar code processing directly from color images
• Color bar code processing at dpis as low as 100 dpi
• Support for one- and two-dimensional (2-D) bar code types from color or bitonal images

Note The Enhanced Bar Code Engine requires additional licensing. See Licensing Requirements for the
Enhanced Bar Code Engine .

Color Processing Directly From Color Images

With the Enhanced Bar Code Engine, your Kofax Capture modules can process color bar codes directly
from color images. This can yield improved recognition results because the color images typically provide
more information to the bar code engine. The additional data from the color images better preserves the
integrity of the bar code elements.

Color Processing of Low Resolution Images

The Enhanced Bar Code Engine allows the Kofax Capture module to process color images scanned at
resolutions as low as 100 dpi. This means that you can scan your color images at lower dpis to speed up
scan time. Since color images contain more data than bitonal images, you can process the lower dpi color
images without sacrificing recognition accuracy.

Consider the following examples:
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Color Image Scanned at 150 dpi

Bitonal Image Scanned at 200 dpi

As the graphics illustrate, the color image scanned at 150 dpi presents a cleaner bar code with straight
lines and clear separation between the bars. The lines in the bitonal image scanned at 200 dpi are not
straight, and blend together in places. Bar codes in this condition may be difficult to read.

Performance and Compatibility Considerations

The Enhanced Bar Code Engine is typically more accurate than the Standard Bar Code Engine, especially
for low-quality or low dpi images. However, the Enhanced Bar Code Engine may be slower than the
Standard Bar Code Engine in some cases. For example, the file sizes of color images can be much larger
than otherwise identical bitonal images. This can adversely impact bar code processing directly from color
images with the Enhanced Bar Code Engine.

In addition, the Enhanced Bar Code Engine adopts a more stringent interpretation of the bar code
specifications. In rare cases, some bar codes that are slightly out of specification or very long may not
be properly read. The Standard Bar Code Engine, which supports one-dimensional bar code types only,
offers a more lenient interpretation of bar code specifications. You can disable the Enhanced Bar Code
Engine for a recognition profile so that the Standard Bar Code Engine can be used. However, only one-
dimensional bar codes can be read with the Standard Bar Code Engine.

Note Refer to your bar code documentation for details about bar code specifications. If your bar codes
are out of specification, it is recommended that you change your process to produce bar codes that
meet at least the minimum requirements of the specifications.

Two-Dimensional (2-D) Bar Code Support

With the Enhanced Bar Code Engine, Kofax Capture can process the following 2-D bar code types (on
color or bitonal images).
• Aztec Code
• Data Matrix
• MaxiCode
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• QR-Code
• PDF 417

In addition, the Enhanced Bar Code Engine can process all of the one-dimensional bar code types as the
Standard Bar Code Engine, with the exception of Linear 2 of 5. 

Tip For best results when drawing zones around bar codes, include at least a half inch boundary around
all sides of the bar code. Make sure you include the entire bar code within the zone. See Drawing Zones
for tips.

Processing Two-Dimensional Bar Codes

Two-dimensional (2-D) bar codes can hold thousands of characters. For example, the PDF 417 bar code
can hold up to 1,850 characters. The encoded data is usually made up of multiple fields packed into a
single string, with each value identified or delimited per custom requirements. An entire database record
for a particular customer or prospect can be encoded into a single 2-D bar code. The fields that make up
the record may be separated with one or more specific delimiter characters, by fixed length fields, or by
some other method dictated by your own requirements. 

With the Enhanced Bar Code Engine, Kofax Capture can read an entire 2-D bar code and store the result
into one index field, but doing so may not yield usable results for your validation operators. To make the
data usable, you can provide a custom validation script to parse the data and write the individual values to
the appropriate index fields.

You can use either Visual Basic .NET language or C# to create the custom validation script to parse the
data.

VB.NET Solution

The solution to parse the string data from the bar code can be done with a validation script written in
VB.NET. You will define an index field to hold the customer information encoded in the 2-D bar code, and
three index fields for the customer information (first name, last name, and customer number). To parse the
data string, you add the processing event as shown in the example that follows.

When you create a validation script with VB.NET, certain variable declarations are automatically
generated. The following field variables are generated when you create your VB.NET project using the
Scripts feature on the Tools tab in the Administration module.
<IndexFieldVariableAttribute("Customer_Record")> _
Dim WithEvents Customer_Record As FieldScript

<IndexFieldVariableAttribute("First_Name")> _
Dim WithEvents First_Name As FieldScript

<IndexFieldVariableAttribute("Last_Name")> _
Dim WithEvents Last_Name As FieldScript

<IndexFieldVariableAttribute("Cust_Number")> _
Dim WithEvents Cust_Number As FieldScript

Now, you will want to add the processing that parses the string data to individual values. From your
VB.NET code editor, select the DocumentPreProcessing event from the Declarations list. The
following Private Sub definition is generated:
Private Sub SampleDC2_DocumentPreProcessing(ByVal Param As Object, _
ByVal Param1 As Kofax.AscentCapture.NetScripting.PreDocumentEventArgs) _
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Handles Me.DocumentPreProcessing
End Sub

Add the following custom code within the Private Sub block to perform the data string parsing:
'*** This sub will extract the first name, last name, and customer 
'*** number from a string similar to "John***Smith***1234***" 

'*** The string we want to parse into an array.
Dim oDelimiterArray As String() = {"***"}

'*** Split on "***"
Dim oCustomerRecordArray As String()
oCustomerRecordArray = Customer_Record.IndexField.Value.Split( _
oDelimiterArray, StringSplitOptions.RemoveEmptyEntries)

'*** The customer's first name is stored first (index 0)
First_Name.IndexField.Value = oCustomerRecordArray(0)
'*** The customer's last name is stored second (index 1)
Last_Name.IndexField.Value = oCustomerRecordArray(1)
'*** The customer's number is stored last (index 2)
Cust_Number.IndexField.Value = oCustomerRecordArray(2)

Compile and save your validation script. Republish the batch class associated with the validation script.

C# Solution

The solution to parse the string data from the bar code can be done with a validation script written in C#.
Similar to the VB.NET solution, define an index field to hold the customer information encoded in the
2-D bar code, and three index fields for the customer information (first name, last name, and customer
number). To parse the data string, you add the processing event as shown in the example that follows.

When you create a validation script with C#, certain variable declarations are automatically generated.
The following field variables are generated when you create your C# project from the Scripts feature on
the Tools tab in the Administration module.
[IndexFieldVariableAttribute("Customer_Record")] 
FieldScript Customer_Record;
[IndexFieldVariableAttribute("Cust_Number")] 
FieldScript Cust_Number;
[IndexFieldVariableAttribute("First_Name")] 
FieldScript First_Name;
[IndexFieldVariableAttribute("Last_Name")] 
FieldScript Last_Name;

Now, you will want to add the processing that parses the string data to individual values. From your C#
code editor, go to the default script constructor and add the DocumentPreProcessing event handler by
typing this followed by a period. Select DocumentPreProcessing from the list of available methods,
properties and events, followed by += (plus and equals signs) and press Tab key, as in the following:
public SampleDC2(bool bIsValidation, string strUserID, string strLocaleName)
: base(bIsValidation, strUserID, strLocaleName)
{
 this.DocumentPreProcessing += SampleDC2_DocumentPreProcessing;
}

The following void SampleDC2_DocumentPreProcessing definition is generated:

void SampleDC2_DocumentPreProcessing(object sender,
 Kofax.AscentCapture.NetScripting.PreDocumentEventArgs e)
{
 throw new NotImplementedException();
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}

Clean the generated throw new NotImplementedException(); statement and then add the
following custom code within the{ } block to perform the data string parsing:
//*** This sub will extract the first name, last name, and customer
//*** number from a string similar to "John***Smith***1234***"
//*** The string we want to parse into an array.
string[] oDelimiterArray = {"***"};
//*** Split on "***"
string [] oCustomerRecordArray;
oCustomerRecordArray = Customer_Record.IndexField.Value.Split(oDelimiterArray,
 StringSplitOptions.RemoveEmptyEntries);
//*** The customer's first name is stored first (index 0)
First_Name.IndexField.Value = oCustomerRecordArray[0];
//*** The customer's last name is stored second (index 1)
Last_Name.IndexField.Value = oCustomerRecordArray[1];
//*** The customer's number is stored last (index 2)
Cust_Number.IndexField.Value = oCustomerRecordArray[2];

Compile and save your validation script. Republish the batch class associated with the validation script.

Turning off the Enhanced Bar Code Engine

The Enhanced Bar Code Engine is selected by default and used if proper licensing is in place for bar code
recognition operations. However, in some cases, you may want to turn it off. For example, you may be
processing one-dimensional bar codes from good quality bitonal images and achieve better performance
with the Standard Bar Code Engine.

You can turn off the Enhanced Bar Code Engine for a recognition profile. This causes the Standard Bar
Code Engine to be used for all processing that uses that recognition profile.

Note Once you turn off the Enhanced Bar Code Engine for a recognition profile, the Standard Bar Code
Engine is used for all processing that uses that profile. This is true even if the licensing for the Enhanced
Bar Code Engine is in place.

1. On the Recognition Profiles window, select the bar code recognition profile that uses the Enhanced
Bar Code Engine.

2. Click Advanced.
The Advanced Bar Code Settings window for the selected recognition profile appears.

3. Clear the "Use enhanced engine if licensed" check box.

Tip Once you clear the "Use enhanced engine if licensed" check box, any 2-D bar code types
previously selected on the General tab become cleared. Before you save the recognition profile,
you should carefully review the selected bar code types on the General tab to ensure they are
appropriate for your processing needs.

4. Click OK.
5. Click Save to save the selected recognition profile. Or, click Save As to save the selected profile to a

new name.
6. Click Close to close the Recognition Profiles window.
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Patch Code Recognition
A patch code is a pattern of horizontal black bars separated by spaces and typically placed near the
leading edge of a paper document to be scanned. It can be used to separate documents.

All patch codes are made up of narrow and wide bars, as follows:
• Narrow bars must be 0.08 inch in height.
• Wide bars must be 0.20 inch in height.
• Entire patch code must be 0.80 inch in height.
• Entire patch code should be at least 2.0 inches in width.

Patch codes that are not used for indexing or separation are typically discarded. You have the option of
retaining them by selecting the "Retain bar codes and patch codes on all pages" check box on the Batch
Class Properties - Advanced Tab. When you select this option, the patch code data (value, type, location)
is stored at the page level. As a result, validation scripts or other customizations can use the decoded
information without having to re-recognize the patch codes. For details, see the help for the Administration
module.

Type II Patch Code

Patch Code Recognition Settings
There are several settings you can make to optimize patch code recognition.

Left Offset

This specifies a point measured from the left edge of the image that falls within the patch code. A value of
0 specifies searching anywhere in the horizontal direction for a patch code.

See Patch Code Placement.

See Patch Code Recognition.
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Note Kofax Capture allows you to use patch codes for various types of processing. For example, you
can use patch codes as batch separators, document separators, control the counter for the endorser/
annotation feature, etc. When setting up each type of processing, you can specify a left offset for the
patch code. If you specify different left offsets, Kofax Capture will automatically default all the left offsets
to 0.

Patch Code Type

This specifies a type of patch code. Kofax Capture supports the following patch code types (Patch II, II,
and T are Kodak ImageLink patch code types).
• Patch I
• Patch II
• Patch III
• Patch III
• Patch T
• Patch VI

A .wmf file for each patch code is included in your Kofax Capture Bin folder. The names of the files are
Patch1.wmf, Patch2.wmf, etc.

Patch Code Placement
To be detected, a patch code must be positioned correctly on the page:
• The patch code must be horizontal.
• It must be located at least 0.20 inch from the leading edge of the image.
• It must not extend beyond 3.75 inches from the leading edge of the image.

Note For duplex scanning operations, patch codes are only detected on the front side of a page. Patch
codes on the back side of a page is ignored.

User Tracking Feature
Kofax Capture can track activity for each user. Kofax Capture will maintain statistical records with
information about users, documents, keystrokes, and other common activities.

When you enable the User Tracking feature, Kofax Capture tracks user activity in a number of database
tables. The tables contain statistical records that are generated as a user creates and updates Kofax
Capture batches and opens/closes processing modules. The records track information about various
items such as user actions, documents, and keystrokes.

When User Tracking is enabled, an Administrative Audit and Logon Audit are also performed. Every action
performed within the Administration module, including the user who initiated the action and the date and
time, is recorded in the Statistics database. User actions related to Kofax Capture logon attempts are also
tracked. If an issue arises, the Administrator can use the audit details to determine which change may
have introduced a problem. For details about which actions are included in the Administrative and Logon
Audit tracking, see the Kofax Capture help.
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Depending on your database selection, the User Tracking statistics are stored in the standard Kofax
Capture database or in your SQL Server, Oracle, or IBM DB2 database. Statistical tables can be
maintained separately from the other database. Refer to Database Utility for more information about
selecting a separate database for statistical tables.

When you install Kofax Capture for the first time, the statistics tables are initially empty.

If the User Tracking and User Profile features are enabled, statistics are maintained for linked operating
system users in the same manner as for Kofax Capture users.

Track User Activity
When you enable the User Tracking feature, Kofax Capture tracks user activity in six database tables.
The tables contain statistical records that are generated as a user creates and updates Kofax Capture
batches and opens/closes processing modules. The records track information about users, documents,
and keystrokes along with details related to actions taken in the Administration module.

When you install Kofax Capture, the tables are initially blank. With client/server installations, the statistics
are compiled per workstation, with a separate database for each. With standalone installations, the
statistics are also compiled separately.

User tracking occurs if Tracking is selected on the Tools tab in the Administration module. By default, the
option is disabled. When using Kofax Analytics for Capture, the Tracking feature must be enabled.

Note When User Profiles are enabled for your Kofax Capture installation, users who have rights to the
Administration module can enable/disable the User Tracking feature.

Enabling the User Tracking Feature
When you enable the User Tracking feature, it goes into effect for every user at your Kofax Capture
installation. By default, the feature is disabled. When using Kofax Analytics for Capture, the Tracking
feature must be enabled.

Note When the User Profiles feature is enabled, users who have rights to the Kofax Capture
Administration module can enable or disable the User Tracking feature.

1. Start the Kofax Capture Administration module.
2. On the Tools tab, in the User & Groups group, click Tracking.

The feature toggles on or off each time you select it.

User Tracking Statistics
If the user tracking feature is enabled in Kofax Capture at the central site, user tracking begins for each
module the next time that module is started. If a module is running when batch classes are downloaded,
that module does not record user tracking until it is restarted.

Batch user tracking statistics are uploaded when a batch is uploaded. Statistics for deleted batches and
launched modules are uploaded only when synchronization occurs.
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Once uploaded, user tracking statistics are incorporated automatically into the central Kofax Capture
database. Once a batch is successfully uploaded and inserted, the remote site RSA deletes all user
tracking statistics associated with that batch at the remote site.

User Tracking Data Tables
Depending on your database selection, user tracking data is stored in different locations. The data
schema and table structures remain the same, regardless of the storage location.

Standard Database Option
If you are using the Standard option, user tracking data is stored in your SQL Server Express database.
You can use compatible reporting applications to view the user tracking data.

If you upgraded to Kofax Capture from an earlier version, any merged statistical data from your prior
export is carried over to the new version.

Other Database Options

If you are using the SQL Server, Oracle, or IBM DB2 database option, your user tracking data is stored in
tables in your selected database.

If you use Kofax Capture with any of the above-mentioned databases, you should be familiar with
that database system and how to access it from your client tools. If necessary, contact your system
administrator for details.

The user tracking statistics are stored in the server and database you specified when switching to or
setting up your database (SQL Server, Oracle, or IBM DB2) for use with Kofax Capture. The structure for
these tables are identical to those used with the standard Kofax Capture database. To delete unwanted
statistics records, create your own SQL statements or execute the predefined stored procedure called
"ClearStats."

StatsBatch Table
The StatsBatch table is used to store records that list batch statistics. A new record is created each time a
user creates a batch.

The columns for the StatsBatch table are listed here. A description of each column follows the list.

StatsBatch Table

Column Type Size Valid on
Create

Default Req'd Indexed Dup

ExternalBatchID 1 PK1 Number Long
integer

Y Y Y N

BatchName Text 128 Y Y N Y

CreationStationID Text 12 Y Y N Y

CreationUserID 2 Text 128 Y Y N Y

CreationUserName 3 Text 80 Y Y N Y
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Column Type Size Valid on
Create

Default Req'd Indexed Dup

BatchClass Text 32 Y Y N Y

BatchClassDescription Text 80 Y Y N Y

BatchReferenceID Text 38 Y Y N N

TransferID Text 38 Y Y Y N

BatchGUID Text 38 Y Y N N

1 ExternalBatchID is the primary key for the Batch table.
2 For linked users, the CreationUserID contain the user’s domain name as well as the user ID.
3 For linked operating system users, the CreationUserName contains the user’s full name.

ExternalBatchID

Unique incremental value assigned to each batch that is created at a Kofax Capture site.

BatchName

Name assigned to the batch when it is created.

CreationStationID

Identifies the Kofax Capture station where the batch is created. The Station ID is assigned during the
installation process.

CreationUserID

If the User Profiles feature is enabled, this is the Kofax Capture login ID for the user who creates the
batch. If the feature is not enabled, this is the Windows login name for the user who creates the batch. If a
Windows login name is not required, the value is listed as "Unknown".

CreationUserName

If the User Profiles feature is enabled, this is the user name assigned in the profile of the user who creates
the batch. If the feature is not enabled, this is the Windows login name for the user who creates the batch.
If a Windows login name is not required, the value is listed as "Unknown".

BatchClass

Name of the batch class on which the batch is based.

BatchClassDescription

Description of the batch class on which the batch is based.

BatchReferenceID

Reserved for use with the Kofax Capture Advanced Reports product.

TransferID
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Reserved for use with the Kofax Capture Advanced Reports product.

BatchGUID

Reserved for use with the Kofax Capture Advanced Reports product.

StatsBatchModule Table
The StatsBatchModule table is used to store records relating to batch processing events in Kofax Capture
processing modules.

Note the following:
• A StatsBatchModule table record is created when any Kofax Capture batch is created or opened. The

initial values are updated when a batch is closed or deleted. Therefore, the StatsBatchModule table
values for a batch in progress differ from those for a batch that is closed or deleted.

• The Valid on Create column indicates which database records are valid after a batch is opened. If the
Valid on Create item is not set to Yes, the record is not valid until the batch is closed or deleted.

The columns for the StatsBatchModule table are listed here. A description of each column follows the list.

StatusBatchModule Table

Column Type Size Valid on
Create

Default Req'd Indexed Dup

BatchModuleID1 PK1 GUID Y Y Y Y

ExternalBatchID2 FK2 Number Long
integer

Y 0 Y N Y

BatchDescription Text 80 N N N Y

ModuleLaunchID3 FK3 GUID Y 0 Y N Y

ModuleCloseUniqueID Text 250 N N N Y

ModuleName Text 32 N N N Y

StartDateTime Date/Time Y NOW() Y N Y

EndDateTime Date/Time N NULL N N Y

BatchStatus Number Integer N 0 N N Y

Priority Number Integer N 0 N N Y

ExpectedPages Number Long
integer

N 0 N N Y

ExpectedDocs Number Long
integer

N 0 N N Y

Deleted Yes/No N 0 N N Y

PagesPerDocument Number Long
integer

N 0 N N Y

PagesScanned 4 Number Long
integer

N 0 N N Y
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Column Type Size Valid on
Create

Default Req'd Indexed Dup

PagesDeleted 4 Number Long
integer

N 0 N N Y

DocumentsCreated4 Number Long
integer

N 0 N N Y

DocumentsDeleted 4 Number Long
integer

N 0 N N Y

ChangedFormTypes4 Number Long
integer

N 0 N N Y

PagesReplaced 4 Number Long
integer

N 0 N N Y

ErrorCode

ErrorText Text 255 N N Y Y

Orphaned Yes/No Y N Y Y Y

TransferID Text 38 Y Y Y N

BatchGUID Text 38 Y Y N N

1 BatchModuleID is the primary key in the BatchModule table.
2 ExternalBatchID is a foreign key in the BatchModule table, and it is the primary key in the Batch table.
3 ModuleLaunchID is a foreign key in the BatchModule table, and it is the primary key in the
ModuleLaunch table.
4 Custom modules that perform these operations are responsible for updating the statistics attributes. If
they fail to update the attributes, the values in these columns will contain zeros for those custom modules.
The custom module sets these values in the Batch ACDataElement.

BatchModuleID

Unique identifier for the record in the table.

ExternalBatchID

Unique incremental value assigned to each batch that is created at a Kofax Capture site. Foreign key to
associated record in the Batch table.

BatchDescription

Description of the batch, assigned when the batch was created.

ModuleLaunchID

Unique value assigned to each Kofax Capture processing module. Foreign key to associated record in the
ModuleLaunch table.

ModuleCloseUniqueID
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Unique identifier for the next Kofax Capture module where the batch is processed. If that module has the
same literal name as another module, this identifier distinguishes one module from the other.

ModuleName

Literal name of the next Kofax Capture module where the batch is processed.

StartDateTime

Date and time when the batch was created or opened.

EndDateTime

Date and time when the batch was closed or deleted.

BatchStatus

Status assigned to the batch, as follows:

2 - Ready

4 - In Progress

8 - Suspended

32 - Error

64 - Completed

128 - Reserved

Priority

Priority level assigned to the batch. Priority values range from 1 to 10, with 1 being the highest priority.
The priority determines the order in which the batch is processed at each module.

ExpectedPages

Number of pages expected in the batch.

ExpectedDocs

Number of documents expected in the batch.

Deleted

Set to True if the batch was deleted during the current processing session.

PagesPerDocument

Number of pages per document. Valid only if fixed page separation is in effect.

PagesScanned

Number of pages scanned during the current processing session.

PagesDeleted
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Number of pages deleted during the current processing session.

DocumentsCreated

Number of documents created during the current processing session.

DocumentsDeleted

Number of documents deleted during the current processing session.

ChangedFormTypes

Number of form types changed from a valid form type to something else during the current processing
session. Used to track invalid form identification results.

PagesReplaced

Number of pages replaced during the current processing session.

ErrorCode

Reserved.

ErrorText

Text of any error message generated during the current processing session.

Orphaned

Relates to a batch that is created or opened, but not completed, due to an unexpected system failure or
interruption.

TransferID

Reserved for use with the Kofax Capture Advanced Reports product.

BatchGUID

Reserved for use with the Kofax Capture Advanced Reports product.

StatsFormType Table
The StatsFormType table file is used to store records relating to each form type used in a batch class. The
records are created when a batch is closed.

Note the following:
• All columns are valid upon creation.
• There are two special FormType names: "Loose Pages" and "None". Loose pages do not belong to a

document. None refers to documents that have not been assigned a form type.
• The data for keystroke counts, CompletedDocs, and CompletedPages are collected on a per session

basis. Therefore, totals from previous sessions are not automatically added to these values.
• The records for Documents, RejectedDocs, Pages, and RejectedPages relate to batch totals.

The columns for the StatsFormType table are listed here. A description of each column follows the list.
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StatsFormType Table

Column Type Size Valid on
Create

Default Req'd Indexed Dup

FormTypeEntryID1 PK1 GUID Y Y Y N

BatchModuleID2 FK2 GUID Y 0 Y Y Y

FormTypeName Text 32 Y Y Y Y

DocClassName Text 32 Y Y N Y

Documents Number Long
integer

Y 0 Y N Y

RejectedDocs Number Long
integer

Y 0 Y N Y

Pages Number Long
integer

Y 0 Y N Y

RejectedPages Number Long
integer

Y 0 Y N Y

KS_Manual3 Number Long
integer

Y 0 Y N Y

KS_OCRRepair3 Number Long
integer

Y 0 Y N Y

KS_ICRRepair3 Number Long
integer

Y 0 Y N Y

KS_BCRepair3 Number Long
integer

Y 0 Y N Y

KS_OMRRepair3 Number Long
integer

Y 0 Y N Y

CompletedDocs3 Number Long
integer

Y 0 Y N Y

CompletedPages3 Number Long
integer

Y 0 Y N Y

TransferID Text 38 Y Y Y N

1 FormTypeEntryID is the Primary Key for the FormType table.
2 BatchModuleID is a foreign key in the FormType table, and it is the primary key in the BatchModule
table.
3 Custom modules that perform these operations are responsible for updating the data. If they fail to do
this, the values in these columns will contain zeros for those custom modules. The custom module sets
these values in the Document ACDataElement.

FormTypeEntryID

Unique value to identify each form type record created.

BatchModuleID
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Unique identifier that indicates the Kofax Capture module associated with the batch for which a form type
record was created. Foreign key to associated record in the BatchModule table.

FormTypeName

Name of the form type. If the entry is "Loose," it relates to pages that do not belong to a document. If the
entry is "None," it relates to documents that have not been assigned a form type.

DocClassName

Name of the document class associated with the form type. This is empty when the FormTypeName is
Loose or Empty.

Documents

Number of documents using this form type in the batch.

RejectedDocs

Number of rejected documents using this form type in the batch.

Pages

Number of pages using this form type in the batch.

Rejected Pages

Number of rejected pages using this form type in the batch.

KS_Manual

For this form type, the number of keystrokes entered in fields that are not associated with an automatic
recognition profile.

KS_OCRRepair 

For this form type, the number of keystrokes entered in fields that exist in zones associated with OCR
processing.

KS_ICRRepair

For this form type, the number of keystrokes entered in fields that exist in zones associated with High
Performance Zonal processing.

KS_BCRepair

For this form type, the number of keystrokes entered in fields that exist in zones associated with bar code
processing.

KS_OMRRepair

For this form type, the number of keystrokes entered in fields that exist in zones associated with OMR
processing.

CompletedDocs

For this form type, the number of documents that have completed processing in the batch.
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CompletedPages

For this form type, the number of pages that have been reviewed in the Quality Control module. Reviewed
pages are tracked if "Require review of scanned pages" is selected in the Quality Control module
properties for the batch class.

TransferID

Reserved.

StatsModuleLaunch Table
The StatsModuleLaunch table is used to store records relating to Kofax Capture module usage. A record
is created each time a user opens a module. Exception: Activity for the Administration module is not
tracked in the StatsModuleLaunch table.

Important Do not attempt to modify or delete incomplete records in the StatsBatchModule table or the
StatsModuleLaunch table. An incomplete record is one for which the EndDateTime column is not null, or
the Orphaned column is set to Yes.

Note the following:
• A record is created each time a Kofax Capture module (except Administration) is opened.
• The Valid on Create column indicates which database columns are valid after a module is opened. All

other columns contain default values.
• The record is updated each time a Kofax Capture module is closed. At that point, all other columns

contain default values.
• Do not modify or delete an incomplete record. An incomplete record is one for which the EndDateTime

column is not null, or the Orphaned column is set to Yes.

The columns for the StatsModuleLaunch table are listed here. A description of each column follows the
list.

StatsModuleLaunch Table

Column Type Size Valid on
Create

Default Req'd Indexed Dup

ModuleLaunchID1 PK1 GUID Y Y Y N

StartDateTime Date/Time Y NOW() Y N Y

EndDateTime Date/Time N NULL N N Y

ModuleUniqueID Text 250 Y Y N Y

ModuleName Text 32 Y Y N Y

UserID2 Text 128 Y Y N Y

UserName3 Text 80 Y Y N Y

StationID Text 32 Y Y N Y

SiteName Text 32 Y Y N Y

SiteID Number Integer Y 0 Y N Y
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Column Type Size Valid on
Create

Default Req'd Indexed Dup

InProcessTID Text 38 Y Y Y N

Orphaned Yes/No Y Y Y N

CompletedTID Text 38 Y Y Y N

1 ModuleLaunchID is the primary key for the ModuleLaunch table.
2 For linked operating system users, the UserID contains the user’s domain name as well as the user ID.
3 For linked operating system users, the UserName contains the user’s full name.

ModuleLaunchID

Unique value assigned to each Kofax Capture processing module record.

StartDateTime

Date and time when the module was launched.

EndDateTime

Date and time when the module was closed.

ModuleUniqueID

Unique identifier for the Kofax Capture module that was launched. If that module has the same literal
name as another module, this identifier distinguishes one module from the other.

ModuleName

Literal name of the Kofax Capture module that was launched.

UserID

If the User Profiles feature is enabled, this is the Kofax Capture login ID for the user who launched the
module. If the feature is not enabled, this is the Windows login name for the user who launched the
module.

UserName

If the User Profiles feature is enabled, this is the user name assigned to the profile of the user who
launched the module. If the feature is not enabled, this is the Windows login name for the user who
launched the module.

StationID

Identifies the Kofax Capture station where the module was launched. The Station ID is assigned during
the installation process.

SiteName
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Text string that identifies the Kofax Capture installation site where the module was launched. The
SiteName is initially configured during the installation process and can be changed using the Database
Utility.

SiteID

Integer that identifies the Kofax Capture installation site where the module was launched. The Site ID is
assigned during the installation process.

InProcessTID

Reserved.

Orphaned

Reserved.

CompletedTID

Reserved.

StatsAdministrative Table
The StatsAdministrative table is used to store records relating to Administration module usage. Also, a
record is created in this table each time a user logs in or out of any Kofax Capture module, including the
Administration module or a custom module.

The columns for the StatsAdministrative table are listed here. A description of each column follows the list.

StatsAdministrative Table

Column Type Size Req'd Indexed

ActionID Text 38 Y Y

ActionKey Number Integer Y

ActionDateTime Date/Time Y

ModuleName Text 32 N

ModuleUniqueID Text 250 N

UserID1 Text 128 N

UserName2 Text 80 N

WindowsUserID Text 128 N

WindowsUserName Text 80 N

StationID Text 32 N

MachineName Text 32 N

MachineAddress Text 32 N

SiteID Number Integer N

SiteName Text 32 N
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Column Type Size Req'd Indexed

Param1 Text 255 N

Param2 Text 255 N

Param3 Text 255 N

Param4 Text 255 N

TransferID Text 38 N Y

1 For linked operating system users, the UserID contains the user’s domain name as well as the user ID.
2 For linked operating system users, the UserName contains the user’s full name.

ActionID

Audit action key.

ActionKey

Audit action name.

ActionDateTime

Date and time when the action is executed.

ModuleName

Name of module in which action is executed.

ModuleUniqueID

Unique ID of the module in which action is executed.

UserID

If the User Profiles feature is enabled, this is the Kofax Capture login ID for the user who launched the
module. If the feature is not enabled, this is the Windows login name for the user who launched the
module.

UserName

If the User Profiles feature is enabled, this is the user name assigned to the profile of the user who
launched the module. If the feature is not enabled, this is the Windows login name for the user who
launched the module.

WindowsUserID

Windows User ID.

WindowsUserName

Windows User name.

StationID
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Identifies the Kofax Capture station where the module was launched. The Station ID is assigned during
the installation process.

MachineName

Machine name.

MachineAddress

Machine IP address.

SiteID

Integer that identifies the Kofax Capture installation site where the module was launched. The Site ID is
assigned during the installation process.

SiteName

Text string that identifies the Kofax Capture installation site where the module was launched. The
SiteName is initially configured during the installation process and can be changed using the Database
Utility.

Param1

First action parameter.

Param2

Second action parameter.

Param3

Third action parameter.

Param4

Fourth action parameter.

TransferID

Reserved for use with KCN Server.

StatsAuditKey Table
The StatsAuditKey table is used to store records associated with audit event names and actions.

The columns for the StatsAuditKey table are listed here. A description of each column follows the list.

StatsAuditKey Table

Column Type Size Req'd Indexed

AuditKeyID Number Integer Y Y

AuditText Text 80 Y
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AuditKeyID

Audit action key.

AuditText

Audit action name.

User Profiles Feature
From the Administration module, you can enable the User Profiles feature to manage Kofax Capture
access and activity on a user-by-user basis. This is accomplished by setting up accounts or "profiles" for
each Kofax Capture user. Each user profile defines a login ID for the user and specifies the modules and
batch classes to which the user is allowed access. The profile also defines the administrative functions to
which the user has rights. Additionally, the administrator can set up group profiles to assign access rights
to multiple users.

Upon installation, Kofax Capture automatically sets up a user profile called "Admin" for the administrator.
The Admin profile is used to add and edit additional user profiles and group profiles. The administrator can
edit the Admin profile, but it cannot be removed. Other administrator users can access the Admin profile
and make limited changes to it. By default, the Admin profile does not have a password assigned to it.

Note You have the option of assigning the username and password for the Admin account during
installation. For details, see "Updating Default Administrator Account During Installation" in the Kofax
Capture Installation Guide. As another option, you can use the User Profile Properties window in the
Administration module to update the username or password for the Admin account after installation. For
details, click Help on the User Profile Properties window.

User profiles and group profiles include assignments for the following:
• User login ID and optional password (user profiles only)
• Access to batch classes (including independent verification)
• Access to Kofax Capture modules
• Group profile membership
• Access to administrative functions and utilities
• Permission to delete batches, documents, folders, and pages in standard interactive modules (Batch

Manager, Scan, Quality Control, Validation, and Verification).

The implementation of user profiles is an optional feature that is enabled from the User Profiles window.

User vs. Group Profiles
To take advantage of any of the Kofax Capture user management features, you must first enable the User
Profiles feature. You can turn this feature on and off as required. If you disable the User Profiles feature,
and later enable it again, all your previous settings are restored and enforced. In Kofax Capture, users
or groups can be given profiles that regulate access to the modules and batch classes. The profile also
defines access to various administrative utilities.
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Note If you enable profiles, you may be asked for a password when starting Kofax Capture modules.
Kofax Capture cannot recover or reset these passwords. If you forget your password, you need to
contact Support personnel.

A user profile is a collection of permission and assignment settings that are assigned to an individual
Kofax Capture user. A group profile is a collection of permission and assignment settings that are
assigned to a group. A group may consist of any number of Kofax Capture users, and users can be
members of any number of groups.

Groups can be assigned the same types of access rights as users, and all members inherit the group’s
rights. Because these rights are inherited, you can quickly change the settings for all the members in a
group simply by editing the group profile. For large groups, this simplifies the maintenance of user rights
and ensures consistency.

You can also link Kofax Capture to your operating system users and groups.

Note An individual user of Kofax Capture has all the permissions granted by the user profile plus those
in all the assigned group profiles.

Enabling the User Profiles Feature
When you initially install Kofax Capture, the User Profiles feature is disabled, and access to the
Administration module is not restricted.

When the User Profiles feature is disabled, users are not required to log in when they launch a Kofax
Capture module. As a result, no restrictions are placed on their access to batch classes, modules, or
Kofax Capture administrative functions.

With user profiles enabled, all access rights defined in user profiles and group profiles become effective.
As a result, users may be prompted for a user ID and password when they start a Kofax Capture module.
When they enter the valid information, they are granted access to the module, provided the module is
included in their user profile or group profile assignments.

When you enable the User Profiles feature, you may be prompted with a Kofax Capture - Login window
the next time you start a module. By default, the "Admin" user ID appears in the Login window with no
password.

Once you have specified a password for any user with administrative rights, you cannot enable the User
Profiles feature without first specifying the User ID and password of a user that has access rights to the
Administration module. This helps prevent unauthorized users from enabling the feature and inadvertently
locking all users out of virtually all Kofax Capture modules.

Important If you set a password for the Admin user and later forget the password (and the Admin user
is the only user with rights to the Administration module), you won't be able to turn off User Profiles
because you won’t be able to start the Administration module. Because there is no way to recover or
reset the password without accessing the Administration module, you must remove and then reinstall
Kofax Capture (which resets the Admin password to <blank>). Also, you lose your batch classes and
any batches that were in progress when you removed the product.

1. Start the Administration module.
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2. On the Tools tab, in the Users & Groups group, click Profiles.
The "Kofax Capture Administration - User Profiles" window appears.

3. Select the Enable User Profiles check box and click Save.
If an Administrator password has been created, the Enable User Profiles window appears.
If prompted, you must provide the Administrator password.

4. The User Profiles feature goes into effect for the entire Kofax Capture system.
The check box must be selected to access the other options on the User Profiles window.

5. On the User Profiles tab, set up a user profile for each user who requires access to Kofax Capture.
See Adding a User Profile.

6. Set up a group profile for each set of multiple users who require similar permissions and
assignments. See Adding a Group Profile.

7. From the "Default user group for new batch classes" list, select the group profile that should have
access to each new batch class created in the Kofax Capture Administration module. You can select
"(None)".

8. On the Lockout tab, set lockout restrictions. See User Profiles window - Lockout tab.
9. Click Save.

Note As soon as you click Save, all profile assignments associated with the other Kofax Capture
modules go into effect. Any assignments associated with the Kofax Capture Administration module
become effective when you close the module.

10. Click Administration.

Turning off the User Profiles Feature
If you turn off user profiles, all existing user and group profile assignments are ignored. If you
subsequently enable user profiles again, your previous settings are restored.

1. Start the Administration module.
2. On the Home tab, in the Batch Class group, click User Profiles.

The User Profiles window appears.
3. Clear the Enable User Profiles check box to turn off the User Profiles feature.
4. Click Save.

Note As soon as you click Save, all user profile assignments associated with other Kofax Capture
modules become inactive. Assignments associated with the Kofax Capture Administration module
become inactive when you close the module.

5. Click Close.

Default Profiles
When you enable the User Profiles feature for the first time, two default profiles are already in place: the
"Admin" user profile and the "(Everyone)" group profile. You cannot remove these profiles, but you can
modify them. For example, the Admin profile does not have a password assigned to it, and you may want
to add a password to the Admin profile. You can also change the username for the Admin profile. For
details about updating the Admin profile, click Help on the User Profile Properties window.
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The Admin profile is intended to be used by the Kofax Capture administrator, who typically is responsible
for setting up and maintaining profiles. By default, every new user profile is automatically assigned to the
"(Everyone)" group. As a result, each new user inherits the rights that are assigned to the "(Everyone)"
group, in addition to the rights assigned in the user profile.

For example, a user whose user profile does not allow access to the Scan module might still be able to
use it. This would occur if the user is a member of a group profile, such as "(Everyone)", for which access
to the Scan module is allowed.

By default, the "(Everyone)" group is allowed access to every batch class and every Kofax Capture
module. You can use the Group Profile Properties window - Members tab to restrict the batch class and
module assignments for the "(Everyone)" group.

Changing the Login Password
Although the administrator usually assigns a password when a user profile is created, the user can
change the password from the Kofax Capture – Change Password window. Furthermore, users with
access to the Kofax Capture Administration module and user profile management can edit any Kofax
Capture user password from the User Profile Properties window. If this is a concern, you may want to limit
access to the Administration module.

Note If you forget the password, you have to uninstall and then reinstall Kofax Capture (which resets the
Admin password back to <blank>). Also, you will lose your batch classes and any batches that were in
progress at the time you uninstalled Kofax Capture.
You have the option of assigning the username and password for the Admin account during installation.
For details, see "Updating Default Administrator Account During Installation" in the Kofax Capture
Installation Guide. As another option, you can use the User Profile Properties window in the
Administration module to update the username or password for the Admin account after installation. For
details, click Help on the User Profile Properties window.

When the user launches a module, the password can be changed by selecting Change Password from
the Kofax Capture - Login window. A user can change the password multiple times.

1. Launch a Kofax Capture module (other than the unattended modules) while the User Profiles feature
is enabled.

2. In the Kofax Capture - Login window, enter the current user ID.
3. Click Change Password.

The Kofax Capture - Change Password window appears.
4. Enter the old password or leave it blank if there is no current password.
5. Enter a new case-sensitive password from 4 to 14 characters.
6. Enter the new password again in the Confirm Password text box.
7. Click OK.

Kofax Capture sets the new password.

Single Sign On
Kofax Capture’s Single Sign On feature is automatically enabled whenever user profiles are enabled, and
at least one of your profiles is linked to an operating system user or group. You can have any combination
of linked groups and users, including Kofax Capture only groups and users. Kofax Capture groups and
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users (groups and users that are not linked to the operating system) do not take advantage of the Single
Sign On feature, and are required to log in.

With this feature, once you have logged in to the operating system, Kofax Capture automatically employs
your security settings each time you launch a Kofax Capture module. This means, if you have the
appropriate access rights, you do not need to log in to each module as you launch it.

If a linked user does not have access rights to a particular module, access is denied. Furthermore, if Kofax
Capture cannot locate a linked group or user profile, the user is required to manually log in.

If the User Profiles feature is enabled, but you are not a linked operating system user or a member of a
linked operating system group, you must manually log in as a Kofax Capture user.

Note Kofax Capture XML Import Connector does not support the Single Sign On feature, or linked
users.

The following chart shows the various login combinations.

Various Login Combinations

Note Batch class access rights and batch editing rights for linked users or groups behave in the same
manner as for Kofax Capture users or groups.

Account lockout for non-linked users
In most cases, users are authenticated as Kofax Capture linked users. But in some situations non-linked
users may also have access to the modules. To comply with security requirements, you can configure
account lockout threshold (invalid logon attempts) and lockout duration for such users.

The following behavior applies for non-linked users when this feature is enabled:
• When the user exceeds the configured number of invalid logon attempts, the following message

appears: "User account locked after exceeding maximum number of failed logon attempts. Please wait
for the lockout period (<number> minutes) to elapse, and then try again. "

• The number of invalid logons for an account is reset after a successful logon or after the account is
unlocked by the system or operator.

1. Start the Administration module.
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2. On the Tools tab, in the Users & Groups group, click Profiles.
The "Kofax Capture Administration - User Profiles" window appears.

3. Select the Enable User Profiles check box.
4. On the Lockout tab, select the Enable account lockout check box.

The check box must be selected to access the other options for this feature.
If you clear the Enable account lockout check box, a confirmation message appears. If the feature
is disabled, all the non-linked users may log on to the system without any warning.

5. Configure the following settings for the Account Lockout Policy.
• Account lockout threshold (invalid logon attempts): The default value is 3.
• Account lockout duration (in minutes): The default value is 30.

Locked users
The Locked Users panel contains a list of users that are locked at the central or remote sites. The users
must wait for the configured lockout duration period to get unlocked automatically or you can manually
unlock selected users.

1. Select the required user from the list. If required, click Refresh to update the list.
2. Click Unlock.

Note If the user is locked at a remote site, it may take some time to wait until the next Remote
Synchronization Agent (RSA) updates the lockout information at the central site.

Centralized User Management
In Kofax Capture, you can manage your user and group profiles locally (from within Kofax Capture),
centrally (using operating system tools or utilities), or using a combination of both methods. These choices
allow you to manage your users and groups in the most effective or efficient manner that meets your
needs.

As you work with your user and group profiles, you need to determine whether local user or centralized
user management method works best for you.

Local User Management

If your users and groups are unique to your Kofax Capture system, and will never be visible to
applications outside of Kofax Capture, you should create and manage these users and groups exclusively
within the Kofax Capture Administration module. This is "Local User Management", and is best suited
for smaller installations, or for customers who need to isolate their Kofax Capture users and groups in a
controlled environment.

Centralized User Management

If there is no particular need for such isolation, you can create and manage your users and groups using
the features and utilities provided by your operating system.

You can link Kofax Capture to your operating system users and groups using the Centralized User
Management feature. Once this link has been established, Kofax Capture will automatically stay
synchronized with your operating system user and group accounts. This allows you to escape the tedium
of replicating and updating dozens or hundreds of users across two working environments.
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In addition, by linking already existing operating system users or groups to Kofax Capture, your users can
employ a single password for both Kofax Capture and the operating system.

Centralized User Management is best suited to large organizations with many users or groups, or to
customers who do not want to maintain multiple passwords or multiple lists of users or groups. We
suggest you link only groups. This simplifies your maintenance tasks, and makes it easier to give large
numbers of users the same profile settings.

Centralized User Management Link Verification
If you have linked Kofax Capture to your operating system users or groups, you will need to synchronize
with your operating system. Synchronization with the operating system is automatically performed each
time you open the User Profiles window, and is maintained according to the following rules:
• If there are any previously linked operating system users or groups that have been deleted from the

operating system, those users or groups are also automatically removed from Kofax Capture. For each
operating system user or group removed, an entry is written to the Kofax Capture error log at the next
synchronization.

• If you have a domain server (with operating system users or groups that are linked to Kofax Capture)
that is not connected to the Kofax Capture system, a message will inform you that these users and
groups are not accessible. Furthermore, the "not currently connected" icon displays next to their names
in the User Profiles window.

• If any previously linked operating system users or groups have been renamed in the operating system,
the changes are automatically updated by Kofax Capture.

Important Each time you make changes to the operating system users or groups, you might want to
open the User Profiles window to ensure complete synchronization between Kofax Capture and the
operating system. If you don’t, the Kofax Capture user tracking logs may reflect outdated User IDs.

Logging in with Scripts
If you are using the Centralized User Management feature, an import script can log in using the
ImportSession.Login function with an empty user ID and password. If the logged in user does not
have access rights, the function will issue an error message indicating that the application does not have
access rights.

Custom modules can accomplish that same thing by using the Login Object in the Kofax Capture
Document Access Application Hierarchy.

If the User Profiles feature is enabled, but the logged in user is not a linked operating system user or a
member of a linked operating system group, a valid Kofax Capture user ID and password must be passed
to Kofax Capture from within the script.

User Profile Management
Administrators can allow or restrict user and group access to user profiles.

If "Allow Administration module access" is not selected but "Allow user profile management" is selected,
the user launching the Administration module goes directly to the User Profiles window. If "Allow
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Administration module access" is selected and "Allow user profile management" is not selected, the user
goes directly to the Administration module with no access to user profiles.

1. On the User Profiles tab, select the user profile that you want to modify and click Edit.
2. On the General tab, select or clear the "Allow user profile management" check box.
3. Click OK.

Selecting Default Groups for New Batch Classes
From the User Profiles window, you select a group profile that will automatically be assigned to each new
batch class created in the Kofax Capture Administration module. By default, the selection is "(Everyone)".

1. Start the Administration module.
2. On the Home tab, in the Batch Class group, click User Profiles.

The User Profiles window appears.
3. Select the Enable User Profiles check box, if necessary.
4. In the Default user group for new batch classes field, select the group profile to automatically assign

to each new user profile.
5. Click Save.

As soon as you click Save, all profile assignments associated with all the Kofax Capture modules,
except the Administration module, go into effect. Any assignments associated with the Administration
module become effective when you close the Administration module.

6. Click Close.

Link Domain Users or Groups
Domain users and groups (centralized management) can be linked to Kofax Capture user profiles. When
linked, Kofax Capture uses the network login to validate the user, thus eliminating the need for a separate
login when starting the program.

Note Linked domain user IDs are displayed as: <domain>\<user ID>. For example, the user "JDoe"
on the "Kofax" domain would be displayed as Kofax\JDoe throughout Kofax Capture. Likewise, linked
groups are displayed as: <domain>\<group name>.

The following procedures assume that you have sufficient administrative privileges to see all the users and
groups in your domain.

1. If necessary, create users or groups with access to the domain.
2. Start the Administration module.
3. On the Tools tab, in the Users & Groups group, click Profiles.

The User Profiles window appears.
4. From the User Profiles window, click Link to open the Microsoft Windows standard Select Users or

Groups window.
5. Use the Select Users or Groups window to select the domain users or groups.

Refer to the documentation provided by Microsoft for more information about using this window.
6. Click OK.
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Unlinking Users or Groups
To unlink domain users or groups

1. Start the Administration module.
2. On the User Profiles window, select the user or group you wish to unlink.
3. Click Delete. Deleting this link does not affect domain user or group accounts.

Adding a Group Profile
Use this procedure to add a group profile.

Note By default, the group profile called "Everyone" is built-in, and you cannot remove it.

1. On the User Profiles window, place your cursor in the Groups list and do one of the following:
• Click New.
• Right-click to display the context menu, and select New.

The Group Profile Properties window appears.
2. Click the General tab and make the following selections:

a. Enter a name up to 32 characters for the group in the Name field. The name is required.

b. Enter up to 80 characters in the Description field.

c. Select Time out after inactivity in minute(s) if you want group members to be logged out
of Kofax Capture automatically after a specified period of inactivity. Then set the number of
minutes that should elapse before the automatic logout occurs. The maximum value is 1440
minutes (24 hours). The default setting of 3 minutes for a new profile is inherited from the
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Everyone group; if you change the default setting, it overrides the value set for the Everyone
group.
Before the automatic logout occurs, a reminder message appears. If user activity is resumed
before the specified time out interval, the working session is extended and the automatic logout
does not occur.
If a user belongs to multiple groups, the maximum timeout value specified for any of the groups
is applied.

Note The timeout setting for a user profile overrides the timeout setting for any group profile
that includes the same user.

The timeout setting applies to any Kofax Capture module that the user is running, along with
the Separator Sheet Utility, Report Viewer, XML Import Connector, and the Database Utility. The
timeout setting does not affect modules running as services or the Kofax License Utility.

Note The timeout setting for a user profile overrides the timeout setting in any group profile
that includes the same user.

d. Select Allow Administration module access to give the group members access to the Kofax
Capture Administration module.

e. Select Allow user profile management to manage user and group access to user profiles.

f. Select Allow admin utility usage to give the group members access to various administrative
utilities such as the Database Utility.

g. Select Allow batch editing in Validation and Verification to allow the group members to edit
batches in the Validation and Verification modules.

Note Selecting this option only gives editing rights to the group. To actually enable batch
editing for the Validation and/or Verification modules, you must also enable the "Allow batch
editing" option for those modules on the Batch Class Properties - Queues tab.

h. Select Allow Batch Manager to edit batches that were granted access rights by a Custom
Workflow Agent to allow the group to edit batches in Batch Manager as described.

i. Select Allow Report Viewer module access to allow the group to access the Report Viewer.
The Administrator is permitted to access the Report Viewer module by default.

j. Select Allow selecting separation method at scan time to allow the group to use the Create
Batch window to select a separation method that overrides the one set for the batch class
definition. The list of available separation methods on the Create Batch window includes only
those that can be applied at scan time.
If this check box is not selected, the separation profile selections are not available to the group
from the Create Batch window, and the separation method associated with the batch class
definition is applied.

k. Select Allow modification of RSA compression settings to allow access to the Image
Compression and XML Compression settings on the Remote Site tab in Batch Manager.
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If this check box is not selected, these settings are not available in Batch Manager. These
compression settings are available only on a remote site.

l. Select Allow RSA to run interactively to run the Remote Synchronization Agent (RSA)
interactively at remote sites. If this check box is not selected, the RSA is run only as a service,
and the Activate RSA button in Batch Manager is not available.

m. Select Allow modification of Scanner Profiles to give the group access to scanner profile and
scan source settings. If this check box is not selected, the scanner profile and source settings in
the Administration, Scan, Quality Control, or custom scan modules are not available for editing.

n. Select Allow Batch Manager to edit batch queue and status to allow the group to modify the
batch queue or status from the Batch Manager module.

3. Select the batch classes you want the group to access.

a. Click the Assigned Batch Classes tab.

b. On the Available list, select the batch classes, and select the appropriate action (add or
remove).

c. Click OK to save the information without closing the window.
4. Select the modules you want the group to access.

a. Click the Assigned Modules tab.

b. From the Available list, select the modules, and click the appropriate action (add or remove).
5. Select the members to add to the group.

a. Click the Members tab.

b. From the Available list, select each user to add to the group, and select the appropriate action
(add or remove).

Note Each user name on the list represents a user profile.

6. Click Close.

Assigning Batch Classes to Groups
When setting up a group profile, use the Assigned Batch Classes tab on the Group Profile Properties
window to specify the batch classes to which the group should have access. The batch classes are listed
in the Available list. To give a group access to a batch class, you must move the batch class name from
the Available list to the Assigned list.

Tip You can view the list of users/groups that are currently assigned to a particular batch class. To view
the list, right-click on a batch class name in the Definitions panel to open the context menu, and select
Assigned User Profiles.

1. From the User Profiles window, select the group profile that you want to modify and do one of the
following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The Group Profile Properties window appears.
2. Click the Assigned Batch Classes tab.
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3. From the Available list, select each batch class to which you want the group to have access.
4. Use the following buttons as appropriate:

• Add: Add the selected item to the Assigned list.
• Add All: Add all the items to the Assigned list.
• Remove: Remove the selected item from the Assigned list.
• Remove All: Remove all the items from the Assigned list.

5. Click OK.

Assigning Kofax Capture Modules to Groups
Use the Assigned Modules tab on the Group Profile Properties window to specify the Kofax Capture
modules to which the group should have access. The modules are listed in the Available modules list. To
assign group access to a module, you must move the module name to the Assigned modules list.

1. From the User Profiles window, select the group profile that you want to modify and do one of the
following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The Group Profile Properties window appears.
2. Click the Assigned Modules tab.
3. From the Available list, select each module to which you want the group to have access.
4. Use the following buttons as appropriate:

• Add: Add the selected item to the Assigned list.
• Add All: Add all the items to the Assigned list.
• Remove: Remove the selected item from the Assigned list.
• Remove All: Remove all the items from the Assigned list.

5. Click OK.

Assigning Members to a Group
Use the Members tab on the Group Profile Properties window to assign one or more users to a group. The
Available list includes the name for each user profile. To assign a user to a group, you must move the user
ID to the Assigned list.

1. From the User Profiles window, select the group profile that you want to modify and do one of the
following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The Group Profile Properties window appears.
2. Click the Members tab.
3. From the Available list, select each user ID you want to add to the group.

Note Each user ID on the list represents a user profile.
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4. Use the following buttons as appropriate:
• Add: Add the selected item to the Assigned list.
• Add All: Add all the items to the Assigned list.
• Remove: Remove the selected item from the Assigned list.
• Remove All: Remove all the items from the Assigned list.

Note The "(Everyone)" group is not listed in the Assigned list.

5. Click OK.

Editing a Group Profile
Use this procedure to update an existing group profile.

1. On the User Profiles window, select the group profile you want to modify and do one of the
following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The Group Profile Properties window appears.
2. As appropriate, review and update the selections on the General, Assigned batch classes,

Assigned modules, and Group Members tabs.
3. Click Apply to save your selections without closing the window.
4. Click OK.

Copying a Group Profile
Use this procedure to duplicate an existing group profile.

1. On the User Profiles window, select the group profile you want to copy and do one of the following:
• Click Copy.
• Right-click to display the context menu, and select Copy.

The Group Profile Properties window appears, listing the same batch class, module, and group
assignments as the profile you copied.

2. On the General tab, assign a unique name for the group profile.
3. Select the appropriate options for the new group profile.
4. Review the selections on the Assigned Batch Classes, Assigned Modules, and  Members tabs,

and update them as appropriate for the new group.
5. Click OK.

Deleting a Group Profile
Use this procedure to delete a group profile. You cannot delete the default "(Everyone)" group profile.

1. On the User Profiles window, select the group profile that you want to remove.
2. Do one of the following:

• Click Delete.
• Right-click to display the context menu, and select Delete.
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3. Click Yes.
The group name for the profile is also removed from all user profiles to which it was assigned.

4. Click Close.

Adding a User Profile
Use the User Profile Properties window to add a user profile.

Note By default, the user profile called "Admin" is built-in, and you cannot remove it.

1. On the User Profiles window, place your cursor in the Users list and do one of the following:
• Click New.
• Right-click to display the context menu, and select New.

The User Profile Properties window appears.
2. On the General tab, make the following selections:

a. Enter the Kofax Capture user login name in the User ID field. The field length must be from 3
to 85 alphanumeric characters (or 3 to 128 for non-linked users). Unicode characters, commas
and periods are accepted. The entry is not case-sensitive.

b. Enter up to 32 characters for the name of the user in the Name field.

c. Enter a description (such as "Scan Operator") up to 80 characters. The entry is not required.

d. Optionally enter a password for the user in the Password field. The field length must be from
4 to 14 alphanumeric characters, and the entry is case-sensitive. Unicode characters are
accepted, along with the following special characters: Comma, period, exclamation point,
ampersand, pound sign, dollar sign, percentage sign, slash, and question mark. The entry is not
required.

e. Enter the password again, if applicable.

f. Select Time out after inactivity in minute(s) if you want the user to be logged out of Kofax
Capture automatically after a specified period of inactivity. Then set the number of minutes that
should elapse before the automatic logout occurs. The maximum value is 1440 minutes (24
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hours). The default setting of 3 minutes for a new profile is inherited from the Everyone group; if
you change the default setting, it overrides the value set for the Everyone group.
Before the automatic logout occurs, a reminder message appears. If user activity is resumed
before the specified time out interval, the working session is extended and the automatic logout
does not occur.
The timeout setting applies to any Kofax Capture module that the user is running, along with
the Separator Sheet Utility, Report Viewer, XML Import Connector, and the Database Utility. The
timeout setting does not affect modules running as services or the Kofax License Utility.

Note The timeout setting for a user profile overrides the timeout setting in any group profile
that includes the same user.

g. Select Allow Administration module access to give the user access to the Administration
module.

h. Select Allow user profile management to give the user the ability to add or user profiles.

i. Select Allow admin utility usage to give the user access to various administrative utilities,
such as the Database Utility.

j. Select Allow batch editing in Validation and Verification to allow the user to edit batches in
the Validation and Verification modules.

Note Selecting this option only gives editing rights to the user. To actually enable batch editing
for the Validation and/or Verification modules, you must also enable the "Allow batch editing"
option for those modules from the Queues tab in the Batch Class Properties window.

k. Select Allow Batch Manager to edit batches that were granted access rights by a Custom
Workflow Agent to allow the user to edit batches in Batch Manager as described.

l. Select Allow Report Viewer module access to allow the user to access the Report Viewer.
The Administrator is permitted to access the Report Viewer module by default.

m. Select Allow selecting separation method at scan time to allow the scan operator to use the
Create Batch window to select a separation method that overrides the one set for the batch
class definition. The list of available separation methods on the Create Batch window includes
only those that can be applied at scan time.
If this check box is not selected, the separation profile selections are not available to the scan
operator on the Create Batch window, and the separation method associated with the batch
class definition is applied.

n. Select Allow modification of RSA compression settings to allow access to the Image
Compression and XML Compression settings on the Remote Site tab in Batch Manager.
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If this check box is not selected, the settings are not available in Batch Manager. These
compression settings are available only on a remote site.

o. Select Allow RSA to run interactively to run the Remote Synchronization Agent (RSA)
interactively at remote sites. If this check box is not selected, the RSA is run only as a service,
and the Activate RSA button in Batch Manager is not available.

p. Select Allow modification of Scanner Profiles to give a user access to scanner profile and
scan source settings. If this check box is not selected, the scanner profile and source settings in
the Administration, Scan, Quality Control, or custom scan modules are not available for editing.

q. Select Allow Batch Manager to edit batch queue and status to allow the user to modify the
batch queue or status from the Batch Manager module.

r. Select Allow deletion of and then select one of the options from the combo box:
• Batches, folders, documents and pages (default)
• Folders, documents and pages
• Documents and pages
• Pages only

For this option to come into effect for the Validation and Verification modules, select Allow batch
editing in Validation and Verification.

Note Selecting this option only gives editing rights to the group. To actually enable batch editing for
the Validation and/or Verification modules, you must also enable the Allow batch editing option for
those modules on the Batch Class Properties Window - Queues Tab.
If this option is not selected, the Delete option is not active and grayed out in all user interfaces
for batches, documents, folders, and pages. In the scenario when the user still has this option
available (for example, using custom panels) and attempts to delete a batch, document, folder or
pages, an error message is displayed and the action is not performed.
By default, this option is selected for the "Everyone" group.

3. Select the batch classes to which you want the user to have access. You can do this later.

a. Click the Assigned Batch Classes tab.

b. From the Available list, select the batch classes, and select the appropriate action (add or
remove).

4. Select the modules to which the user has access.

a. Click the Assigned Modules tab.

b. On the Available list, select the modules, and select the appropriate action (add or remove).
5. Select the groups to which you want the user to belong. You can do this later.

a. Click the Group Members tab.

b. On the Available list, select each group that you want to add, and select the appropriate action
(add or remove).

Note Each group name on the list represents a group profile. For details on setting up group
profiles, see Adding a Group Profile.

6. Click Close.
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Assigning Batch Classes to Users
When setting up a user profile, use the Assigned Batch Classes tab on the User Profile Properties window
to specify the batch classes to which the user should have access. The batch classes are listed in the
Available list. To give a user access to a batch class, you must move the batch class name from the
Available list to the Assigned list.

Tip To view the list of users/groups currently assigned to a batch class, right-click on a batch class, and
then select Assigned User Profiles.

1. From the User Profiles window, select the user profile that you want to modify and do one of the
following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The User Profile Properties window appears.
2. Click the Assigned Batch Classes tab.
3. From the Available list, select each batch class to which you want the user to have access.
4. Use the following buttons as appropriate:

• Add: Add the selected item to the Assigned list.
• Add All: Add all the items to the Assigned list.
• Remove: Remove the selected item from the Assigned list.
• Remove All: Remove all the items from the Assigned list.

5. Click OK.

Assigning Kofax Capture Modules to Users
Use the Assigned Modules tab on the User Profile Properties window to specify the Kofax Capture
modules to which the user should have access. To give a user access to a module, you must move the
module name from the Available list to the Assigned list.

1. From the User Profiles window, select the user profile that you want to modify and do one of the
following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The User Profile Properties window appears.
2. Click the Assigned Modules tab.
3. From the Available list, select each module to which you want the user to have access.
4. Use the following buttons as appropriate:

• Add: Add the selected item to the Assigned list.
• Add All: Add all the items to the Assigned list.
• Remove: Remove the selected item from the Assigned list.
• Remove All: Remove all the items from the Assigned list.

5. Click OK.
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Assigning a User to One or More Groups
Use the Group Members tab on the User Profile Properties window to assign a user to one or more
groups. The Available list includes the name for each group profile (except the “(Everyone)” group). To
assign a user to a group, you must move the group name to the Assigned list.

1. On the User Profiles window, select the user profile to modify and do one of the following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The User Profile Properties window appears.
2. Click the Group Members tab.
3. On the Available list, select each group you want to the user to join.

Note Each name on the list represents a group profile.

4. Use the following buttons as appropriate:
• Add: Add the selected item to the Assigned list.
• Add All: Add all the items to the Assigned list.
• Remove: Remove the selected item from the Assigned list.
• Remove All: Remove all the items from the Assigned list.

Note The "(Everyone)" group is not listed in the Assigned list.

5. Click OK.

Editing a User Profile
Use this procedure to update an existing user profile.

1. On the User Profiles window, select the user profile to modify and do one of the following:
• Click Edit.
• Right-click to display the context menu, and select Edit.

The User Profile Properties window appears.
2. As appropriate, review and update the selections on the General, Assigned Batch Classes,

Assigned Modules, and Group Members tabs.
3. Click OK.

Copying a User Profile
Use this procedure to duplicate an existing user profile.

1. From the User Profiles window, select the user profile that you want to copy and do one of the
following:
• Click Copy.
• Right-click to display the context menu, and select Copy.

The User Profile Properties window appears, listing the same batch class, module, and group
assignments as the profile you copied.
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2. From the General tab, assign a unique user ID (the user name, description, and password are
optional). Then select the appropriate options for the new user profile.

3. Review the selections on the Assigned Batch Classes, Assigned Modules, and Group Members
tabs, and update them as appropriate for the new user profile.

4. Click Close.

Deleting a User Profile
Use this procedure to delete a user profile. You cannot delete the default "Admin" user profile.

1. On the User Profiles window, select the user profile that you want to remove.
2. Do one of the following:

• Click Delete.
• Right-click to display the context menu, and select Delete.

3. Click Yes.
The user ID for the profile is also removed from all groups to which it was assigned.

4. Click Close.

Checking Batch Class Assignments
Check the user profile / group profile assignments for a specific batch class from the Assigned Profiles
window.

Note You can also assign access to a batch class with the User Profile Properties window or the Group
Profile Properties window.

1. Start the Administration module. From the Batch Contents tree view, select the name of the batch
class for which you want to look up the user/group assignments.

2. Right-click and select Assigned User Profiles.
The Assigned Profiles window appears.

3. Click the Users tab to view the list of users currently assigned to work on the batch class.
4. Click the Groups tab to view the list of groups currently assigned to work on the batch class.
5. Use the button controls to update the list of currently assigned users and/or groups for the batch

class.
6. Click Apply to save the changes without closing the window.
7. Click OK to save the changes and close the window.

Setting An Automatic Timeout
You can set a Kofax Capture user or group to automatically sign out after a certain period of inactivity,
based on the "Time out after inactivity" setting on the User Profile Properties or Group Profile Properties
window. For example, if you set the timeout interval to 60 minutes, the user is automatically signed out if
no activity is detected for 60 minutes.

Before the automatic logout occurs, a reminder message appears. If user activity is resumed before the
specified time out interval, the working session is extended and the automatic logout does not occur.
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A message appears before the timeout goes into effect, so the user has an opportunity to cancel the
timeout.
The timeout setting applies to any Kofax Capture module the user is running, along with the Separator
Sheet Utility, Report Viewer, XML Import Connector, and the Database Utility. The timeout setting does not
affect modules running as services, the Scanner Configuration Utility or the Kofax License Utility.

For details, see the Help for the User Profile Properties and Group Profile Properties windows in the
Administration module.

Document Separation
Document separation is the process of distinguishing one document from another at scan time or during
import. Batches are made up of stacks of paper pages. The stack may contain single page documents,
multipage documents, or a combination of both. The images must be separated back into documents,
either automatically or manually, as the batch is scanned or imported. Once the document has been
separated, then form identification associates the document with its form type.

Patch Code Separation
With Kofax Capture, you can use patch codes for different types of processing. For example, in addition
to controlling how the endorser/annotation counter is reset, you can use patch codes on separator sheets
to separate documents and/or batches. You can use the same or different patch code types for different
types of processing.

For each type of processing, you must specify a left offset value. Kofax Capture searches for patch codes
in a horizontal direction on an image, and the left offset provides a starting point for the search. If you
specify different left offsets for the different types of processing, Kofax Capture automatically sets the left
offset to 0. This allows Kofax Capture to search anywhere in the horizontal direction for the patch code.

Note Not all scanners support the patch code options provided by Kofax Capture. Refer to the
documentation that came with your scanner for more information about your scanner.

Defining a Custom Document Separation and Form Identification Profile
You can define a custom document separation and form identification profile on the Custom Separation
and Form Identification Profiles window.

When you display the window from the Ribbon in the Administration module, you can define one or more
custom profiles to be available for selection when you define your batch classes.

When you display the window from the Create Batch Class or Batch Class Properties windows, you can
define one or more custom profiles and select one of them for the current batch class.

Kofax Capture provides a set of Kofax-defined separation and form identification profiles which combine
default settings for the most common separation and form identification combinations. Some have image
cleanup profiles and recognition profiles associated with them.

1. On the Tools tab, in the Separation & Identification group, click Profiles.
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2. Select the name of a separation and form identification profile from the list. The other options on the
window change to indicate the settings defined for that profile.

3. Select a method for document separation. You can select one of the following:
• Kofax Manual
• Kofax Fixed Pages
• Kofax Patch Code Separators
• Kofax Bar Code Separators
• Kofax Separator Sheets
• Kofax Page Recognition (for form identification)

Note Single document processing may increase the number of documents processed in an hour,
but it is only available when document separation occurs automatically in the Scan module.

4. If you selected "Kofax Patch Code Separators" in step 2, select additional settings as follows:

a. Select a recognition profile from the list of profiles. If none of the profiles is appropriate for your
needs, click the Edit button.
The Recognition Profiles window appears, and you can define a custom profile.

b. On the Name list, select Kofax Patch Code.

c. Select an image cleanup profile from the list. If none of the profiles is appropriate for your
needs, click the Edit button.
The Image Cleanup Profiles window appears, and you can define a custom profile. Click Save
As to assign a name to the image cleanup profile, and then click Close.

d. Click Save As to save your recognition profile. Assign a name and click OK.
5. If you selected "Bar code" in step 2, select additional settings as follows:

a. Select a recognition profile from the list of profiles. If none of the profiles is appropriate for your
needs, click the Edit button.
The Recognition Profiles window appears, and you can define a custom profile.

b. Select one of the bar code recognition profiles.

c. Select an image cleanup profile from the list. If none of the profiles is appropriate for your
needs, click the Edit button.
The Image Cleanup Profiles window appears, and you can define a custom profile. Click Save
As to assign a name to the image cleanup profile, and then click Close.

d. Click Save As to save your recognition profile. Assign a name and click OK.
6. Select a method for form identification. You can choose one of the following:

• Manual identification
• Separation bar code
• Kofax separator sheets
• Page recognition

Note Not all form identification options are available with all document separation options. The
options that are not available are grayed.
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7. If you selected "Kofax Page Recognition" in step 6, select additional settings as follows:

a. Select a recognition profile from the list of profiles. If none of the profiles is appropriate for your
needs, click the Edit button.
The Recognition Profiles window appears, and you can define a custom profile.

b. Select an image cleanup profile from the list. If none of the profiles is appropriate for your
needs, click the Edit button.
The Image Cleanup Profiles window appears, and you can define a custom profile. Click Save
As to assign a name to the image cleanup profile, and then click Close.

c. Click Save As to save your recognition profile. Assign a name and click OK.

d. Use the Confidence slider to set a recognition confidence value.
You can select any value from 0 to 100, with 0 being the lowest confidence and 100 being the
highest.

e. Use the Difference slider to set a recognition difference value.
You can select any value from 0 to 100, with 0 being the lowest difference and 100 being the
highest.

8. Click Save As to save the settings as a new separation and form identification profile without closing
the window.

9. Click Save to save the settings without closing the window.
10. Click Close to close the window.

Identifying Document Separator Zones
Use a separator zone to separate your images into documents. This is useful if the first page of all the
forms in a batch contains fixed data at a fixed location. If the fixed data is of a type that can be read
automatically (for example, using OCR, bar code recognition, patch code recognition, or other types of
recognition), you can use a separator zone as a document separator. The page with the separator zone is
considered the first page of the document.

1. Scan or import a sample document (at least the first page) for every form type in the batch class.
2. On the sample page, draw the separator zone and specify the type of recognition to be used to

process the zone.
For example, if the first page of your document contains a company logo that is all text, you can draw
a separator zone around the logo text and optionally specify the text as search text.

3. Specify an OCR recognition profile for processing the zone.

Using Manual Separation
Manual separation puts you in complete control of the document separation and form identification
process. With this method, you typically use the Scan module to select the appropriate document and
form type for each page of the batch.
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Manual Separation Method

Some custom modules require that you select manual separation as the method of document separation.
This is especially true if the custom module skips the Scan module or replaces the Recognition Server
module. See your custom module provider for information about configuring a batch class for document
separation and form identification.

Because manual separation does not occur automatically in the Scan module, single document
processing is not available when selected.

1. Configure a batch class for manual separation.
2. In the Scan module, create a batch using a batch class that uses manual separation.

Manual separation normally occurs in the Scan module. Images that are not manually separated are
sent to the Quality Control module with the message, "No loose pages allowed," and you have to
complete manual separation in the Quality Control module.

3. Scan your documents.
4. Look at the Batch Contents panel and notice that no documents are listed. Instead the pages are

listed as numbered images.
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5. Right-click Image 1 and click "Create Document" to open the Select Form Type window.

Select Form Type Window

If the batch class contains only one form type, the window does not appear. Instead, when "Create
Document" is clicked, the image is automatically placed in a document identified with that single
form type.

6. The "Form Types" area shows all the forms in the batch class. Select the form type that matches
Image 1 and click OK. This creates a new document of that form type and adds Image 1 to it.

7. If more than one image belongs in the document, click and drag the image to add it to the correct
document.

8. Repeat Steps 6 through 8 for every image in the batch until every image is part of an identified
document.

9. Once manual separation is complete, close the batch and continue processing it through the
workflow.

Using Fixed Page Separation
Fixed page document separation divides all the images of the batch into documents at scan time by
counting the images and creating a new document every set number of images. For example, if every
document in the batch class has exactly two pages, then you could set fixed page separation to two
pages. At scan time, a new document would be created every two pages.
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Fixed Page Separation

When single document processing is enabled, fixed page separation converts each separated document
into an individual batch, then automatically closes the batch before separating the next document.

1. Configure a batch class for fixed page separation.
2. Prepare a stack of documents to be scanned.

If a page is missing or out of order at scan time, the order of subsequent pages may be incorrect for
the rest of the documents. For example, if fixed page separation is set to two pages and a page 1 is
missing somewhere in the batch, every document after that will start with page 2 and end with page
1, thus spoiling the rest of the batch.

3. Create a batch that uses fixed page separation.
4. Scan your documents.
5. Look at the Batch Contents panel. Notice that each page is in a document, and that each document

has been associated with the only form type in the batch class.
The batch class for this example only has one form type. Fixed page separation will automatically
identify each document in this case. If there had been more than one form type in the batch class,
the images would have been separated into documents, but the form type for the documents would
have been left blank (see Single Form Type Form Identification).

6. Continue processing the batch through the workflow.

The default behavior for fixed page separation with blank pages is to count the blank pages before
separation. To ignore blank pages during separation, add the IgnoreBlankPage element to the
ACConfig.xml file. This ignores the blank page and includes the next non-blank page.

Insert the following line in the ACConfig.xml file under the <ACConfig> element:

<IgnoreBlankPages>1</IgnoreBlankPages>

Using Patch Code Separation
Patch code document separation divides all the images of the batch into documents at scan time by
analyzing each page of the batch looking for a patch code separator sheet. When a patch code separator
sheet is detected, the scan engine adds the subsequent pages to a new document. By default, the patch
code separator sheet itself is automatically deleted from the batch after document separation, but this can
be changed with custom options.
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Patch Code Separation

This method of separation is easily confused with separator sheet separation. The patch code separation
method separates indiscriminately, based on any of the six patch code types, and has limited form
identification abilities. On the other hand, separator sheet separation is much more configurable.

Patch I Patch II

Patch III Patch IV

Patch VI Patch T

When single document processing is selected, patch code separation converts each separated document
into an individual batch, then automatically closes the batch before separating the next document.

1. Configure a batch class for patch code separation.
2. Start the Separator Sheet Utility.
3. Select Document Separator as the Separator Sheet Type.
4. Select the Batch Class Name for which you wish to print a patch code separator sheet.
5. Select a Patch Code Type and the document separator is ready to print.

Important It does not matter which patch code type you select, since the default Kofax patch code
profile will separate images into documents with any of the six patch code types. However, do not
select a patch code type that is already reserved for batch separation. Doing so results in errors
during batch class publication.

6. Click Print to print the selected patch code separator sheet and make copies as needed.
7. Prepare a stack of documents to be scanned and place a patch code separator sheet between each

document.
8. Create a batch that uses patch code separation.
9. Scan your documents.

If the batch class has one form type, patch code separation automatically identifies each document in
this case. If there had been more than one form type in the batch class, the images would have been
separated into documents, but the form type for the documents would have been left blank.

10. Close the batch and continue processing it through the workflow.
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Using Bar Code Separation
Bar code separation divides all the images of the batch into documents at scan time by analyzing each
page of the batch looking for a separator sheet with a bar code on it. When a bar code separator sheet
is detected, the scan engine adds the subsequent pages to a new document. By default, the bar code
separator sheet itself is automatically deleted from the batch after document separation. Also, bar code
separation treats any page containing a horizontal Code 39 bar code as a separator sheet, which means
that pages containing a Code 39 bar code are deleted. You can use custom options to change these
settings.

Bar Code Separation

Note Code 39 bar codes within documents may cause unwanted document separation.

What is encoded in the bar code is irrelevant. The mere presence of a Code 39 bar code triggers
document separation — other bar code types do not trigger document separation. To separate based
on the value of the bar code, see Using Separator Zone Separation or Using Form Identification Zone
Separation.

When single document processing is selected, bar code separation converts each separated document
into an individual batch, and then automatically closes the batch before separating the next document.

1. Configure a batch class for bar code separation.
2. Print a bar code separator sheet for each document in the batch. A bar code separator sheet can be

any sheet of paper that contains a horizontal Code 39 bar code.
Make sure the orientation of the Code 39 bar code is horizontal across the separator sheet. Vertical
or diagonal bar codes are not recognized.

3. Prepare a stack of documents to be scanned and place a bar code separator sheet between each
document.

4. Create a batch that uses bar code separation.
5. Scan your documents.

The batch class for this example only has one form type. Bar code separation automatically identifies
each document in this case. If more than one form type existed in the batch class, the images would
be separated into documents, but the form type for the documents would be left blank.

6. Continue processing the batch through the workflow.
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Using Separator Sheet Separation
Separator sheet document separation divides all the images of the batch into documents at scan time by
analyzing each page of the batch looking for a separator sheet. When a separator sheet is detected, the
scan engine adds the subsequent pages to a new document and, at the same time, identifies the new
document’s form type. Separator sheet separation is similar to patch code separation, except that with
this method the separator sheet performs two functions. It both separates pages into documents and uses
the bar code to identify the form type. This makes this method the most reliable and powerful of all the
separation and form identification methods.

Separator Sheet Separation

When single document processing is selected, separator sheet separation converts each separated
document into an individual batch, and then automatically closes the batch before separating the next
document.

1. Configure a batch class for separator sheet separation.
2. In the Separator Sheet Utility, select "Document Separator" as the Separator Sheet Type.
3. Select the Batch Class Name for which you wish to print a separator sheet.
4. Select a Patch Code Type.

Note It does not matter which patch code type you select, since the default Kofax separator sheets
profile separates images into documents with any of the six patch code types. However, do not
select a patch code type already reserved for batch separation. Doing so causes errors during
batch class publication.

5. Select a Form Type and the separator sheet is ready to print.
6. Click Print to print the selected separator sheet. Print one separator sheet of this form type for

each document to be scanned. If necessary, change the Form Type and click Print again to print a
separator sheet for a different form type.

7. Prepare a stack of documents to be scanned and place the correct separator sheet between each
document. Make sure the form type bar code printed on the separator sheet matches the next
document in the stack of documents.

8. Create a batch that uses separator sheet separation.
9. Scan your documents.

10. Look at the Batch Contents panel and notice that each page belongs to a document, and that each
document has been associated with the corresponding form type.

11. Continue processing the batch through the workflow.
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Using Page Recognition Separation
Page recognition document separation divides all the images of the batch into documents in the
Recognition Server module by comparing each scanned image to the first pages of the form types in the
batch class. When a scanned page matches the first page of a form type, that image is added as the first
page in a new document of that form type. Subsequent pages are added to this new document until a new
first page match is found.

Page Recognition Separation

The matching process is based on two thresholds: confidence and difference.
• Confidence. Recognition Server compares each scanned image to the first page of each form type in

the batch class. It then calculates the percentage by which they match. The result is Kofax Capture’s
level of confidence that the two images match. The confidence threshold is the minimum acceptable
level of confidence in which separation and form identification will occur.
• If more than one comparison yields a passing confidence level, the match with the higher confidence

is chosen. On the other hand, if every confidence ranking falls below the confidence threshold, the
image is added as the next page in the previously created document.

• However, if the confidence level falls below the threshold, but there is no document to add it to (for
example, the image is the first in the batch), the image is sent to the Quality Control module where
you have to manually separate and identify the image.

• Difference. This measures the similarity of two images by comparing the differences in confidence.
The two highest confidence levels are compared. If the difference between the two is greater than the
difference threshold, then the match with the greater confidence level is chosen, assuming it is greater
than the confidence threshold.
• If the difference between the two falls beneath the difference threshold, then the image is considered

too similar to confidently separate and identify. In this case, the image is sent to the Quality Control
module where you will have to manually separate and identify the image.
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Confidence Threshold Table

Because page recognition separation occurs in the Recognition Server module and not in the Scan
module, single document processing is not available when selected.

1. Configure a batch class for page recognition separation.
2. Prepare a stack of documents to be scanned.
3. Create a batch that uses page recognition separation.
4. Scan your documents.
5. Look at the Batch Contents panel. Notice that no documents are listed. Instead, just the pages are

listed as numbered images.
Page recognition separation occurs in the Recognition Server module instead of the Scan module as
the images are being processed.

6. Close the batch and start Recognition Server which will automatically process the batch.
The error "Document was not confidently separated" indicates that Recognition Server could
not confidently separate your images. To prevent this error in the future, create a custom page
recognition profile and adjust the confidence settings.
If Recognition Server was able to confidently separate the batch images, then processing continues
to the next module in the batch class queue.
However, if there was an error in Recognition Server, then Batch Manager sends it to the Quality
Control module where you have to manually separate and identify the unrecognized images.

7. Continue processing the batch through the workflow.
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Using Separator Zone Separation
Separator zone document separation compares a specific zone on each scanned image with the same
specific zone on the first sample page of each form type in the batch class. Every time a match is found,
document separation occurs, and the image becomes the first page of a new document.

Separator Zone Separation

The separator zone is drawn on the first sample page of a form type. If other form types exist in the batch
class, this zone is replicated on the first page of every other form type in the batch class. The specific
information used to identify the zone can be a single specific piece of data collected from any recognition
profile. For example, it could be the word "Northwest" captured using the Kofax Advanced OCR Zonal
recognition profile, or it could be a bar code with the value "13579" using the Kofax 3 of 9 Bar Code
recognition profile.

No matter which recognition profile you select, the data must be the same on the first page of each
sample page in the batch class. If there is more than one form type in the batch class, separator zone
separation separates the documents without identifying the form type. However, if the batch class only has
one form type, each new document is identified as that form type.

Because separator zone separation does not occur in the Scan module, single document processing is
not available when selected.

Configuring an Existing Batch Class
1. Confirm that Recognition Server is included in your batch class.
2. Begin configuring a custom separation and form identification method.

Separator zone separation is not a Kofax default option. It is only available through the use of a
custom profile.

3. In the Document Separation area, select "Use separator zone," and in the Identification area, select
"Manual identification."
If, in the Identification area, you select Page recognition instead of Document separation you
would have a combination of two separation methods — separator zone and page recognition
separation. For now, we are focusing on separator zone separation. Experiment with combining the
various methods of document separation and form identification.

4. Click Save As and enter a name for the new profile and then click Close to return to the Batch
Class Properties window where the new custom profile is selected.

5. Click OK to save your settings and close the Batch Class Properties window.
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6. On the Definitions panel, select the Batch class tab.
7. Click to expand your batch class, document class, and then expand the first form type. Select the first

sample page of the form type and it appear in the page panel on the right.
8. On the Insert tab, in the Zones group, click Separator. Draw a separator zone around something

that is common to the first page of every form type in the batch class.
The Create Separator Zone window appears.

9. Select and configure the appropriate recognition profile.
10. Click OK to set the separator zone.
11. Repeat steps 7 to 10 with each form type in the batch class.
12. Publish the changed batch class to make the changes available for processing.

Processing a Batch with Separator Zone Separation
1. Prepare a stack of documents to be scanned.
2. Create a batch that uses separator zone separation.
3. Scan your documents.
4. Look at the Batch Contents pane and notice that no documents are listed. Instead, just the pages

are listed as numbered images.

Scanning Completed with Separator Zone Separation

Separator zone separation occurs in Recognition Server as the images are being processed instead
of the Scan module.

5. Close the batch and start Recognition Server, which automatically processes the waiting images.
If Recognition Server is able to confidently separate the batch images, processing continues with the
next module in the batch class queue.
If there was an error in Recognition Server, Batch Manager sends it to the Quality Control module,
where you have to manually separate and identify the unrecognized images.

6. Continue processing the batch through the workflow.
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Using Form Identification Zone Separation
Form identification zone document separation is not the same as form identification. Form identification
zone separation compares specific zones on each scanned image with the same zones on the first
sample page of each form type in the batch class. Every time a match is found, document separation
occurs and the new document is identified with the matching form type. On the other hand, form
identification is the process of matching documents with form types.

Form Identification Zone Separation

The form identification zone is drawn on the first sample page of each form type. The specific information
the zone is set to recognize can be a single specific piece of data collected from any recognition profile.
Because form identification zone separation does not occur in the Scan module, single document
processing is not available when selected.

Configuring an Existing Batch Class for Form Identification Zone Separation
1. Confirm that Recognition Server is included in your batch class.
2. Begin configuring a custom separation and form identification method.

Separator zone separation is not a Kofax default option. It is only available through the use of a
custom profile.

3. In the Document Separation area, select "Use page recognition for form identification," and in
the Identification area, select Page recognition.

4. Set both Confidence and Difference to 0%. This effectively turns off page recognition and forces
separation and identification to depend entirely on the form identification zones on the first page of
each form type in the batch class.

5. Click Save As, type an appropriate name for the new profile, and then click Close to return to the
Batch Class Properties window where the new custom profile is selected.

6. Click OK to save your settings and close the Batch Class Properties window.
7. On the Definitions panel, select the Batch class tab, click to expand your batch class, and then

expand the first form type of your document class.
8. Select the first sample page of the form type.

The sample page appears in the page panel on the right.
9. On the Insert tab, in the Zones group, click Form.
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10. Draw a form identification zone around something unique and identifiable on the first page of the
form type.
The Create Form Identification Zone window appears.

11. Select and configure a recognition profile.
The configuration options for the form identification zone change according to the recognition profile
you select.

12. Click OK to set the form identification zone.

Form ID Zone Selected
13. Repeat steps 8 to 12 with each form type in the batch class.

You can create more than one form identification zone on the first page of a form type. Multiple zones
can improve the accuracy of this method, but adding zones decreases the overall processing speed.

14. Publish the changed batch class to make the changes available for processing.

Processing a Batch with Form Identification Zone separation
1. Prepare a stack of documents to be scanned.
2. Create a batch that uses form identification zone separation.
3. Scan your documents.
4. Look at the Batch Contents panel. Notice that no documents are listed. Instead, just the pages are

listed as numbered images.
Form identification zone separation occurs in the Recognition Server module, instead of the Scan
module, as the images are being processed.

5. Close the batch and start the Recognition Server module, which automatically processes the waiting
images.
If Recognition Server was able to confidently separate the batch images, then processing continues
to the next module in the batch class queue.
If an error occurs in Recognition Server, then Batch Manager sends it to the Quality Control module,
where you have to manually separate and identify the unrecognized images.

6. Continue processing the batch through the workflow.
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Editing a Separator Zone
Use the Separator Zone Properties window to edit a separator zone.

1. With the sample page displayed, right-click the separator zone to edit and click Properties.
2. On the Separator Zone Properties window, edit the properties.
3. Click Apply to save the changes without closing the window.
4. Click Test to apply your settings to this zone and check the results. The sample page must be

displayed from the Batch class tree view tab to use QuickZones to verify your recognition and
cleanup settings.

5. Click OK to save the changes and close the window.
• Once you select the zone, you can resize it.
• You can edit a separator zone from a sample page displayed from the Document class tree view

tab. However, the sample page must be displayed from the Batch Class tree view tab when
creating separator zones.

Document Separation Troubleshooting
The following table lists resolutions to the most common problems found while using the different
separation methods.

Troubleshooting Document Separation

Method Problem Resolution

Manual Why do I get a "No loose
pages allowed" error?

"No loose pages allowed" is a common problem related
to manual separation, because each image in the batch
must be separated and identified in the Scan module before
further processing can occur.
When a new batch class is created, manual separation
is the default separation method. Most production batch
classes should not use this separation method. Review your
separation needs, and select a more appropriate method for
your batch class.

Fixed Page Using XML Import Connector
to import into a batch class
that has been configured to
use fixed page separation
yields a "No loose pages
allowed" error in subsequent
modules.

This error occurs because the imported images were not
converted into Kofax Capture documents in the Scan
module. To allow separation and form identification to occur
at import time, include the following attribute in the Batch
element of your XML:
EnableAutomaticSeparationAndFormID=”1”

Patch Code When I scan in color or
grayscale mode, separation
doesn’t occur.

For this separation method, the Scan module only
recognizes and separates black and white images. It treats
color and grayscale images as if they were blank. However,
Recognition Server does complete the separation process.
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Method Problem Resolution

The patch code separator
sheet is automatically deleted
by the Scan module. I need
to keep it in the document for
further processing.

In the Custom Separation and Form Identification Profile
window, clear the Found on stand-alone separator sheet
check box, and in the export connector setup screen, select
Skip first page.

My patch code separator
sheets are not being read at
scan time when scanning in
landscape mode and rotating
the images.

Depending on your scanner model, rotation may occur
after the attempt has been made to read the patch code
separator sheet. In this case, patch code separation does
not work unless there a patch code separator sheet exists
in the orientation of the scan before rotation. To correct this
problem, be sure to use a patch code separator sheet with
the patch code in the orientation you intend to scan.

Sometimes, separation occurs
at the wrong time. It behaves
as if my page was a separator
sheet.

It is possible that Kofax Capture is misinterpreting portions of
your documents as a patch code. Patch II and Patch IV are
the most common patch code types to be misinterpreted.
To avoid this confusion, create a custom patch code profile
that specifies the intended patch code. In this case, do not
choose Patch II or Patch IV.

The bar code separator sheet
is automatically deleted by the
Scan module. I need to keep
it in the document for further
processing.

In the Custom Separation and Form Identification Profile
window, clear the Found on stand-alone separator sheet
check box, and in the export connector setup screen, select
the option Skip first page.

When I scan in color or
grayscale mode, separation
doesn’t occur.

For this separation method, the Scan module only
recognizes and separates black and white images. It treats
color and grayscale images as if they were blank. However,
Recognition Server completes the separation process.

I need to separate documents
based on the value of the first,
or only, bar code on a page.

Use separator zone separation rather than bar code
separation.

Bar Code

I need to capture the value
of the bar code used to
separate the documents. Can
I use page-level bar code
recognition with the same bar
code used to separate the
documents?
If so, what are the
requirements to make this
happen?

Use form identification zone separation rather than bar code
separation.
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Method Problem Resolution

My bar code separator
sheets are not being read at
scan time when scanning in
landscape mode and rotating
the images.

Yes. Both separation and page-level bar code recognition
can happen on the same bar code. As a result, you can
separate and populate an index field with the bar code value
at scan time.
There are several requirements to make this happen in the
Scan module (if separation fails in the Scan module, then, if
included in the batch class, the Recognition Server module
separates the documents instead):
• There must be only one form type in the batch class.
• There must be only one bar code recognition profile. This

means that the page-level bar code recognition profile
must be the same as the custom separation and form
identification profile.

• There must not be any recognition scripts in the batch
class.

• There must not be any zonal processing (for example, no
index zones set to "auto recognition").

When I scan in color or
grayscale mode, separation
doesn’t occur.

For this separation method, the Scan module only
recognizes and separates black and white images. It treats
color and grayscale images as if they were blank. However,
Recognition Server does complete the separation process.

The separator sheet is
automatically deleted by the
Scan module. I need to keep
it in the document for further
processing.

In the Custom Separation and Form Identification Profile
window, clear the Found on stand-alone separator sheet
check box, and in the export connector setup screen, select
the skip first page setting.

My separator sheets are not
being read at scan time when
scanning in landscape mode
and rotating the images.

Depending on the model of the scanner you are using,
rotation may occur after the attempt has been made to
read the bar code separator sheet. In this case, bar code
separation does not work unless a bar code exists in the
orientation of the scan before rotation. To correct this
problem, be sure to use a bar code separator sheet with the
bar code in the orientation you intend to scan.

Separator Sheet

When printing separator
sheets with the Separator
Sheet Utility, the landscape
patch code or bar code is not
printed.

The problem is not with the Separator Sheet Utility; instead,
it is caused by the current printer or printer drivers. Either
update your printer drivers or use a different printer.

My images are sent to the
Quality Control module with
the note, "Document was not
confidently separated."

Either the images did not pass the confidence threshold or
the difference threshold. Adjust one or both of the thresholds
and try again.
If, after several attempts, you continue to get this message,
you may need to consider using a different separation and
identification method.

Page Recognition

Why can’t separator zones be
added to the second sample
page of a form type?

Separator zones must display on the first page of a form
type. It is likely that if you need a separator zone on a page
other than the first, you probably need to create another
form type.
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Method Problem Resolution

Why can’t separator zones or
form identification zones be
added to the second sample
page of a form type?

Separator zones and form identification zones must display
on the first page of a form type. It is likely that if you need
them on a page other than the first, you probably need to
create another form type.

Separator Zone and
Form Identification
Zone

I have a clearly defined and
reliable separator zone or
form identification zone.
Why is my form identification
failing?

Check your Separation and Form Identification profile to
make sure both Confidence and Difference are set to 0%.
Many times when using these zones, the forms are too
similar to use page recognition reliably. Setting Confidence
and Difference to 0% bypasses page recognition and lets
separation and identification occur based solely on the
separator zone or form identification zone. 

Table Behavior on Windows
Some of the windows in Kofax Capture contain a table for entering certain types of data. To navigate in
the table, use any of the following:
• Mouse to move anywhere in the table
• Click to select a cell
• Tab key to move from column to column within a row
• Up and Down arrow keys to move from row to row within a column
• Home and End keys to move to the top or bottom row of the table

To add a new field type, click New Field Type. The Create Field Type window appears.

To select a value for columns with a list of choices, use your mouse to select from the list.

To sort the table, click the column header to sort the table by the values in that column. (Note that some
tables cannot be sorted.)

To reorder rows in the table, click the row and drag it to a position.

To use table fields, create a new row and select (TABLE) as the field type. You can then add or remove
rows to the (TABLE) with the table row buttons at the lower-left of the window.

On some windows (such as the Create Batch Class, Create Document Class, Batch Class Properties, and
Document Class Properties), you can drag rows to reorder them.

Tip As an alternative to the New Index Field button shown in the illustration, you can right-click in the
table and do one of the following: select "Insert" from the context menu or press the Insert key on the
standard keyboard or the numeric keypad. If you do so with a field selected, the new field is inserted
above the selected one. It is added with the same attributes as the selected field.

As an alternative to the Delete Index Field button shown in the illustration, you can right-click in the
table and do one of the following: select Delete from the context menu or press the Delete key on the
standard keyboard or the numeric keypad.
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Table Properties

Deleting a Row in a Table
1. Click the row to remove.
2. Do one of the following:

• Click Delete Index Field.
• Right-click and select Delete from the context menu.
• Press the Delete key from the standard keyboard or the numeric keypad.

Adding a Row to a Table
1. Click New Index Field. Right-click and then click Insert on the context menu.

The row contains default values for all of the columns.
2. Select the row below the intended new row position.
3. Right-click and select Insert on the context menu.

A new row is added directly above the original row. The new row will contain the same values as the
row directly below it.

4. Select the row below the intended new row position.
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5. Press Insert from the standard keyboard or the numeric keypad.
A new row is added directly above the original row. The new row contains the same values as the
row directly below it.

Working with Multiple System Administrators
By default, multiple system administrators can run the Administration module on multiple workstations for
each Kofax Capture installation. If you try to edit an item (batch class, document class, and so forth) that
is already being edited by another system administrator, you may receive an error message or a message
asking you to try editing the item later. If you receive no message and are able to edit an item concurrently
with another system administrator, the last changes saved remain in effect.

Running the Administration Module with One Administrator
1. Ensure that all system administrators have closed the Administration module.
2. In the KfsDB element of the ACConfig.xml file, add the following line:

<AllowMultipleAdmins>0</AllowMultipleAdmins>

Running the Administration Module with Multiple Administrators
1. Close the Administration module.
2. In the KfsDB element of the ACConfig.xml file, add the following line:

<AllowMultipleAdmins>1</AllowMultipleAdmins>
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The Batch Manager Module

This module can be used to check the status or control the flow of batches in the Kofax Capture system.
In addition, batches can be created, deleted, or routed to another processing module.

You can filter the list of batches to restrict the list of batches. The filter criteria can be saved as a profile
for each Windows user, based on the Windows logon; if user profiles are enabled, you can save the filter
criteria per user. For details, see "Filtering Batches" in the online help.

From Batch Manager, you can also create a history log file (Bat_yymm.txt) that records events that occur
while a batch is in progress. For details, see the Batch Manager help.

Uploading Batches with Batch Manager
You can manually upload batches in Batch Manager (if the batch is ready for the Kofax Capture Network
Server module).

1. Open the Batch Manager module at the remote site.
2. Select a batch that is "ready" for the KCN Server module.
3. On the Home tab, in the Batch group, click Process Batch.

The batch begins to upload and the Batch Processing window appears.

Recalling a Batch
From the central site, you can recall a batch that has been transferred to a remote site. If you recall a
batch, work on that batch at the remote site is lost. If a remote site is in the middle of uploading a batch
when it is recalled, work done at the remote site is still lost. In addition, the batch is deleted at the remote
site when the next synchronization takes place. However, if the site profile is set to retain images at the
remote site, the image files are not deleted.

You might choose to recall a batch, for example, if it cannot be processed at a remote site for some
reason (such as network or staffing constraints). Once a batch has been recalled, all subsequent
processing remains at the central site regardless of the original routing rules applied to the batch class.
After being recalled to the central site, the batch goes to the module it would have gone to at the remote
site, had the recall not occurred.

A workflow agent can still control routing for a recalled batch. It is up to the workflow agent designer to
decide if recalled batches should be routed away from the central site. For example, the workflow agent
can check to see if a batch has been recalled, and choose to route the batch to a specific remote site as
determined by rules within the agent.
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When a recalled batch is deleted from the remote site at the next synchronization, the following message
is logged in the Kofax Capture error log (ERR_YYMM.txt) and the ACIC log (ACIC_YYMM.txt at the
remote site):

The batch "<name>" has been deleted from the remote site due to a recall.

If a recalled batch is locked at the remote site during the next synchronization, a warning message is
recorded in the logs. The batch is not deleted until it is unlocked, and a subsequent synchronization
occurs. Normally, if someone at a remote site deletes a batch, that batch is also deleted at the central site
during the next synchronization. However, if that deleted batch has already been recalled to the central
site, the recall takes precedence and the batch is not deleted at the central site.

1. At the central site, open Batch Manager.
2. Select the batch (or batches) you want to recall.
3. On the Home tab, in the Batch group, click Recall Remote.

Note You can only select this menu item if the batch status is "In Progress (<Site Name> – Ready
to download)", " In Progress (<Site Name> – Downloading)", or "In Progress (<Site Name> –-
Downloaded)."

A confirmation window appears.
4. Select Yes to confirm the recall.

The designated batches are recalled to the central site.

Converting a Kofax Capture Site to a Remote Site
To use a Kofax Capture installation as a Kofax Capture Network Server remote site, you must first convert
it to a Kofax Capture Network Server remote site and activate the RSA.

Each configuration (client/server or standalone) must have at least one RSA activated, although more
than one workstation in a client/server configuration can run the RSA.

Converting a remote site causes:
• The Administration module to become unavailable at the remote site.
• Batch classes to be deleted at the remote site.
• Batch classes, licensing information, and other settings to be downloaded from the central site.
• Additional Kofax Capture Network Server options to be available from the remote site's Batch Manager

module.
• The Remote Synchronization Agent (if activated) to be started and added to your Startup group. Also,

the RSA icon is present in your Windows system tray. The RSA can also be installed as a service.

Batch class creation and management must occur at the central site.
1. Open the Batch Manager module at the remote site.
2. On the Remote Site tab, in the RSA group, click Convert to Remote Site.

Note If you select No, you can upload batches through the Batch Manager module. You can activate the
RSA on the remote site at a later time.
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Activating RSA on a Remote Station
When you convert a site to a remote site, you are prompted to confirm activating the RSA on the remote
site. If you choose not to activate the RSA when the site is converted to a remote site, you can activate
the RSA at a later time.

For automatic polling, you need at least one client running the RSA at a remote site.

Note If you change the site name, the change is not reflected in the RSA Status display until the RSA is
stopped and restarted.

Activating the RSA
If the User Profiles feature is enabled, you can activate the RSA only if "Allow RSA to run interactively" is
enabled for your profile.

1. On the remote installation, open the Batch Manager module.
2. On the Remote Site tab, in the RSA group, click Activate RSA.

A confirmation message appears.
3. Click Yes to confirm.

The RSA icon appears in the Windows system tray, the Remote Synchronization Agent is added to
the Startup group, and the RSA is started.

Note If you perform an automatic installation of Kofax Capture, you can set the RSAURL attribute to
the full URL of the Web server in the initialization file to automatically activate the RSA on a remote
workstation.

Closing or Stopping the RSA
1. Right-click the RSA icon in the system tray.
2. On the context menu, click Close.

Restarting the RSA
To restart the RSA, do one of the following:
• Restart your computer.
• On Windows XP computers: Select Start Programs > Startup > Remote Synchronization Agent.

Switching Central Sites (Web Server URLs)
The Web Server URL window is used to specify the central site's Web server URL. You might need to
switch URLs, if the Web server experiences a problem. The instructions below assume you are using the
same Kofax Capture server at your central site with the old and new Web server.
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Note If the new Web server points to a different Kofax Capture server, ensure that no batches are in
process, before switching central sites.

1. At the remote site, close any Kofax Capture modules that may be running (except the RSA and
Batch Manager).

2. If necessary, open Batch Manager at the remote site.
3. On the Remote Site tab, in the RSA group, click Web Server URL.

The Web Server URL window displays the previously entered Web server URL.
4. In place of the old Web server URL, type the URL of the new Web server. If the Web site requires

SSL, you must specify the URL with "https" instead of "http."
5. Click OK.

If the URL cannot be validated, an error message appears. If this occurs, check the spelling of the
Web server URL.
If the specified Web server URL is validated, and all pending statistics and pending batches have
been uploaded to the old central site, a warning appears, prompting you to confirm switching central
sites.
A message also appears, stating that new batch classes and licensing will be downloaded, and batch
classes and licensing from the old site will be discarded.

6. When prompted, click Yes to confirm changing the URL.
7. Close all Kofax Capture modules at the remote site (so that you have completely logged off Kofax

Capture), and restart them as required.

To track user statistics, you have to ensure that user tracking is configured at the Kofax Capture central
site server.
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The Scan Module

The Scan module is used to prepare, create, or edit batches of documents. Scan is typically the first
queue in the Kofax Capture processing workflow.

Scan Module Overview
Use the Scan module to create, open, suspend, delete, or close a batch. You can edit the contents of a
batch before it is sent to the next module in the processing workflow.

The Scan module is typically monitored and used by a scan operator, whose basic tasks include:
• Batch preparation: Before scanning, the operator manually prepares a batch of paper documents,

adds separator sheets (if required), counts the number of pages in the batch (if required), and loads the
batch into the scanner.

• Batch creation: The operator creates the batch by selecting the type of batch to create (the batch
class) and then scanning or importing documents and pages. The document images are stored in a
temporary folder for further processing by Kofax Capture.

• Batch editing: Once the batch is created, the operator can visually check documents or pages, and
edit them as necessary. Editing functions include replacing, reordering, or rejecting documents and
pages. Entire documents or individual pages can be rotated and saved in the rotated state.

When the batch is ready for further processing, the scan operator can close the batch to send it to the
next processing module. If any of the documents or pages is rejected, the batch is sent to the Quality
Control module.

Scan operators also have access to batch fields (optionally defined for a batch class), scanner properties,
and endorser properties. They might also enter certain types of information for a batch, such as a batch
total (optionally defined for a batch class) or the total number of pages in a batch.

Setting Up the Scan Module
When you set preferences for the Scan module, specify whether to scan documents or import images,
perform permanent image cleanup on the entire batch, or endorse pages as they are scanned.

1. In the Administration module, on the Batch Class Properties window, click the Queues tab.
2. On the Selected Queues list, select Scan and then click Properties.

The Scan Properties window appears.
3. On the General tab, select a capture mode: Scan or Import.

The selection becomes the default mode for any batch created, based on the current batch class.
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4. Select an image cleanup profile from the list. If none of the profiles is appropriate, click Edit to create
a custom image cleanup profile.
The settings are applied to all documents in the batch.

5. Select one or both optional features for use with Kofax Capture, if your scanner supports them. The
features cannot be used with Kofax Capture unless you select the appropriate check box.
• Select Patch code reader if your scanner is equipped with a patch code reader.
• Select Bar code reader if your scanner is equipped with a bar code reader.

6. To endorse and/or annotate your pages, click the Endorsing tab and select preferences.

Note Not all scanners support the endorser/annotation feature. Of those that do, some only
support a subset of the options on the Endorsing tab. Before making selections, make sure you
understand the capabilities of your scanner. Since scanners are selected in the Scan module,
Kofax Capture cannot validate your selections in the Administration module.

a. Enter the Prefix text for the endorser/annotation text. Alternatively, click the Values button
and select a Kofax Value to use as your string. The same prefix is used for the endorser string
imprinted on the documents and the annotations added to the images.

b. Select the number of Counter digits for the automatic counter.
The value of the counter is appended to the prefix string for the endorser/annotation text.

c. Enter the Text Offsets for the endorser/annotation text.

d. Enter the Font Settings for Type and Orientation.

e. Enter the Counter Patch Code Control settings.

f. Enter the Counter Increment settings.

g. Enter the Counter Reset settings.
7. On the Batch Class Properties - Advanced tab, optionally select preferences that affect processing

in the Scan module. For details about individual settings, click Help.
8. Click OK to save your settings.

The Auto-Import Feature
The Auto-Import feature allows the Scan module to create batches by reading batch information (such as
the paths to images stored on disk, index data, and more) from special-purpose auto import files. Auto-
Import is implemented as a command line option, and it is designed to allow another application to gather
batch information, store the information in a special-purpose file, and then launch the Scan module to
create the batches from the information in that file. As soon as Scan is finished auto importing the batch,
an "auto import is complete" message is sent back to the calling application and that instance of Scan is
shut down. The batches are then ready for processing within Kofax Capture.

For example, you might have an application that polls a system folder for incoming faxes. When a fax
comes in, the application stores information about the images in a file. When a certain number of faxes
come in, or a certain amount of time has passed, the application launches the Scan module to create the
batch. Once the batch is created, it can be routed to other Kofax Capture processing queues as defined
by the batch class.
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The Auto-Import feature is one method for automatically creating a batch. You can use the XML Import
Connector module to use XML to import documents into a batch.

Note The XML Import Connector module is deprecated and will be removed in a future release.

Import Image Files and Index Data
To auto import image files and index data, you must have an auto import ASCII text file and an optional .ini
file. The ASCII text file must contain the index data and the paths/file names of the files to import. You
can store additional batch information (such as the batch name, batch description, and priority) in the
optional .ini file.

Image File Information and Index Data (ASCII Text File)
The auto-import ASCII text file must have the following entries. (They are shown below on separate lines
to make them easier to read. In the text file, all information for a particular image file must be on the same
line.)
"batch class name",

"index field name","associated index field value",

"index field name","associated index field value", 

. . .

"index field name","associated index field value",

"path and file name of the document image"

For example:
"Medical Forms","Plan Num","JM3891","Name","Lee","x:\reldocs\5.tif"

"Medical Forms","Plan Num","PB7930","Name","Smith","x:\reldocs\6.tif"

Parsing Logic
When parsing the auto-import ASCII text file format, Kofax Capture does the following:
• Looks for the initial quotation mark
• Looks for the first comma following the next quotation mark
• Uses the value between the initial quotation mark and the last quotation mark encountered before the

comma, and ignores data outside the set of quotation marks

In the following examples, the underlined text represents the values that Kofax Capture uses.
"index field name", "associated index field value",

Embedded quotation marks or embedded commas are supported.
"index field name", "associated index "field" value",

"index field name", "associated, index field value",

Avoid a format that uses an embedded comma followed by an embedded quotation mark, as shown
below.
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"index field name", "associated"index field,"value",

Associated Batch Information (.ini File)
By default, batches created with the Auto-Import feature use the default batch name, description, and
priority level. (The defaults are date/time for the batch name, no description, and 5 for priority level.) If you
do not want to use the default values, you can provide an .ini file containing the values.

If you have an .ini file, it must have the same name as its associated text file. For example, if the name of
your text file is medforms.txt, the name of your .ini file must be medforms.ini. Both files must exist in the
same folder.

The format for the .ini file is shown below.

[Options]

BatchName0=

Description0=

Priority0=

. . .

BatchNamen=

Descriptionn=

Priorityn=

For example:

[Options]

BatchName0=Import00-98/12/12

Description0=Patient medical forms

Priority0=4

BatchName1=Import01-98/12/12

Description1=Patient medical forms

Priority1=

Note Any parameter left blank is set to the default value. For example, "Priority1=" from the preceding
example would set the priority of the batch to 5.

Run Auto-Import for Image Files and Index Data
You can launch the Scan module to import image files and index data with the following command:

SCAN -i:Path\TxtFileName -w:hWnd –m:MsgID

Where:
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-i:Path\TxtFileName

This is the path and file name of the text file that contains the index data and the locations and names of
the image files to import.

-w:hWnd

This is the window handle of the application to receive the "auto-import is complete" message. Specify this
parameter in decimal format, rather than hexadecimal.

-m:MsgID (optional)

When the auto-import process is complete, the Scan module sends a message to the window identified
by the –w parameter. The messageID number must be specified in order for the message to be returned.
Specify this parameter in decimal format, rather than hexadecimal. Windows requires that this number be
greater than 1024.

During the auto-import operation, the Scan module sequentially reads the entries in the text file and
imports all images into the same batch until a different batch class name is encountered. For example, if
the first 50 image files specified in the text file have the same batch class name, all 50 files are placed in
the first batch. If the next 25 image files have a different batch class name, they are placed in a second
batch, and so on. If a blank line is encountered in the text file, a new batch is started.

Import Image Files Only
To auto-import image files only, you need an auto-import.ini file that contains the names of the files
to import, along with other information required for the operation. You might want to use this method if the
requirements of your application are such that index data is not needed.

Image File Information Only - No Index Data (.ini File)
The auto-import.ini file for image file information must have the format shown in the following
example.
[Options]

BatchName=Import00-98/12/12

Description=Patient History Forms

BatchClass=Patient Forms

Priority=7

PagesPerDoc=1 -or- PagesPerDoc="auto"

hWnd=1111

MsgID=1074

LogFile=C:\IMP.txt

File0=F:\FAX\001.tif

File1=F:\FAX\002.tif

Filen=F:\FAX\00n.tif
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For the files to import, the total path and file name must be fewer than 127 characters.

The .ini file with the batch class name specified in the DocumentClass= key is
DocumentClass=Patient Forms, where "Patient Forms" in the preceding example is the batch class
name.

New Kofax Capture users are encouraged to use the BatchClass= key. If the file happens to include
both the DocumentClass= key and the BatchClass= key, Kofax Capture uses the BatchClass= key
and ignores the other one.

Also note the following:
• The Priority entry overrides the default priority defined for the batch class. For example, if the

priority for the document class is 5 and the priority specified in the auto-import file is 10, 10 is used for
that batch. If no Priority entry is specified, Kofax Capture uses 5 as the default.

• The Priority entry also supports an entry of Low (9), Normal (5), or Urgent (2).
• The PagesPerDoc entry overrides the default value defined for the batch class. If you do not include

a PagesPerDoc entry, your batch contains the same number of documents as you have files in your
list (one document per file). Each document contains the same number of pages as its associated file.
If the PagesPerDoc entry is "auto", then Auto-Import uses the separation method defined for the batch
class in the Administration module.

• The list of files (File0=, File1=, and so on) must be sequential. For example, if you have five files to
import, they must be listed in the .ini file as File0=, File1=, File2=, File3=, and File4=. If your list skips a
number (for example, your list goes from file File0= to File2=), processing ends after File0 is imported.

• The LogFile entry is used to specify a path and file name for the log file. If not specified, the default
name (AUTOIMPO.LOG) is used. See Auto-Import Log File for details about the log file entries.
Required entries are the following:
• BatchClass= or DocumentClass=
• Image file names

• The hWnd= entry and the MsgID= entry, if specified, must use decimal format, rather than hexadecimal
format.

Because Kofax Capture is a 32-bit application, the specified window handle must refer to a valid 32-bit
window handle. If a 16-bit application is used to specify a window handle, the messages are not returned
successfully to the application.

Run Auto-Import for Image Files Only
You can launch the Scan module to import image files only with the following command:

SCAN -i:Path\INIFileName

Where:

-i:Path\INIFileName

This is the path and file name of the .ini file that contains the locations and names of the image files to
import.
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Auto-Import Issues
When using the Auto-Import feature, be aware of the following:
• The Auto-Import process stops if it detects the following:

• Batch class for which batch totaling is in effect
• Batch class defined with batch fields
• Batch class with multiple form types that use index values

• Auto-Import does not validate index values. The assumption is that an index queue is defined to
process the values and allow for translation of invalid index values to valid values.

Auto-Import Log File
During an auto-import operation, the Scan module writes entries to a log file. The entries describe the
results of the operation.

Information is logged to the log file in the following format:
START: batch name , start date , start time

Name of first file imported

Name of second file imported

. . .

Name of last file imported

END: end date , end time , error number , index of last file imported , error message

The name of the log file is AUTOIMPO.log, and it is stored in the same folder as the auto import text file.
When importing image files only, you have the option of overriding the default log file name.

When an error occurs, a non-zero constant and an error message are logged to the file. When the auto
import process is successful, a code of 0 (zero) is logged.
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The Quality Control Module

Batches can be sent to Quality Control in two ways:
• As part of the batch processing workflow defined for a batch class
• As exception cases

Quality Control Module Overview
If you select the Quality Control module as one of the processing modules for a batch class, all batches
based on that batch class are routed through the Quality Control module. This provides a way to monitor
the quality of all batches in the system. To make this happen, you must select Quality Control as one of
your processing modules for a batch class.

If you select the Quality Control module for use only with exception cases, batches containing documents
or pages rejected from any module are routed automatically through the Quality Control module.

The Quality Control module is typically monitored by a scan or quality control operator, whose basic tasks
include:
• Quality assurance: The operator visually checks the integrity of a batch. The operator checks the quality

of the images and ensures the forms have been correctly identified. If necessary, the operator can edit
the batch.

• Batch editing: The operator visually checks documents or pages, and edits them as necessary. Editing
functions include replacing, reordering, or rejecting documents and pages. Entire documents or
individual pages can be rotated and saved in the rotated state.

The quality control operator can change the form type assigned to a document.

When the batch is ready for further processing, the quality control operator can close the batch to send it
to the next processing module.

Tip For more information about Quality Control, refer to the online Help available from the Quality
Control module.

Setting Up the Quality Control Module
When setting up the Quality Control module, specify how the operator should review and verify pages.

1. In the Administration module, on the Batch Class Properties window, click the Queues tab.
2. On the Selected Queues list, select Quality Control and then click Properties.

The Quality Control Properties window appears.
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3. Select each check box as applicable:
• Require review of scanned pages: Requires the quality control operator to visually review each

page in the batch before closing it.
• Require verification of form type: Requires the quality control operator to verify that forms in the

batch are correctly identified.
• Skip after Rescan: Skips the Quality Control module after documents are rescanned as a result

of Quality Control (rescan).
4. Click OK to save your settings.
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The Recognition Server and OCR Full Text
Modules

This chapter gives an overview of the Recognition Server and OCR Full Text modules.

Recognition Server Module Overview
The Recognition Server module separates batches into documents, identifies form types, performs
image cleanup, and extracts index data from images. It is required for any batch that uses automatic form
identification, automatic document separation, automatic image cleanup, or automatic validation.

The Recognition Server module is an unattended module. Batches are processed in this module, and then
automatically passed to the next module specified for the batch.

While batches are processed at this module, the results of the processing appear on the main screen.

This module requires no additional setup.

Note Single document processing is not available when document separation does not occur
automatically in the Scan module.

OCR Full Text Module Overview
This module performs Optical Character Recognition (OCR) on an entire document and stores the
results in a specified output format such as Microsoft Word or ASCII. The output format is specified in the
document class associated with the document. The folder where the files are exported is specified in the
export connector associated with a document class/ batch class. 

OCR Full Text is an unattended module that requires no additional setup. While batches are processed at
this module, the results of the processing appear on the main screen.

OCR Full Text Processing
OCR Full Text is used to capture an entire page and save the results as a text or word processing file. It is
usually used in conjunction with full text search engines. 

You enable OCR Full Text processing from the Create Document Class window or the Document Class
Properties window.
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The settings for OCR Full Text processing are defined within an OCR Recognition profile.

OCR Full Text Log File
The results of processing a batch at the OCR Full Text module can be tracked in a log file. This log file can
be useful for reviewing how the batch was processed. When this feature is selected, the log file is created
in your Kofax Capture installation folder:

\IMAGES\<BatchNumber>\LOG\OCR.txt

where <BatchNumber> is the number of a batch. A separate log file is available for each batch.

The log files are temporary; they are automatically deleted when the batch is exported. You can review the
log file for a batch as long as the batch is available to Kofax Capture. You can copy the file to a different
folder to review it after the batch is exported.

The Logging feature is available on the Tools menu.

Using Kofax Advanced OCR Full Text
This procedure shows how to set up your batch classes to use the Kofax Advanced OCR Full Text engine.

The following procedure assumes that your document and batch classes already exist. If not, you can
make these selections while creating new classes.

1. Open the Batch Class Properties window.

a. Click the Queues tab.

b. Add OCR Full Text and other required modules.

c. Click OK.
2. Open the Document Class Properties window.

a. Click the OCR tab.

b. Select Enable OCR full text.

c. Select a dictionary file.

d. In the Recognition Profile drop-down list, select Kofax Advanced OCR Full Text.

e. Select Skip first page of each document.

f. Click OK.
3. Open the Export Connector window.

a. Select the Kofax Capture Text export connector.

b. Click the Document Storage tab.

c. Select Export OCR full text files.

d. Select an export folder.

e. Click OK.

f. Click Close.
4. Publish the batch class.
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The Validation and Verification Modules

From the Validation module, operators manually enter or select field data for each document in a
batch. They also validate data captured with an automatic recognition method (such as OCR, bar code
recognition, etc.). Validation is typically monitored and used by a validation operator, whose basic tasks
include manual data entry, data validation, or batch editing.

Note that validation also occurs through validation scripts associated with the batch class. The default
validation scripts provide validation limited to the length of the field and the type of data in the field.
Custom validation scripts can also be used to perform additional validation. Refer to the Kofax Capture
Developer's Guide for more information about custom scripts.

The Verification module is used to verify data a second time after the data is processed through the
Validation module. Verification occurs for any field with the Verify attribute set to True on the Document
Class Properties window.

Validation Module
From this module, validation operators manually enter or select index field data for each document in a
batch. They also validate index field data captured with an automatic validation method (such as OCR, bar
code recognition, etc.).

The Validation module is typically monitored and used by a validation operator, whose basic tasks include:
• Manual validation: For manual index fields, the operator manually enters or selects index field data.
• Data validation: For automatic index fields, the operator visually checks that the data is correctly

captured. If not, the operator can enter or select the correct data.
• Batch editing: The operator can visually check documents or pages, and edit them as necessary.

Editing functions include replacing, reordering, or rejecting documents and pages. Entire documents or
individual pages can be rotated and saved in the rotated state.

Data is also validated by a validation script for the document class. The default scripts provide minimal
validation, such as checking for the specified length of the data. Additional validation can be performed
with custom scripts.

When the batch is ready for further processing, the validation operator can close the batch to send it to the
next processing module. 
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Setting Up the Validation Module
When you set up the Validation module, specify whether the validation operator is allowed to edit the
batch.

1. In the Administration module, on the Batch Class Properties window, click the Queues tab.
2. On the Selected Queues list, select Validation and then click Properties.

The Validation Properties window appears.
3. Select the Allow batch editing check box.

When selected, the validation operator is able to edit the batch.
4. Click OK to save your settings.

Verification Module
In this module, verification operators re-enter or visually verify data previously processed by the
Verification module. This occurs for any index field tagged with the "verify" attribute in the document class
definition. 

The Verification module is typically monitored by a validation or verification operator, whose main tasks
include:
• Verification: The operator verifies the data entered or verified by the validation operator:

• If double-key data entry is specified, the verification operator enters or selects data for the index
fields. Then, the index data is compared to the data entered or selected by the validation operator.
If the data entered by the verification operator is the same as the data entered by the validation
operator, the document is considered correctly validated.

• If double-key data entry is not specified, the verification operator can visually check the data entered
or selected by the validation operator. If necessary, the verification operator can change the data.

• Batch editing: The operator can visually check documents or pages, and edit them as necessary.
Editing functions include replacing, reordering, or rejecting documents and pages. Entire documents or
individual pages can be rotated and saved in the rotated state.

Data is also validated by a validation script for the document class. The default scripts provide minimal
validation, such as checking for the specified length of the data. Additional validation can be performed
through custom scripts.

When the batch is ready for further processing, the verification operator can close the batch to send it to
the next processing module. If any documents in the batch are rejected, the batch is sent to the Quality
Control module.

Setting Up the Verification Module
When you set up the Verification module, specify preferences for verifying index data for documents.

1. In the Administration module, on the Batch Class Properties window, click the Queues tab.
2. On the Selected Queues list, select Verification and then click Properties.

The Verification Properties window appears.
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3. Select each check box as applicable, and then click OK.
• Allow batch editing: Allows the verification operator to change the form type for a document, and

to create or delete pages and documents in the batch.
• Blind data entry: Hides values entered by the validation operator.
• Use independent verification: Prevents the operator who validated the batch from performing

the verification.
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The PDF Generator Module

PDF Generator is an unattended module that processes an entire document and stores the results in the
PDF format you specify (PDF Image Only or PDF Image Under Text).

Note Both output types create a single PDF file per document. It is not possible to create a separate
PDF output file for each page of a document.

Set the PDF format type in the Document Class Properties or the Create Document Class windows. If
you set the output type to PDF without including PDF Generator as a queue in the processing workflow, a
warning message appears when you publish the batch class.

eDocuments
The PDF Generator module treats eDocuments as blank pages. Additionally, each eDocument is treated
as if it were a single page. This is consistent with eDocument treatment in other Kofax Capture modules,
such as OCR Full Text.

Licensing
The PDF Generator module is included with Kofax Capture, and if you intend to exclusively process Kofax
PDF Image Only files, no additional licenses are required. However, if you intend to output Kofax PDF
Image Under Text files, you must obtain an upgrade.

Kofax PDF Compression
Kofax PDF Compression is an optional setting that directs the Kofax Capture PDF Generator module to
create compressed PDF documents. This option can be used in combination with all Kofax PDF output
types. PDF/A generates PDF 1.4. All other Kofax PDF output types generate PDF 1.4 or later, depending
on the settings.

Compressed PDFs, in most cases, reduce file size, provide faster transmission speeds over networks,
and occupy less space on storage devices.
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Compression Formats
Kofax PDF Compression automatically selects the compression format based on PDF choice (standard
PDF or PDF/A) and the input image type. The following table shows PDF and image type combinations
and the resulting compression format.

Compression Formats

Image Type and PDF Type Compression Format

Black & white image CCITT4/JBIG2

Color or grayscale image and PDF/A Combination of JPG-JPEG and CCITT4/JBIG2

Color or grayscale image and standard PDF Combination of JPG-JPEG/JPEG 2000 and CCITT4/
JBIG2
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The Export Module

Export is typically the final module in the Kofax Capture workflow. The Export module copies images to
permanent storage and writes index data to a database or back-end document management system.
Several standard export connectors are available for export to the following:
• ODBC-compliant databases
• Microsoft Access databases
• ASCII text files

Add your own custom export connectors to export your images and index data per specific requirements.

If your batch contains color image files, Export handles them according to the following rules:
• Only the color version of the image is exported (not the bitonal version).
• If color image cleanup is specified for the batch, but has not yet been performed, the Export module

performs the cleanup before exporting the document. No messages are displayed in such cases, but
system performance may be affected.

Export is an unattended module. Batches sent to the Export module are automatically processed.

Setting Up the Export Module
When you set up the default Export module, you can specify timing settings for exporting batches.

Note With Kofax Capture, you can customize the export process. The information here applies only to
the default Export capabilities. If your Export module has been customized, refer to the documentation
that came with your application.

1. In the Administration module, on the Batch Class Properties window, click the Queues tab.
2. On the Selected Queues list, select Export and then click Properties.

The   window appears.
3. Select a timing option for the export of batches.

• If you select "All Immediate," the batch is set for export when it is sent to the Export module.
Batches at the Export module are exported by priority level. Batches of the same priority level are
exported on a first in, first out basis.

• If you select "Timed," the batch is exported based on the start/stop settings that you specify.
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4. For timed batches, select the start/stop settings:

a. Select a priority.

b. Select a start time.

c. Select a stop time.
5. Select the batch export order.

"Export batch by document order" causes all the documents to be processed in order. This is the
default setting.
"Export batch by assigned export connector" causes all the connectors to be processed in order.

6. Select the type of Error Recovery to use.
When selected, all batch processing is terminated whenever an error occurs, and the entire batch is
marked as un-exported. If not checked, fatal errors and non-fatal errors are handled differently. Fatal
errors are handled as if this check box is selected. For non-fatal errors, the document causing the
error is rejected and ignored for the rest of the batch processing, and processing continues for the
remaining documents in the batch.

7. Click OK to save your settings.
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Disaster Recovery

This chapter provides information about configuring and using the Kofax Capture Disaster Recovery
feature, which is intended for system administrators who manage the disaster recovery features for a
Kofax Capture Enterprise installation.

Disaster recovery is the process of regaining access to the data, hardware and software necessary
to resume critical business operations after a natural disaster or catastrophe occurs. In a large Kofax
enterprise installation that includes multiple sites, servers, and personnel centers in various geographical
locations, a thorough business recovery plan is imperative.

A business recovery plan is a start-to-finish solutions approach to disaster recovery for your site. Although
the Disaster Recovery feature provides a partial solution, it cannot fill the void for hardware and software
configurations that are unique to your site, nor can it provide specific training for your personnel.

Your business recovery plan should include a training section for your personnel so they know what to
do in various situations. For example, if a central site becomes inoperable, normal duties will cease for a
large number of people who could potentially be deployed to work on solutions.

Interruption of Critical Functions
The Kofax Capture Disaster Recovery feature addresses the infrastructure needed to prepare for
business continuity and data recovery.

Business Continuity
Business Continuity refers to the recovery and restoration of interrupted critical functions. For a Kofax
Capture enterprise site, Business Continuity requires a backup central site. When a disaster strikes and
causes the primary site to go down, remote sites are automatically routed to the alternate central site,
personnel perform appropriate tasks per their training, and batches continue to be seamlessly uploaded.
This case requires no special action because it is transparent.

Data Recovery
Data Recovery implies that data is safely backed up and can be restored. For a Kofax Capture enterprise
site, this requires the batch backup feature to be selected, batches and batch classes to be replicated to
another secure location, and that administrative data is exported on a regular basis. When a site goes
down, it can easily be restored to the last backup point.

Note The Disaster Recovery feature ensures recovery of batches created at remote sites, but provides
no recovery solution for batches created at a central site.
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Features
Use the Kofax Capture Disaster Recovery feature to do the following:
• Back up, replicate, and restore batches and batch classes
• Specify batch upload behavior for optimal use of multiple central sites
• Manage the availability of central sites with easy-to-use utilities
• Share licensing across a Kofax Capture Enterprise installation
• Customize how administrative data is copied to alternate central sites
• Easily send custom module configuration data to an entire installation
• Customize load balancing among central sites using workflow agents
• Export and import administrative data

Note The SQL Server AlwaysOn Availability Groups feature for high availability and disaster recovery is
supported.

Setting Up for Disaster Recovery
You can make configuration settings that affect several areas: the entire enterprise, central sites, alternate
central sites, and customization. The following sections explain each configuration.

Enterprise Setup
Disaster Recovery setup at the enterprise level includes the following:

Shared and Backup Licensing Support for Disaster Recovery

Because a Disaster Recovery configuration has at least two central sites, it employs a shared license
scheme that requires minor configuration adjustments.

Backing Up, Replicating, and Restoring Batches

The Disaster Recovery configuration provides several features intended to secure your batches and
batch classes in the event of a central site failure. First, it provides a mechanism to automatically back up
batches and their associated batch classes to a user-specified location. Once automatic batch backup
is configured, you can schedule third-party replication software to transparently copy batch information
to a secure location. In the case of a disaster, your critical business data is securely backed up. Once
the down central site is active again, you can execute an easy-to-use command line utility to restore any
batches that may have been lost.

Central Site Setup
Setting up your central sites for a Kofax Capture Disaster Recovery configuration includes the following:
• Creating a list of all the central sites and their URLs that are part of your Kofax Capture Disaster

Recovery configuration. For more information, see Creating a List of Central Sites.
• Specifying batch upload behavior. You can configure a primary site so that remote sites automatically

select a central site for load balancing or upload batches using a priority list of central sites. To specify
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batch upload behavior and to optionally create a priority list of central sites, use the KCN Server
Remote Site Profiles Window - Business Continuity tab. You can also specify batch upload behavior
using a workflow agent.

Alternate Site Setup
The Kofax Capture Disaster Recovery configuration provides several optional methods to modify the way
batches are processed. For example, when you export administrative data from one system and import
it to another, you can substitute new values for the configuration settings. You might use this feature to
develop and test using one path for images, and then move to a production configuration using another
path for images. You could also use this method to specify a new path for images in a disaster recovery
scenario. There are comparable substitution mechanisms provided for image files, custom data, and
export connector setup data. For more information, see Data and Path Substitution.

Customization
The Kofax Capture Disaster Recovery configuration also provides several customization options, as
outlined below.

Transferring Custom Module Configuration Data

You can place custom module configuration data in a designated folder at the central site. As a result,
a KCN Server automatically sends the configuration data to remote sites when they synchronize and
to alternate central sites when a batch of another central site is uploaded. This allows administrators
to easily send custom module configuration data to the entire installation. For more information, see
Transferring Custom Module Configuration Data.

Customizing Workflow Agents

You can create a workflow agent using the Kofax Capture Optimized Custom Module API to customize
the current load balancing or priority scheme. For example, based on a set of business rules, you might
want to override the current priority list and route batches to a different central site from what is currently
specified. For more information, see the Kofax Capture Developer’s Guide.

Operations
After enabling and configuring your Kofax Capture Disaster Recovery configuration, you can manage the
use and availability of each central site as explained below.

Switching to a New Primary Central Site

You can switch any remote site to a new primary central site by running the KCN Server Site Switch
command line utility. You might want to temporarily switch remote sites to another primary central site to
perform routine maintenance at a particular central site. In another case, a central site might be down, and
to preserve business continuity, you can switch all remote sites to use another central site as a primary.
For more information about this utility, see Switching to a New Primary Central Site.

Removing a Central Site

You can delete a central site by running the KCN Remove Central Site command utility. After switching
any remote sites that are using a particular central site, you might want to delete that central site from
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the KCN Server central site list. You can perform this operation to remove a particular central site for an
undetermined period of time. For more information about the utility, see Deleting a Central Site.

Exporting and Importing Administrative Data

You can export and import administrative data such as batch classes, KCNS profiles, and user profiles.
This allows you to save periodic snapshots of administrative data. You can use administrative data export
and import in to duplicate administrative settings when restoring or switching primary sites or to transfer
administrative settings from a development site to a production site. For more information, see Exporting
and Importing Administrative Data and Administrative Data Export and Import Recommendations.

Tracking Batch Class Versions

At the central site, you can use the Versions feature to update and track the published batch class
versions that are in use at each remote site. For more information about the Versions feature, see the
Administration module help.

Backup and Shared License Server Support
This section explains how licensing is activated and configured in a Kofax Capture Disaster Recovery
configuration.

Backup License Server Support for Disaster Recovery

To manage all licensing requests, Kofax Capture supports multiple license servers: a primary and one
or more backups. When multiple license servers are available, each license server requires its own
activation code and license configuration. A remote site backup license server gets a license from the
central site. If you selected the hardware key option, each license server also requires its own hardware
key.

Note For information about the backup license server for remote sites, see "Activating the Remote
Backup License Server" in the Installation Guide.

In any configuration, if the primary license server fails, the system automatically switches to the backup
license server. The system can use this backup license server until it runs out of volume. When the
primary system is restored, Kofax Capture automatically switches to it again for licensing. A backup
license is included with Kofax Capture Enterprise.

With a disaster recovery configuration, you can activate the backup license server at an alternate site.
That way, in a disaster situation or during routine maintenance, if the system at the central site providing
primary licensing becomes unreachable, a system at an alternate central site with backup licensing can
continue the licensing function, allowing uninterrupted workflow.

For example, your business might require a system that includes two central sites that process 2M pages
a year with 20 remote sites (with one station license at each site). Regardless of how the site is configured
for batch uploading, all remote sites would initially obtain licensing from the primary licensing server at
a central site. If, for some reason, the primary licensing server becomes unavailable, licensing would
automatically switch to the backup licensing server at an alternate central site.
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Note The backup license server is intended for use as a short-term solution until the primary license
server is up and running again. The backup server offers limited page volume licensing, which is
suitable as an interim solution but not for long-term purposes. Therefore, the backup license server must
be configured for temporary use only in the event of a license server failure.

Setting Up Shared License Server Support for Disaster Recovery

In a Disaster Recovery system configuration, licensing must be shared among all central sites. For
example, suppose your system configuration contains two central sites. Set up your configuration using
the following general steps:

1. Install both central sites. If you selected the hardware key licensing option, attach hardware keys.
2. Activate your licenses. The activation process establishes licensing information for the central sites

as well as all remote sites (based on assigned remote site profiles).

a. Activate the primary license wherever you plan to run the primary license server.

b. Activate a backup license at the alternate central site. The backup server can also be activated
on the server or any workstation at the site.

3. When activation is complete, set up shared licensing by configuring all central sites to use the
primary license server.

4. Finally, install the remote sites. Remote sites receive their licensing based on the rules you have
established in the KCN Server Remote Site Profiles window.

Note The license server on a standalone installation cannot be shared.

Configuration

You can configure a shared license by updating the ACConfig.xml file. For a client/server installation, this
file is located in <ServerPath>\Config. Check with your administrator for the exact location of this file.

The following shows a typical section of the licensing portion of the ACConfig.xml file.
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Licensing for a Disaster Recovery Configuration

<Licensing>
  <Service Key=”Licensing\Licensing Service” 
   Host=”System_on_CS_1”/>
  <Service Key=”Licensing\Licensing Service” 
   Host=”System_on_CS_2”/>
</Licensing>

The terms "System_on_CS_1" and "System_on_CS_2" reflect the fact that a license server may be
activated on any workstation or server at the central site.

The following examples show how to configure a shared license. It explains how to edit the ACConfig.xml
file and which license server to use.

Two Central Sites - Configuration

The following illustrates a sample configuration with two central sites.

Before Editing ACConfig.xml

Central Site ACConfig.xml File License Server

1
(Primary)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_1”/>
</Licensing>

Primary

2
(Alternate)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_2”/>
</Licensing>

Backup
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Note the changes in the following table.

After Editing ACConfig.xml

Central Site ACConfig.xml File License Server

1
(Primary)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_1”/>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_2”/>
</Licensing>

Primary

2
(Alternate)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_1”/>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_2”/>
</Licensing>

Backup

Note The text that changed in each ACConfig.xml file is bold.

Four Central Sites - Configuration

In a four central site configuration, a license server is required on only two of the four central sites. The
following illustrates a sample configuration.

Before Editing ACConfig.xml

Central Site ACConfig.xml File License Server

1
(Primary)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_1”/>
</Licensing>

Primary

2
(Alternate)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_2”/>
</Licensing>

Backup

3
(Alternate)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”Central_Site_3”/>
</Licensing>

None

4
(Alternate)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”Central_Site_4”/>
</Licensing>

None
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Note the changes in the following table.

After Editing ACConfig.xml

Central Site ACConfig.xml File License Server

1
(Primary)

<Licensing>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_1”/>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_2”/>
</Licensing>

Primary

2
(Alternate)

<Licensing>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_1”/>
<Service Key=”Licensing\Licensing
Service” Host=”System_on_CS_2”/>
</Licensing>

Backup

3
(Alternate)

<Licensing>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_1”/>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_2”/>
</Licensing>

None

4
(Alternate)

<Licensing>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_1”/>
<Service Key=”Licensing
\Licensing Service”
Host=”System_on_CS_2”/>
</Licensing>

None

Note The text that changed in each ACConfig.xml file is bold.

In addition to editing the ACConfig.xml file, we recommend that you disable the license servers on central
sites 3 and 4. For details, see the Installation Guide.

Optional Advanced Settings

The following shows a section of the licensing portion of the ACConfig.xml file that uses several advanced
features.
<Licensing ServerTimeout=”30”>
  <Service Key=”Licensing\Licensing Service” 
  Host=”System_on_CS_1”
  Protocol=”http” />
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</Licensing>

The ServerTimeout parameter specifies the number of seconds that a site tries to connect to a license
server to obtain licensing before it times out. In this case, the site would try for 30 seconds before it times
out. The licenses are listed in priority order. If a site cannot connect to a license server within the server
time-out period, it tries the next one on the list. After trying the last server on the list, it begins again at the
first server in the list.

Network Considerations

License sharing occurs among all client stations directly attached to the central site and specified license
servers. In order to communicate, the license server requires TCP port 2424 or 3581. You must allow this
port at all central sites.

Remote sites require only HTTP or HTTPS to communicate with central sites. You do not need to open
TCP port 2424 or 3581 to enable communications and license sharing among remote sites and central
sites (only among the central sites themselves).

Site Administrator Activity
As a site administrator, you are responsible for the following areas: initial setup, routine maintenance, and
manual intervention in the case of a down system.

For the initial setup, a site administrator must configure shared and backup licenses, set up a backup
location for batches and batch classes, configure a replication scheme, create a list of central sites, and
specify upload behavior. The administrator can also optionally export administrative data, transfer custom
module configuration data, and create custom workflow agents.

Routine maintenance might include exporting administrative data at regular intervals, monitoring batch
upload activity and balancing, and monitoring batch replication activity.

Manual intervention might include adding a central site, switching remote sites to another central site,
restoring batches and batch classes to a restored site, importing administrative data to a restored site, and
possibly deleting a central site.

For business continuity, the system automatically switches batch uploads to alternate central sites
depending on defined upload behavior.
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Business Continuity

Backing Up, Replicating, and Restoring Batches
The Disaster Recovery configuration provides several features to secure your batches in the event of a
central site failure. First, it provides a mechanism that allows you to automatically back up batches and
their associated batch classes to a user-specified location. Once automatic batch backup is configured,
you can schedule replication software to transparently move batch files to a secure location. In the case
of a disaster, your critical business data is now securely backed up. You can restore any batches that may
have been lost to an alternate central site or to the down central site when it is active again. The following
sections describe how to implement each part of this process.

Setting Up Automatic Batch Backup
This section explains how to set up a Disaster Recovery configuration for automatic batch backup. Once
this is set up, you can replicate the backed up files and, in the event of a disaster, restore any lost batches
or batch classes.

Enabling and Configuring Batch Backup
To enable and configure automatic batch backup, add the following element to the ACConfig.XML file:
<Replication Path="Backup Path" DelayTimeInMinutes="Delay Time">
 <ExcludedBatchClass>Excluded Batch Class</ExcludedBatchClass>
</Replication>
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Example
<Replication Path="\\MyComputer\Backup\" DelayTimeInMinutes="720">
 <ExcludedBatchClass>Order Form</ExcludedBatchClass>
 <ExcludedBatchClass>Invoices</ExcludedBatchClass>
</Replication>

Use the following parameters to configure automatic batch backup.

Replication Path

The Replication Path specifies a backup location. When you select the automatic batch backup feature,
the system creates a copy of each batch in the specified folder. This makes it ready for replication
by a third-party software package. If the published batch class used by a batch has not already been
replicated, a copy of the batch class is also copied to the specified backup location.

Note Deleting batch classes in the backup location is not recommended because you might
inadvertently delete a batch class that is needed by a backed up batch.

When batches and batch classes are placed in the specified backup location, they are separated into a
batch folder and a batch class folder:
<Specified backup location>\Batches\
<Specified backup location>\BatchClasses\

Access to these folders must be granted to the user that is running the KCN Service. Failure to grant this
permission prevents batches from being backed up and possibly delays overall batch insertion time.

DelayTimeInMinutes

The DelayTimeInMinutes parameter defines the time between when a batch is successfully inserted (and
backed up) and when the remote site receives notification that the batch can safely be deleted. This delay
gives your third-party replication software time to replicate batches before they are automatically deleted
from the remote site. During this time, the status of batches at remote sites is In "Progress (Replicating -
<CentralSiteName>)."

When setting the delay time, leave a reasonable margin. For example, a time that is too short, such as
one hour (60), may not leave enough time to safely replicate batches. On the other hand, a time that is
too long, such as 24 hours (1440) might overload the disk with batches waiting for replication. It may also
cause a large percentage of duplicate batches in a disaster recovery situation if remote sites re-send
batches that were already restored. A delay time of 12 hours (720) might be a good starting point, and
then adjust it up or down based on the actual replication time.

Batches remain at the remote site until the first time the remote site synchronizes with the central site after
the delay time has expired, or the batch is exported or deleted at the central site.

A batch is only backed up the first time it is uploaded to the central site; it is not backed up again on
subsequent uploads. Backed up batches in the specified backup location are deleted only when a batch is
exported or deleted from the central site.

Batch classes are never deleted from the specified backup location.

ExcludedBatchClass
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By default, all batch classes are backed up to the specified backup location. You can exclude any batch
class from the backup and replication process using the ExcludedBatchClass parameter. Batch classes in
this list and the batches that use them are not placed in the specified backup location.

Multiple Versions of Batch Classes
The batch backup feature backs up all versions of published batch classes that are uploaded from remote
sites.

Errors
If an error occurs during the backup process, the batch is not deleted from the remote site and an entry is
logged to the error file. In this case, the batch is sent back to the remote site and must be uploaded again
once the error has been corrected.

Backup Requires Remote Site Upgrade
The batch backup feature requires that remote sites be upgraded to the latest version of Kofax Capture.

Replication
Once you have configured automatic batch backup as outlined in the previous section, you are ready to
transfer data to an off-site location on a scheduled basis. This requires that you purchase and configure a
third-party replication application of your choice.

The replication software that you purchase should be a Windows server, file-based, file replication
software application that replicates files over a WAN. Use the instructions that came with your third-party
software to install and configure your software on a remote server.

When you configure your third-party replication software, specify the replication path. The replication path
is the local folder where Kofax makes copies of batches and published batch classes. This is the path that
you specified in the ACConfig.XML file in the section titled Setting Up Automatic Batch Backup.
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Backup and Replication

Restoring Batches Using the KcnsRestoreBatches Command Line Utility
The KCN Server Restore Batches utility, KcnsRestoreBatches.exe, is a standalone command line utility
that restores batches from a specified location. You can find this utility in the Kofax Capture bin folder.

Notes:
• All error messages are written to the error log.
• If the utility encounters a batch that has already been restored, it is skipped.
• You can restore batches to Kofax Capture without KCNS installed and enabled.
• If you restore a batch to a central site that is not connected to the remote site that the batch requires

for routing, the central site still routes the batch with the assumption that the required remote site will
eventually be connected.

• Only one instance of the utility may be run at a time.
• The utility cannot be run on a remote site.
• If the batch routing rules in a batch require routing to a remote site, an installed and enabled KCN

service must exist at the site where the batch is restored. Without a KCN service, this type of batch is
not "Ready to download." Note that a batch cannot be recalled unless it is ready to download.

Command Line Parameters
You can specify the path where batches have been backed up and login credentials when required. You
can also remove backed up batches that have been successfully inserted. Specify parameters with a
forward slash (/) or a hyphen (-).

/path [path]
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This parameter is required to specify the location from which to restore batches. Follow the /path
parameter with a valid path, as in the following example:
KcnsRestoreBatches /path “\\mysystem\batchbackup”

/u [username]

If you run the utility at a site where User Profiles is selected, you must be assigned the "Allow
Administration module access" right. Use the /u parameter along with the /p parameter to specify a user
name and password. See the example for the /p parameter.

/p [password]

If you run the utility on a central site where User Profiles is selected, an administrator login is required.
Use the /p parameter along with the /u parameter to specify a user name and password. The following
example specifies a valid user, steven, and his password, Vq4Rc8t2x.
KcnsRestoreBatches /path “\\mysystem\batchbackup” 
/u steven /p Vq4Rc8t2x

/d

By default, the utility moves restored batches that have been successfully inserted into a subfolder so it
does not attempt to restore them again. If you would rather delete the backed up batches, include the /d
parameter.

/?

The "?" parameter displays the correct usage of the KcnsRestoreBatches utility to the console. It defines
each of the supported command line parameters and provides an example for formatting the command
line. For example, you can use the following to display information about correct usage:
KcnsRestoreBatches /?

Error Codes

The Kofax Capture Restore Batches command utility returns the codes listed in the table.

Value Name Description

0 Normal The utility ran successfully and without exception.

1 BadUsage The path parameter was supplied without an actual path.

2 LoginRequired User Profiles is selected, but a login was not provided.

3 LoginFailed Credentials were supplied but could not be validated.

4 UnknownError An unhandled exception was encountered. Check the
error log.

5 IsRemoteSite The utility was run on a remote site. Therefore, no
batches are restored. To successfully restore batches,
run the utility on a station other than a remote site.

6 InvalidDirectoryStructure The utility expected the following subfolder in the path
specification: "<Path>\Batches". If this folder is not
specified, an invalid directory message is logged and
this error code is returned.
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Value Name Description

7 NormalExitWithErrors Errors occurred during the batch restoration process.
Check the error log for details.

8 CannotValidateUser The utility was not able to ascertain whether user profile
information was needed.

Backing Up and Restoring the Standard Database
This section gives instructions for backing up and restoring the Kofax Capture Standard database for a
client/server or standalone installation. The procedures apply to SQL Server Express, the default selection
for the Standard database.

Note To back up and restore a SQL Server, Oracle, or IBM DB2 database, follow the instructions from
the respective database provider.

The SQL Server Express database contains information about User Tracking and current batches in the
system waiting to be processed.

The Standard database backup is not a complete backup of Kofax Capture, which also requires a backup
of the server files folder and the designated image folders. The Server Files folder is selected during
installation and is typically C:\ProgramData\Kofax\CaptureSV. In addition, the temporary image
folders defined in the batch classes need to be backed up to preserve the images associated with batches
in progress.

Follow the procedures in this section to properly back up and restore your Standard database. Your folder
paths may differ from the samples that appear in the procedures, depending on the type of installation
(client/server or standalone) and other factors.

Standard Database Instance Names
To perform the backup and restore procedures, you need the name of the Standard database instance.

If you are installing Kofax Capture for the first time, the instance name is KofaxCap2014.

If you upgraded to Kofax Capture 11.1.0 from a previous version of the product, the instance name may
vary:
• If you use an MSI-based deployment method to upgrade to Kofax Capture 11.1.0, the Standard

database instance name for the previous version is retained. For example, when upgrading from Kofax
Capture 10.0 to 11.1.0, KofaxCap2008R2 is retained as the Standard instance name.

• If you use the Kofax Capture installation wizard to perform the upgrade to 11.1.0, the Standard
database instance name for the previous version is replaced with the name KofaxCap2014.

Use the following table to identify your Standard instance name.
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Standard Database Instance Names

Kofax Capture Version Standard Instance Name Notes

11.1.0 KofaxCap2014 Instance name used for new 11.1.0
installations

10.2 KofaxCap2012 Instance name for new 10.2 installations

10.1 KofaxCapture Instance name for new 10.1 installations

10.0 KofaxCap2008R2 Instance name for new 10.0 installations

8.0, 9.0 AscentCapture Instance name for new 8.0 / 9.0 installations

Client/Server Installations
Use the following procedures to back up and restore the Standard database instance for a client/server
installation.

In these procedures, <NN> refers to the version of SQL Server Express (if you upgraded to Kofax Capture
11.1.0 from a previous version, <NN> refers to the previous version of SQL Server Express).

Also, the Standard database instance name is represented as <Instance_Name>. To identify the
applicable instance name for your installation, see the table in Standard Database Instance Names.

Backing Up the Standard Database
1. Stop the SQL Server service associated with the Standard database instance. Also stop the Kofax

Capture service and any unattended module services, as applicable.
2. Copy ACSystem.mdf and ACSystem_log.ldf, which are typically located here:

C:\ProgramData\Kofax\Capture\Server\DB\MSSQL<NN>.<Instance_Name>\ MSSQL
\DATA

3. Start the SQL Server service associated with the Standard database instance.

Restoring the Standard Database
Be sure to restore the database in conjunction with the rest of the Kofax Capture file structure, to ensure
that the restored installation is complete.

1. Stop the SQL Server service associated with the Standard database instance. Also stop the Kofax
Capture service and any unattended module services, as applicable.

2. Browse to C:\ProgramData\Kofax\Capture\Server\DB\MSSQL<NN>.<Instance_Name>
\MSSQL\Data

3. Rename the original ACSystem.mdf and ACSystem_log.ldf to ACSystem_Orig.mdf and
ACSystem_log_Orig.ldf, respectively.

4. Copy your backed up ACSystem.mdf and ACSystem_log.ldf into the folder.
5. Start the SQL Server service associated with the Standard database instance.
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Standalone Installation
Use the following procedures to back up and restore the Standard database instance for a standalone
installation.

In these procedures, <NN> refers to the version of SQL Server Express (if you upgraded to Kofax Capture
10.2 from a previous version, <NN> refers to the previous version of SQL Server Express).

Also, the Standard database instance name is represented as <Instance_Name>. To identify the
applicable instance name for your installation, see the table in Standard Database Instance Names.

Backing Up the Standard Database
1. Stop the SQL Server service associated with the Standard database instance. Also stop the Kofax

Capture service and any unattended module services, as applicable.
2. Copy ACSystem.mdf and ACSystem_log.ldf, which are typically located here:

C:\ProgramData\Kofax\Capture\Server\DB\MSSQL<NN>.<Instance_Name>\MSSQL
\DATA

3. Start the SQL Server service associated with the Standard database instance.

Restoring the Standard Database
Be sure to restore the database in conjunction with the rest of the Kofax Capture file structure, to ensure
that the restored installation is complete.

1. Stop the SQL Server service associated with the Standard database instance. Also stop the Kofax
Capture service and any unattended module services, as applicable.

2. Browse to the following:
C:\ProgramData\Kofax\Capture\Server\DB\MSSQL<NN>.<Instance_Name>\MSSQL
\Data

3. Rename the original ACSystem.mdf and ACSystem_log.ldf to ACSystem_Orig.mdf and
ACSystem_log_Orig.ldf, respectively.

4. Copy your backed up ACSystem.mdf and ACSystem_log.ldf into the folder.
5. Start the SQL Server service associated with the Standard database instance.

Data and Path Substitution
When you export administrative data from one system and import it to another, you can substitute new
values for the configuration settings. Substitution is possible in the following areas:
• Image Path Substitution
• Export Connector Setup Substitution
• Custom Data Substitution
• External Field Substitution

This section explains how to use ACConfig.xml to specify data and path substitution values. As another
option, you can specify substitution values using the Data Substitution window that appears during the
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process of importing a new batch class into Kofax Capture. All values specified on the Data Substitution
window are saved in ACConfig.xml.

If you import a batch class with a name that already exists, the Data Substitution window does not appear,
and the substitution settings in ACConfig.xml are automatically applied.

Image Path Substitution
With ACConfig.xml, you can use image path substitution to:
• Develop and test using one path for images, and then move to a production configuration using another

path for images.
• Specify a new path for images in a disaster recovery scenario.

Keep the following in mind as you modify ACConfig.xml:
• The path for the index storage path is based on the custom path and file name specified on the Index

Storage tab on the Text Export Connector setup window. See Custom Data Substitution.
• Path substitution for the Text Export Connector does not support substitution of macros. If the original

path includes a macro, the substitution is successful but the macro becomes a text constant after you
import the batch class.

Syntax
Path substitution format in ACConfig.xml:
<ACConfig>
 <AdminDataSubstitution>
   <Replace Old="<old path>" New="<new path>"/>
 </AdminDataSubstitution>
</ACConfig>

Substitution Location
The system substitutes every entry in ACConfig.xml for the following location.

Substitution Location

Purpose Object Property

Image folder for a batch class BatchClass ImageFolder
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Export Connector Setup Substitution
For text and database export connectors, you can substitute path data and certain custom data.

Note If you modify the export connector’s source code that affects this substitution scheme, you may not
get the intended results.

Syntax
Data setup substitution format in ACConfig.xml:
<ACConfig>
 <AdminDataSubstitution>
   <Replace Old="<old_data_source_name>" New="<new_data_source_name>"/>
 </AdminDataSubstitution>
</ACConfig>

Substitution Locations
The system substitutes every entry in ACConfig.xml for each of the following locations.

Substitution Locations

Purpose Object Property

ODBC source for Database Export
Connector

ReleaseSetupData ConnectString

Image folder for Export Connector ReleaseSetupData ImageFilePath

Full text OCR folder for Export
Connector

ReleaseSetupData TextFilePath

PDF folder for Export Connector ReleaseSetupData KofaxPDFPath

Custom Data Substitution
You can also substitute certain custom data, including data in the CustomProperty table, using KCEC-
Text.inf or DBRel.inf. KCEC-Text.inf is the setup file used for text export connectors, and DBRel.inf is the
setup file used for database export connectors.

To substitute custom data, modify ACConfig.xml and KCEC-Text.inf or DBRel.inf, as applicable.

Syntax
ACConfig.xml

Data substitution format in ACConfig.xml:
<ACConfig>
 <AdminDataSubstitution>
   <Replace Old="<Old Value>" New="<New Value>" />
 </AdminDataSubstitution>
</ACConfig>
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KCEC-Text.inf
[Ascent Capture Text]
DataSubstitution="<custom property>"
PathSubstitution="<custom property>"

Example
The following example substitutes a value of "False" for a value of "True" found in the
EnableKofaxPDFExport property.

ACConfig.xml
<ACConfig>
 <AdminDataSubstitution>
   <Replace Old="True" New="False"/>
 </AdminDataSubstitution>
</ACConfig>

KCEC-Text.inf
[Ascent Capture Text]
DataSubstitution=EnableKofaxPDFExport

Note The search and replace is blind. When you configure for a True/False substitution, make sure that
you do not unintentionally globally change the wrong settings.

Data Validation
For a CAB insert, the system performs no data validation. For KCNS batch insertion, the system first
checks to see if the substitution path exists. If it does not, the insertion will fail.

Remove and Add Export Connector to Apply Edits
For the changes to go into effect, you must use the Export Connector Manager to remove and add the
export connector whenever you substitute custom data using KCEC-Text.inf or DBRel.inf.

External Field Substitution
You can substitute the target URL for external field types for SharePoint. To substitute a target URL,
modify ACConfig.xml.

Syntax
ACConfig.xml

Data substitution format in ACConfig.xml:
<ACConfig>
 <AdminDataSubstitution>
   <Replace Old="http://old-sp-site/subsite1" New="http://new-sp-site/subsite2"/>
 </AdminDataSubstitution>
</ACConfig>
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Transferring Custom Module Configuration Data
You can place custom module configuration data in a designated folder at the central site and the KCN
Server automatically sends the configuration data to remote sites when they synchronize and to alternate
central sites when a batch of another central site is uploaded. This allows administrators to easily send
custom module configuration data to the entire installation. This feature is for large binary data files, such
as images.

To obtain the name of the designated folder that is used for this data, invoke the CustomDataFolder
method.

For example, you might want to run a custom module on several remote sites that all require the
same sample image. In this case, an admin plug-in would pass the custom module name to the
CustomDataFolder method and it would return a data storage path. After copying the sample image to
the designated folder on the central site, the next time published batch class information is transferred
to other sites, the sample image and any other data in the designated custom module folder would
also be transferred. Consequently, a custom module at any remote site can access the image from the
corresponding folder location at its remote site.

The values that each method returns are read-only and determined automatically based on the batch
class name and the custom module’s ID. You can also create subfolders within the designated folder
location and all data included in the subfolders are transferred.

Each object library (Kofax Capture AdminMod and Kofax Capture Document Access) contains two
methods that return a custom module folder name. You can use the methods during setup and during
runtime. One method returns a global custom data folder location based on the provided module ID. The
other method returns a custom data folder name based on the published batch class and the provided
module ID.

The following tables show each method per object library and the folder name string that it returns.

Kofax Capture AdminMod (ACAdMod.dll)

Method Returns folder name string

AdminApplication.CustomDataFolder (strModuleID as
string)

"<CaptureSV>\PubTypes\Custom\<strModuleID>"

BatchClass.CustomDataFolder (strModuleID as String) "<CaptureSV>\PubTypes\Custom\<Batch Class Name>
\<strModuleID>"

Kofax Capture Document Access (DBLite.dll)

Method Returns folder name string

RuntimeSession.CustomDataFolder (strModuleID as
String)

"<CaptureSV>\PubTypes\Custom\<strModuleID>"

Batch.CustomPublishedDataFolder (strModuleID as
String)

"<CaptureSV>\PubTypes\Custom\<Batch Class Name>
\<strModuleID>"
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Note To ensure that your custom module data folder is unique, it is recommended that the value you
pass to strModuleID be the custom module ModuleID (<company>.<application>.<module>) you use
when you register the custom module.

Switching to a New Primary Central Site
The KCN Server Site Switch utility, KcnsSiteSwitch.exe, is a standalone command line utility that specifies
a new primary central site in a Kofax Capture Disaster Recovery configuration. By specifying the URL
of the original primary central site, you broadcast to remote sites to discontinue using that site. Then the
remote sites switch to use a new primary central site, which is the site from which you are running the
KCN Server Site Switch utility.

The central site switch takes place automatically once a remote site is synchronized. If the remote site’s
existing primary central site URL matches a URL in the site switch list, it makes the switch to the new
primary central site.

The KCN Server Site Switch utility is available in the Kofax Capture bin folder.

Command Line Parameters
The utility supports several command line parameters. You can specify the URL of the old primary central
site, and when required, a user name and password. You can also remove a URL from the site switch list,
view all currently specified central site URLs in the site switch list, and display the correct usage. If you
specify an invalid or incomplete parameter, the utility defaults to the behavior of the View (v) parameter.

You can specify only one command line parameter at a time using a forward slash (/) or a hyphen (-).

/url [URL]

To specify a primary central site to switch from, you must specify its URL. The URL parameter is followed
by a valid URL, as in the following example:

KcnsSiteSwitch /url http://mywebserver/kcn

Note For WebSphere, the specified URL must be an exact match of the primary central site’s web
server URL because it is case-sensitive. This restriction does not apply to IIS.

/url [URL] [user] [password]

If you run the utility on a central site where User Profiles is selected, an administrator login is required.
The following example specifies a valid user, robert, and his password, MyC8q29x.

KcnsSiteSwitch /url http://mywebserver/kcn robert MyC8q29x

/v

The View (v) parameter displays all entries in the site switch list, which is a list of URLs specified at the
central site where the utility is run.

/r [URL]
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The Remove (r) parameter removes a specified URL from the site switch list. Once all affected remote
sites have completed switching primary central sites, you may want to remove any URL entries that are no
longer relevant by removing them from the list. The following example removes http://phoenix/kcn
from the site switch list:

KcnsSiteSwitch /r http://phoenix/kcn

/r [URL] [user] [password]

This parameter removes a specified URL from the site switch list when an administrator login is required.
For more information, see the "/r" parameter. The following example removes http://phoenix/kcn
from the site switch list using a valid user, john_baker, and his password, Z73Nt2x:

KcnsSiteSwitch /r http://phoenix/kcn john_baker Z73Nt2x

/?

The "?" parameter displays the correct usage of the KcnsSiteSwitch utility to the console. The following
command displays information about correct usage:

KcnsSiteSwitch /?

Error Codes
The KCN Server Site Switch command utility returns the following codes.

Error Codes

Value Name Description

0 Normal The utility ran successfully and without exception.

1 BadUsage Invalid parameters were entered.

2 LoginRequired User Profiles is enabled, but a login was not provided.

3 LoginFailed Credentials were supplied but could not be validated.

4 SiteNotFound A site targeted for removal was not on the site list.

5 LicenseError An enterprise license is required but not found.

6 UnknownError An unhandled exception was encountered. Check the
error log.

Deleting a Central Site
The KCN Remove Central Site command utility, KcnsRemoveCentralSite.exe, is a standalone command
line utility that deletes a central site (URL) from the KCN Server central site list. Once deleted, the central
site is no longer available to remote sites. The utility duplicates the functionality of deleting a central site
from the KCN Server Central Site Manager in the Kofax Capture Administration module.

KCN Remove Central Site is controlled completely via command line parameters. You can specify
parameters with a forward slash (/) or a hyphen (-).
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You can find this utility in the Kofax Capture bin folder.

Command Line Parameters
The utility supports several command line parameters. You can specify the URL of the central site to
be deleted, and when required, a user name and password. If you specify any invalid or incomplete
parameters, you are prompted with the correct usage. You can specify only one command line parameter
at a time.

/r [URL]

When you want to delete a central site, you must specify its URL. The "r" parameter is followed by a valid
URL, as in the following example:

KcnsRemoveCentralSite/r http://<mywebserver>/kcns

For WebSphere, the specified URL must be an exact match of the central site’s web server URL because
it is case-sensitive. This restriction does not apply to IIS.

/r [URL] [user] [password]

An administrator login is required if the utility is run on a central site where User Profiles is active. If the
current user is already logged in as an administrator, the credentials are used automatically. Otherwise,
a User Profiles username and password must be supplied. The following example switches one primary
central site to another using a valid user, robert_s, and his password, MyC8q29x.

KcnsRemoveCentralSite/r http://<mywebserver>/kcns robert_s MyC8q29x

/v

Use the "v" parameter to view the <URL> for each of the central sites that are currently available. Central
sites shown here can be deleted.

/?

Use the "?" parameter to display the correct usage of the KcnsRemoveCentralSite utility to the console.
The following command displays information about correct usage.

KcnsRemoveCentralSite /?

The correct usage also appears when you enter any invalid parameter.

Error Codes
The KCN Remove Central Site command utility returns the following codes.

Error Codes

Value Name Description

0 Normal The utility ran successfully and without exception.

1 BadUsage Invalid parameters were entered.

2 LoginRequired User Profiles is selected, but a login was not provided.
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Value Name Description

3 LoginFailed Credentials were supplied but could not be validated.

4 SiteNotFound An alternate site targeted for removal was not on the site
list.

5 UnknownError An unhandled exception was encountered. Check the
error log.

Exporting and Importing Administrative Data
You can export and import administrative data such as batch classes, KCNS profiles, and user profiles to
save periodic snapshots of administrative data. You can use administrative data to export and import in
the following cases:
• To duplicate administrative settings when restoring or switching primary sites
• To transfer administrative settings from a development site to a production site

Administrative data includes:
• Batch classes
• KCNS profiles (includes the Central Site List, Central Site Profile, Remote Site List, and Remote Site

Profiles)
• User profiles

Batch Classes
Use this feature to export and import batch class assignments and override settings for user profiles and
KCNS profiles (central and remote). When you export a batch class, it also exports the user profiles and
KCNS profiles it is assigned to, as well as the class-specific overridden batch routing settings for KCNS
profiles.

Exported and Imported Data
The following data is exported and imported with batch classes.

Option Description

Export All batch class assignments and override settings with the associated batch class
are exported. Optionally, you can exclude a KTM project when the batch class is
exported.
To exclude a KTM project folder, use the “Include KTM project” setting on the KTM
tab on the Export window in the Administration module.

Import Optionally imports all batch class assignments and override settings for batch
classes selected for import. The import process matches batch class assignments
and override settings to profiles by name. If a profile is not found, the settings for
that profile are not imported.

Transfer Mode

275



Kofax Capture Administrator's Guide

Select one of the following options to specify how duplicate batch classes are handled if the import
process encounters a duplicate batch class name.

Transfer Mode Options

Option Description

Do not import duplicates Does not import the duplicate batch class and its associated assignments and
override settings.

Save duplicates to a new
name

Renames the imported duplicate batch class by appending an integer to the name.
This is the default. Batch class assignments and overrides apply to the renamed
batch class. For example, if both central sites A and B contain a user profile named
"John" and the "Order Forms" batch class is exported from A and imported to B, the
renamed batch class becomes "OrderForms1" assigned to user John.

Replace duplicates with items
imported

Replaces the existing duplicate batch class. The batch class assignments and
override settings are updated in the profiles for the batch class.

Importing Batch Class Assignments and Override Settings

To import batch class assignments and override settings for the selected batch classes, select the Import
batch class assignments and override settings for the selected batch classes check box on the
Batch Classes tab.

Importing is Additive Only

When importing batch class assignments, they are only added to the existing assignments. Under no
circumstances are assignments ever removed.

KCNS Profiles
Use this feature to export and import KCNS profiles.

Exported and Imported Data
The following table lists the data that can be both exported and then imported.

Exported and Imported Data

Options Description

KCNS Central Site List Exported and imported data includes the list of central
sites.

KCNS Central Site Profiles Exported and imported data includes the data in the
Batch Routing tab on the KCN Server Central Site Profile
window. Note that the information in the Batch Class
Override tab is not imported. To import this data, use the
"Import batch class assignments and override settings for
the selected batch classes" setting on the Batch Classes
tab on the Import window.

KCNS Remote Site List Exported and imported data includes the list of remote
sites.
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Options Description

KCNS Remote Site Profiles Exported and imported data includes most of the
information contained in the KCN Server Remote Site
Profile window, which includes the following tabs:
Batch Routing
Assigned Batch Classes (Exported and imported data
includes only the "All batch classes" and "Selected batch
classes" settings. It does not include the list of assigned
batches classes and routing settings.)
Station Licensing
Volume Licensing
Polling
Business Continuity

Transfer Mode
Select one of the following options to specify how the import process should handle duplicate KCNS
profiles.

Transfer Mode Options

Option Description

Skip duplicate KCNS profiles If the import process encounters a duplicate KCNS
profile on the target system, it does not import the KCNS
profile.

Replace existing KCNS profiles The existing profile is updated with the settings of
the imported profile with the exception of data items
described earlier in the "Exported and Imported Data"
table.

Batches Routed to a Remote Site Not Ready to Download Without a KCN Service

If the batch routing rules in a batch require routing to a remote site, an installed and enabled KCN service
must exist at the site where the batch is imported. Without a KCN service, this type of batch would not be
"Ready to download." Note that a batch cannot be recalled unless it is ready to download.

User Profiles
Use this feature to export and import Kofax Capture user profiles.

Exported and Imported Data
The following User Profiles data is exported and imported.

Exported and Imported Data in User Profiles

Option Description

Export All (including linked) users and groups are exported.
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Option Description

Import Only new (including linked) users and new groups are imported. Existing users and
groups are never updated. The following information is imported for new users and
groups:
Users: General tab, Assigned Modules tab, and Group Members tab
Group: General tab, Assigned Modules tab, and Members tab

Data Not Exported or Imported
The following User Profiles data is not exported or imported:
• Enable User Profiles check box. This data is excluded to prevent interference with the current

processes of existing users.
• "Default user group for new batch classes" setting.
• Assigned batch classes. To import this data, use the "Import batch class assignments and override

settings for the selected batch classes" setting on the Batch Classes tab on the Import window.
• All existing users and groups.

Administrative Data Export and Import Recommendations
This section provides important recommendations and procedures for importing and exporting
administrative data.

Disaster Recovery

In the case of a disaster, if you have made recent backups of all administrative data, you can easily import
all batch classes, KCNS profiles and user profiles to the restored system.

Development to Production Site Data Transfer

In the case of a development, test, and production system, you can develop batch classes, KCNS profiles,
and user profiles on a development system and then incrementally transfer the settings to the production
system. You can choose to import only the modifications from the most recent update.

Note To successfully export and import administrative data from a development site to a production site,
the two sites should contain the same site configuration and site names. Also, before importing data,
first synchronize all remote sites with the central site.

Exporting Administrative Data
Use the following recommendations to export administrative data to prepare for a disaster recovery
scenario or to transfer administrative data from a development system to a production system.

To export administrative data to prepare for disaster recovery

In the Export window:
• On the Batch Classes tab, add all batch classes to "Selected Batch Classes" for export.
• On the KCNS Profiles tab, select the "Export KCNS profiles" check box to export all KCNS profiles.
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• On the User Profiles tab, select the "Export user profiles" check box to export user profiles (All,
including linked, users and groups are exported).

• On the KTM tab, select the “Include KTM project” setting to include the Kofax Transformation Modules
project folder when files are exported.
If no changes exist in the KTM project folder, you can exclude it by clearing the "Include KTM project"
check box.

To export administrative data from a development system

Depending upon your goals, you may export certain types of administrative data that has been updated
for production:
• To export specific batch classes: In the Export window, on the Batch Classes tab, add selected batch

classes to "Selected Batch Classes" for export.
• To export KCNS profiles: In the Export window, on the KCNS Profiles tab, select the "Export KCNS

profiles" check box. Selecting this option always exports all KCNS profiles.
• To export only user profiles: In the Export window, on the User Profiles tab, select the "Export user

profiles" check box. The exported data includes all the settings (except assigned batch classes) on the
User Profiles window.

Importing Administrative Data

Recommendations
• Importing all data at the same time is recommended because it automatically imports data in the correct

order.
• If you import batch classes, KCNS profiles, and user profiles separately, be sure to import batch classes

last. This ensures that batch class assignments are available for the already imported KCNS profiles
and user profiles.

• If you already imported administrative data without following the recommended order, you can still add
batch class rights and assignments.

• To make an exact copy of administrative data from another site, before importing, be sure to delete user
profiles on the production (target) system with identical names as user profiles on the development
(source) system.

• When you export administrative data from one system and import it to another, you can substitute new
values for the configuration settings.

Importing Batch Classes
1. Export batch classes according to the recommendations in Exporting Administrative Data.
2. Start the Administration module.
3. On the Home tab, in the Batch Class group, click Import.
4. Select the file that contains the exported batch classes obtained in Step 1, and click Open.
5. When the unpacking process is complete, click OK.
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6. On the Import window, on the Batch Classes tab, do the following:
• Click Add All.
• Select Replace duplicates with items imported.
• Select the Import batch class assignments and override settings for the selected batch

classes check box.
• Click Import.

If the batch class is being imported for the first time, the Data Substitution window displays the
current and new values for the imported data. You can use the window to replace paths and other
values that are outdated when you import the batch class from one environment to another.
Upon first import, the Export Credential Management window also appears. Use the window to
update the login credentials used by export connectors, without having to edit them individually if
credentials change for a content management system.

Importing KCNS Profiles
1. Export KCNS profiles according to the recommendations in Exporting Administrative Data.
2. Start the Administration module.
3. On the Home tab, in the Batch Class group, click Import.
4. Select the file that contains the exported KCNS profiles obtained in Step 1, and click Open.
5. When the unpacking process is complete, click OK.
6. On the Import window, on the KCNS Profiles tab:

• Select the Import KCNS profiles check box to import all KCNS profiles.
• Select Replace existing KCNS profiles.

7. Click Import.

Importing an Exact Replica of the Exported User Profiles
1. Export user profiles according to the recommendations in Exporting Administrative Data.
2. Delete all user profiles on the target system.
3. Start the Administration module.
4. On the Home tab, in the Batch Class group, click Import.
5. Select the file that contains the exported user profiles obtained in Step 1, and click Open.
6. When the unpacking process is complete, click OK.
7. On the Import window, on the User Profiles tab, select the "Import user profiles" check box to

import user profiles.
All (including linked) users and groups are imported.

Note If you do not manually delete all user profiles and import new ones from the source system,
you can manually update them on the target system. However, if you later import batch classes,
they may get assigned to users you did not intend to modify.

Importing Only Exported User Profiles
1. Export user profiles using the recommendations in Exporting Administrative Data.
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2. On the target system, delete only the user profiles with names identical to the user profiles on the
source system. (If you do not delete them, the import process automatically skips them.)

3. Follow steps 3 through 7 in the previous procedure.

Exporting at Remote Sites

You can export batches at remote sites. Export connector installation and registration for non-Kofax export
connectors must be performed at the central and remote sites using the export connector registration
utility. However, export connector setup must be performed at the central site.

Note If an export connector is not registered and the remote site is designated for remote export, an
error is not returned at the remote site during batch class synchronization.

If Export Fails at a Remote Site

If export fails at a remote site, you have several options:
• Check to see that the export paths exist on the remote site (you set these at a central site and they

should be the same at the remote site) and database connections are correct (depending on the script,
this may mean that the remote site must reside on the same domain as the central site). If these issues
caused the export to fail, you can re-export the batch once they are fixed.

• Use a workflow agent to route the batch to another remote site.
• Recall the batch and export it at the central site.

Notes
• Document IDs are unique per site, so if multiple sites (primary central, alternate central, or remote)

export to the same database or merge their data, document IDs may collide. When exporting to a
common back end document management system, use Document GUIDs when possible.

• When a remote site exports a batch, if the central site recalls the batch before the remote site
synchronizes, the central site can also export the batch. If both sites export to the same back end
document management system or merge data, there may be duplicate batches.

Reinstalling an Alternate Central Site
If you reinstall an alternate central site (using the same name but with a new GUID), use the following
procedure to make it operational with the current profile settings on the primary central site.

1. Export the current KCNS profiles from the primary central site.

2. Remove the previous alternate central site from the KCNS Server Central Site Manager.

3. Add the reinstalled alternate central site to the KCNS Server Central Site Manager.

4. Import the exported KCNS profiles to the alternate central site with "Replace existing KCNS profiles"
selected.
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Kofax Capture Services

With Kofax Capture, you can install and run the Kofax Capture XML Import Connector, Recognition
Server, Instant Batch Notification, Kofax PDF Generator, OCR Full Text, RSA, and Export modules as
services under Windows. As services, these unattended modules can be configured to run automatically
at system boot.

Services are installed from a command prompt (see Configuring a Kofax Capture Service). After
installation, use the Windows Services utility to configure and monitor your Kofax Capture service.

Run Unattended Modules as Services
After completing the Kofax Capture installation, you can run the unattended modules (XML Import
Connector, Recognition Server, Kofax PDF Generator, OCR Full Text, or Export) as services. You can run
the services on each workstation where they will be implemented, or you can run them on the server.

When using KCN Server, you can also install the Remote Synchronization Agent (RSA) as a service.

To install services, you must be logged in to Windows with administrator rights.

To install the service for a Kofax Capture module, run the installation from a command prompt on the
station where you want to run a module as a service as follows:

Workstations

"<Kofax Capture installation folder>\Bin\module.exe" -install

Servers

"<Kofax Capture installation server software folder>\ServLib\Bin\<module.exe>"
-install

Where:

<Kofax Capture installation folder> or <KCN Server installation server software
folder> is the path to your Kofax Capture installation.

module.exe is the executable file name for the module you want to install as a service.

Note Running additional services on your server may impact overall system performance, and therefore
is not recommended unless you are using a multiprocessor system as your server.

The following executables are available in the Kofax Capture Bin folder.

282



Kofax Capture Administrator's Guide

Executable Description

acxmlai.exe XML Import Connector (deprecated)

ocr.exe OCR Full Text

kfxPdf.exe Kofax PDF Generator

fp.exe Recognition Server

release.exe Export

acirsa.exe Remote Synchronization Agent (RSA)

The quotation marks enclosing the path are required. For example, to run Recognition Server as a
service:

"C:\Program Files (x86)\Kofax\CaptureSS\ServerLib\Bin\fp.exe" -install

Note If the User Profiles feature is selected, you must install the service with additional command line
arguments. See the next section.

To verify that you installed the service correctly, check that the module name appears in the Services
utility. Before running the service, you need to configure it. See Configuring a Kofax Capture Service.

Kofax Capture Enterprise users can install multiple instances of a service.

Installing a Kofax Capture Service with User Profiles
If the User Profiles feature is selected, you must provide a user ID when you install a Kofax Capture
Service. As a result, the service is launched under the designated user's Kofax Capture login account, and
the Kofax Capture login window is bypassed.

Note To install a service, you must be logged in to Windows with administrator rights.

To install a service when the User Profiles feature is selected, use the following syntax:

"C:\Program Files (x86)\Kofax\Capture\Bin\<module.exe>" -install -u:"<userID>"
-p:"<password>"

If a Linked User is running Kofax Capture Services, the user ID and password command arguments are
not required. Instead, install the Kofax Capture services (for unattended modules) without specifying the
User ID and Password command-line arguments. Then, set the "Log on as" account for the service to an
appropriate user in the Service properties in the Windows Service Control Manager.

Note Kofax Capture Enterprise users can install multiple instances of a service with user profiles.

If you install a Kofax Capture Service with a user ID and password, and then decide to turn off the User
Profiles feature, you must do the following:

1. Remove the Kofax Capture Service before you turn off the User Profiles feature. Be sure to include
the command line arguments for user ID and password with the uninstall command.

2. Turn off User Profiles.
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3. Reinstall the Kofax Capture service without the user ID and password.

To verify that you installed the module correctly, check that the module name appears in the Services
utility. Before running the service, you need to configure it. See Configuring a Kofax Capture Service.

Starting the Services Utility
1. Start the Windows Services utility.
2. Look in the Service list for the name of the Kofax Capture module that you installed as a service.

Configuring a Kofax Capture Service
After installing a Kofax Capture Service, use the Services utility to configure a startup type and a logon
account type. By default, the startup type selection is "Manual." To configure a Kofax Capture Service to
start automatically at system boot, you need to change the startup type to "Automatic."

For the logon account, you must specify a Windows user account that is valid for the workstation
where you intend to run the Kofax Capture Service. By default, every Kofax Capture Service uses the
LocalSystem account as the default user. We recommend that you change to a standard user account. If
you are accessing resources in a network environment, be sure to specify a valid network account. You
cannot configure the service without a valid logon account.

1. Start the Windows Services utility.
2. Select the name of the Kofax Capture Service to configure.
3. Open the properties window.
4. At Startup type, select one of the following:

• Automatic: Automatically starts the service at system boot.

• Manual: Manually starts the service when the user selects Start from Services utility.

• Disabled: Turns off the service. Select this option only if you want to turn off the service for a
period of time, without removing it.

5. When configuring a Kofax Capture Service, you need to specify a logon account type.

a. Select a valid user account and password.

b. At "Log on as," select this account.

c. Enter the user account for the workstation where the service is installed. If the user account is a
network user, be sure to use the following format:
<domain>\<accountname>

d. At Password, enter the password for the user account.

e. At Confirm Password, enter the user account password again.
The Kofax Capture Service is ready to be run.

284



Kofax Capture Administrator's Guide

Monitoring Kofax Capture Services
After configuring a Kofax Capture Service, use the Services utility to monitor and manage the service.
• With automatic startup enabled, you can stop a Kofax Capture Service from the Services utility. When

the system is restarted, the service is also automatically restarted.
• With manual startup enabled, you can start or stop a Kofax Capture Service from the Services utility.

If you start the service and then restart the workstation, the Kofax Capture Service is not automatically
restarted.

You can use the Services utility to turn off a service. The service is not restored until you select automatic
or manual startup.

Note The Pause/Resume/Continue functions in the Services utility are not available to Kofax Capture
Services. For more information about other Services utility options, refer to the Windows online Help or
your Microsoft documentation.

With Kofax Capture Services selected, error logs and processing module logs are generated in the
standard locations, with one potential exception. In a client/server environment, some errors may prohibit
logging to the Kofax Capture installation folder on the server. In that situation, errors are logged in the
Kofax Capture installation folder on the client, typically located in C:\Program Files (x86)\Kofax
\Capture.

Multiple Service Instances
This feature is only available with Kofax Capture Enterprise installations.

Use Multiple Instance Support to run multiple instances of any Kofax Capture service on a single
computer. This takes advantage of multi-CPU computers. For example, a Recognition Server station
running on a dual CPU computer can have up to eight instances of the service installed, increasing the
number of batches the station can process.

For each service, the maximum number of multiple instances allowed is four times the number of physical
processors on the computer.

To install multiple instances of a service, just repeat the installation procedure for that service. An ID is
automatically appended to the service name for each instance.

For example, to install three instances of the OCR Full Text service, you would repeat the installation
command-line sequence three times:

"<Kofax Capture installation folder>\Bin\ocr.exe" -install

"<Kofax Capture installation folder>\Bin\ocr.exe" -install

"<Kofax Capture installation folder>\Bin\ocr.exe" -install

Each multiple instance of the OCR Full Text service is assigned a unique instance ID.
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To install multiple services with user profiles, use the same method of repeating the command-line
installation.

To remove multiple instances of a service, repeat the removal procedure for that service. For example, to
remove three instances of a service, repeat the removal procedure three times. When multiple instances
of a service are removed, the instance with the highest numbered instance ID is removed first.

Note When multiple services of the same kind are run on the same computer, a single concurrent Kofax
Capture station license and Enterprise license are required. For example, a user would need a single
station license to run the OCR Full Text, OCR Full Text:2 and OCR Full Text:3 services.

Remove Services
You can remove services at any time without affecting the standard Kofax Capture installation. If you
uninstall the standard Kofax Capture installation, you must remove the services first.

To remove services, use a command-line argument to specify each service to uninstall. For instance, to
remove the Recognition Server service, use the following command:

"<Kofax Capture installation folder>\Bin\fp.exe" -uninstall

If you have multiple instances installed, you must repeat the uninstall command-line sequence for each
instance. When multiple instances of a service are removed, the instance with the highest numbered
instance ID is removed first.

If the User Profiles feature is selected, be aware of the following:
• When removing a service, you must include the applicable user ID and password arguments with the

uninstall command. These arguments are described in Installing a Kofax Capture Service with User
Profiles.

• If you install a Kofax Capture Service with arguments for the user ID and password, and then decide to
turn off the User Profiles feature, you must do the following:
• Remove the Kofax Capture Service before you turn off the User Profiles feature. Be sure to include

the command-line arguments for user ID and password with the uninstall command.
• Reinstall the Kofax Capture Service without the command-line arguments for user ID and password,

after you turn off the User Profiles feature.
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Using Kofax Capture Network Server

Kofax Capture Network Server (KCN Server) adds Internet and Intranet processing capabilities to Kofax
Capture. With this capability, Kofax Capture remote stations can be connected to a central site through
the Internet (or Intranet) to assist in the production document and data capture process. You can scan and
process batches at the remote site, and then upload them to the central site for further processing and
export.

Kofax Capture Network Server eliminates the common and costly practice of shipping documents from
remote offices to a central site for processing. It supports remote scanning and processing of documents
through the Internet or Intranet.

Using Kofax Capture Network Server, IT and IS managers can develop and implement enterprise-wide
capture solutions. With Kofax Capture Network Server, documents can be scanned inexpensively at
remote stations and then automatically uploaded to the central site, securely and reliably.

Integration with Kofax Capture

Kofax Capture Network Server is integrated with certain Kofax Capture modules and menus. Specifically,
options for configuring and using Kofax Capture Network Server are available from the Kofax Capture
Administration and Batch Manager modules.

Centralized Administration

The Kofax Capture system administrator can centrally manage configuration information, station licenses,
schedules for uploading batches, and batch class definitions for all remote sites by creating and assigning
remote site profiles to remote sites. The administrator can view a list that shows the Kofax Capture
version installed at each remote site to determine if product updates are current.

You can specify the default behavior for assigning remote site profiles to new remote sites. This behavior
is automatically applied when a new remote site synchronizes with Kofax Capture Network Server the first
time. For example, if a remote site profile name matches a remote site, you can set a policy in which the
remote site automatically receives the matching remote site profile.

Centralized License Management

Kofax Capture supports a centralized license management scheme that requires a software license
or hardware key (optional) on the Kofax Capture server (in a client/server installation) and standalone
stations (in standalone installations) at the central site. No licensing is required for Kofax Capture Network
Server remote site stations.

Kofax Capture Network Server also requires volume licenses. However, all licensing is managed at the
central site.

Data Security
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Kofax Capture Network Server can be configured to meet the security needs of your company. For
example, you can configure your Web server software for optimal security.

Offline Capability

With Kofax Capture Network Server, remote stations do not have to be connected to the central Kofax
Capture server while processing batches. You can set your remote stations to connect with your central
site and then synchronize with your central site at predetermined intervals or on demand.

Internet/Intranet Support

Kofax Capture Network Server is suitable for Internet and/or Intranet configurations.

Remote Site Profile Support

With Kofax Capture Network Server, you can create remote site profiles, which consist of groups of
settings assigned to one or more remote sites.

An important feature is the ability to exclusively specify where in the Kofax Capture workflow the remote
site routes batches to the central site.

Batch Class Assignment

Use Kofax Capture Network Server to control which batch classes are visible to specific remote sites,
based on remote site profiles.

Event Logging

Kofax Capture Network Server maintains a comprehensive log of polling activity and other events. Logs
are maintained at both the central site and the remote sites.

Site Switching Capability

With Kofax Capture Network Server, you can easily switch Web servers or central sites, if necessary.

Remote Synchronization Capability

Through the Remote Synchronization Agent (RSA), you can easily synchronize with the central site on
a defined schedule or on demand. As a result, you can download batch classes and upload completed
batches to the central site at the same time. You can use user profiles to restrict the ability to run the RSA
interactively at remote sites.

Assign Web Server Port Number

If you do not want to use the standard Kofax Capture Network Web Server ports, you can assign alternate
ports. By default, all HTTP communications use port 80, and all SSL communications use port 443.

Web Cache Affinity

If you have cache folders in multiple locations, a Kofax Capture Network Service will "prefer" to use its
local cache folder (if it exists) rather than the other caches, provided other factors (such as priority) are
equal. This "cache affinity" reduces network overhead and may improve performance.
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KCN Server Components
Kofax Capture Network Server components are installed at your central site and remote sites as
described in this section.

Kofax Capture Network Server Software
The KCN Server software is installed on a Web server at your central site and acts as a broker between
your central Kofax Capture database and the remote locations. The Web server does not need to be on
the same computer as the Kofax Capture server.

Kofax Capture Network Service
The Kofax Capture Network Service is responsible for responding to requests from the remote sites.
Specifically, the Kofax Capture Network Service performs the following operations:
• Inserts batches into Kofax Capture on the Kofax Capture server one batch at a time
• Extracts batch class and other remote site profile information
• Verifies licenses

The Kofax Capture Network Service is a manually embedded process included with the Kofax Capture
Service, which is automatically installed on all servers and workstations during the Kofax Capture
installation process.

On the Windows Services list, Kofax Capture Network Service is listed in the Description column for the
Kofax Capture Service. For more information about enabling the Kofax Capture Network Service, see the
Kofax Capture Installation Guide.

File Cache Folder Locations
The file cache folder locations, accessed by both the Kofax Capture Network Service and the Web server,
are used to hold batches uploaded from remote sites until the data can be inserted into Kofax Capture at
the central site. The folders can be anywhere on your network, provided that the location offers access to
the following:
• Web server and file cache folder locations
• KCN Service and file cache folder locations

Multiple file cache folders can be created on one or more computers. You might want to create multiple
file cache folders so that if one file cache folder location fails, the remote sites can continue to synchronize
using the remaining file cache folder locations.

Web Server
The Web site is used to route requests and data between the KCN Server remote sites and the central
site.
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Remote Synchronization Agent (RSA)
The RSA runs on at least one remote workstation at each remote site to automatically download batch
classes from the central site and upload batches to the central site. The download and upload processes
are occur at the same time.

Batches created at a remote site are processed through all the modules set to run at the remote site.
When the remote processing is complete, the batches are uploaded to the central site for further
processing and export.

Remote Synchronization Agent System Tray Icon
The Remote Synchronization Agent (RSA) system tray icon is installed when you activate the RSA
application.

Use the RSA allows to perform the following operations:
• View the status of batches and statistics being uploaded
• Synchronize on demand to download batch classes and upload completed batches, user statistics and

administrative data such as shared scanner profiles
• Download batch classes on demand

Usually, synchronization occurs on the schedule set up within the remote site profile assigned to the
remote site, or according to the polling settings defined by the remote site itself. You can use Synchronize
Now to perform the upload and download process on demand.

You can double-click the RSA Windows system tray icon or right-click Status on the RSA shortcut menu to
display the Remote Synchronization Agent window.

If the User Profiles feature is enabled, the tray icon cannot be used to start the RSA unless "Allow RSA to
run interactively" is selected in the user's profile.

Note If the RSA has been installed as a service, the RSA application does not have to be activated or
running for the RSA to perform automatic polling or synchronize with the central site. In this case, the
RSA system tray icon does not appear.

Changing Kofax Capture Network Web Server Port Numbers
If you do not want to use the standard Kofax Capture Network Web Server (KCN Web Server) ports,
you can assign alternative ports. By default, all HTTP communications use port 80, and all SSL
communications use port 443.

Note When selecting alternative ports, you must ensure that the ports you assign are not being used by
other applications or services. Port conflicts can result in intermittent and unpredictable problems.

To specify a different port number, use the following procedure.
1. Run the Internet Information Services administrative tool.
2. Select the Web site where KCN Web Server Components are installed.
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3. Change the TCP Port setting to a number, such as 8080.
4. At the remote site, start Batch Manager.
5. On the Remote Site tab, in the RSA group, click Web Server URL.
6. Specify the Web Server URL and the new port number using the following syntax:

<protocol>://<host>[:port]/acis

For example, if the alternate TCP port number is 8080, the URL would be similar to this:
http://central:8080/acis

Kofax Capture Network Server Activity Logs
As the KCN Server performs its tasks, information is written to various log files.

Windows Application Event Log File
You can view the Windows application event log file using the Event Viewer. You might want to view the
Windows Application Event Log if the RSA stops running.
• Use Windows Control Panel to select the Event Viewer.
• Select an item from the Tree tab in the left pane to display the log in the right pane.
• Double-click any line item in the log to view additional details.

Kofax Capture Network Server Log Files
Information on Kofax Capture Network Server is stored in log files at the Kofax Capture Network Server.
Errors that occur during batch status checking are logged at the remote site's log file, ACIC_YYMM.txt.

Server Log File

Errors are logged by the KCN Service and sent to <Kofax Capture installation>\logs
\ACIS_YYMM.txt. The YY specifies the current year and the MM specifies the current month, such as
ACIS_1305.txt.

Each entry in ACIS_YYMM.txt includes the following information:
• Date and time that the RSA locked the batch for processing
• Status number
• Module name
• Kofax Capture server name
• Kofax Capture server version
• Transfer identifier
• Remote site name
• Remote station ID
• Remote Kofax Capture version
• Message
• Extra information as appropriate
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Errors are also logged by the Kofax Capture Network Server and sent to <Kofax Capture
installation folder>\logs\ACIW_YYMM.txt. The YY specifies the current year and the MM
specifies the current month, such as ACIW_1305.txt.

Remote Site Log File

The client log file ACIC_YYMM.txt lists the activity between the remote site and the central site, including
information about downloaded batch classes, uploaded batches, and other information.

Each entry in the log file includes the following information:
• Date and time
• Status number
• Message
• Station ID
• Windows computer name
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Database and Other Utilities

On the User Profile Properties and Group Profile Properties windows, you can manage access to
administrative utilities with the "Allow admin utility usage" check box. Currently, this check box allows
access to the Database Utility, which is used for tasks related to Kofax Capture databases.

Note If you select Oracle or IBM DB2 as your database configuration, the Repair and Compact tab is not
available on the Database Utility.

When the User Profiles feature is selected, Kofax Capture does the following when users attempt to
launch an administrative utility:
• Prompts user for a login ID
• Allows access to a utility if both of the following are true:

• The "Allow access to admin utilities" check box is selected in the user profile or group profile
• A valid login ID is entered, as defined in the user profile or group profile

• Denies access to a utility if either of the following is true:
• The "Allow access to admin utilities" check box is not selected in the user profile or group profile
• A valid login ID is not entered, as defined in the user profile or group profile

The Database Utility
Use the Database Utility (DBUtil.exe) to perform the following tasks.
• Configure your system database and statistics database
• Rename your database
• Enable SecurityBoost
• Review and edit site or workstation identification information
• Access the Batch Information Editor
• Repair and compact the database (for SQL Server and SQL Server Express only)
• Select USGCB compliance for the Standard database password
• Get information that may be useful when contacting technical support

This utility is available from the Bin folder in your Kofax Capture workstation or server installation.
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The Separator Sheet Utility
The Kofax Capture Separator Sheet Utility is used to define and print separator sheets for batches and
documents.

Document separator sheets contain patch codes to separate documents, and an optional bar code that
encodes the name of the form type. During processing, Kofax Capture recognizes the document separator
sheet, reads the bar code (if it exists), and separates and identifies documents accordingly.

Batch separator sheets contain a patch code that signifies the beginning of the next batch and a bar
code that encodes the name of the batch class. During processing, Kofax Capture recognizes the batch
separator sheet, reads the bar code, and creates a new batch based on the batch class.

Note As the number of published batch classes increases, it may affect the time it takes to launch the
Separator Sheet Utility.

With the Separator Sheet Utility, you can do the following:
• Create batch separator sheets, which are used when you select Unattended Scanning in the Scan

module
• Create document separator sheets
• Print separator sheets (when using document separator sheets with multiple form types, you can print a

separator sheet for each type)

Note The Separator Sheet Utility is only used for published batch classes with patch codes defined as
the document separation method.

Creating a Batch Separator Sheet
Batch separator sheets are used with the Unattended Scanning feature in the Scan module.

1. Start the Kofax Capture Separator Sheet Utility.

Note The Batch Class Name list does not include batch classes that use batch totals, required
batch fields, or numeric batch fields without default values.

2. At Separator Sheet Type, select Batch Separator.
3. Select portrait or landscape orientation.
4. On the Batch Class Name list, select the batch class associated with the batch that requires

separator sheets.

Note The Batch Class Name list does not include batch classes that use batch totals, required
batch fields, or numeric batch fields without default values.

5. Notice that the Patch Code Type list includes the patch code that is currently reserved for batch
separation.

In the preview window, you see the sample batch separator sheet updated to reflect your selections,
including the patch code, the batch class name and the date/time the batch class was published.
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Creating a Document Separator Sheet
1. Start the Kofax Capture Separator Sheet Utility.

Note The Separator Sheet Utility is only for published batch classes where patch codes are defined
as the document separation method.

2. At Separator Sheet Type, select Document Separator.
3. At Batch Class Name, use the list to select the name of the batch class for which you want to print

separator sheets.
4. At Patch Code Type, use the list to select a patch code type.
5. At Form Type, do one of the following:

• Select None if you do not want the separator sheet to include a bar code that identifies the
document class/form type name.

• Select the document class / form type for which you want to print a separator sheet. Kofax Capture
adds a bar code to the separator sheet to identify the name of the form type.

• Select Print All Forms to produce separator sheets for each document class/form type in the
selected batch class.

The Scanner Configuration Utility
The Scanner Configuration Utility is used to configure scan and image source devices.

Using the Scanner Configuration Utility, you can view a list of image devices (scanners and file import
sources) and the installed drivers that are available on your computer. From this list, you can select a
scanner and set it as the default, or restore the default settings for a specific scanner. You can also create
and manage your import sources so you can select a source from any Kofax Capture module that allows
you to create batches (such as Scan, Quality Control, or Batch Manager).

You can start the Scanner Configuration Utility from the Kofax Capture program group.

You can also select a scanner using the Scan Source list on the Scan panel in the Administration, Scan,
or Quality Control module.

Configuring a Source Device
You configure source devices with the Scanner Configuration Utility.

1. Start the Scanner Configuration Utility.
2. Select your source device from the list.

Scanners appear on the list if they are Kofax VRS-certified, or if their drivers are installed on the
computer.

3. Click Configured sources.
4. If no configured sources exist for this device, click Create Standard Sources.
5. To set the default source for your device, select the appropriate configured source from the list and

click Set Device Default Source.
A check mark appears next to the default source.
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6. Click Close.
7. To set a configured scanner as the default, select it from the available image device list and click Set

as Default.
Your current default scanner and source are listed at the bottom of the Scanner Configuration Utility
window.

8. Click Close to exit the utility.

For detailed information about all the Scanner Configuration Utility options and features, click Help or
press F1.

You can also select a scanner using the Scan Source list on the Scan panel in the Administration, Scan,
or Quality Control modules.

Setting Image Quality
Kofax Capture internally stores color image files using JPEG compression, which gives you the ability
to adjust the quality of the compressed image. The more highly compressed the image is, the worse the
quality becomes.

Good OCR recognition requires the best possible quality in the compressed image. See Color Support
for more information on compression. Unlike most of the other properties you can set in Kofax Capture,
JPEG image compression quality is not set directly within the program. Instead, you must use the Scanner
Configuration Utility.

Note For OCR, set the JPEG compression quality to 100 percent. For patch codes and bar codes, use
at least 75 percent. Any changes to this setting take effect the next time you open the Kofax Capture
modules that use it. If one of these modules is already open, you must close it and re-open it for the new
setting to take effect.

1. Start the Scanner Configuration Utility.
2. In the Scanner Configuration Utility window, select your image device from the list.
3. Click Configure Sources.
4. In the Configure Sources window, select your source from the list.
5. Click Properties.
6. In the Source Properties window, set the JPEG compression quality to an appropriate value.
7. Click OK to save your settings and close the window.
8. Click Close.
9. Close the Scanner Configuration Utility.

Selecting Advanced Source Properties
You can select advanced source properties in the Scanner Configuration Utility or when you select a
source device from your application.

1. Start the Scanner Configuration Utility.
2. Select your image device from the list.
3. Click Configured sources.
4. In the Configured sources window, select your source from the list.
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5. Click Properties.
6. In the Source Properties window, select your preferences.
7. Click OK to save your settings and close the window.
8. Click Close.
9. Close the Scanner Configuration Utility. The advanced source properties apply to batches created

with the selected source device.

Custom Storage String XML Data
Custom storage strings may be used by custom module developers to pass additional information
(extended recognition data) between modules using an XML string with a structure understood by all the
custom modules sharing the data.

This document-based custom storage string, called "Kofax.AC.ExtendedRecognitionInfo," is used for the
storage of extended recognition data. The prefix "Kofax.AC" is used to help prevent collisions with other
custom storage strings.

The hierarchy of the XML string is documented below. In many cases, names of elements, and especially
attributes, have been kept short to limit the size of the XML string. Extended recognition information is not
produced for group zones.

Reference DTD File
An XML DTD file that defines this XML format is provided in the local\Bin subfolder of the Kofax Capture
installation. This file (ACExtRec.dtd) is for reference only and is not utilized by Kofax Capture. To
prevent issues with resolving file references, add-on applications making use of this XML string should not
include a reference to this DTD.

Support for Non-ASCII Characters
All Non-ASCII characters must be represented in UTF-8 (Multi-Byte) format according to the currently
active code page. UTF-16 (Unicode) strings are not supported by Kofax Capture.

Sample
The following sample XML string is for a document with a single field called "pet." In this case, the
recognized value from the engine is "cat." Based on parameters in Kofax Capture, the resulting index field
value has a low confidence mark character added, resulting in "c^at". For this low confidence character,
an alternative, lower-confidence character of "o" is provided in the extended recognition information.
<ExtendedRecognitionInfo> 

 <ExtIndexFields> 

 <ExtIndexField Name=”pet” EngineValue=”cat” FieldValue=”c^at” Row=”1” Conf =”87”
 X=”300” Y=”300” W=”2000” H=”600” > 

  <ExtChars> 
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  <ExtChar WordStart=”1” LineStart=”1” Char=”c” Conf =”100” X=”0” Y=”0” W=”600”
 H=”600” /> 

  <ExtChar Char=”a” Conf =”70” X=”600” Y=”0” W=”600” H=”600” Rejected=”1” > 

   <ExtAltChars> 

    < ExtAltChar Char=”o” Conf =”60” /> 

   </ExtAltChars > 

  </ExtChar> 

  <ExtChar Char=”t” Conf =”90” X=”1200” Y=”0” W=”600” H=”600” /> 

  </ExtChars> 

 <ExtAltFields> 

  <ExtAltField EngineValue=”cart” Conf=”60”> 

   <ExtChars> 

   <ExtChar WordStart=”1” LineStart=”1” Char=”c” Conf =”100” X=”0” Y=”0” W=”600”
 H=”600” /> 

   <ExtChar Char=”a” Conf =”70” X=”600” Y=”0” W=”600” H=”600” /> 

   <ExtChar Char=”r” Conf =”40” X=”1200” Y=”0” W=”300” H=”600” Rejected=”1”/> 

   <ExtChar Char=”t” Conf =”50” X=”1400” Y=”0” W=”300” H=”600” Rejected=”1”/> 

  </ExtChars> 

  </ExtAltField> 

 </ExtAltFields> 

 </ExtIndexField > 

 </ExtIndexFields > 

</ExtendedRecognitionInfo>

Element ExtendedRecognitionInfo
This is a placeholder element that encloses all related data for a document. This element has no
attributes.

Element ExtIndexFields
This element represents a collection of index fields. This is the only sub-element possible directly under
an ExtendedRecognitionInfo element. This element has no attributes.

Element ExtIndexField
This element represents extended recognition information for an index field. ExtIndexField elements can
only exist as children of ExtIndexFields elements.
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Within an ExtIndexFields element, there is no required order for the ExtIndexField objects. Multiple
ExtIndexField elements with the same "Name" attribute can exist within the same ExtIndexFields
collection, but each ExtIndexField with the same name must have a different value in the "Row" attribute.

Attributes
Attribute DataType Description

Name String Name of the Kofax Capture index field.
This name can also be used to locate the index field definition
information within the corresponding document class.

EngineValue String Value returned by the recognition engine without any string-based
post-processing. This value exactly corresponds to the child ExtChar
elements (described below).
This element may not be the same as the Kofax Capture index field
value if the engine value has been modified by recognition scripts,
marking, or other post-processing features.

FieldValue String Recognition value after post-processing results have been applied.
In the case of the Recognition Server, this value corresponds exactly
to the index field value. A consumer of this data can determine if value
has been modified by comparing the index field value to this attribute.
Custom modules that perform recognition without any post-processing
should provide identical values for the index field, the FieldValue
attribute, and the EngineValue attribute.

Row Integer The 1-based row number of a table field. This value is 1 if this index
field is not part of a table.
For fields recognized by Kofax Capture, this attribute is always 1, even
if subsequent text processing by Kofax Capture splits the recognized
value into multiple rows.

Conf Integer Field confidence value.

Page Integer Page number (within the document) on which the zone was
recognized.

X Integer Zone left coordinate in BMUs (1/1200 of an inch) from the top left
corner of the page.

Y Integer Zone top coordinate in BMUs from the top left corner of the page.

W Integer Zone width in BMUs.

H Integer Zone height in BMUs.

Element ExtAltFields
This element represents a collection of alternate field values for an index field. This is an optional element
possible only under an ExtIndexField element. This element has no attributes and represents the original
data returned by the engine, without any string post-processing that may occur in Kofax Capture.

The Recognition Server does not generate this element. It is included in the specification for use by
custom modules.
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Element ExtAltField
This element represents an alternate field value for an index field. ExtAltField elements can only exist as
children of ExtAltFields elements. Within an ExtAltFields element, there is no required order for ExtAltField
objects.

The Recognition Server does not generate this element. It is included in the specification for use by
custom modules. Custom modules may make use of algorithms within the recognition engine to generate
alternate combinations or numbers of characters.

Attributes
Attribute DataType Description

EngineValue String Alternative field value returned by the engine.

Conf Integer Alternative field confidence value.

Element ExtChars
This element represents a collection of characters that make up an index field. This is an optional element
possible under an ExtIndexField element or an ExtAltField element. This element has no attributes.

Element ExtChar
This element represents extended recognition information for a character. Multiple ExtChar elements
can exist as children of an ExtChars element. There is one ExtChar element for each character in the
EngineValue attribute of the parent ExtIndexField element, and the order of ExtChar elements is the same
as the order of recognized characters.

Attributes
Attribute DataType Description

Char String (Character) Recognized character. If the engine had several choices for this
character position, this value represents the choice with the highest
confidence. Other choices, if applicable, are represented by ExtAlt sub-
elements.

Conf Integer Character confidence value.

LineStart Integer Optional attribute. If the value is present and equal to "1," this
character starts a new line.
The Recognition Server generates this attribute, even though it is
optional.
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Attribute DataType Description

Rejected Integer If this attribute is present and equal to "1," this character needs human
validation and/or repair.
To allow for less space usage, this attribute is considered optional and
needs to be present only if the character is rejected. If the attribute
is not present, client code should assume that the character is not
rejected.
For fields recognized by Kofax Capture, this attribute is set whenever
a character is recognized that would normally generate a "mark"
character in the index field. This attribute is provided even if the mark
character is empty.

WordStart Integer Optional attribute. If the value is present and equal to "1," this
character starts a new word.
The Recognition Server generates this attribute, even though it is
optional.

X Integer Zone left coordinate in BMUs (1/1200 of an inch) from the top left
corner of the page.

Y Integer Zone top coordinate in BMUs from the top left corner of the page.

W Integer Zone width in BMUs.

H Integer Zone height in BMUs.

Element ExtAltChars
This element represents a collection of alternate choices for a character. This is the sole element possible
under an ExtChar element. This element has no attributes.

ExtAltChars and ExtAltChar elements are not generated when the "Kofax Advanced OCR Zonal" engine is
used. Characters at the beginning of misspelled words are not marked as rejected.

Element ExtAltChar
This element represents an alternate character choice. Multiple ExtAltChar elements can exist as children
of an ExtAltChars element. One ExtAltChar element exists for each alternate character choice, and there
is no required order for the character choices.

Attributes
Attribute DataType Description

Char String (Character) The alternate character

Conf Integer Character confidence value (0-100)

Custom Reports
The Kofax Capture Report Viewer module is based on the Crystal Reports Viewer.
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With Crystal Reports (purchased separately), you design and create your own reports using the visual
report designer. The report designer is equipped with tools that give you the ability to develop your own
reports. This section only covers information specific to customizing reports for Kofax Capture; we assume
that you are already familiar with both SQL Server and Crystal Reports.

The easiest modification you can make is to use your own logo in place of the Kofax Capture logo. The
simplest way to create reports of your own is to modify the standard reports. For example, you can
change the groups and/or data columns by modifying the queries used by these reports.

The Kofax Capture logo in the upper right corner of the standard reports is easily replaced with your own
logo.

To use your own logo, use a graphics editor of your choice to size your logo so that is it no larger than 300
pixels wide by 80 pixels high.

After resizing, save your logo file as logo.bmp in <Kofax Capture installation folder>\Bin
\Reports. You can use any color depth.

Note If you use a logo that exceeds the recommended size, the image overflows into other parts of the
report.

If the standard reports cannot be modified to suit your needs, you can use Crystal Reports to create your
own reports.

If you make your own reports, it may be helpful to understand how the logo graphic is integrated into the
standard reports. The default logo is placed in the standard reports as an image with a dynamic Graphic
Location based on a formula field named "LogoLocation." The LogoLocation is specified by the Report
Viewer at runtime.

The position of the bitmap image is determined by the location of the upper left corner of the bitmap. To
accommodate bitmaps of varying sizes, the Kofax Capture Report Viewer positions the "CompanyLogo"
control so that its right edge lines up with the right edge of the "PrintDateTime" control. Both controls must
be present, or the image position does not adjust properly.

Note You can modify the Summary Data, Comments field to edit the Report Description displayed in the
Select Report window.

Database Connection
The Report Viewer module can be used only with the Kofax Capture database. You cannot use it to
generate or view reports based on data from other sources.

When creating custom reports, you need to create an OLE DB (ADO) connection using the Microsoft OLE
DB Provider for SQL Server.

If you are using the SQL Server database configuration, use the database connection information
provided by your database administrator.

If you are using the built-in Kofax Capture Standard database configuration, use the following connection
information, where <servername> is the location of the Kofax Capture server.
• <servername>\kofaxcap2017 or <servername>\kofaxcap2014
• UserID: StatsMgr
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• Password: Screen73
• Password when USGCB Compliance is selected: HDveq3XTgHS6%h$
• Database: ACSystem

Database Views
The following database views make it easier to access data for the reports. You can use them with your
custom reports.

viewBatchList

This view includes one row for each batch currently in the system. These values are always available,
even if User Tracking is not selected.

Column Description

BatchGUID String that uniquely identifies a batch.

ExternalBatchID External ID of the batch.

BatchName Name of the batch.

BatchClassName Name of the batch class.

ModuleName Localized name of the current module. Same as Queue in Batch Manager.

ModuleUniqueID Not localized unique ID for the current module.

ModuleCustom True if the current module is a custom module.

Description Batch description.

Priority Current batch priority.

StationID ID of the station processing the batch.

ContainsErrors Same as the ! column in Batch Manager.

ActualPages Number of pages in the batch as of the last time a session was closed.

ActualDocs Number of documents in the batch as of the last time a session was closed.

BatchStatus Same as StatsBatchModule.BatchStatus.

BatchStatusName String equivalent of BatchStatus.

InProgressString Descriptive information about the batch current state when it is being processed.
Currently used only by Kofax Capture Network Server.

NextSiteGUID Unique ID of the site where the batch will be processed next. Same as the current site
GUID if Kofax Capture Network Server is not used.

NextSiteName Name of the site where the batch will be processed next.

CreationDate Date and time when the batch was created.

CreationTimeZone Number of minutes that the creation time varies from GMT.

CreationSiteGUID Unique ID of the site where the batch was created.

CreationSiteName Name of the site where the batch was created.

CreationSiteTZName String representing the time zone where the batch was created.
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viewStatsBatchSummary

This view includes one row for each row in StatsBatch that also has at least one row in StatsBatchModule.
This is essentially one row for each batch. These values are only available if User Tracking is selected.

Column Description

BatchName Same as in StatsBatch.

CreationStationID Same as in StatsBatch.

CreationUserID Same as in StatsBatch.

CreationUserName Same as in StatsBatch.

BatchClass Same as in StatsBatch.

BatchClassDescription Same as in StatsBatch.

ExternalBatchID Latest EndDateTime for the batch from StatsBatchModule.

LastSessionDateTime Earliest EndDateTime for the batch from StatsBatchModule.

FirstSessionDateTime The difference between StatsBatchModule.EndDateTime and
StatsBatchModule.StartDateTime added up for all sessions.

ProcessingSeconds Difference between LastSessionDateTime and FirstSessionDateTime.

EndToEndSeconds Difference between LastSessionDateTime and FirstSessionDateTime.

Documents 1 Difference between StatsBatchModule.DocumentsCreated and
StatsBatchModule.DocumentsDeleted added up for all sessions.

Pages 1 Difference between StatsBatchModule.PagesCreated and
StatsBatchModule.PagesDeleted added up for all sessions.

Priority Priority of the batch. If the priority changed as the batch was processed, this
is the average priority based on the number of sessions.

ExpectedPages Same as in StatsBatchModule.

ExpectedDocs Same as in StatsBatchModule.

Deleted Greater than 0 if the batch has been deleted.

Exported Greater than 0 if the batch has been deleted.

PagesPerDocument StatsBatchModule.PagesPerDocument. If the number of pages changed as
the batch was processed, this is the average number of pages based on the
number of sessions.

PagesScanned 1 Total of StatsBatchModule.PagesScanned.

PagesDeleted 1 Total of StatsBatchModule.PagesDeleted.

DocumentsCreated 1 Total of StatsBatchModule.DocumentsCreated.

ChangedFormTypes 1 Total of StatsBatchModule.ChangedFormTypes.

PagesReplaced 1 Total of StatsBatchModule.PagesReplaced.

1 If your custom module statistics attributes aren't properly set in the API, the data in these columns are
undefined.

viewStatsSession
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This view includes one row for each row in StatsBatchModule. This is essentially one row for each
session.

Column Description

ModuleStartDateTime Same as in StatsModuleLaunch.StartDateTime.

ModuleEndDateTime Same as in StatsModuleLaunch.StartDateTime.

ModuleUniqueID Same as in StatsModuleLaunch.

ModuleName Same as in StatsModuleLaunch.

UserID Same as in StatsModuleLaunch.

UserName Same as in StatsModuleLaunch.

StationID Same as in StatsModuleLaunch.

SiteID Same as in StatsModuleLaunch.

SiteName Same as in StatsModuleLaunch. If this value is empty, then the SiteID is
substituted.

OrphanedModule Same as in StatsModuleLaunch.Orphaned.

BatchModuleID Same as in StatsBatchModule.

ExternalBatchID Same as in StatsBatchModule.

BatchDescription Same as in StatsBatchModule.

NextModuleUniqueID Same as in StatsBatchModule.ModuleCloseUniqueID

NextModuleName Same as in StatsBatchModuleModuleName.

SessionStartDateTime Same as in StatsBatchModule.StartDateTime.

SessionEndDateTime Same as in StatsBatchModule.EndDateTime.

ProcessingSeconds Difference between StatsBatchModule.EndDateTime and
StatsBatchModule.StartDateTime.

BatchStatus Same as in StatsBatchModule.

BatchStatusName String equivalent of BatchStatus.

Priority Same as in StatsBatchModule.

ExpectedPages Same as in StatsBatchModule.

ExpectedDocs Same as in StatsBatchModule.

Deleted Same as in StatsBatchModule.

PagesPerDocument Same as in StatsBatchModule.

PagesScanned 1 Same as in StatsBatchModule.

PagesDeleted 1 Same as in StatsBatchModule.

DocumentsCreated 1 Same as in StatsBatchModule.

DocumentsDeleted 1 Same as in StatsBatchModule.

ChangedFormTypes 1 Same as in StatsBatchModule.

PagesReplaced 1 Same as in StatsBatchModule.
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Column Description

ErrorCode Same as in StatsBatchModule.

ErrorText Same as in StatsBatchModule.

OrphanedBatch Same as in StatsBatchModule.Orphaned.

1 If your custom module statistics attributes aren't properly set in the API, the data in these columns are
undefined.

Save Custom Reports
The standard report templates are stored in <Kofax Capture installation folder>\Bin
\Reports. If you store your custom reports in the same location, they automatically appear in the Report
Viewer Reports menu and in the Select Report window.

Report template files must have an .rpt extension. Reports are added to the menu and the window in
alphabetical order based on the file name. You can control the sort order by prefixing numbers to the file
names:

01_Special Report.rpt

02_Western Region Report.rpt

03_National Report.rpt

The leading numbers are removed from the name for display in the menu or window.

You can also add accelerators to your report names by inserting an ampersand (&) before the character
to use. For example, you would do the following to make the first letter of each report the accelerator
character:

01_&SpecialReport.rpt

02_&WesternRegionReport.rpt

03_&NationalReport.rpt

The Select Report window also has a brief description of each report. With Crystal Reports, you can add
a comment to the report summary information. This comment is used by the Select Report window as the
report description.

Displaying the Report Settings Window
If your custom report includes a text object named "DateRangeTitle," the Report Viewer module displays
the Report Settings window using the value assigned to DateRangeTitle as the title of the window. The
Report Viewer also sets the "ReportStart" and "ReportEnd" parameters to the values selected in the
window.

If your report does not include parameters named "ReportStart" and ReportEnd, the window appears and
the report is generated, but with logged errors.
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If your report does not include a text object named "DateRangeTitle," the Report Settings window does not
appear.

If the report has the named objects that trigger the Report Settings window as well as other parameters,
the Report Settings window is displayed first, followed by the standard Crystal Reports window for only the
remaining parameters.

If your custom report has only parameters other than "ReportStart" and "ReportEnd," a standard Crystal
Reports window is displayed instead.

Note that if the standard Crystal Reports parameters window is displayed, the Please Wait window closes
before the entire report appears.

Paper Size
The Report Viewer module can automatically adjust your report margins so that a single report template
can print correctly with both A4 and Letter size paper.

To set the Report Viewer module to automatically adjust for these standard paper sizes, save your report
template for Letter size paper with margins set as specified in this section. The values are selected so that
both A4 and Letter have at least quarter-inch margins.

If you use other settings, the Report Viewer does not make automatic adjustments. This may work if you
want to use different paper sizes.

Use the following values for Letter size paper.

Orientation Top and Bottom Margins Left and Right Margins

Landscape 0.617 inches 0.500 inches

Portrait 0.500 inches 0.617 inches

When printing to A4, the margins are automatically adjusted to the following values.

Orientation Top and Bottom Margins Left and Right Margins

Landscape 0.500 inches 0.846 inches

Portrait 0.846 inches 0.500 inches

Kofax Reporting
Kofax Reporting is a separately purchased product that helps system administrators, business process
managers, and other stakeholders gain visibility into and take control of Kofax managed business
processes. This product serves as the single conduit across many Kofax products, providing a centralized
storage of historical operational metrics and audit data. By default, Kofax Reporting is disabled.

The following Kofax products are currently supported:
• Kofax Capture
• Kofax Transformation Modules
• Kofax Front Office Server
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All the reporting features included with Kofax Capture are still available and remain unchanged.

Registering a Custom Module or Workflow Agent with the
Extension Registration Utility

If you plan on using a custom module or workflow agent at your remote sites, you must register the
custom module or workflow agent at the central site and each applicable remote site, after you add the
module or workflow agent to the batch class workflow.

Note When registering a custom module, the RegAscEx command only has to be run once at the
remote site (on only one workstation). On the other hand, when registering a workflow agent, the
RegAscEx command has to be run at every remote site workstation that will use that workflow agent.
This is because the OCX or DLL needs to be registered with the operating system on each workstation.

When importing a batch class containing a workflow agent, you must have previously installed the
necessary workflow agents. Failure to do so results in an error.

By default, KCN Server remote site users cannot download batch classes with workflow agents that have
not been registered on the remote site workstation. This is consistent with the behavior for downloading
custom modules. An exception to this rule applies if the WorkflowAgentSkipIfCantLoad flag has
been set. In this case, this check is not performed because any non-registered workflow agents are
skipped.

To run a custom module or workflow agent at a remote site, the appropriate custom module executable
(.exe) or workflow agent COM server (.dll or .ocx) must be installed on the local hard drive at every remote
site workstation.

Note The custom module executable or workflow agent COM server must exist at a remote site before
the site can use it.

1. If you are registering a workflow agent, ensure the workflow agent registration file (.aex) has been set
up to define the property settings.

2. Copy the executable (.exe, .dll, or .ocx) and registration (.aex) files to <Kofax Capture
installation>\Bin.

3. Open a Command Prompt window.
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4. Register your custom module or workflow agent by executing the Kofax Capture Extension
Registration Utility, RegAscEx.exe. By default, the utility is available from <Kofax Capture
installation>\Bin.
• To register a custom module, enter the following: RegAscEx.exe /f <filename> /m
<modulename>

• To a register workflow agent, enter the following: RegAscEx.exe /f <filename> /w
<workflowagentname>
where:
• filename is the name of your registration (.aex) file
• modulename is the name of your custom module
• workflowagentname is the name of your workflow agent

Note The /m and /w arguments are optional. If the /m and /w options are not used, you can register
the custom modules and workflow agents at the same time. If successful, the following message
appears:
Success (1002): Module 'modulename' registered.

Success (1008): Workflow 'workflow agent name' registered.

Limiting the Length of Field Names
You can limit the length of certain field names (such as batch class names, document class names, etc.).

1. With any text editor (such as Notepad), create a file named Limits.ini to specify the limits.
The format for Limits.ini is shown in this procedure.

2. Copy Limits.ini to your installation folder:
• For client/server configurations, copy Limits.ini to your server folder as listed in the registry

under HKEY_LOCAL_MACHINES\SOFTWARE\Kofax Image Products\Ascent Capture
\3.0\Server Path. The file must exist in the server folder so that all clients can access it.

• For standalone installations, copy Limits.ini to your Kofax Capture folder.

[AdminLimits]

BatchClassName=32

DocumentClassName=32

FormTypeName=32

BatchFieldName=32

IndexFieldName=32

FieldTypeName=32

FieldTypeDescription=80

FieldTypeLength=254
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See the Valid Maximum Values Table for the valid values to set for your limits. Note that the values shown
here represent the default values for Kofax Capture.
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Chapter 14

Kofax Capture Licensing

Kofax Capture uses a centralized licensing scheme with the following key features:
• Licenses can be delivered or upgraded via the Internet.
• Licenses can be volume-based.

Although many options and variations are possible, the licensing basics are simple and straightforward.
After installing or upgrading the product, activate the license by obtaining an activation code from Kofax.
In most cases, the activation occurs automatically.

This scheme applies to both hardware and software licenses.

Kofax Capture Service
The Kofax Capture Service (ACSvc.exe) coordinates all license operations from the Kofax Capture
server site. It has no user interface, and generally there is no need for you to interact with this service.
Workstations and all remote Kofax Capture Network Server sites receive their licensing permissions from
the central Kofax Capture Service. However, standalone installations have a built-in service.

Sharing a License Server
It is possible for a number of otherwise independent Kofax Capture installations to share a common
license server. For example, you can use this approach to simplify the license purchase process. Note
that sites sharing the license server must all have network access to the shared server. Also note that the
system time and date for every site sharing the license server must be within two days of one other. If the
system dates are too far apart, an error occurs.

How Kofax Capture Network Server Licensing Works
KCN Server has a flexible licensing capability that ties into the Kofax Capture licensing mechanism. Each
time a remote site synchronizes with the central site, licensing information is exchanged. This ensures that
the licensing information is reasonably current and consistent across the entire installation.

Each time a remote site synchronizes with the central site, it sends any volume usage information to
the central site and downloads any updates to the volume licensing. All licensing downloaded to the
remote site automatically expires 5 days after the current remote site date. This ensures that remote sites
periodically synchronize volume usage information.
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In a disaster recovery scenario, if you switch remote sites to a new primary site, your existing number
of station licenses is sufficient — the number of station licenses required for the remote sites does not
increase.

The Kofax Capture Service (ACSvc.exe) coordinates all license operations from the Kofax Capture server
site, and it is installed automatically with Kofax Capture. It has no user interface and, in general, there is
no need to interact with this service.

Workstations and all KCN Server remote sites receive their licensing permissions from the central Kofax
Capture Service. Each remote site also has its own service. This service works in concert with the service
at the central site to manage the allocation of licenses and the tracking of volume usage.

If you selected the hardware key licensing option when you purchased Kofax Capture, the hardware key is
only required on the Kofax Capture central site server.

Hardware keys are not required on Kofax Capture Network Server remote sites. Furthermore, the Kofax
Capture Web server does not require a hardware key.

If a remote site fails to synchronize after 5 days, the licenses expire and the remote site is not able to
function. Synchronizing keeps a license from expiring.

Kofax Capture Licensing with Terminal Services and Citrix
You can operate Kofax Capture via a Terminal Services or Citrix session. Once logged in to the Terminal
Services or Citrix session, Kofax Capture operates as if it were installed on your local computer. However,
you should be aware of the following station licensing conditions.

Supported Version
Kofax Capture has been certified for use with Citrix Presentation Server 4.5 Enterprise.

Running Multiple Modules in a Session
Station licenses apply to the session rather than the computer, so you can run multiple licensed
applications in one session. Licensed applications running within the same session share the same station
license. For example, if you are running Recognition Server, Validation, and Quality Control at the same
time on the same computer, and in the same Terminal Services or Citrix session, only one Kofax Capture
concurrent station license is required.

However, licensed applications that are running within different sessions do not share the same station
license. For example, if you are running Recognition Server, Validation, and Quality Control at the same
time on the same computer, but each is running in a different Terminal Services or Citrix session, three
Kofax Capture station licenses are required.

Running a Mix of Session and Client-Based Modules
Kofax Capture applications that run as services are part of the same session as the console. For example,
if Recognition Server is running as a service and a user at the console is running Validation, then a single
Kofax Capture station license is used. However, if Recognition Server is running as a service and a user
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connects remotely (via Terminal Services or Citrix) and runs Validation, two Kofax Capture station licenses
are required.

Tracking Terminal Services and Citrix Session Usage Statistics
To track individual sessions running on a single station, the station ID for the session includes both the
station ID and the session ID. Example:

StationID = ScanStation: Sess 42

Disconnecting and Logging Out Terminal Services and Citrix Sessions
When a Terminal Services or Citrix session is disconnected, the session state becomes "Disconnected."
All running applications remain running in an idle state, and any consumed Kofax Capture station licenses
remain consumed. When the user is reconnected, the session becomes active again, and the running
applications resume their prior states.

Note If a licensed Kofax Capture module is running within a disconnected session and the administrator
forces a logoff of that session, or the application terminates abnormally for any reason, the consumed
Kofax Capture station license is released within the timeout period (20 minutes by default) or after the
Kofax Capture licensing service has been manually restarted.

When a Terminal Services or Citrix session is logged out, the session is closed and any consumed Kofax
Capture licenses are released. The session no longer displays in the Management Console.

Limiting Volume Licenses at Remote Sites
Use the Kofax Capture Network Server Remote Site Volume Management feature to control how volume
licenses are shared by your remote sites. If you have a certain volume of Scan/ Import Page Count, you
can divide the volume among your remote sites. Each remote site could be given the entire amount, or
each remote site could be allocated any fraction of the license volume.

Normally, a volume license is shared across all stations in a Kofax Capture installation. If Kofax Capture
Network Server is installed, volume license usage is shared across the central site and all remote sites.
This configuration is ideal if you want to centrally manage a license pool.

In some situations, there might be an advantage to treating each remote site as an independent consumer
of volume licenses. You can assign specific limits for volume-based licenses to remote site profiles. This
setting is optional, and can be done for all, none, or some of the volume-based licenses.

From the perspective of a remote site, these limits set the maximum volume available to it, regardless of
the total volume allowed by the license at the central site.

The following example illustrates how this works.

Assume that you have the following licenses and volumes at the central site.

Name and Type of License Maximum Volume Minimum Volume

Scan/Import Page Count - Annual 1000 1000
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Name and Type of License Maximum Volume Minimum Volume

Scan/Import Page Count - One Time Use 1000 1000

PDF Image + Text (PDF Text Under Image) -
Annual

1000 1000

PDF Image + Text (PDF Text Under Image) - One
Time Use

1000 1000

You have already created a remote site profile called "Back 40" and now want to limit some of the volumes
available to that profile. By implication, all remote sites assigned the Back 40 profile will have the same
limits placed on them.

You set the following volume limits on the Back 40 remote site profile.

Name Period Periodic Limit One Time Use Limit

Scan/Import Page Count Annual 500 0

PDF Image + Text (PDF Text
Under Image)

Annual 400 0

The preceding settings mean that each remote site with this profile has a maximum annual allowance
of 500 scan/import pages and 400 PDF Image Under Text pages. There is no "one time use" volume
assigned.

Note that if you have 10 remote sites with the Back 40 profile, you have essentially allocated 5000
Concurrent License volume counts and 4000 PDF Image Under Text license volume counts. The
combined total of the remote sites greatly exceeds the maximum allowed by these licenses at the central
site. Even so, the central site maximum volume provides an absolute limit on the volume for your entire
installation, which cannot be exceeded during production regardless of your combined remote site
allowances.

Each time your remote sites synchronize with the central site, the available volume reported at the central
site is decremented according to the usage at the remote sites. In this example, once the maximum
volume is reached at the central site, the system is no longer able to process batches.

Use the following basic steps to limit volumes at remote sites. This procedure assumes that a remote site
profile already exists and that at least one remote site has been assigned to that profile.

1. At the central site, start the Administration module.
2. On the Tools tab, in the Distributed Capture group, click the arrow under Remote and then click

Site Profiles.
The Kofax Capture Network Server Remote Site Profiles window appears.

3. In the Name field, select the remote site profile to modify.
4. Click the Volume Licensing tab.

Note the available licenses at the top and the applied limits at the bottom. If this is the first time you
have modified volume licensing limits for this profile, all the boxes are unselected.

5. Select one of the licenses.
A check mark appears in the selected box and the two limit fields change from No Limit to 0.

6. Click in the Periodic Limit field and enter a number from 0 to 2000000000.
This limits the periodic license count for the selected license type.
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7. Click in the One Time Use field and enter a number from 0 to 2000000000.
This limits the "one time use" license count for the selected license type.

8. Repeat steps (5 - 7) for other license types.
9. Click Save.

Your changes are saved to the selected remote site profile.
10. Repeat steps (3 - 8) for other remote site profiles.
11. Close the window.

The next time a remote site assigned to that profile is synchronized, the new licensing limits are
transferred.

Kofax Capture Network Server License Types
This section describes the license types employed by Kofax Capture Network Server.

System License

A system license enables a feature or sets limitations for your Kofax Capture installation. With Kofax
Capture Network Server, all system licenses from the central site are shared with all remote sites. If the
central site is running with an evaluation license, the evaluation license is shared with all remote sites.

Remote Site License

At a remote site, the License Utility shows a system license called "Kofax Capture Network Server remote
site license configuration."

To keep the Remote Site Licenses from expiring, you should routinely synchronize (preferably once each
day) with the central site. If you do not synchronize, your Remote Site Licenses expire after 5 days. If this
happens, simply synchronize to reacquire the licenses.

Station License

Kofax Capture Network Server uses the same station licenses as Kofax Capture.

On a new Kofax Capture Network Server installation, station licenses are initially allocated entirely to the
central Kofax Capture Network Server site. The "(Default)" remote site profile is created by the installation
application and allocates one Concurrent Station License to each remote site.

The administrator can allocate additional station licenses to each remote site by creating or editing remote
site profiles.

As with a Kofax Capture installation, the Kofax Capture Service at the remote site may substitute one
license for another if a matching license is not available. However, substitutions across remote sites or
with the central site are not supported. In other words, substitutions are limited only to those licenses
available at that remote site.

Information about a station license is not displayed in the License Utility at remote sites.
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Hardware Key Requirements
If you selected the hardware key licensing option, a hardware key is required on all Kofax Capture servers
and standalone Kofax Capture installations. Kofax Capture uses a USB hardware key; parallel hardware
keys are not supported.

Kofax Capture client workstations and Kofax Capture Network Server remote sites do not require
hardware keys.

Your activation code is tied to your hardware key. Using the activation code on the wrong system, or
changing the hardware key does not work. 

Note If you are using software-based licensing, there is no need for a hardware key. Every other aspect
of activation remains the same.

Kofax Capture License Types
Kofax Capture has three types of licenses:
• System licenses
• Station licenses
• Volume licenses

Note Certain features, such as the Enhanced Bar Code Engine, require additional licenses that are not
part of Kofax Capture.

The Administration module, the Batch Manager module, the Database Utility, and the Kofax License Utility
do not require any licenses.

System Licenses
A system license enables a feature or sets limitations shared by the entire Kofax Capture system.
Specifically, a system license applies to a particular server and all associated client workstations. In a
Kofax Capture Network Server installation, a system license automatically applies to all remote sites.

The following sections describe the various system licenses supported by Kofax Capture. To activate
Kofax Capture, the correct Version System License must be present in the activation code. Without the
appropriate Version System License, Kofax Capture cannot be activated. For example, Kofax Capture
version "x" requires a Version System License specifically for version "x."

Software License

Software-based licensing is the default licensing method. Hardware keys are an alternate form of
licensing. Except for the hardware key, both types of licensing are the same.

Kofax Capture License

The Kofax Capture License gives you the ability to use all the standard features of Kofax Capture.
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Kofax Capture Enterprise License

The Kofax Capture Enterprise License gives you the ability to use all the features available in the Kofax
Capture License with the addition of the following:
• High Availability support
• Multiple Instance support
• Terminal Services and Citrix support
• WebSphere support
• Backup Licensing option
• SQL Server Enterprise Edition, Oracle Database, and IBM DB2 configurations
• Disaster Recovery features (adding and editing alternate central sites, automatic site switching, batch

replication, uploading new batches to alternate central sites, or related WorkFlow Agent API features).

Note Kofax Capture does not ship with or install a full-featured version of SQL Server Enterprise Edition,
Oracle Database, or IBM DB2.

Kofax Capture Product Suite Evaluation License

The evaluation licenses give you the ability to run all modules and have the same activation steps as a
purchased license. All evaluation licenses allow you to run in "evaluation mode" for a limited time and
with a limited page volume. Evaluation mode provides unrestricted access to most of the features and
capabilities of Kofax Capture. Depending on your purchase contract, certain restrictions may be imposed
on features allowed by the evaluation mode.

The Kofax Capture product suite has a three-day evaluation license.

If you select the hardware key license option, Kofax Capture attempts to activate your license
automatically after installation. However, in some circumstances, automatic activation may not be
possible. For example, you may have problems with your Internet connection or hardware key. In such
cases, Kofax Capture may be able to obtain an evaluation license.

If acquired, this evaluation license is good for three calendar days, not counting the day you installed
Kofax Capture. During this evaluation period, there is an absolute usage limit of 3000 pages.

If automatic activation fails, you can obtain an activation code at http://www.kofax.com/support/index.asp?
t=activation. If that is not possible, you can send an email to Activation@Kofax.com. If activation fails for
any reason, do not attempt to reinstall Kofax Capture. Doing so will render it useless until you obtain an
activation code from Kofax.

When your license is about to expire, you will see messages reminding you that the evaluation period will
soon end. The exact timing of these messages depends on your sales contract.

Even though evaluation licenses have volume limitations, you do not receive a warning as you approach
your page limit. This is because the number of pages remaining is always visible in the Scan module. You
can regularly monitor your remaining page counts by looking at this counter.

Station Licenses
Use a station license to run the following Kofax Capture components:
• Scan
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• Import scripts
• XML Import Connector and Auto-Import
• OCR Full Text
• PDF Generator
• Quality Control
• Recognition Server
• Export
• Validation
• Verification
• Custom modules
• Customized Standard module
• Email Import Connector

When Kofax Capture Network Server XML Import Connector is run in polling mode, it does not acquire a
license until it begins processing a batch. When the batch is closed, the license is released.

Kofax VRS Station Licenses

To use the VRS QC Later feature, it is necessary to have the appropriate station license. As with other
Kofax licenses, this license is activated over the Internet. When activated, the purchased Kofax VRS
license(s) appears in the Kofax License Utility. The three types of Kofax VRS station licenses are listed in
the following table. Each license includes a class of scanners, grouped by throughput.

License Text in License Utility Supports VRS QC Later Mode

Kofax VRS Professional for Desktop Scanning No

Kofax VRS Professional for Workgroup Scanning Yes

Kofax VRS Professional for Production Scanning Yes

The Kofax VRS Professional for Desktop Scanning station license does not support the VRS QC Later
mode. However, it is still possible to use VRS QC Later with a desktop scanner version of Kofax VRS
if one of the other two types of station licenses is available. For example, a desktop scanner version of
Kofax VRS can run with a workgroup or production license if a desktop scanner license is not available. In
this case, VRS QC Later will work, since the higher licenses support it.

As with other types of station licenses, Kofax Capture reallocates the Kofax VRS scanner licenses as they
are released.

Note The Kofax Capture evaluation license does not enable Kofax VRS.

Station Licenses with Terminal Services and Citrix

Use a Station license to use Kofax Capture during Terminal Services and Citrix sessions as if Kofax
Capture were installed locally. However, there are special considerations that apply if Kofax Capture
Licensing is used with Terminal Services and Citrix.

Volume Licenses
Volume licenses limit the number of pages that you can process across the Kofax Capture installation.
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In general, each imported image file decrements a volume license by a count of 1 for each page
embedded in the image file (most image file formats support only one page; however, TIFF files can
support multiple pages). 

When scanning or importing using standalone separator sheets, the first separator sheet in each batch is
counted against the volume. However, subsequent standalone separator sheets (and blank pages deleted
at scan time) don't decrement the page count.

Also, if a bar code/ patch code is found on a standalone separator sheet during document separation, that
separator sheet is not counted, either.

An important clarification applies when importing PDF files as TIFF images (as opposed to treating them
as eDocuments). When you import a PDF file as a TIFF file, each page in the PDF file results in an
embedded page in the corresponding TIFF image file. Consequently, Kofax Capture decrements your
license count by one. Therefore, a 124-page PDF file decrements your volume count by 124 pages.

However, if you import the 124-page PDF file as an eDocument, your volume count is decremented by
only one page. Note that Kofax Capture has important restrictions on the way eDocuments are handled.
These same restrictions apply to PDF files treated as eDocuments.

There are two classes of volume licenses: periodic licenses and one- time use licenses.

Periodic licenses are the most common form of volume license, and they automatically renew on a regular
cycle. Annual licenses reset to their maximum volume allowance on the first day of each year. If a new
volume license is purchased mid-period, it begins with a full volume. If you upgrade to a license with a
greater volume, your volume count continues uninterrupted; it does not reset.

One-time use licenses work by authorizing an absolute number of pages. Each time you process a page,
the number is decremented by one. When the remaining amount reaches zero, the license expires. It
does not automatically renew.

When used in conjunction with periodic licenses, a one-time use license is used first. If your one-time
license count falls to zero, Kofax Capture starts using your periodic license.

You can purchase one-time use licenses at any time. If you have a remaining volume on a current one-
time use license, the new volume is added to your remaining count.

Each type of volume license is described in the following sections.

Scan/Import Page Count License – annual

This license is used by the Scan module, import scripts, and custom modules that scan or import pages.

The Scan/Import Page Count license is available with annual periods that automatically renew.

Scan/Import Page Count License – one-time use

This license is the same as the Scan/Import Page Count License annual license, except this license is
only decremented when the annual license is depleted.

This is a one-time use license.

Kofax PDF Image + Text Page Count – annual

This license is used by the Kofax PDF Generator when generating Kofax PDF Image Under Text output.
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The Kofax PDF Image + Text (Image Under Text) Page Count annual license is available with yearly
periods that automatically renew.

Kofax PDF Image + Text Page Count – one-time use

This is the same as the Kofax PDF Image + Text Page Count periodic license, except this license is only
decremented when the annual license is depleted.

This is a one-time use license.

Remaining Volume Count

The Kofax Capture Scan and Quality Control modules display the total number of pages remaining in your
Scan/Import volume licenses. This is the sum of the current periodic and one-time use licenses minus
the number of pages you have used. This display is updated at least as frequently as batches are closed,
opened, and created. The same rules apply to the scan counter available to import scripts.

This display shows volume counts for images.

Note The count may be updated more frequently for pages processed locally than for KCN Server
remote stations.

Network Support for Licensing
The licensing system requires a TCP/IP connection between all Kofax Capture client workstation
applications and the Kofax Capture Service (on the Kofax Capture Server).

The Kofax Capture Service retries for up to 1 minute in the case of a network or server problem. If the
server or network recovers within this period, the client workstation detects this and continues normally.

Otherwise, a client workstation error occurs. Note that unattended applications, such as the Export
module, continue running, even after such an error. Attended applications, such as the Scan module, will
fail and likely need to be restarted.

Note If the Kofax Capture Service is restarted, workstations reacquire any previously held station
licenses once they are reconnected.

Licensing Requirements for the Enhanced Bar Code Engine
The Enhanced Bar Code Engine requires additional licensing, as described later in this section. If the
Enhanced Bar Code Engine is selected for a recognition profile, but the required licensing is not in place,
the Standard Bar Code Engine is automatically used. Processing for 2-D bar codes produces empty
results and no warnings or messages appear.

An exception occurs when you test zones on sample pages from the Administration module. If the
Enhanced Bar Code Engine is selected, but the required licensing is not in place, empty results are not
returned. However, a warning appears in the Results area of the Zone Test window.

Depending on the setup parameters, Kofax Capture usually performs bar code recognition within the Scan
module. However, in the following cases, it is necessary to defer bar code recognition to the Recognition
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Server module. If you plan to use the Enhanced Bar Code Engine in these cases, the computer running
the Recognition Server module must have the appropriate license.
• If automatic index zones of any kind exist in the document class, all bar codes, including page level bar

codes, are processed by the Recognition Server module.
• If more than one type of bar code exists per document class (including all page level or zonal bar

codes), all bar codes are processed by the Recognition Server module.
• If Recognition scripts exist, all bar codes are processed by the Recognition Server module.
• If more than one form type exists, all bar codes are processed by the Recognition Server module.

The following table shows the licensing requirements for various configurations using the Enhanced Bar
Code Engine.

Module Processing Activity Enhanced Bar Code
Hardware Key Licensing 1

Enhanced Bar Code
Station Licensing 2

Administration Testing zone-level or page-
level bar code recognition
with QuickZones

yes yes

Scan and Quality Control Bar code recognition when
scanning with a scanner

yes yes

Recognition Server Bar code recognition yes yes

1  Requires that an Enhanced Bar Code hardware key be installed on every workstation. If you are using
this hardware key, you must shut down all Kofax Capture modules before you attach the Enhanced Bar
Code Engine hardware key. Failure to do so will yield unpredictable processing results.
2  Requires that Enhanced Bar Code be added to your Kofax Capture licensing. In a standalone
configuration, only one Enhanced Bar Code station license is required, but in a client/server configuration,
a license can only be used by one workstation at a time. In a client/server configuration, if a module
attempts to use a license while another workstation is using it, the module either uses a second license or,
if a second license is unavailable, the values that require the Enhanced Bar Code Engine are left blank. To
avoid this condition, we recommend that you purchase multiple Enhanced Bar Code station licenses.

Note The Scan, Quality Control, and Recognition Server modules use an Enhanced Bar Code station
license while a batch invokes the Enhanced Bar Code Engine. In these cases, the license becomes
available to other workstations again when the batch is closed. However, the Administration module
uses an Enhanced Bar Code station license when the Enhanced Bar Code Engine is invoked through a
zone test's recognition profile. In this case, the license does not become available to other workstations
until the Administration module is closed.

Activating Your Licenses
Activation is accomplished by acquiring an activation code that is tied to your computer using software-
based licensing. Using the activation code on a different system does not work.

Activation is automatically attempted during the installation of Kofax Capture server, or a Kofax Capture
standalone system.
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Note If you are using the hardware key option, the activation code is tied to your hardware key. Every
other aspect of activation remains the same as software-based licensing.

The Kofax License Utility requires a special activation code to activate your licenses. Normally, licenses
are activated automatically as part of the installation process. There may be situations, however, in which
you must manually acquire an activation code.

While activating your licenses, we suggest that you shut down all Kofax Capture applications throughout
your installation.

Automatic Activation
On a new installation (where Kofax Capture has not previously been installed, or where the previous
installation was removed), Kofax Capture attempts to automatically activate your license. If this succeeds,
you can immediately use all the features and capabilities allowed by your license. If this fails, you can use
the Evaluation License, provided your hardware key shows no usage count. If you are reinstalling Kofax
Capture and your hardware key shows usage, you are not granted an Evaluation License.

Automatic Activation requires an Internet connection and automatically does the following:
1. Contacts a Kofax server via the Internet.
2. The server at Kofax generates the correct activation code and sends it back to the installation

program.
3. The installation program activates your licenses and notifies you that they are activated.

Note Automatic activation can also be performed with the License Utility.

Manual Activation Methods
You can manually activate Kofax Capture if you are unable to activate automatically.

Note If you obtain your activation code manually, you must use it to activate your system within 30 days.
After activation, you can continue to use Kofax Capture indefinitely without obtaining a new code. If
you are not able to complete the activation within 30 days of obtaining the code, you must obtain a new
activation code.

While automatic activation is the most convenient activation method, there may be cases in which manual
activation is required.

For example:
• You do not have access to the Internet.
• Your Internet connection is temporarily down.
• You are visiting a customer without Internet access.

All manual activation methods require you to obtain an activation code. The following procedures cover
several common methods of manual activation.
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Web Page Activation

To use the Web page, you must have your Kofax serial number. You obtain this number from the email
you received from Kofax, inside the Kofax Capture box, or on the hardware key (if applicable). With the
hardware key option, you can also find your serial number in the Kofax License Utility. The serial number
consists of two letters followed by a series of numbers.

1. Note the Kofax serial number.
2. Using your Internet browser, open to the Kofax Capture Activation page at http://

www.kofax.com/support/index.asp?t=activation.
3. Enter your serial number in the space provided on the Web page and click Submit to generate your

activation code.
4. After the Web page has generated the activation code, copy the code to the Clipboard.
5. In the Kofax License Utility, select File and then Activate to open the Activate window.
6. Click Manual to open the Manual Activation window and paste the activation code from the email

into the indicated area.
7. Click Activate.

The utility activates the system and notifies you that the system is now ready for use.

Email Activation

To use the email activation method, you must have your Kofax serial number. Use this method only if all
other activation methods have failed.

1. Note the Kofax serial number.
2. Contact Kofax at info@Kofax.com, request an activation code, and provide the serial number.
3. Kofax generates the activation code and relays this information back to you via email.
4. In the Kofax License Utility, select File and then Activate to open the Activate window.
5. Click Manual to open the Manual Activation window and paste the activation code from the email

into the indicated area.
6. Click Activate.

The utility activates the system and notifies you that the system is now ready for use.

Activation at Another Location

This method can be used if you plan to visit a remote site (or a different workstation) where automatic
activation is not possible.

1. Note the Kofax serial number.
2. Open the Kofax Capture activation page:

http://www.kofax.com/support/index.asp?t=activation

3. Enter your serial number in the space provided on the Web page and click Submit to generate your
activation code.

4. After the Web page has generated the activation code, copy the code to a text file and save it.
5. Go to the remote site or workstation where Kofax Capture will be activated.
6. In the Kofax License Utility, select File and then Activate to open the Activate window.
7. Click Manual to open the Manual Activation window and copy the activation code from the text file

into the indicated area.
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8. Click Activate.
The utility activates the system and notifies you that the system is now ready for use.

Reactivation
In some cases, you may need to reactivate your Kofax Capture licenses. For example, you may have
upgraded the terms of your license to allow for a higher page count.

You can repeat the activation process, even if the system has already been activated. If reactivation fails,
then the system is rolled back to its earlier state.

If you use the same activation code, the terms and conditions of your license are unchanged. Reactivation
of an identical periodic license does not reset the volume used or the maximum amounts permitted. If you
use a new activation code, the terms and conditions of your licenses may change.

Important If you intend to reactivate using the same activation code, you must do so within 30 days of
receiving the code. All activation codes expire after 30 days.

Reactivating After a Hardware Key Failure
After obtaining your new hardware key, you must reactivate your Kofax Capture installation.

Note Upon reactivation, your volume counts will reflect any usage that occurred while you were waiting
for a new hardware key. In other words, Kofax Capture continues to track your volume usage under
these conditions.

There is no need to shut down the Kofax Capture Service, but we suggest that you shut down all other
Kofax Capture applications.

1. Install the new hardware key on the server.
2. Start the Kofax License Utility, which will still show the old serial number.
3. Select File and then Activate.

The Activate window displays your new serial number.
4. Click either Automatic or Manual to select an activation method.

Activating Your Kofax Capture Network Server Licenses
You must activate your Kofax Capture Network Server installation before your evaluation period expires,
or you cannot use it for production work. This is done by acquiring an activation code tied to your
computer. Using the activation code on a different computer will not work.

Activation Code
The License Utility uses a special code to activate your licenses. Normally this happens automatically
when you install the product.

324



Kofax Capture Administrator's Guide

There may be situations, however, in which you must acquire an activation code at another time. Be sure
to complete your activation within 30 days of getting the activation code, or the code will expire and you
can no longer use it.

Kofax Capture Network Server Activation
All your KCN Server licenses (central and remote sites) are activated at the same time. The activation
process establishes licensing information for the central site as well as all remote sites (based on
assigned remote site profiles). You are responsible for distributing the license information to the remote
sites. However, this does not involve subsequent activation activities.

For example, suppose you have a central KCN Server site and 20 remote sites. You would first install and
license the Kofax Capture Network Server central site. If necessary, activate the central site by running the
Kofax License Utility.

Next, install the remote sites. Remote sites receive their licensing based on the rules you have
established on the Licensing tab on the Kofax Capture Network Server Remote Site Profiles window.
For example, if you use the "(Default)" remote site profile, remote sites each get one Concurrent Station
License.

At the central site, use the Kofax Capture Network Server Remote Site Manager to assign remote site
profiles to remote sites. When each site synchronizes with the central site, it receives the assigned
licensing.

Note Remote sites do not need to activate licensing.
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Chapter 15

Kofax Capture Configuration File:
ACConfig.xml

This chapter gives you details about the Kofax Capture configuration file (ACConfig.xml), which is
available in the following folder:

Client/server: <ServerPath>\Config

Standalone: c:\ProgramData\Kofax\Capture\Config

Important If you change any settings in ACConfig.xml, be sure to test them thoroughly before using
the updated file in a production environment. Altering the settings may impact product behavior and/or
integration with other Kofax products.

For information about ACConfig.xml settings that affect Kofax Front Office Server, refer to the Kofax Front
Office Server Administrator's Guide.

Parent Element / Element Attribute Default Value / Description

ACConfig / BatchCatalogNewEncryption Enabled Default value: 0 (Off)
1 = On
Supports the custom encryption
algorithm for Kofax Capture non-linked
user passwords in BatchCat.xml,
instead of the standard encryption.

ACConfig / RevertSBWhenScanning Enabled Default value: 0 (Off)
1 = On
Reverts SecurityBoost while scanning or
changing a scan profile.

ACConfig / OCRAdvancedSettings AutoCleanRecognizerSession Default value: 0 (Off)
1 = On
By default, the recognition engine
caches image information between
sessions to improve the quality.
If the default settings produce
inconsistent recognition results, apply
this switch to ensure more reliable
quality.

326



Kofax Capture Administrator's Guide

Parent Element / Element Attribute Default Value / Description

DetectEmptyParagraphs Default value: 1 (On)
0 = Off
Use this switch to ensure that
paragraphs are recognized correctly
when the OCR Full Text module is in
use and "Use blank line as paragraph
separator" is enabled.
This affects plain text output only.

ReplacePageBreakWithEmptyLineDefault value: 1 (On)
0 = Off
Supports the ability to insert an empty
line between pages when exporting
multiple pages into a single text file, if
"Use page break as page separator" is
enabled for the OCR Full Text profile.

RemoveExcessEmptyLines Default value: 1 (On)
0=Off
Intended for use with
ReplacePageBreakWithEmptyLine;
supports the ability to remove excess
empty lines if more than one empty
line is inserted between paragraphs or
pages.

ResolutionScale <number>
The width and height of PDF output is
reduced by a factor of <number>.
This applies only to images with a width
greater than 8.5 inches.
This limitation prevents the generation
of small PDF images if the original
image size is already very small.
Change the 8.5 inch width threshold by
appending the OutputWidthThreshold
switch.
For implementation details, see PDF
Generator DPI Calculator.

OutputWidthThreshold <number>
Use this element to change the 8.5 inch
width threshold for PDF output. Use
this switch along with ResolutionScale.
For implementation details, see PDF
Generator DPI Calculator.
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Parent Element / Element Attribute Default Value / Description

ACConfig / PreAllocatedUniqueDocID Default value: 1
Valid range: 1-50
Use this element to prevent degradation
in performance for the Export module in
a high-volume processing environment.
As the value is increased, the number of
database transactions is reduced, which
results in improved export speed.

ReliableFileSystem Changes to this element may require
application to be restarted.

MaxRetrySeconds Default value: 120
Total file system operations retry time
before returning an error.
OK to edit.

MilliSecondsBetweenTries Default value: 500
Wait time between file system retries.
OK to edit.

ReliableFileSystem / Retry

MinimumRetries Default value: 1
Minimum retry attempts when file
system operation fails. This setting
disregards other settings.
OK to edit.

ACConfig / Services

ServerTimeout Default value: 30
The number of seconds a site tries to
connect to a license server to obtain
licensing.

TotalTimeoutSeconds Default value: 300
The amount of time (in seconds) the
system will attempt to connect to a
license server before timeout.

Services / Licensing

UseDefaultWebProxy Default value: 0
0: Do not use the Internet Explorer web
proxy configuration.
1: Use the Internet Explorer web proxy
configuration.
OK to edit.
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Parent Element / Element Attribute Default Value / Description

Services / BatchNotification WaitForAvailableBatchTimeOut Default value: 60
Polling interval used if the Batch
Notification feature is not responding.
Note: if the server or workstations are
not reachable, the applications revert
back to polling.
The valid range is 1 to 600 seconds.
OK to edit.

Key Default value: Licensing/Licensing
Service
Cannot edit.

Host Default value: DNS Machine Name of
machine where the License Server is
enabled
OK to edit.

Protocol Default value: http
Protocol used to communicate with the
service.
Cannot edit.

Port Default value: 2424
Requires corresponding registry
change.
OK to edit.

Licensing / Service

Enterprise Default value: 0
This value is set after license activation
to indicate the system includes an
Enterprise license. Used only to display
the correct splash screen; not used to
verify licensing for any features.
Cannot edit.

Key Default value: BatchNotification\Batch
Notification Service
Cannot edit.

Host Default value: DNS Machine Name of
machine where the batch notification
service is enabled.
OK to edit.

BatchNotification / Service

Protocol Default value: http
Protocol used to communicate with the
service.
OK to edit.
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Parent Element / Element Attribute Default Value / Description

Port Default value: 2424
Requires corresponding registry
change.
OK to edit.

ACConfig / CurrentVersion Default value: 11.0
Contains current version of the
application.
Cannot edit.

ACConfig / ACIS Added when aciscfg enables the KCN
Server service.

Key Default value: ACIS\ACI Service
Cannot edit.

Host Default value: DNS Machine Name of
machine where the License Server is
enabled.
OK to edit.

Protocol Default value: http
Protocol used to communicate with the
service.
Cannot edit.

ACIS / Service

Port Default value: 2424
Requires corresponding registry
change.
OK to edit.

ACConfig / KfxDb DisableSQLImpersonation Default value: 0
Specifies that Kofax Capture modules
ignore switching the database execution
context without checking the database
role.

CommandTimeout Default value: 300
Used when a command takes a long
time to execute. Match the default
command timeout value to the default
retry time to match the threshold you
are willing to wait for a command to
complete.
OK to edit.

KfxDb / SQL-Server Use the Database Utility to edit.

KfxDb / IBM-DB2 Use the Database Utility to edit.

KfxDb / Oracle Use the Database Utility to edit.
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Parent Element / Element Attribute Default Value / Description

KfxDb / BatchStorageOption Default value: 0
0: Batches are stored in a Microsoft
Access database.
1: Batches are stored in a different
database such as SQL Server.
Use the Database Utility to edit.

KfxDb / DataArchitecture Either Standard or DBMS values. Valid
DBMS values are SQLServer, Oracle, or
IBM DB2.
Standard: A standard database with
batches in access.
A valid DBMS value indicates a
standard database is not being used.
Use the Database Utility to edit.

KfxDb / DBMS The DBMS used. Valid DBMS values
are SQLServer, Oracle, or IBM DB2.
Note: When DataArchitecture is
Standard, this must be SQL Server.
Use the Database Utility to edit.

KfxDb / AllowMultipleAdmins 0: Allow the Administration module to
open on multiple stations.
1: Allow only one open instance of the
Administration module.
OK to edit.

SQL-Server / Database Default value: ACSystem
Use the Database Utility to edit.

SQL-Server / StandardInstance Default value: <ACServer>
\AscentCapture <KCServer>
\KOFAXCAP2012
This value is stored even when using
SQL Server. It is only used if you switch
back to Standard.
Cannot edit.

SQL-Server / UserID Default value: sa
Use the Database Utility to edit.

SQL-Server / Password Default value: Encrypted
Use the Database Utility to edit.

SQL-Server / LocalDataDirectory Default value: <Server-Files>\Server\DB
\MSSQL$Ascent Capture\Data
where database is stored on the
database server.
Cannot edit.
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Parent Element / Element Attribute Default Value / Description

SQL-Server / AuthenticationMode Default value: SqlServer
SqlServer or MixedMode
Use the Database Utility to edit.

SQL-Server / UseBatchCatMth Default value: 0
Used during upgrade.
Cannot edit.

SQL-Server / SQLServerInstance Name of the SQL Server instance if
using SQL Server.
Use the Database Utility to edit.

SQL-Server /
ThrowImmediateWhenCantRetry

Default value: 0
Used for development only.
Set to 1 in debug mode to trigger an
exception rather than execute the
command. Indicates a coding error. A
database operation is called and retry
handling is not set in the application
code.
Cannot edit.

SQL-Server / IsDatabaseInstalled Default value: 1
Indicates the database is ready for use.
Cannot edit.

IBM-DB2 / Server Name of the DB2 server.
Use the Database Utility to edit.

IBM-DB2 / Database Name of the DB2 database.
Use the Database Utility to edit.

IBM-DB2 / UserID User ID for the DB2 server.
Use the Database Utility to edit.

IBM-DB2 / Password Encrypted password for the DB2 User
ID.
Use the Database Utility to edit.

Oracle / Service Name of the local Oracle service.
Use the Database Utility to edit.

Oracle / UserID User ID for the Oracle server.
Use the Database Utility to edit.

Oracle / Password Encrypted password for the Oracle User
ID.
Use the Database Utility to edit.
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Parent Element / Element Attribute Default Value / Description

RemoteSite Default value: 0
Set to 1 to configure a temporary image
storage location at a KCN Server
Remote site.
You can change the remote site storage
location any time, but a change does
not go into effect until you republish
the batch class at the central site
and synchronize it to the remote site.
Relative paths are not supported.
Although you can change the temporary
storage location multiple times for a
remote site, we recommend that you
keep any location available if it contains
images.
Use Batch Manager to edit.

DontStoreCredentials Default value: 0
RSA Authentication Modification.

BatchUploadOption Default value: 0
0: Allow .xml file to upload.
1: Allow .mdb or .accdb file to upload.
OK to edit.

ACConfig / ACIServer

DisableSharingProfiles Default value: 0
Set to 1 at an KCN Server
DisableSharingProfiles to turn off the
sharing of scan profiles with remote
sites.
OK to edit.

Number Default value: 0
Indicates cache numbers. Must start at
0 and be sequential.
OK to edit.

ACIServer / Cache

Path Default value: <ACServer>\ACIUpload
Cache path.
OK to edit.

ACIServer / AdditionalDownloadFiles

ACIServer / MaxLogFileSize Default value: -1
The maximum log file size for KCN
Server. When this log file size is
exceeded, the old log is renamed to the
current date and time and a new log
file is created. This value is in bytes.
A value of -1 indicates no size limit; a
value of 0 turns off logging.
OK to edit.
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Parent Element / Element Attribute Default Value / Description

ACIServer / TransferTimeout Default value: 0
In seconds, the timeout value for a
connection between a remote site and
a central site. Allows large batches to
be sent successfully without timing out
during the file transfer.
OK to edit.

ACIServer / ConnectSiteTimeout TimeoutSeconds Default value: 5
Guaranteed time (in seconds) the RSA
spends attempting to connect to a single
central site.
OK to edit.

ACIServer / AlternateSiteTimeout TimeoutSeconds Default value: 270
Guaranteed total time (in seconds) the
RSA spends attempting to connect to all
central sites.
OK to edit.

ACIServer / BatchUploadTimeout TimeoutSeconds Default value: 270
Guaranteed time (in seconds) the RSA
spends attempting to upload a single
batch after connecting to a central site.
OK to edit.

ACIServer / EnableXmlCompression Default value: 0
Enables compression of the batch; .xml
file when downloading to a remote site.
OK to edit.

ACIServer / UploadDeploymentLogs 0: Turn off uploads of remote site
Customization Deployment logs. To
restore upload capabilities, remove this
element.
OK to edit.

Enable Default value: 0
Block sync when the central site is
publishing batch classes.
OK to edit.

ACIServer / AcisSyncWhilePublish

LogError Default value: 1
Prevents error in log when
AcisSyncWhilePublish is turned off.
0 = Prevent error
1 = Allow error
OK to edit.
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Parent Element / Element Attribute Default Value / Description

ACIServer / SiteSwitch Optional URL used to define a new
primary central site in a Kofax Capture
Disaster Recovery specification.
OK to edit.

ACIServer / ImageDirectory Path Default value: C:\Temporary Image
Storage
Temporary image storage location
(local storage). Use an element in
ACConfig.xml at the remote site to
specify a location, instead of a static
location for each remote site.
OK to edit.

RequireSynchAtRS Default value: 0 (Off)
1 - On
After enabling this feature, the
KCN Service starts monitoring the
custom files changes after the first
synchronization request is sent from the
remote site.

MonitoringIntervalSeconds Default value: 0 (Off)
1 - On
Indicates how often to scan for custom
file changes if the Capture shared data
folder (CaptureSV) is not stored at the
local remote server.
Add this attribute in addition to
RequireSynchAtRS.

ACIServer / CustomSynchronization

CustomFilePattern Add this attribute in addition
to RequireSynchAtRS and
MonitoringIntervalSeconds.
Indicates a specific file extensions to
monitor the custom files changes, such
as *.txt.
This CustomFilePattern attribute is only
valid if the MonitoringIntervalSeconds
attribute is defined.
The default value is empty, which
means all the custom files are checked
after a defined number of seconds.

ACIServer / RSASynchTaskAlternate CopyClassFilesToLocal Default value: 0 (Off)
1 - On
Add this tag to copy the downloaded
catalog (Classes.xml) and class files
(BatchCat.xml) to the local Kofax
Capture folder.
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Parent Element / Element Attribute Default Value / Description

AdditionalDownloadFiles / File Location Extra XML files transferred during batch
class download.
OK to edit.

SiteSwitch / URL See KcnsSiteSwitch.exe usage.
Use KcnsSite Switch.exe to edit.

ACConfig / AdminDataSubstitution Substitute custom data available in the
CustomProperty table.

Old Old value to be replaced.
OK to edit.

AdminDataSubstitution / Replace

New Value that replaces the old value.
OK to edit.

Path The path where batches and batch
classes are exported for replication.

DelayTime InMinutes The time the remote site will hold on to
a batch after it has been exported for
replication.

ACConfig / Replication

DebugLog Default value: 0
In milliseconds, log duration time if
DebugLog is set for Replication in
ACConfig.xml.
OK to edit.

Replication / ExcludedBatchClass Name of a batch class to exclude
from replication. Can be multiple
ExcludedBatchClass elements.

Enable Default value: 0
Use the Database Utility to edit.

User Use the Database Utility to edit.

ACConfig / SecurityBoost

Password Use the Database Utility to edit.

CompactDBs Default value: 1
Set to 1 to compact Microsoft Access
batch databases before they are copied
to the server. Only applies when closing
Recognition Server, Validation, or
Export or during recovery.
OK to edit.

ACConfig / BusinessServices

AlwaysCompactDBs Default value: 0
Set both CompactDBs and
AlwaysCompactDBs to 1 to compact the
batch database after every module.
OK to edit.

336



Kofax Capture Administrator's Guide

Parent Element / Element Attribute Default Value / Description

CheckBatchDB Default value: 0
Set to 1 to check for corrupted files each
time a Microsoft Access batch database
is opened. Corrupted files are fixed if
necessary.
OK to edit.

DeleteDBs Default value: 1
Set to 1 to delete the local Microsoft
Access batch database when the batch
is closed.
OK to edit.

CleanonAutorecover Default value: 0
Set to 1 to check for corrupted
files each time a batch database is
recovered. Corrupted files are repaired
if necessary.
OK to edit.

CachePublishedBatchClasses Value is currently ignored.
Microsoft Access batch class databases
are always cached.

LogLockNextBatchErrors Default value: 0
In LockNextBatch, an error message is
logged if a batch is skipped for any of
the following reasons:
• Batch is locked.

• User who validated the batch gets
this batch as the next one.

• Batch has already moved to a
different queue or state.

OK to edit.

UseAccessForSetup Default value: 0
Batch class (setup) information is read
from the system database even when
not using batches in SQL. Set to 1 when
not using SQL batches for possible
performance improvements.
OK to edit.

CacheSampleImages Default value: 0 (Off)
1 = On
Caches the sample images locally for
access by Kofax Capture modules
(except Administration).
OK to edit.
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Parent Element / Element Attribute Default Value / Description

IgnoreZeroStatsFormTypes Default value: 1 (On)
0: Includes all form type records in the
StatsFormType table, even if they have
no associated documents and pages.
1: Excludes form type records from the
StatsFormType table if they have no
associated documents and pages.
OK to edit.

SkipPartitioning Default value: 0 (Off)
1 = On
Improves database response time when
Open Next Batch Automatically feature
is enabled.

<BusinessServices
 SkipPartitioning="1" />

OK to edit.

OrderByCreationDate Default value: 0 (Off)
1 = On
With the Open Next Batch Automatically
feature, selects the next batch based
on the Creation Date instead of the
ExternalBatchID.

<BusinessServices
 OrderByCreationDate="1" />

OK to edit.

ACConfig / Workstations

Workstations / Workstation Host Default value: Machine name
Used by monitor sample application.
OK to edit.

ACConfig / MultiProcesses MaxInstancesPerProcessor Default value: 4
Starting too many instances degrades
performance. If the computer is powerful
enough to handle more, this setting can
be changed.
OK to edit.

ACConfig / ZONE_CorrectSkew Default value: 0
Used to enable skew correction
configuration for Recognition Server.
Allowed values:
0: Turn off skew correction.
1: Correct skew by horizontal black
squares.
2: Correct skew by vertical black
squares.
4: Correct skew by horizontal lines.
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Parent Element / Element Attribute Default Value / Description
8: Correct skew by vertical lines.
16: Correct Skew by horizontal text.
32: Correct Skew by vertical text.
Specify one or more of the values.
Selected skew corrections apply to all
workstations.
OK to edit.

ACConfig / OCR_CorrectSkew Default value: 0
See explanation for
ZONE_CorrectSkew. The settings are
the same and apply to the OCR Full
Text module.
OK to edit.

ACConfig / PDF_CorrectSkew See explanation for
ZONE_CorrectSkew. The settings
are the same and apply to the PDF
Generator module.
OK to edit.

ACConfig / MultiBatchQueueChange Default value: 0
0: Turn off multi-select batches to
change the queue.
1: Allow multi-select batches to change
the queue.
When selected, error batches are
returned to the processing queue where
they were most recently opened, and
they are unrejected. Also, the state for
each is changed from Error to Ready.

Important An exception applies
if any of the error batches were
already opened in the Quality
Control module at any time,
causing them to be automatically
assigned to the Scan module, with
all documents and pages remaining
rejected. This applies even if the
Quality Control module is assigned
as a processing queue for the batch
class.

OK to edit.
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Parent Element / Element Attribute Default Value / Description

ACConfig / PublishWarning ExportConnectorsSupportPDF Default value: 0
Affects warning that occurs if one export
connector uses PDF generation and
another does not.
0: Turn off warning.
1: Allow batch publishing to generate a
warning.
OK to edit.

ACConfig /
OCR_PDF_SkipProcessEDocs

Default value: 0
0: Suppress creation of blank PDFs.
1: Allow creation of blank PDFs.
OK to edit.

jbig2_quality Default value: .82
PDF Generator PDF compression
changes image contents.
Specify a float value for the engine to
compress the PDF output. Value range
can be from 0.0 to 1.0, such as 0.82.
OK to edit.

jbig2_weight Default value: 1.0
Specify a float value for the engine to
compress the PDF output. Value range
can be from 0.0 to 1.0, such as 1.0.
OK to edit.

jbig2_compression_off Default value: 0
Suppress JBIG2 for PDF image
compression.
0: Turn off suppression
1: Turn on suppression
OK to edit.

EnableDLCompression Default value: 0 (Off)
1 = On
Enables the enhancement to improve
PDF file quality.
Note: Once enabled, the old
compression engine is no longer used,
regardless of the settings in the PDF
profiles.

ACConfig / PDF_Compression_Settings

EnableDLJbig2 Default value: 0 (Off)
1 = On
OK to edit.
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Parent Element / Element Attribute Default Value / Description

DLCompressionQuality Does not use the JBIG2 library of
Datalogics for PDF Compression.
1: Uses the JBIG2 library of Datalogics
for PDF Compression:
<PDF_Compression_Settings
EnableDLJbig2="1" />

In the preceding example, the VRS
JBIG2 is turned off automatically, the
output returned by VRS is decoded
with CCITT and then re-compressed by
Datalogics with JBIG2.
Another attribute named
DLCompressionQuality is introduced to
change the compression quality with the
corresponding values:
Auto = 0
Minimum = 1 (Default)
Low = 2
Medium = 3
High = 4
Maximum = 5
Lossless = 6
In some cases, the Lossless setting
may be useful.
Example:
<PDF_Compression_Settings
EnableDLJbig2="1"
DLCompressionQuality="6" />

OK to edit.

ACConfig / EBCLicenseCheck RefreshPerBatch Default value: 0
OK to edit.

ACConfig / ScanProcessInterval Default value: 10
OK to edit.

341



Kofax Capture Administrator's Guide

Parent Element / Element Attribute Default Value / Description

ACConfig / DisableBatchNotification Default value: 1
Turn off the batch notification service for
an entire site.
0: Turn on batch notification.
1: Turn off batch notification.
OK to edit.

Note For new Kofax Capture
11.0 installations, the batch
notification service is managed
with a registry key instead of the
entry in ACConfig.xml. However, if
you upgrade to Kofax Capture 11.0
from an earlier version, the registry
key is not created and the entry in
ACConfig.xml is used.

ACConfig / IgnoreBlankPages Default value: 0
When using the blank page deletion
feature in combination with fixed page
separation:
0: Delete blank pages after page
separation.
1: Delete blank pages prior to page
separation.
OK to edit.

ACConfig / ValidationScript NoUIRefreshForSaveAnd
SkipFields

Default value: 0
To improve performance, prevents
a refresh of the user interface when
a validation script includes several
SaveAndSkip fields.

ACConfig / WaitTimeOutSession Default value: 2
Set a warning message wait time when
the session is about to time out.
OK to edit.

ACConfig /
GetPublishedBatchRetryNumber

Default value: 5
An error message may display when
remote site user verification occurs at
the same time as batch creation.
Set to 5 to implement a 5-second retry
mechanism. Verification overlap does
not occur and the error message does
not appear.
OK to edit.
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Parent Element / Element Attribute Default Value / Description

ACConfig / EBCLicensingLevel Default value: module
Define the Enhanced Bar Code (EBC)
license level on the Recognition Server.
module: does not accept the shared
EBC license. EBC license is released
when the module is closed.
batch: accept the shared EBC license.
EBC license is released when the batch
is closed.
OK to edit.

ACConfig / InstanceUICounterUpdate Default value: 0
0: Do not force UI to update the Page,
Document- and Folder count instantly in
the Scan module.
1: Force user interface to update Page,
Document and Folder count instantly in
Scan module.
OK to edit.

ACConfig / IndividualLogs Enable Default value: 0
Makes it possible for each export
process to write information to its own
log file.
0: Turn off
1: Turn on
OK to edit.

UseFre9Defaults Default value: 1
Define an ABBYY default value used
during image recognition or export.
0: Use ABBYY FRE 10.0 or later as the
default.
1: Use ABBYY FRE 9.0 as the default.

UseLocalFolderForExport Default value: 1 (Off)
1 = On
Stores exported files to a local
temporary folder. Otherwise, the files
are stored over the network and large
files may fail to be stored.

ACConfig / FRE10

SynthesizePerPage Default value: 1 (On)
1 = Off
Uses Page API instead of Document
API.

ACConfig / HexEncoding Specifies a bar code profile name to
encode bar code data in hexadecimal.
Intended to avoid error caused by
NULLs embedded in the bar code data.
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Parent Element / Element Attribute Default Value / Description

Name Specify a profile name for which the
value will be expanded to hexadecimal.
0: Turn on
1: Turn off
OK to edit.

HexEncoding / Profile

Enable Default value: 0
Sets encoding for this profile.
OK to edit.

ACConfig / PreviousLanguage Value represents the previous version
language, such as de, pr-BR, etc.
Cannot edit.

ACConfig / TurnOffFQDN Default value: 0
0: Use Fully Qualified Domain Naming
convention for managing locks in Kofax
Capture and for the batch notification
service.
1: Turns off support for Fully Qualified
Domain Naming.
OK to edit.

ACConfig / LogRemoteSiteBatchDelete Default value: 1
Sets preferences for logging exported
and deleted batches.
1: Logs exported and deleted batches
as they are deleted.
0: Logs only deleted batches as they
are deleted.
OK to edit.

ACConfig / TimeoutWarningDuration Default value: 2
Specify when a message should appear
to warn users about an upcoming
working session timeout. Time interval
set in minutes.
OK to edit.

ACConfig / Server Name Default value: server name
The server name is stored here during
installation.
Used on the workstation to update
registry.
Cannot edit.
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Parent Element / Element Attribute Default Value / Description

ACConfig / PreviousVersion Element added by installation when
upgrading to Kofax Capture 10.x from
a previous version. Value represents
the previous version such as 8.0, 9.0 or
10.0.
Cannot edit.

Enable Default value: 0
When a database validation is included
in the batch class, opening database
validation properties may take an
extremely long time.
Set to 1 to restrict database validation
query against user's schema.
OK to edit.

ACConfig / DBValRestrictions

Schema OK to edit.

ACConfig / CheckStatusFrequency Batches Default value: 0
Checks ACConfig.xml to determine how
many batches are uploaded before a
status check is performed in a single
operation at the central site.
OK to edit.

ACConfig / Reporting Enable Default value: 1
0: Turn off the Reporting feature.
Batches may open more quickly.
OK to edit.

ACConfig / SupportLongUserName Enable Default value: 0
0: Truncates username data in the
BatchStatistics table to 32 characters
before it is transferred to a remote site.
1: Supports length of 50 characters for
username data in the BatchStatistics
table.
OK to edit.

ACConfig / SharePoint SharePoint data source validation.
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Parent Element / Element Attribute Default Value / Description

SharePoint / TermsetCache Caching is used to minimize round trips
to SharePoint. This cache is stored in
memory and is not persistent. You can
specify individual limits for Managed
Metadata term sets, Enterprise
Keywords terms, and lookup results
in the SharePoint element section of
ACConfig.xml. You can also specify
expiration times (in minutes) for each
individual value. Unused values are
removed from the cache when the
expiration time has elapsed. Each time
a value is used, the expiration timer is
reset to zero.

SharePoint / TermsCache See description for SharePoint/
TermsetCache.

SharePoint / LookupCache See description for SharePoint/
TermsetCache.

TermsetCache / MaxValues Default value: 100

TermsetCache / Lifetime Default value: 60

TermsCache / MaxValues Default value: 10000

TermsCache / Lifetime Default value: 60

LookupCache / MaxValues Default value: 1000

LookupCache / Lifetime Default value: 60

ACConfig / OCEProfilesConversion Performance Default value: 1
Used to ensure optimal recognition
results for High Performance profiles.
When High Performance profiles
are converted to Advanced OCR
Recognition profiles, globally sets the
Operation mode to "Maximize accuracy"
instead of "Maximize performance."
0: Turn on
1: Turn off
OK to edit.

OCEProfilesConversion / Profile Name Used to apply the
OCEProfilesConversion setting to
specific High Performance profiles
(instead of all profiles).
The setting is applied to each High
Performance profile name that you
specify.
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Parent Element / Element Attribute Default Value / Description

Performance Default value: 1
Used to ensure optimal results for
the specified High Performance
profiles. When the specified profiles
are converted to Advanced OCR
Recognition profiles, sets the Operation
mode to "Maximize accuracy" instead of
"Maximize performance."
0: Turn on
1: Turn off
OK to edit.

ACConfig / ExportKTMProject Enable Default value: 1
0: Excludes Kofax Transformation
Modules projects when batch classes
are exported.
1: Includes Kofax Transformation
Modules projects when batch classes
are exported.

ACConfig / KCNS
AlwaysTransferCustomData

Default value: 0
0: Excludes KTM or other
CustomDataFolder files downloaded
from the central site to a remote site.
1: Includes KTM or other
CustomDataFolder files downloaded
from the central site to a remote site, if
their modified dates are newer than the
corresponding files on the central site.
The KCN AlwaysTransferCustomData
setting at the central site overrides the
setting at a remote site.
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Parent Element / Element Attribute Default Value / Description

ACConfig / ACIServer/BatchRouting RescanSite Default value: N/A
Automatically routes error batches to
a remote site if they were created at a
central site. Use the tag to define the
site name and GUID for processing
error batches and override the Rescan
Location setting configured in the KCN
Server Central Site profile. Example:

<ACConfig>
   ...
    <ACIServer>
      <BatchRouting
 RescanSite="<Site_Name>|
<Site_GUID>"/>
    </ACIServer>
   ...
</ACConfig>

The site name and GUID for the remote
site are available from the Database
Utility on the Identification tab.

Note If the specified remote site
name or GUID does not exist,
the following error appears in the
error log and the error batch is
not routed: "...The selected
site cannot be assigned as
the next site."

OK to edit.

ACConfig / Export UseDecimalBasedFileName Default value: 0
0: Does not apply special handling for
decimal-based file names.
1: Ensures that the decimal-based file
names are assigned to reflect the export
sequence for single-page TIFF images.
<Export
UseDecimalBasedFileName="1"/>

OK to edit.

ACConfig / PDFExport FastWebView Default value: 0 (Off)
1 = On
Turns on Fast Web View for PDF files.
<PDFExport FastWebView="1"/>
OK to edit.
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Parent Element / Element Attribute Default Value / Description

ACConfig / DisableBatchNotification PropagateToRemoteSite Default value: 0 (Off)
1 = On
Disables batch notification services
errors and messages for the entire
Kofax Capture installation. Synchronize
the DisableBatchNotification tag
for remote sites by adding the
PropagateToRemoteSite attribute.
When PropagateToRemoteSite is set to
True, this tag is sent to the remote site.

<DisableBatchNotification
 PropagateToRemoteSite="True">1</
DisableBatchNotification>

OK to edit.

DeletedBatches Default value: 1 (On)
0 = Off
Disables logging to the Deleted
Batches log file (LOG_yymm.txt). This
option may be useful in a high-volume
production environment in which logging
can adversely affect performance.

<Logging DeletedBatches="0"/>

OK to edit.

ACConfig / Logging

EnableMilliseconds Default value: 0 (Off)
1 = On
Adds milliseconds to logging files.
Otherwise, the time is logged in
seconds only. Applies to log files of
exported/deleted batches, error logs,
and KCN Server logs.

ACConfig / TransferAllVSFiles Enable Default value: 0
1=On
Includes all Visual Studio Solution files
during remote site synchronization in a
KCN Server environment.

<TransferAllVSFiles
 Enable="1"/>

After adding the tag, restart the Kofax
Capture service. By default, the
unrequired Visual Studio Solution files
are excluded.
OK to edit.
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Parent Element / Element Attribute Default Value / Description

Name Default value: N/A
Prevents PDF files from becoming
unreadable when Image Cleanup
profiles are disabled. Otherwise, all
images, including color, are detected as
black and white and the PDF Generator
produces unexpected results.
To apply this behavior to one PDF
export profile, use the following format
and replace "abc" with the profile name
used for the PDF Generator:

<ACConfig>
    ...
      <PDFExport>
        <Profile Name="abc"
 DetectColorImage="1"/>
      </PDFExport>
    ...
</ACConfig>

To apply this behavior to all PDF export
profiles, use the following format:

<ACConfig>
    ...
      <PDFExport
 DetectColorImage="1"/>
    ...
</ACConfig>

OK to edit.

PDFExport/Profile

DetectColorImage Default value: 0 (Off)
1=On

<PDFExport
 DetectColorImage="1"/>

Prevents PDF files from becoming
unreadable when Image Cleanup
profiles are disabled.

ACConfig /
RemoveUserRightsWithoutInvokingWFA

Default value: True (On)
False = Off
Skips the invoking of Workflow Agents
when Remove Access Rights is
selected in Batch Manager.
To force Workflow Agents to be invoked
when Remove Access Rights is
selected in Batch Manager, change the
value to false.
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Parent Element / Element Attribute Default Value / Description

ACConfig / OCRAdvancedSettings/
MultiProcessingMode

Value Default value: 1 (Off)
0 - On
Prevents a PDF Generator internal
program error.
1: Disabled.
OK to edit.

StopCreatingEmptyDocuments Default value: 0 (Off)
1 = On
Prevents the creation of empty
documents, which can occur as the
result of duplicate, consecutive patch
codes.
OK to edit.

ACConfig / DocumentSeparation

DeleteBackSideSeparator Default value: 1 (Off)
0 - On
Deletes only the first image when
Standalone Separator Sheet is enabled.
To retain the back side of the separator
sheet, set the attribute to "0."

ACConfig / FormIdentification UseColorImage Default value: 0 (Off)
1 = On
Uses a color image for form
identification.
OK to edit.

EnablePageValidationMode Default value: 0 (Off)
1 = On
Eliminates duplication of the first page in
multipage layout view during validation.
As a result, Validation will display pages
along with index fields without index
zones.
OK to edit.

ACConfig / Validation

ClearIndexFieldsOnPageRotationDefault value: 0 (Off)
1 = On
Clears the index field values at
Validation when the user rotates the
page.
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Parent Element / Element Attribute Default Value / Description

ACConfig / AdminDataSubstitution Replace Old Default value: N/A
Uses a regular expression wildcard
representing the batch class folder
name at the end of the temporary image
folder path. The regular expression
wildcard may be useful if you are
importing a large number of batch
classes from one environment to
another.
To use this enhancement, add the
UseRegex="1" attribute to replace the
original batch class name. The Old
attribute is a regular expression pattern,
and the New attribute is a string to
replace it.
In the following example, all paths
containing "C:\Program Files
\Ascent\"  are substituted with "D:
\abc\".

<ACConfig>  
  ...
   <AdminDataSubstitution>
      <Replace Old="C:\
\Program Files\\Ascent\
\(.+)" New="D:\abc\$1"
 UseRegex="1" />
   </AdminDataSubstitution>
  ...
</ACConfig>

If the regular expression is valid and the
paths are substituted successfully, it is
noted in the Capture log.
If the regular expression is not valid and
the paths are cannot be substituted, it is
noted in the Capture log:

2017-09-06 22:04:37, ...,
 Kofax Capture Administration
 Application, 
<Machine Name>, <File
 Version>, Regex, 0, parsing
 "C:\Program Files\\Ascent\
\(.+)" 
- Malformed \p{X} character
 escape.

OK to edit.
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Parent Element / Element Attribute Default Value / Description

ACConfig / PDFExport/Profile Encryption Default value: 0 (Off)
1: On
Prevents the PDF Generator from
producing encrypted PDF files with
blank passwords.

<ACConfig>
  ...
    <PDFExport Encryption="1"
 Password="kofax">
      <Profile Name="abc"
 Encryption="0"/>
      <Profile Name="def"
 Encryption="1"
 Password="kofax123"/>
    </PDFExport>
  ...
</ACConfig>

For the "abc" profile, the encryption will
be turned off.
For the "def" profile, the encryption
will be turned on with the password of
kofax123.
For other profiles, the encryption will be
turned on with the password of kofax.

Note The values defined for the
Encryption and Password attributes
in the PDFExport tag are applied
to all profiles except the ones
overridden by the Profile tag. Also,
the default values of the Encryption
and Password attributes are "0"
and empty.

OK to edit.

ACConfig / BatchFilterProfiles Enabled Default value: 1 (On)
0 = Off
Enables Batch Filter Profiles
functionality for Kofax Capture 11.0:
<BatchFilterProfiles
Enabled="1"/>

0 = Disables Batch Filter Profiles
functionality in Kofax Capture 11.0
and restores the behavior from Kofax
Capture 10.0:
<BatchFilterProfiles
Enabled="0"/>

OK to edit.
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Parent Element / Element Attribute Default Value / Description

Enabled Default value: 0 (On)
1 = Off
Restricts Kofax Capture users to a
single login session per module.
OK to edit.

ACConfig / SingleLogonSession

IncludedServiceModuleIds Default value: Empty
Lists the unique module IDs that run
under service mode or OLE mode with
SingleLogonSession enabled. The
unique module IDs are separated by
commas without spaces.
Example:
IncludedServiceModuleIds=
"LCI.Validation,Kofax.
Verification,Kofax.Correction,release.exe"

OK to edit.

ACConfig / EDocViewer UseIEForMSOfficeFiles Default value: 1 (On)
0 = Off
Uses custom control to view Microsoft
Word, Excel, PowerPoint, or other files if
Microsoft Office is installed.

<EDocViewer
 UseIEForMSOfficeFiles="0" />

OK to edit.

ACConfig /
PasswordEncryptionAlgorithm

Default value: AES
Used for custom encryption key for the
database password.
1. Execute the following command once
at the Kofax Capture servers at the
central site and the remote site:
DBUtil.exe /algorithm=AES /
privatekey=<private key>

Where <private key> is the base64
encoded file that contains the custom
key. The <private key> length must be
128 or 256 bits.
2. Store the private key in
[CaptureSV]\KofaxCapture.key.
3. Encrypt the existing Database
password in ACConfig.xml using the
new private key and initialization vector.

Note The new encryption applies
only to the Database password.
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Parent Element / Element Attribute Default Value / Description

ACConfig / PasswordInitializationVector Default value: N/A
Used internally by Kofax Capture for
password encryption. The value is
generated randomly and cannot be
edited.

ACIServer / RSASynchTaskAlternate NumBatches Default value: 10
Checks and updates the status of the
batches after NumBatches is uploaded
or downloaded.
OK to edit.

ACConfig / OmniPage EnableLog Default value: 0 (Off)
1 = On
With the OmniPage Log
enabled, OmniPage_<Module-
Name>_<PID>_<Month>-
<Day>-<Hour>-<Minute>-
<Second>.log is created and saved
in <drive:>ProgramData\Kofax
\Capture\Local\OmniPage. This
file contains information related to the
OmniPage recognition engine.

Tip To save free disk space from
a heavy load of log, settings, and
image files, use the

OmniPage

tag cautiously and disable when
unnecessary.

ACConfig / BatchCreation ValidateHiddenFieldLength Default value: 0 (Off)
1 = On
When the default value of a hidden
batch field includes more characters
than allowed by the field type, a batch
can be created when it should have
been prevented. Enable this attribute to
validate the hidden field length.

ACConfig / ReportViewer UseOleDbForOracle Default value: 0 (Off)
1 = On
Enables Report Viewer to use Ole DB
Provider for Oracle instead of the ODBC
Provider.
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Parent Element / Element Attribute Default Value / Description

ODBCSqlDriver Makes the ODBC driver configurable for
Report Viewer.
Default value: SQL Server
SQL Native Client
SQL Server Native Client 10.0
SQL Server Native Client 11.0
ODBC Driver 11 for SQL Server
ODBC Driver 13 for SQL Server
Makes the ODBC driver configurable for
the Report Viewer.

ACConfig / CheckTokenMembership Enabled Default value: 0 (Off)
1 = On
Enables the single sign-on feature for
child domains.

EnableTextInjectionForPDF Default value: 0 (Off)
1 - Detects the bitmap pages and
recognizes the text layers in a PDF
eDocument page.
2 - Recognizes text when the content
page includes both image and text.
You must restart the PDF Generator
module to apply the changes.

Note • If bitmap pages are
detected, the PDF output will be
overridden to the original page.
• The PDF version may be updated
automatically to 1.6 when enabling
this feature.
• If the input is a PDF/A file, the
output format setting in the PDF
profile should be the same as
the input file to retain PDF/A
compliance. For example: If the
input is PDF/A-1a, then the PDF
profile should be configured to use
PDF/A-1a for recognition.

AССonfig / EDocProcessing

InsertPagesToOutputPDF Default value: 0 (Off)
1 = On
Inserts the eDocument page to the final
output.
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Parent Element / Element Attribute Default Value / Description

AССonfig / PublishBatchClass UseLocalTempFolder Default value: 1 (On)
0 = Off
1 - The Administration module uses
a local folder when a batch class is
published.
0 - The Administration module uses a
network shared folder when a batch
class is published.

ACConfig / CaptureUI LayoutPreservation Default value: 1 (On)
0 = Off
If set to "0," the custom panel layout
is automatically resized according to
the main window when the module is
relaunched.

PDF Generator DPI Calculator
To prevent the PDF Generator from producing excessively large PDF output files that are time-consuming
to process, use the ResolutionScale and OutputWidthThreshold tags in ACConfig.xml. Using this
approach, you can save time and produce manageable PDF sizes.

Note The ResolutionScale and OutputWidthThreshold settings alter the PDF page dimensions but do
not impact the dimensions of the original source document. For example, you could use these settings
to produce a standard letter size PDF based on an "oversized" engineering drawing.

ResolutionScale
ResolutionScale is a multiplier that increases the value used as the dpi to generate a smaller PDF file
size. Increasing the dpi reduces the image size based on this formula:

Resolution (in pixels) / dpi

ResolutionScale impacts the resulting PDF document size only if the calculated width is greater than the
value specified for OutputWidthThreshold (in inches). The default value for ResolutionScale is 1.0.

OutputWidthThreshold
Use OutputWidthThreshold to prevent creation of an image that is too small. This value indicates the
smallest acceptable image width and serves as a safety mechanism to prevent creation of images that are
too small for the document. When not used in ACConfig.xml, or if no value is specified, the default value is
8.5 inches.
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Example
A batch contains two single-page documents: Document 1 with a 4000x8000 pixel image and Document 2
with an 800x1600 pixel image. Both have a dpi of 200. Document 1 creates a larger PDF file and must be
converted to produce a smaller file size without impacting Document 2.

The ResolutionScale is set to 2 and the OutputWidthThreshold is not configured in ACConfig.xml
(therefore, a default of 8.5 is assumed).

Document 1 (D1) calculation:
• The DPI passed to the PDF Generator engine is 400 (200 x 2 - dpi times ResolutionScale).
• PDF image size is 10 x 20, or (4000 / 400) by (8000 / 400).
• Because 10 inches is greater than the OutputWidthThreshold value, the values are valid for use by the

PDF Generator engine to create a PDF image.

Document 2 (D2) calculation:
• PDF image size is 2 x 4, or (800 / 400) by (1600 / 400).
• Because 2 is less than the OutputWidthThreshold value, the ResolutionScale multiplier is ignored, and

the original dpi is used to generate a PDF image that is 4 by 8 inches, or (800 / 200) by (1600 / 200).
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Appendix A

Security Model for Kofax Capture

Kofax Capture and Kofax Transofrmation Modules

A. User login and authentication

Category Authentication and Authorization

Description User provides login credentials for Kofax Capture application.

Security Details Kofax Capture supports corporate directory systems, such as Active Directory
through the Linked Users and Linked Groups features, which take advantage of
the corporate infrastructure for authentication and credential management.
Kofax Capture also has an application specific authentication and authorization
mechanism for convenience. This includes credential management and
storage. Stored passwords are encrypted. The Linked Users feature must be
used to take advantage of external systems that provide AES or equivalent
encryption.

B. Client transmission to servers
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Category Data in transit

Description Clients (such as Scan or Validation) transmit to servers.

Communication Database, .NET Remoting, SMB

Security Details All streams of data in transit can be protected with IPsec to take advantage of
network-level peer authentication, data origin authentication, data integrity, data
confidentiality (encryption), and replay protection.
Details on the streams used are as follows:
Database information containing metadata is transferred to and from the
database using the database manufacturer’s client driver. The network protocol
varies depending on what database is being used.
For more information, consult documentation from your database manufacturer.
.NET Remoting (TCP 2424) is used for licensing and batch notification
traffic. No confidential information (nothing related to images or metadata) is
transmitted or accessed.
Images are transmitted to/from the file system using the SMB (TCP 445)
protocol.

C. Image and metadata storage

Category Data at rest

Description Image and metadata is stored.

Security Details Images are stored in the file system and can be secured through use of
Windows file system permissions. As additional protection, the Kofax Capture
environment should be configured with the SecurityBoost feature that prevents
user accounts from accessing the file system outside the application.
Images can be also optionally be encrypted via Microsoft BitLocker or Microsoft
Encrypting File System (EFS).
Metadata is stored in the Kofax Capture database, which is accessed through
a configured system account, or by assigning permissions to each user.
Database level encryption is also available by using the encryption feature
within the database itself.
Note: When using the Microsoft SQL Server, you must set the "Store batches
in SQL Server" configuration option to ensure all metadata is stored in the
database. Oracle or IBM DB2 do not offer a comparable option, as all metadata
is always stored in the database.
Whether or not file system and/or database encryption is enabled, passwords
(for external systems or application-specific users), are further protected.
Passwords are always stored using the Triple DES encryption algorithm and
the SHA1 hashing algorithms approved by the Federal Information Processing
Standard (FIPS) Publication 140-2 standard.
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Kofax Capture Network Server

A. User login and authentication

Category Authentication and Authorization

Description User provides login credentials for Kofax Capture application.

Security Details Kofax Capture supports corporate authentication systems, such as Active
Directory through the Linked Users and Linked Groups features, which take
advantage of the corporate infrastructure for authentication and credential
management. Kofax Capture also has an application-specific authentication
and authorization mechanism for convenience. This mechanism includes
credential management and storage. Stored passwords are encrypted. The
Linked Users feature must be used to take advantage of external systems that
provide AES or equivalent encryption.

B. Remote Site connection to Kofax Capture Network Server web server

Category Data in transit

Port 80 or 443

Protocol HTTP or HTTPS

Communication .NET remote method calls

Description Kofax Capture can be configured to use SSL to enable security for
communications over networks such as the Internet. This allows end-to-end
encryption of the Transport Layer.

Security Details Remote site requests include HTTP GET requests for data from the File
Cache and KCN Service, HTTP POSTs to upload files to the File Cache,
and .NET remote method calls to the KCN Service.

C. Kofax Capture Network Server web server connection to the Kofax Capture Server application
server.

Category Data in transit
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Port 2424

Protocol TCP

Communication .NET remote method calls

Description The KCNS Web Server implements a .NET remote method interface that
allows remote sites to interact with central site Kofax Capture system.

Security Details In this context, Kofax Capture Network Server acts as a “client” to Kofax
Capture. Compared to interactive clients, Kofax Capture Network Server is
typically deployed in a protected server room near the Kofax Capture server,
and thus there is relatively low risk of data being intercepted. However, if
desired, the Kofax Capture Network Server connection to Kofax Capture can
be further secured as described earlier.
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